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C omputers for consumers have come a long
way in just 20 years or so. They're now at
the heart of the way many people communi-
cate, shop, and learn. They provide useful tools
for tracking information, organizing finances,
and being creative.

During the rapid growth of the personal com-
puter, you might have been too busy to jump in
and learn the ropes, but you now realize how
useful and fun working with a computer can be.

This book can help you get going with com-
puters quickly and painlessly.

About This Book

This book is specifically written for mature
people like you, folks who are relatively new

to using a computer and want to discover the
basics of buying a computer, working with soft-
ware, and getting on the Internet. In writing
this book, I've tried to take into account the
types of activities that might interest a 50+ year
old discovering computers for the first time.

Foolish Assumptions

This book is organized by sets of tasks. These
tasks start from the very beginning, assuming
you know little about computers, and guide
you through the most basic steps in easy-to-
understand language. Because I assume you're
new to computers, the book provides explana-
tions or definitions of technical terms to help
you out.

| “*oduc’rion

Conventions Used
in This Book

This book uses certain conventions to help
you find your way around, including:

w=» When you have to type something in a text
hox, | put it in bold type. Whenever | men-
fion a Web site address, | put it in another
fonf, 1ike this. Figure references
are also in bold, fo help you find them.

w=p For menu commands, | use the <> symbol fo
separate menu choices. For example, choose
Tools=>Internet Options. The = symbol is
just my way of saying “Open the Tools menu
and then click Internet Options.”

e Callouts for figures draw your attention fo an
action you need to perform. In some cases,
points of interest in a figure might be circled.
The text tells you what to look for; the circle
makes it easy fo find.

Tip icons point out insights or helpful
suggestions related fo tasks in the

step list.
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All computers are run by software called an operating system, such as
Windows. Because Microsoft Windows-based personal computers
(PCs) are the most common type, the book focuses mostly on
Windows functionality.

Why You Need This Book

Working with computers can be a daunting prospect to people who
are coming to them later in life. Your grandchildren may run rings
around you when it comes to technology, and you might have fallen
for that old adage, “You can't teach an old dog new tricks.” However,
with the simple step-by-step approach of this book, you can get up to
speed with computers and overcome any technophobia you might
have experienced.

You can work through this book from beginning to end or simply open
up a chapter to solve a problem or help you learn a new skill whenever
you need it. The steps in each task get you where you want to go
quickly, without a lot of technical explanation. In no time, you'll start
picking up the skills you need to become a confident computer user.

How This Book Is Organized

This book is conveniently divided into several handy parts to help you
find what you need.

w= Part I: First Steps with Your Computer: If you need
to buy a computer or get started with the basics of
using a computer, this part is for you. These chapters
help you explore the different specifications, styles,
and price ranges for computers and discover how to
set up your computer out of the box, including
hooking it up to a printer. These chapters provide
information for exploring the Windows desktop
when you first turn on your computer, customizing
Windows to work the way you want it to, and getting
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the hang of the way Windows organizes files and
folders. Finally, I provide information on using the
Help system that’s part of Windows.

w= Part II: Having Fun and Getting Things Done with
Software: Here's where you start working with that
new computer. Using the popular and inexpensive
Microsoft Works software, discover how to create
documents in the Works Word Processor and work
with numbers in the Spreadsheet. Chapters in this
part also introduce you to built-in Windows applica-
tions you can use to work with digital photos, listen
to music, and play games.

w= Part III: Exploring the Internet: It's time to get
online! The chapters in this part help you understand
what the Internet is and what tools and functions it
makes available to you. Find out how to explore the
Internet with a Web browser; how to stay in touch
with people via e-mail, instant messaging, chat, blogs;
and even how to make Internet phone calls.

w= Part IV: Taking Care of Your Computer: Now that
you have a computer, you have certain responsibilities
towards it (just like having a child or puppy!). In this
case, you need to protect the data on your computer,
which you can do using Windows and Internet
Explorer tools. In addition, you need to perform some
routine maintenance tasks to keep your hard drive
uncluttered and virus free.

Get Going!

Whether you need to start from square one and buy yourself a
computer or you're ready to just start enjoying the tools and toys
your current computer makes available, it's time to get going, get
online, and get computer savvy.
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Buying a
Computer

If you've never owned a computer and now
face purchasing one for the first time, decid-
ing what to get can be a somewhat daunting
experience. There are lots of technical terms to
figure out and various pieces of hardware (the
physical pieces of your computer such as the
monitor and keyboard) and software (the
brains of the computer that help you create
documents and play games, for example) that
you need to understand.

In this chapter, I introduce you to the world of
activities your new computer makes available
to you, and I provide the information you
need to choose just the right computer for you.
Remember as you read through this chapter
that figuring out what you want to do with
your computer is an important step in deter-
mining which computer you should buy. You
have to consider how much money you want
to spend, how you'll connect your computer to
the Internet, and how much power and perfor-
mance you'll require from your computer.
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Understand All You Can Do with Computers

In just a couple of decades, computers have moved from being expen-
sive behemoths that lived in corporate basements to being personal
productivity and entertainment tools. They have empowered people to
connect around the world in unprecedented ways, and they've made
common tasks much easier to handle.

The following list walks you through some of the things your com-
puter will enable you to do. Depending on what activities are impor-
tant to you, you can make a more informed purchasing choice.

w= Keep in touch with friends and family. The Internet
has made it possible to communicate with other
people via e-mail; share video images using webcams
(tiny, inexpensive video cameras that capture and
send your image to another computer); and make
phone calls using a technology called VoIP (Voice
over Internet Phone), which uses your computer and
Internet connection to place calls. You can also chat
with others by typing messages and sending them
through your computer using a technology called
instant messaging. These messages are exchanged in
real time, so that you and your grandchild, for exam-
ple, can see and reply to text immediately. Part III of
this book explains these topics in more detail.

w= Research any topic from the comfort of your home.
Online, you can find many reputable Web sites that
help you get information on anything from expert
medical advice to the best travel deals. You can read
news from around the corner or around the world.
You can visit government Web sites to find out infor-
mation about your taxes, Social Security, and more,
or even go to entertainment sites to look up your
local television listings.
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w= Create greeting cards, letters, or home inventories.
Whether you're organizing your holiday card list or
figuring out a monthly budget, computer programs
can help. For example, Figure 1-1 shows a graph that
the Excel program created from data in a spreadsheet.
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Figure 1-1

w= Pursue hobbies such as genealogy or sports. You can
research your favorite teams online (see Figure 1-2)
or connect with people who have the same interests.
The online world is full of special interest chat groups
where you can discuss your interests with others.

w= Play interactive games with others over the Internet.
You can play everything from shuffleboard to poker
or action games in virtual worlds.

w= Share and create photos, drawings, and videos. If you
have a digital camera, you can transfer photos to your
computer (called uploading) or copy photos off the
Internet and share them in e-mails or use them to
create your own greeting cards. If you're artistically
inclined, you can create digital drawings. Many popu-
lar Web sites make sharing digital movies easy, too.
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If you have a digital video camera and editing soft-
ware, you can use editing tools to make a movie and
share it with others. Steven Spielberg, look out!

w= Shop online and compare products easily, day or
night. You can shop for anything from a garden
shed to travel deals or a new camera. Using handy
online features, you can easily compare prices from
several stores or read customer product reviews. Web
sites such as www.nextag. com list product prices
from a variety of vendors on one Web page, so you
can find the best deals. Beyond the convenience, all
this information can help you save money.
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Figure 1-2

w= Handle your financial life. You can do your bank-
ing or investing online and get up-to-the-minute
data about your bank account, credit card balances,
and investments.

10
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Understand Hardware and Software

Your computing experience is made up of hardware and software. The
hardware is all the tangible computer equipment, such as the keyboard
and mouse, and the software is what makes the hardware work or lets
you get things done, such as writing documents with Microsoft Word
or playing a Solitaire game. Think of the hardware as being like your
television set and the shows that you watch as being like the software.

The hardware on your computer consists of

[T 2

2

2

1=

2

A central processing unit (CPU), which is the very
small, very high-tech semiconductor chip that acts as
the brains of your computer. The CPU is stored in a
computer tower along with the other nuts and bolts
of your computer.

A monitor, which displays images on its screen such
as the Microsoft Windows 7 desktop or a document
in a software program.

A keyboard, which is similar to a typewriter keyboard.
In addition to typing words, you can use a keyboard
to give the computer commands.

A mouse, which you also use to give your computer
commands, but this little device is more tactile. You
move the mouse around your desk with your hand,
which moves a pointer around on-screen. Using this
pointer, you can click on items like buttons that
cause an action, or click on the screen and drag the
mouse to select text or an object to perform an action
on it (such as deleting it or making the text bold).

Peripherals, such as a printer, speakers, webcames,
and microphones. These may or may not come with
your computer when you buy it, but your computer
does come with slots (called ports) where you plug in
various peripherals.

11
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Software (also known as programs or applications) is installed on your
computer hard drive, which resides in the computer casing (either in
your laptop or, for a desktop computer, in the computer tower). Here
are a few basics about software:

w= You use software to get your work done, run enter-
tainment programs, and browse the Internet. For
example, Quicken is a financial management pro-
gram you can use to balance your checkbook or keep
track of your home inventory for insurance purposes.

m= Some programs come preinstalled on your com-
puter; you can buy and install other programs as
you need them. For example, there is always an
operating system on a computer, because it runs all
the other programs. Also some programs are
included with your operating system, such as
Solitaire, an electronic version of the old favorite
card game, which comes with Windows 7. Skype, a
program that enables you to make online phone
calls using your computer, is a popular program that
you can find on the Internet and install on your
computer yourself.

m= You can uninstall programs you no longer need.
Uninstalling unwanted programs helps to free up
some space on your computer, which helps it per-
form better.

w= Some software programs called utilities exist to
keep your computer in shape. An antivirus program
is an example of a utility used to spot and erase com-
puter viruses from your system. Your operating system
(such as Windows 7 Home Premium, which you
hear more about in the task, “Choose a Version of
Windows”), also includes some utilities, such as the
Windows Defender program. Windows Defender

12
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protects your computer from unwanted intrusion by
malicious programs called spyware. See Part IV for
details about using utilities.

Explore Types of Computers

Just as there are many styles of shoes or mobile phones, you can find
several styles of computers. Some are small and portable, some use
different operating systems to make everything run, and some excel at
certain functions such as working with graphics or playing games. This
section explains some features you'll need to consider when choosing
the type of computer you should buy.

Operating System: Windows is probably the most common com-
puter operating system, and this book mainly focuses on its features.
However, Macintosh computers from Apple are also popular. These
use Apple-specific software; however, many software applications
written for Windows are also available for the Macintosh, and you
can also set up your Mac to run the Windows operating system,
which gives you the best of both worlds. Some computers run on a
freely available operating system called Linux, which has similar
functionality to Windows.

Computer Design: Two types of computers you can buy are a laptop
and a desktop. Here's the difference:

w= A laptop is portable, weighing anywhere from two to
eight pounds (the lowest weight ones are called net-
books). The monitor, keyboard, and mouse are built
into the laptop. (Note that if the monitor is dam-
aged, you have to pay quite a bit to have it repaired
or hook it up to an external monitor.) Figure 1-3
shows an example of a laptop, which is sometimes
called a notebook computer. Choose a laptop if you
want to use your computer mainly away from home
or you have little space in your home for a larger
computer.

13
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Figure 1-3

w= Desktop models typically have a large tower, such as
the tower shown in Figure 1-4, that contains the
computer’s central processing unit (called a CPU).
The keyboard, mouse, and monitor are separate.
Desktop computers take up more space than laptops
and are not portable, but they're usually less
expensive.

A computer’s central processing unit (CPU)

Figure 1-4

Pictures and Sound: If you work with a lot of visual elements (for
example, photographs, home movies, or computer games), consider a
computer that has a better graphics card. Games often involve sound,
so a high-end sound card may also be useful. Computers with more

14
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sophisticated sound and image capabilities are often referred to as
gaming or multimedia models and they typically require a larger hard
disk to handle these functions. Because the capabilities of these cards
change all the time, I don’t give you the specifications for what's high
end; instead, ask the person you're buying the computer from whether
the system can handle sophisticated sound and graphics.

Choose a Version of Windows

As mentioned in the previous task, choosing your computer’s operating
system (software that runs all the programs and organizes data on your
computer) will be one of your first decisions. This book focuses on
computers running the current version of Windows, which is called
Windows 7. Windows 7 comes in three different versions for home and
business users. If you consider yourself primarily a home user, you
should consider the Home Premium version of Windows 7:

w= Home Premium includes entertainment tools such as
Windows Media Center for playing music and movies.
If you want to do more than look at photos, you'll
find that this version of Windows 7 is good at work-
ing with design and image manipulation programs
such as Photoshop. Also, if you choose a laptop, be
aware that Home Premium includes great features for
managing the battery power of your computer.

w= Windows 7 Professional is great for small busi-
nesses or if you work from home. This version of
Windows has ultimate security features.

w=  Windows 7 Ultimate provides everything that
Professional provides, plus a few more bells and whis-
tles for protecting your computer from thieves with
BitLocker and handling languages other than English.

before that, Windows XP. Many people still use com-

@ Before Windows 7, there was Windows Vista, and
puters that run Vista or XP and get along just fine.
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However, Windows XP doesn’t come with as many
security tools. If you decide to use Windows XP, find a
friend or family member who's knowledgeable about
computers and can help you use XP features or other
software programs that will help keep your computer
secure. Note that if you're using Vista or XP, some of
the steps for common tasks are different than they are
if you use Windows 7; however, you can still use this
book to find out about many computer basics.

Choose a Price Range

16

You can buy a computer for anywhere from $299 to $5,000 or more,
depending on your budget and computing needs. You may start with a
base model, but extras such as a larger monitor or higher-end graphics
card can soon add hundreds to the base price.

You can shop in a retail store for a computer or shop online using a
friend’s computer (and perhaps get his or her help if you're brand new
to using a computer). Consider researching different models and
prices online and using that information to negotiate your purchase in
the store if you prefer shopping at the mall. Be aware, however, that
most retail stores have a small selection compared to all you can find
online on a Web site such as Dell.com.

Buying a computer can be confusing, but here are some guidelines to
help you find a computer at the price that’s right for you:

w= Determine how often you will use your computer. If
you'll be working on it eight hours a day running a
home business, you will need a better quality com-
puter to withstand the use. If you turn on the com-
puter once or twice a week, it doesn’t have to be the
priciest model in the shop.

w= Consider the features that you need. Do you want
(or have room for) a 20-inch monitor? Do you
need the computer to run very fast and run several
programs at once, or do you need to store tons of
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data? (Computer speed and storage are covered later
in this chapter.) Understand what you need before
you buy. Each feature or upgrade adds dollars to
your computer’s price.

Shop wisely. If you walk from store to store or do
your shopping online, you'll find that the price for
the same computer model can vary by hundreds of
dollars at different stores. See if your memberships in
organizations such as AAA, AARP, or Costco make
you eligible for better deals. Consider shipping costs
if you buy online, and keep in mind that many stores
charge a restocking fee if you return a computer you
aren’t happy with. Some stores offer only a short time
period, such as 14 days, in which you can return a
computer.

Buying used or refurbished is an option, though
new computers have reached such a low price
point that this may not save you much. In addi-
tion, technology gets out of date so quickly, you
might be disappointed buying an older model.
Instead, consider going to a company that produces
customized, non-name-brand computers at lower
prices — perhaps even your local computer repair
shop. You might be surprised at the bargains you can
find (but make sure you're dealing with reputable
people before buying).

Online auctions are a source of new or slightly
used computers at a low price. However, be sure
you're dealing with a reputable store or person by
checking reviews others have posted about them or
contacting the Better Business Bureau. Be careful not
to pay by check (this gives a complete stranger your
bank account number); instead use the auction site’s
tools to have a third party handle the money until
the goods are delivered in the condition promised.

Chapter 1: Buying a Computer
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®

Check the auction site for guidance on staying safe
when buying auctioned goods.

Some Web sites, such as Epinions.com, allow you to
compare several models of computers side by side,
and others, such as Nextag.com, allow you to com-
pare prices on a particular model from multiple
stores.

Select a Monitor

18

Monitors are the window to your computer’s contents. If you're buy-
ing a desktop computer, it may come with a monitor that suits your
purposes, or you might upgrade to a better monitor. A good monitor
can make your computing time easier on your eyes. The crisper the
image, the more impressive your vacation photos or that highly visual
golf game will be.

Consider these factors when choosing a monitor:

nmp

=y

Size: Monitors for the average computer user come in
all sizes, from tiny 10-inch screens on smaller lap-
tops to 22-inch desktop models. Larger screens are
typically more expensive. Although a larger monitor
can take up more space side to side and top to bot-
tom, many don’t have a bigger footprint (that is, how
much space their base takes up on your desk) than a
smaller monitor.

Image quality: The image quality can vary greatly. You
will see terms such as LCD (liquid crystal display;
also referred to as flat panels), CRT (cathode ray
tube), flat screen, brightness, and resolution. Today,
CRT screens, though still available, are old
technology.

Look for an LCD monitor, preferably with a flat
screen (see Figure 1-5) to ease glare.
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An LCD monitor with a flat screen
Figure 1-5

w= Resolution: A monitor’s resolution represents the
number of pixels that form the images you see on
the screen. The higher the resolution, the crisper the
image. You should look for a monitor that can pro-
vide at least a 1,024 x 768 pixel resolution.

m= Cost: The least expensive monitor might be the one
that comes with a computer package, and many of
these are perfectly adequate. You can often upgrade
your monitor when you buy if you customize a sys-
tem from a company such as Dell or Gateway.
Monitors purchased separately from a computer can
range from around $100 to $3,000 or more. Check
out monitors in person to really see whether their
image quality and size are worth the money.

Choose an Optical Drive

You've probably used or seen a DVD used to play movies at home.
Computers can also read data from or play movies or music from
DVDs. Your computer is likely to come with at least one optical drive,
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which is a small drawer that pops out, allowing you to place a DVD in
a tray, push the drawer back into the computer, and use the contents
of the DVD. If you buy a software program, it will come on a CD or
DVD, so you also need this drive to install software.

When you buy a computer, keep these things in mind about optical
drives:

w= DVDs versus CDs: DVDs have virtually replaced CDs
as the computer storage medium of choice, but you
might still find a CD floating around with music or
data on it that you need to read. For that reason, you
might want a DVD/CD combo drive.

w= DVD drives: DVD drives are rated as Read (R) or Write
(W). A readable DVD drive only allows you to look
at data on it, but not save data to it. A writeable
DVD drive allows you to save data (or images, or
music) to it. A RW, or read-writeable, DVD drive lets
you both read and write to DVDs.

w= DVD standards: In the earliest days of DVDs, there
were two different standards, + and -. Some drives
could play DVDs formatted + but not those format-
ted -, for example. Today, you should look for a
DVD drive that is specified as +/- so it can deal with
any DVD you throw at it.

a computer, if it doesn't come with recovery disks, is
to burn recovery disks that you can use if you have to
restore the computer to it’s factory settings. You
might need to do this, for example, if a virus corrupts
your settings. Your computer should offer this as an
option when you first start it, but if it doesn’t, check
your computer’s help system or the manufacturer’s
Web site to find out how to burn recovery disks.

@ One of the first things you should do when you buy

20
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Understand Processor Speed and Memory

You computer contains a processor contained on a computer chip.
The speed at which your computer runs programs or completes tasks
is determined in great measure by your computer’s processor speed.
Processor speed is measured in gigahertz (GHz). The higher this mea-
surement, the faster the processor. I won’t quote the speed you should
look for because these chips are constantly getting smaller and contain
more and more power. However, when you shop, know that the
higher numbers give the best performance and factor that into your
decision depending on your needs.

In addition, computers have a certain amount of storage capacity for
running programs and storing data. You'll see specifications for RAM
and hard drive memory when you go computer shopping. Again, the
specific numbers will change, so the guideline is to look for higher
RAM numbers if you feel you need more storage capacity.

m= RAM is the memory needed to simply access and
run programs. RAM chips come in different types,
including DRAM, SDRAM, and the latest version,
DDR2. Look for a minimum of 1 gigabyte (GB) of
RAM for everyday computing.

m= RAM chips are rated by access speed, which relates to
how quickly a request for data from your system
can be completed. You might see RAM speed mea-
sured in megahertz (MHz). Today, 800 MHz could
be considered good access speed.

w= Your hard drive has a certain capacity for data
storage measured in gigabytes (GB). These days
you should probably look for a minimum of a
160GB hard drive, but hard drives can come with
a range of huge capacities, with the largest being
measured in terabytes (TB, measured in thousands
of gigabytes).

21
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Your computer will require some RAM to run the
operating system. Windows 7 requires 1GB of main
memory and 16GB of hard drive space.

Determine How You’ll Connect to the Internet

22

You have to decide how you’ll connect to the Internet. You can use a
dial-up connection over a standard phone line or pay a fee to get a
broadband connection such as DSL. (Check with AARP to find out

if they offer discounted connections in your area.) However, if you
want a wireless connection that works like your cell phone to pick up
a signal in certain hotspots, you have to be sure to buy a computer with
wireless capabilities. Here’s how these work:

1=

1=

Dial-up: If you intend to use a dial-up connection
(that is, connect over your phone line), your com-
puter has to have a dial-up modem either built in or
in an external model. Dial-up connections can be
very slow, and while you're using them, you can't use
your phone to make or receive calls. I'd discourage
you from using dial-up unless you absolutely have to.

Wireless: Wireless connections require that you have a
computer equipped with wireless capability. You can
access the Internet wirelessly when you're near a
wireless hotspot (a place that offers wireless service),
and many hotspots are appearing at public places
such as hotels, airports, and restaurants. You can also
subscribe to a Wireless Wide Area Network (WWAN)
service from a mobile phone provider to tap into its
connection. Check the computer model you want to
buy to be sure it is wireless enabled. There are vari-
ous techy standards for wireless such as 802.11a, b,
or g. The very latest standard to look for is 802.11n,
which delivers better wireless performance.
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w= Broadband: Broadband connections can be DSL (dig-
ital subscriber line) or cable modem. In both cases,
you pay a fee to a provider, which might be your
phone company or cable company. DSL works over
your phone line but doesn’t prohibit you from using
the phone when you're online. Cable runs over your
cable TV line and is a bit faster than DSL, though con-
nections can be less dependable. Both are considered
always-on connections, meaning that you don't have
to wait to dial up to a phone connection or connect
to a wireless network — you're always connected.

See Chapter 16 for more about setting up your
Internet connection.

Buy a Customized Computer

You can buy prepackaged computer systems online or in an electronics
store. An alternative is to buy a customized computer. Companies
such as Dell (see Figure 1-6) and Gateway offer customized computer
systems. When you buy the computer, you can pick and choose
various features, and the provider will build the system for you.
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Here are some of the variables you'll be asked about when you pur-
chase a customized system, many of which are discussed in this
chapter:

w= Type and speed of processor
w=  Amount of RAM or hard drive capacity

w= Installed software, such as a productivity suite like
Microsoft Office or Microsoft Works, or a premium
version of an operating system

w= More sophisticated graphics or sound cards

w= Peripherals such as a printer or an upgrade to a wire-
less mouse or keyboard

w= Larger or higher-end monitor
w= Wireless capability

w= Warranty and technical support

These all add to your final price, so be sure you need an option before
you select it. Most of these companies provide explanations of each
item to help you decide.
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Setting Up Your
Computer

nce you unpack your new computer, you

may need help getting it set up. Here I
cover the basics: connecting your computer
to a monitor, keyboard, and mouse (if you
bought a laptop computer, you can skip these
tasks as they're all built in!); turning the com-
puter on and off; and mastering the basic use
of your mouse.

Next you can set up the date and time in your
computer’s internal clock so they match your
time zone, and you can apply daylight savings
time settings properly. Finally you get to work
with your user accounts. Windows allows you
to create multiple user accounts; each account
saves certain settings and allows you to control
files and folders separately. When each user
logs on with a particular user account, it's like
accessing a unique personal computer.

Here, then, are the procedures that you can fol-
low to get going with your computer.
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Connect the Monitor, Keyboard, and Mouse

Your computer comes with a monitor, keyboard, and mouse. You
should connect these before turning on the computer. Your computer
will offer several types of connection ports, though USB ports are
becoming the most common. Wireless keyboards and mouses use a
small transmitter that you insert into a USB port, for example.

Use the following table in conjunction with Figure 2-1 to identify
device-to-PC connector ports.

Connection Location What It’s Good For
VGA port 1 Connect your monitor.
USB port 2 Connect various USB devices, such as a digital camera.
Parallel port 3 Connect a non-USB printer.
Audio 4 Connect speakers.
3
L XN f?l.h.l-[E.S [ X N
USB @Qoooooooooo-o]@
— COMT
— olebiijo o) @-@ OJOXO)
VGA IN k) =) (omm
1 ——
2 1 4
Figure 2-1

Log On and Off Windows 7

1. With your computer set up, you're ready to turn it on.
Start by pressing the power button on your computer to
begin the Windows 7 start-up sequence.
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2. In the resulting Windows 7 Welcome screen, enter your
password, if you have set one, and click the arrow button
or click Switch User and choose another user to log on
as. (If you need help with using the mouse to make your
selection, see the next task.) Windows 7 verifies your
password and displays the Windows 7 desktop, as shown
in Figure 2-2. (Note: If you haven’t set up the password
protection feature for more than one user, you're taken
directly to the Windows 7 desktop. For more on adding
and changing passwords, see Chapter 21.) The icons on
your desktop may vary depending on what programs
your computer manufacturer may have installed.

The Windows 7 desktop

SRR REEEEEE
Wednesday

4

March 2009

& : mg 3 J&f @ B s ) ;}im T
Figure 2-2
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3. Once you're logged in, to change to another user account,
first save any open documents, close any open applica-
tions, and then choose Start. Then click the arrow next to
the button, labeled Shut Down, in the bottom-right cor-
ner of the Start menu and choose Log Off. Windows 7
logs off and displays a list of users. To log on again, click
a user icon.

and, under the User Accounts and Family Safety
heading, click Add or Remove User Accounts. Then
click Create a New Account. Follow instructions to
enter a name for the account and set a password for
it, if you like.

@ To create another user, choose Start=>Control Panel,

to the password screen, you have to click the icon for

@ After you set up more than one user, before you get
the user you wish to log on as.

Use the Mouse

Unlike using a typewriter, which uses only a keyboard to enter text
into documents, with a computer you use both a keyboard and a
mouse to enter text and give commands to the computer. Though you
might have used a keyboard of some type before, a mouse might be
new to you, and frankly, it takes a little getting used to. In effect, when
you move your mouse around on your desk (or in some models, roll a
ball on top of the mouse), a corresponding mouse pointer moves
around your computer screen. You control the actions of that pointer
by using the right and left buttons on the mouse.

Here are the main functions of a mouse and how to control them:

w= Clicking: When people say “click,” they mean “press
and release the left mouse button.” Clicking has a
variety of uses. You can click while in a document to
move the insertion point, a little line that indicates
where your next action will take place. For example,
you might click in front of a word you already typed
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and then type another word to appear before it in a
letter. Clicking is also used in various windows to
select check boxes or radio buttons (also called option
buttons) to turn features on or off or to select an
object such as a picture or table in your document.

w=  Right-clicking: If you click the right mouse button,
Windows displays a shortcut menu that is specific to
the item you clicked. For example, if you right-click a
picture, the menu that appears gives you options for
working with the picture. If you right-click the
Windows desktop, the menu that appears lets you
choose commands that display a different view or
change desktop properties.

w=  Clicking and dragging: To click and drag, you press
and continue to hold down the left mouse button and
then move (drag) the mouse to another location. For
instance, you can click in a document and drag your
mouse up, down, right, or left to highlight contents
of your document. This highlighted text is selected,
meaning that any action you perform, such as pressing
the Delete key on your keyboard or clicking a button
for bold formatting, is performed on the selected text.

w= Scrolling: Many mouse models have a wheel in the
center that you can roll up or down to scroll through
a document or Web site on your screen. Just roll the
wheel down to move through pages going forward,
or scroll up to move backward in your document.

Set the Date and Time

1. The date and clock on your computer keep good time,
but you might have to provide the correct date and time
for your location. To get started, press the Windows key
on your keyboard (the one with the Windows logo on it)
to display the taskbar if it isn't visible.
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2. Right-click the Date/Time display on the far right of the
taskbar and then choose Adjust Date/Time from the

shortcut menu that appears.

3. In the Date and Time dialog box that appears (see Figure
2-3), click the Change Date and Time button. In the Date
and Time Settings dialog box that appears, enter a new
time in the Time field or use the up and down arrows
next to that field to change the time. If you wish, click on
a new date in the calendar display. Click OK.

4. To change the time zone, click the Change Time Zone
button, choose another option from the Time Zone drop-

down list, and click OK.

5. Click OK to apply the new settings and close the dialog

box.

= Date and Time i i 23]

Date and Time | Additional Clocks | internet Time |

Date:
Wednesday, March 04, 2009

: R
W\ . <‘_ } -'J."I Time:

) o' 2:21:58 PM

— | 1% Change date and time... I

Time zone

(UTC-08:00) Pacific Time (US & Canada)

| Change time zone...

Daylight Saving Time begins on Sunday, March 08, 2008 at 2200 AM. The
clock is set to go forward 1 hour at that time.

[¥] Notify me when the clock changes

Get the latest time zone information and updates online

How do I set the clock and time zone?

oK | l Cancel Apply

Figure 2-3

Click the
Change Date and Time
button
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If you don’t want your computer to adjust for
Daylight Saving Time, click Change Time Zone and
click the Automatically Adjust Clock for Daylight
Saving Time check box to turn this feature off.

Another option for displaying the time or date is to
add the Clock or Calendar gadget to the Windows
desktop. See Chapter 10 for more about using gadgets.

Create a New User Account
1. Choose Start>Control Panel.

2. In the resulting window, click the Add or Remove User
Accounts link.

3. In the resulting Manage Accounts dialog box, shown in
Figure 2-4, click Create a New Account.

4. In the next dialog box, shown in Figure 2-5, enter an
account name, and then select the type of account you
want to create:

¢ Administrator, who can do things like create and
change accounts and install programs

e Standard user, who can’t do the tasks an adminis-
trator can

5. Click the Create Account button and then close the
Control Panel.

to it, such as assigning a password or changing the
account type, by double-clicking it in the Manage
Accounts window you reached in Step 3 (in the pre-
ceding step list) and following the links listed there.

@ After you create an account, you can make changes
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Create a new account ————

What is a user account?

Additional things you can do
#5et up Parental Controls
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Figure 2-4

Choose an account type
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@Qv 42, « User Accounts » Manage Accounts » Create New Account - ‘¢’| ‘ Search Control Panel L |

File Edit | View Tools Help

Name the account and choose an account type

This name will appear on the Welcome screen and on the Start menu,
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Standard account users can use most software and change system settings that do not affect other users or
the security of the computer,

*) Administrator
Administrators have complete access to the computer and can make any desired changes, Based on
notification settings, administrators may be asked to provide their password or confirmation before
making changes that affect other users.

We recommend that you protect every account with a strong password.

Why is a standard account recommended?

| Create Account ] ‘ Cancel

Figure 2-5
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Switch User Accounts

1. Click Start and then click the arrow on the side of the
Shut Down button (see Figure 2-6).

2. Choose Switch User. In the resulting screen, click on the
user you want to log in as.

3. If the user account is password-protected, a box appears
for you to enter the password. Type the password and
then click the arrow button to log in.

4. Windows logs you in with the specified user’s settings.

If you forget your password and try to switch users
without entering one, Windows shows your pass-

word hint, which you can create when you assign a
password to help you remember it.

Microsoft Office Word 2007 3

Snaglt 9

I3

Nancy
Getting Started 3

Documents
Windows Media Center

sf )

Pictures
...... Calculator

Music

Sticky Motes

Games

% Snipping Tool
Computer
=

|f :B Microsoft Office PowerPoint 2007 »
- Control Panel

) Ppaint <
'f‘;[ Devices and Prin| Switch user

- Log off
( Toolbar Settings Default Program Lock

Restart

»

| Search programs and files .'..

All Programs Help and Suppe

Click this arrow

Figure 2-6
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You can set up several user accounts for your computer,
@ which helps you save and access specific user settings
and provide privacy for each user’s files with pass-
words. To find out about setting up user accounts and
changing their settings, see earlier tasks in this chapter.

Change Your User Account Picture

1. If you don't like the picture associated with your user
account, you can change it. Choose Start=>Control Panel=>
Add or Remove User Accounts.

2. In the resulting Add or Remove User Accounts dialog
box, click the account you want to change.

3. In the resulting window, click the Change Picture button
and click another picture (or browse to see more picture
choices) to select it (see Figure 2-7).

@_' %8, » Control Paned » User Accounts snd Famiy Safety » User Accounts » Change Your Picture

o
@
3

Click the Change Picture button
Figure 2-7

4. Click the Change Picture button; the dialog box closes.

5. Click the Control Panel’s Close button to close it.
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Shut Down Your Computer

1. To turn off your computer when you're done, you need
to initiate a shut down sequence in your operating sys-
tem instead of simply turning off the power. Choose Start
and then click the Shut Down button.

2. If you prefer to stop your computer running but not turn
the power off, click the arrow to the right of the Shut
Down button and, in the resulting shortcut menu shown
in Figure 2-8, choose Hibernate on a laptop (or simply
close the lid of your laptop) to shut the computer down;
if you want to reboot (turn off and turn back on) your
computer, choose Restart.

If you're going away for a while but don’t want to

@ have to go through the whole booting up sequence
complete with Windows 7 music when you return,
you don’t have to turn off your computer. Just click
the Sleep command instead (in Step 2) to put your
computer into a kind of sleeping state where the
screen goes black and the fan shuts down. When you
get back, just click your mouse button or press Enter,
or in some cases (especially on some laptops) press
the Power button; your computer springs to life, and
whatever programs and documents you had open are
still open.

If your computer freezes up for some reason, you can
turn it off in a couple of ways. Press Ctrl+Alt+Delete
twice in a row, or press the power button on your
CPU and hold it until the computer shuts down.

@,

Don't simply turn off your computer at the power
source unless you have to because of a computer dys-
function. Windows might not start up properly the
next time you turn it on if you don't follow the
proper shut down procedure.

@,
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Figure 2-8
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Understand the Desktop

Think of the desktop as the place where you can open and work with
all the windows that you use to get your work done. The desktop
appears when you first turn on your computer. You can use various
elements of the desktop to open or manage files, access settings for
Windows, go online, and more. Figure 3-1 shows the desktop and
some of the elements on it, including the following:

w= The taskbar is home to the Start menu, accessed by
clicking the Start button. Currently open programs
are listed here, and you can click on one to switch
programs. Finally, you can work with various settings
such as the volume control using icons displayed on
the taskbar.

w= The right side of the taskbar, which is called the
Notifications area, contains many commonly used
functions such as the computer date and time set-
tings, the network connections icons, and the icon
you click to safely remove hardware, such as a USB
storage device, from your computer.

w= The Frequently Used Programs area is a set of icons
within the taskbar that you use to open frequently
used programs. You can customize this area of the
taskbar to contain any programs you want. See the
section “Work with Frequently Used Programs” later
in this chapter.

w= The Recycle Bin holds recently deleted items. It will
empty itself when it reaches its maximum size
(which you can modify by right-clicking the Recycle
Bin and choosing Properties), or you can do so man-
ually. Check out the section “Empty the Recycle Bin”
later in this chapter for more about this.
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w= Desktop shortcuts are icons that reside on the desk-
top and provide a shortcut to opening a software
program or file. Your computer usually comes with
some shortcuts, such as the Recycle Bin and a
browser shortcut, but you can also add or delete
shortcuts. Click a desktop shortcut to launch an asso-
ciated program. See the “Create a Shortcut to a File
or Folder” section later in this chapter.

Recycle Bin ~ Desktop shortcut  Taskbar Gadgets

R Lo
Wednesday

4

March 2009

- T

e \ = 216 PM
>R EN o % m ) al ()

MQ u]l ﬁf @i P8O a0 »

T |
Start  Frequently Used Programs Notifications
button area area
Figure 3-1
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w= Gadgets can be placed on the desktop. These are

®

handy little tools including a stock ticker, a clock,
and a calendar, but you can also download lots of
other gadgets from the Windows Web site. Chapter
10 explains how to get started with gadgets.

The desktop is always there as you open program win-
dows to get your work done. If you make a program
window as big as it can be (maximize it), you won't see
the desktop, but you can go back to the desktop at any
time by shrinking a window (minimizing it) or closing
windows. You can also press Alt+Tab simultaneously
and choose the desktop from the open programs’
icons in the window that appears.

Work with the Start Menu

1. Press the Windows key on your keyboard or click the
Start button on the desktop to display the Start menu
(see Figure 3-2).

40

2. From the Start menu, you can do any of the following:

e Click All Programs to display a list of all programs
on your computer. You can click any program in
the list to open it.

e Click any category on the right of the Start menu
to display a Windows Explorer window with
related folders and files (see Figure 3-3).

e Click either frequently used programs at the left of
the Start menu or click the arrow to the right of an
application to display a list of recently used files
and click on a file to open it in that application.

e Click the Power button icon to close all programs
and turn off Windows.
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e Click the arrow next to the Power button to display
a menu of choices for putting your computer in
sleep or hibernate mode (see the next tip for more
about these settings), for restarting your computer;
or for logging off or logging in as a different user.

3. When you move your cursor away from the Start menu,
it disappears.

®

Putting your computer in sleep mode is like pausing
your computer without closing open documents and
programs. Sleep still uses a bit of power and allows
you to quickly get back to work after only a few sec-
onds. Hibernate mode is mainly for laptops because
it saves your battery life. When you choose Hibernate,
open documents and program settings are saved to
your hard drive and your computer switches off.

It takes longer to boot up your computer from
Hibernate and have the Windows desktop display,
but it saves more power than Sleep.

Open the Start menu, right-click in a blank area, and
click Properties to display the Taskbar and Start
Menu Properties dialog box, where you can custom-
ize the Start menu behavior. For example, you can
modify the functionality of the Power button and
choose whether to list recently opened programs and
files in the Start menu.

If you open the Start menu and right-click in a blank
area of the menu, a shortcut menu pops up. Choose
Properties to display the Taskbar and Start Menu
Properties dialog box, where you can customize the
Start menu behavior. If you would rather use the
look and feel of the Start menu in older versions of
Windows, select Classic Start Menu in the Taskbar
and Start Menu Properties dialog box and then click
OK. (Note that this book deals only with the
Windows 7 Start menu features.)
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Work with Frequently Used Programs

1. If you have programs you use often, you can pin them to
the Frequently Used Programs area, which is the area of
the taskbar just to the right of the Start button (see
Figure 3-4). When you first open Windows, this area
may include icons for programs such as Internet Explorer
and Windows Media Player or a shortcut to open
Windows Explorer.

R 0O ¥ 9

|
Frequently Used Programs area
Figure 3-4

2. To open any of these items, click its icon and the window
for that program opens (see Figure 3-5).

|O| Windows Media Player Sl bl (= [ =)
bl » Library * Playlists » Animal sounds Play Burn sync
Organize * » B v [Sears s @ | savelist =
1 Guess You're Right A
Love Comes P
Muita Bobeira
OAM's Blues
Despertar
Amanda = U ed List =
Drag items here
to create a playlist.
—
¥ 0O << l'gi i ) —a& =
.
Figure 3-5
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3. To close an item you've opened, click the Close button in
the top-right corner of the window (with an “X” on it).

®
®

To display additional items in the taskbar, right-click
that application in the Start menu or on the desktop
and then choose Pin to Taskbar. You can also drag a
desktop icon to the taskbar. (If you want help creat-
ing a desktop shortcut, see the task, “Create a
Shortcut to a File or Folder,” later in this chapter.)

You can add other functions to the taskbar. Right-
click on a blank area of the taskbar and choose
Properties. Click the Toolbars tab to display it. Click
the check box for any of the additional items listed
there, such as a browser Address bar or links.

Arrange Icons on the Desktop

1. Right-click the desktop and choose View in the resulting
shortcut menu; be sure that Auto Arrange Icons isn't
selected, as shown in Figure 3-6. (If it is selected, deselect
it before proceeding to the next step.)

Verify that Auto Arrange Icons isn't selected

View
Sort By
Refresh

NVIDIA

New

Undo Rename Ctrl+Z

13 Large Icons
| @ Medium Icons

Small Icons

Auto Arrange Icons

v | AlignIcons to Grid

v Show Desktop tems

Control Panel

B Screen Resolution
B Gadgets

& Personalize

Figure 3-6
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2. Right-click the Windows 7 desktop. In the resulting short-
cut menu, choose Sort By, and then click the criteria for
sorting your desktop shortcuts (see Figure 3-7).

View » |

Sort by 3 Mame
Refresh Size

Pata Ttem type

T Date modified

Undo Rename Ctrl+Z
Mew 4

= Screen resclution
@ Gadgets
ﬂ_' Perzonalize

Figure 3-7

3. You can also click any icon and drag it to another loca-
tion on the desktop — for example, to separate it from
other desktop icons so you can find it easily.

If you've rearranged your desktop by moving items
hither, thither, and yon and you want your icons

orderly rows along the left side of your desktop,
snap them into place with the Auto Arrange feature.
Right-click the desktop and then choose Viewr>
Auto Arrange Icons.

Icons, Medium Icons, or Small Icons in the View sub-

@ Use the shortcut menu in Step 1 and choose Large
menu to change the size of desktop icons.

Empty the Recycle Bin

1. When you throw away junk mail, it’s still in the house —
it's just in the trash bin instead of on your desk. That'’s
the idea behind the Windows Recycle Bin. Your old files
sit there, and you can retrieve them until you empty it or
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until it reaches its size limit and Windows dumps a few
files. Right-click the Recycle Bin icon on the Windows 7
desktop and choose Empty Recycle Bin from the menu
that appears (see Figure 3-8).

Open
o EmpyReccesn  —— Select this option
Create shortcut

Rename

Properties

Figure 3-8

2. In the confirmation dialog box that appears (see Figure
3-9), click Yes. A progress dialog box appears indicating
the contents are being deleted. Remember: After you empty
the Recycle Bin, all files in it are unavailable to you.

Up until the moment you permanently delete items

@ by performing the preceding steps, you can retrieve
items from the Recycle Bin by right-clicking the desk-
top icon and choosing Open. Select the item you
want to retrieve and then click the Restore This Item
link near the top of the Recycle Bin window.

Delete Multiple ltems el pahaes [E5
Are you sure you want to permanently delete these 39 items?
o Yes | | No |
N
Figure 3-9

clicking it and choosing Properties. In the dialog box
that appears, you can change the maximum size for
the Recycle Bin and whether to immediately delete

@ You can modify the Recycle Bin properties by right-
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files you move to the Recycle Bin. You can also dese-
lect the option of having a confirmation dialog box
appear when you delete Recycle Bin contents.

Find a File with Windows Explorer

1. Windows Explorer is a program you can use to find a file
or folder by navigating through an outline of folders and
subfolders. It's a great way to look for files on your com-
puter. Right-click the Start menu button and choose
Open Windows Explorer, or click the Windows Explorer
button on the taskbar (it looks like a set of folders).

2. In the resulting Windows Explorer window (shown in
Figure 3-10), double-click a folder in the main window
or in the list along the left side to open the folder.

el (o (1 ]Es]

\J\:/ [ » Libraries » v|¢,| [ Search Libraries o |
File Edit View Tools Help
Organize = Mew library e il 9'
I Favorites &| Documents
4 Recently Change| e i
Public L :
Bl Desktop 3 J) Fdrlsm
¥ Downloads b
2| Recent Places =i Pictures
| Playlists k} Librar
= Libraries ﬁ Videos
[ Documents HARn
o Music
=| Pictures x
4 items

Libraries let you access and arrange items from one or more folders quickly without moving th...

4 items

Double-<lick a folder to open it
Figure 3-10
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3. The folder’s contents are displayed. If necessary, open a
series of folders in this manner until you locate the file
you want.

4. When you find the file you want, double-click it to open it.

files in Windows Explorer, click the arrow on the
Views button (it looks like a series of columns) and
choose one of the following menu options: Extra
Large Icons, Large Icons, Medium Icons, or Small
Icons for graphical displays; Details to show details
such as Date Modified and Size; Tiles to show the
file/folder name, type, and size; and Content to dis-
play the date modified and file size only. If you are
working with a folder containing graphics files, the
graphics automatically display as thumbnails unless
you choose Details.

E ; To see different perspectives and information about

There are some shortcuts to commonly used folders

@ in the Start menu, including Documents, Pictures,
Music, and Games. Click one of these and Windows
Explorer opens that particular window.

Create a Shortcut to a File or Folder

48

1. Shortcuts are handy little icons you can put on the desk-
top for quick access to items you use on a frequent
basis. (See this chapter’s first section, “Understand the
Desktop,” for an introduction to shortcuts.) To create a
new shortcut, first choose Start=>All Programs and locate
the program in the list of programs that appears.

2. Right-click an item, FreeCell for example, and choose Send
Tor>Desktop (Create Shortcut), as shown in Figure 3-11.
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3. The shortcut appears on the desktop (see Figure 3-12).
Double-click the icon to open the application.

Occasionally, Windows 7 offers to delete desktop
icons that you haven't used in a long time. Let it. The
desktop should be reserved for frequently used pro-
grams, files, and folders. You can always re-create
shortcuts easily if you need them again.
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Double-click to use the new shortcut

A

=

LECTHTET

Figure 3-12
E ; To clean up your desktop manually, right-click the

desktop and choose Personalize. Click the Change
Desktop Icons link to the left. In the Desktop Icon
Setting dialog box that appears, click the Restore
Default button, which returns to the original desktop
shortcuts set up on your computer.

right-clicking the desktop, choosing New, and then
choosing an item to place there, such as a text docu-
ment, bitmap image, or contact. Then double-click
the shortcut that appears and begin working on the
file in the associated application.

@ You can create a shortcut for a brand-new item by

Start a Program

1. Before you can use a program, you have to start it (also
called launching a program). Launch an application by
using any of the following four methods:

e Choose StartAll Programs. Locate the program
name on the All Programs list that appears and
click it. Clicking an item with a folder icon dis-
plays a list of programs within it; just click the
program on that sublist to open it (as shown in
Figure 3-13).
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Click a folder to display the programs within it

. Administrative Tools
. ASUS Uility

, Axara

, Camtasia Studio 6

J Crawler Toolbar

) CyberLink DVD Suite
. Extras and Upgrades

Owner

Documents

. Garnes

J HP

. iTunes

. LightScribe Direct Disc Labeling
. Maintenance

""" Pictures
Music

Games
, Microsoft Mouse
J Microsoft OffiCe m— Favorites
"o Activation Assistant for Microsoft O
lf: Microsoft Office Access 2007 Computer
[ Microsoft Office Excel 2007
[ Microsoft Office Outlook 2007 Control Panel
[ Microsoft Office PowerPaint 2007
[ Microsoft Office Publisher 2007 Devices and Printers
i, Microsoft Office Word 2007
. Microsoft Office Tools

Help and Support
1 Back

| | Search programs and files ye | | Shut Down E

igure 3-13

e Double-click a program shortcut icon on the desk-
top (see Figure 3-14).

e Click an item on the taskbar. The taskbar should
display by default; if it doesn't, press the Windows
key (on your keyboard) to display it, and then
click an icon on the taskbar (refer to Figure 3-14),
just to the right of the Start button.

e If you used the program recently and saved a
document, choose it from the list of recently used
programs displayed when you first open the Start
menu. Then click a document created in that pro-
gram from the list that displays.
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Doublelick a program shortcut . . .

Lg
Salelns R
l
Blfe - O ¥ © DG
or click a program icon
Figure 3-14

2. When the application opens, if it's a game, play it; if it's a
spreadsheet, enter numbers into it; if it’s your e-mail pro-
gram, start deleting junk mail. . . . You get the idea.

Not every program that’s installed on your computer

@ appears as a desktop shortcut or taskbar icon. To add
a program to the taskbar or to add a desktop short-
cut, see Chapter 3.

Resize Windows

1. When you open an application window, it can be maxi-
mized to fill the whole screen, restored down to a smaller
window, or minimized to an icon on the taskbar. With
an application open and maximized, click the Restore
Down button (the icon showing two overlapping win-
dows) in the top-right corner of the program window
(see Figure 3-15). The window reduces in size.
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The Restore Down button

7 FreeCell X
Game Help

Keeso
S

K

Game #10413

Figure 3-15

Cards left 52

2. To enlarge a window that has been restored down to
again fill the screen, click the Maximize button. (Note:
This button is in the same location as the Restore Down
button; this button changes it's name to one or the other,
depending on whether you have the screen reduced in
size or maximized. A ScreenTip identifies the button
when you rest your mouse pointer on it.)
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3. Click the Minimize button (it’s to the left of the Restore
Down/Maximize button and looks like a small bar) to
minimize the window to an icon on the taskbar. To open
the window again, just click the taskbar icon.

dow. If you reduce a window in size, you can then
click and hold the title bar to drag the window
around the desktop, which is one way to view more
than one window on your screen at the same time.
You can also click and drag the corners of a reduced
window to resize it to any size you want.

@ With a window maximized, you can’t move the win-

Switch between Programs

1. Open two or more programs. The last program that you
open is the active program.

2. Press Alt+Tab to move from one open application win-
dow to another.

3. Press and hold Alt+Tab to open a small box, as shown in
Figure 3-16, revealing all opened programs.

FreeCell

1

Press the Tab key to select another
open program in this list

Figure 3-16
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4. Release the Tab key but keep Alt pressed down. Press Tab
to cycle through the icons representing open programs.

5. Release the Alt key, and Windows 7 switches to which-
ever program is selected. To switch back to the last pro-
gram that was active, simply press Alt+Tab, and that
program becomes the active program once again.

All open programs also appear as items on the
Windows 7 taskbar. Just click any running program
on the taskbar to display that window and make it
the active program. If the taskbar isn’t visible, press
the Windows key on your keyboard to display it.

Close a Program

1. With an application open, first save any open documents
(typically you can choose Filee>Save to do this, though in
recent Microsoft Office products you click the application
button and choose Save As) and then close the applica-
tion by using one of these methods:

e Click the Close button in the upper-right corner of
the window.

e Click Alt+F4 to close an active open window.

e Choose File (or application button)=>Exit (see
Figure 3-17).
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56

BN i + | Document - WordPad

]

Recent documents
Hew

1 Ch\Users\Owner\Documents\Document.rtf

Open

=
[

g l Save as 4

§.; A Page setup
e

Sl Send e-mail

About WordPad

-

Exit WordPad

Select the Exit option
Figure 3-17

2. The application closes. If you haven't saved changes in
any open documents before trying to close the applica-
tion, you see a dialog box asking whether you want to
save the document(s) (see Figure 3-18). Click Save or
Don’t Save, depending on whether you want to save your

changes.

WordPad R S e

Do you want to save changes to Document?

| Save i| Don't Save || Cancel

Figure 3-18
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To save a document before closing an application,
choose Filer>Save and use settings in the Save dialog
box (that appears) to name the file and also specify
which folder to save it to.

Note that choosing Filee>Exit closes all open docu-
ments in an application. Choose Filem>Close to close
only the currently active document and keep the
application and any other open documents open.

You don’t have to close an application to open or
switch to another. To switch between open applica-
tions, press Alt+Tab and use the arrow keys to move
to the application (or document if multiple docu-
ments are open in an application) in which you want
to work.

Chapter 3: Getting Around the Windows 7 Desktop

57



Part I: First Steps with Your Computer

58




Setting Up Your
Display

ou chose your designer Day Planner, paper

clip holder, and solid maple inbox for your
real-world desktop, right? Why shouldn’t the
Windows desktop give you the same flexibility
to make things look the way you like? After all,
this is the main work area of Windows, a space
that you traverse many, many times in a typical
day. Take it from somebody who spends many
hours in front of a computer: Customizing
your desktop pays off in increased productivity
as well as decreased eyestrain.

To customize your desktop, you can do the
following:

m=  Set up Windows to display images and
colors.

w= [Ise screen saver settings to switch from
everyday work stuff to a pretty animation
when you've stopped working for a time.

w= You can modify your screen resolution
setting, which controls how sharp and
detailed a picture your screen displays.
(See Chapter 5 for more about settings
that help those with visual challenges.)

| “*ap’rer

Getready to...

w= Customize Windows'
Appearance..................

w= Set Your Screen’s
Resolution ....cooeeeeeeenn

w= Change the Desktop
Background...................

w= Choose a Desktop Theme ...

w Set Up a Screen Saver ...

w= Change the Color and
Appearance of Windows

= Modify Windows

Transparency.................
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w=  Modify Windows transparency. Windows Aero Glass
is an effect that makes the borders of your windows
transparent so you can see other windows layered
underneath the active window. You might love it, or
hate it, but you should know how to turn the effect
on or off.

Customize Windows’ Appearance

When you take your computer out of the box, Windows comes with
certain preset, or default, settings such as the appearance of the desk-
top and a color scheme for items you see on your screen. Here are
some of the things you can change about the Windows environment
and why you might want to change them:

w= As you work with your computer, you might find
that changing the appearance of various elements on
your screen not only makes it more pleasant to look
at, but also helps you see the text and images more
easily. You can change the graphic that’s shown as
the desktop background, even displaying your own
picture there.

w= You can adjust your screen resolution to not only
affect the crispness of images on your screen but also
to display items larger on your screen, which could
help you if you have visual challenges. (See Chapter
5 for more about Windows features that help people
with visual, hearing, or dexterity challenges.)

w= Windows has built-in themes that you can apply
quickly. Themes save sets of elements that include
menu appearance, background colors or patterns,
screen savers, and even mouse cursors and system
sounds. If you choose a theme and then modify the
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way your computer looks in some way — for exam-
ple, by changing the color scheme — that change
overrides the setting in the theme you last applied.

w= Screen savers are animations that appear after your
computer has remained inactive for a time. In the
early days of personal computers, screen savers
helped to keep your monitor from burning out
from constant use. Today, people use screen savers
to automatically conceal what they're doing from
passersby or just to enjoy the pretty picture.

Set Vour Screen’s Resolution

1. Changing screen resolution can make items on-screen
easier to see. Choose Start=>Control Panel=>Appearance
and Personalization and click the Adjust Screen
Resolution link.

2. In the resulting Screen Resolution window, click the
arrow to the right of the Resolution field.

3. Use the slider (as shown in Figure 4-1) to select a higher
or lower resolution. You can also change the orientation
of your display by making a choice in the Orientation
drop-down list.

4. Click OK to accept the new screen resolution and then
click the Close button to close the window.

smaller, crisper images. Lower resolutions, such as
800 x 600, produce larger, somewhat jagged images.
The upside of higher resolution is that more fits on
your screen; the downside is that words and graphics
can be hard to see.

@ Higher resolutions, such as 1400 x 1250, produce
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=IEE=]

File Edit View Tools Help

Change the ap

Display:
Resolution:

Orientation:

Make text and othe

What display settin

Connectto a projeg

.
@-v-vlu €« Appearance and Personalization » Display » Screen Resolution

pearance of your display

1. Mobile PC Display ~|

1024768 - |

1280 x 800 (recommended)

800 x 600

~ % | [ Search Control Panel

| Detect |

| Identify ‘

Advanced settings

Ok | ‘ Cancel

3]

|
Click and drag the
Figure 4-1

Resolution slider

window displays another dialog box where you can

@ The Advanced Settings link in the Screen Resolution

work with color management and monitor settings.

in most software programs to get a larger or smaller

@ Remember that you can also use your View settings

view of your documents without having to change
your screen’s resolution.

Change the Desktop Background

1. You can display a picture or color that appeals to you on

your desktop. Right-click the desktop and choose

Personalize from the shortcut menu.

2. In the resulting Personalization window, click the
Desktop Background link to display the Desktop

Background dialog box, shown in Figure 4-2.
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aliel (o [
@Qv‘d %« Personalization » Desktop Background - ‘ t,‘ | Search Control Panel 2|

File Edit View Tools Help

Choose your desktop background

Click a picture to make it your desktop background, or select more than one picture to create a slide show,

Picture location: ISu\id Colors 'H EBrowse... J

. . . . '

l:‘ Mare...

| Savechanges | Cancel

Figure 4-2

3. Select a category of desktop background options from the
Picture Location list box (see Figure 4-3) and then click
the image from the background preview list that you
want to use. The background is previewed on your
desktop.

4. Click Save Changes to apply the settings and close the
dialog box, and then close the Personalization window.

If you apply a desktop theme (see the next task), you
overwrite whatever desktop settings you've made in

this task. If you apply a desktop theme and then go
back and make desktop settings, you replace the
theme’s settings. However, making changes is easy
and keeps your desktop interesting, so play around
with themes and desktop backgrounds all you like!
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Select a location Click a picture

il (o |[E1 ]S
@Qvlﬂ' « Personalization » Desktop Backgfound - ‘*f‘ ‘ Search Control Panel » |

File Edit View Tools Help

Choose your desktop backgfound

Click a picture to make it your desktdp background, or select more than one picture to create a slide show.

Picture location: [Pu:turs\_lbrary v][ Browse...

Windows Desktop Backgrounds
sl IL\

Top Rated Photos
4 Pictures (C:\U Solid Colors —

Picture pOSItIOH Change picture every:

E
A
S
m
m

30 minutes

Save changes | Cancel

Figure 4-3

Choose a Desktop Theme

1. Themes apply several color and image settings at once.
Right-click the desktop and choose Personalize. The
Personalization window opens.

2. In the resulting Personalization window, shown in
Figure 4-4, select a theme. Your options include the
following:

¢ My Themes uses whatever settings you have and
saves them with that name.

e Windows Themes offers up themes related to
Nature, Landscapes, Light Auras, and your country
of residence.
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e Ease of Access Themes offer a variety of easy to
read contrast settings in a variety of themes.

3. Click Close to close the dialog box.

Themes save sets of elements that include menu
appearance, background colors or patterns, screen
savers, and even mouse cursors and sounds. If you
modify any of these individually — for example, by
changing the screen saver to another one — that
change overrides the setting in the theme you last
applied.

Select a desktop theme

I | ]
‘i-\ uv‘q » Control Panel » JAppearance and Personalization » Personalization v|+7| ‘ Search Control Panel el

File Edit View Tools Help

E Control Panel Home . @
= Change the visuals and sounds on your computer

Change desktop icons Click a theme to change the desktop background, window color, sounds, and screen saver all at once.,

Change mouse pointers [Ty Themes (5) -~

Change your account picture

prm Ol

Get more themes online

Windows Themes (5]

@ WS

Ease of Access Themes (6)

- g

m

Current Theme: Windows 07 Wiley Final Theme March  Save theme
p |
oL 4%
Display <
Taskbar and Start Menu Desktop Background Window Color Sgunds Screen Saver
Ease of Access Center Solid Colar Custom Windows Default None

Figure 4-4
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You can save custom themes. Simply apply a theme,
make any changes to it you like using the various

Appearance and Personalization settings options, and
then in the Personalization dialog box, click Save
Theme. In the resulting dialog box give your new
theme a name and click Save. It will now appear on
the Theme list.

Set Up a Screen Saver

1. If you want an animated sequence to appear when your
computer is not in use for a period of time, set up a
screen saver. Right-click the desktop and choose
Personalize. In the resulting Personalization window,
click the Screen Saver button to display the Screen Saver
Settings dialog box, as shown in Figure 4-5.

EX Screen Saver Settings Tl bonlam
. Screen Saver .
] -
WS
| = o O OO
| = 4 @
Screen saver
|§(N0ne) . v

Power managerment

Conserve energy or maximize performance by adjusting display
brightness and other power settings.

Change power settings...

OK | | Cancel

Figure 4-5
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2. From the Screen Saver drop-down list, choose a screen
saver.

3. Use the arrows in the Wait xx Minutes text box to set the
number of inactivity minutes that Windows 7 waits
before displaying the screen saver.

4. Click the Preview button to take a peek at your screen
saver of choice (see Figure 4-6). When you're happy with
your settings, click to stop the preview, and then click OK.

5. Click the Close button in the Personalization window to
close it.

Figure 4-6
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tings: for example, how fast they display or how
many lines they draw on-screen. To customize this,
click the Settings button when in the Screen Saver
Settings dialog box.

@ Some screen savers allow you to modify their set-

Change the Color and Appearance of Windows

1. You can modify the appearance of elements on your
screen one by one. Right-click the desktop and choose
Personalize.

2. In the resulting Personalization window, click the
Window Color button to display the Window Color and
Appearance dialog box, as shown in Figure 4-7.

EX Window Color and Appearance LS T
[ '."Iin&bw Cdibr ana..t‘-\ppearance [
e
Active Window ] 4|
Mormal Selected
Window Text j
Message Box x|
Message Text J
1 OK

To turn on Windows Aero, select a Windows thermne. Colors and sizes selected
here apply only if you have selected the Windows 7 Basic theme or an Ease of
Access theme,

Item: Colorl:
Desktop R ||:| v
B
0K | | Cancel
Figure 4-7
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3. Select items one by one from the Item drop-down list.
Make any changes you wish by using the Size, Color, and
Font settings.

4. Click OK to accept the settings, and then click Save
Changes to return to the Personalization window.

5. Click the Close button to close the Personalization
window.

When customizing a color scheme, be aware that not

@ all screen elements allow you to modify all settings.
For example, setting an Application Background
doesn’t make the Font setting available — because
it's just a background setting. Makes sense, huh?

Some colors are easier on the eyes than others. For

@ example, green is more restful to look at than orange.
Choose a color scheme that is pleasant to look at and
easy on the eyes!

Modify Windows Transparency

1. You can apply a Windows Aero theme to get a transpar-
ent effect on windows you display. Choose Start=>
Control Panel=>Appearance and Personalization. In the
Appearance and Personalization window that appears
(see Figure 4-8), click Personalization.

2. In the resulting Personalization window (see Figure 4-9)
click on a theme in the Aero Themes section of My
Themes.
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70

3. Click the Close button to close the Personalization

window and see the results.

Click the Personalization link

el (o [ E1 ]

m-"g v Control Panel » Appearance and Perdonalization »

File Edit View Tools Help

B Control Panel Home g
Personalization

Change the theme

i’

System and Security
I k and Internet z
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Make text and other items larger or smaller
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Appearance and Add gadgets to the desktop
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Sy 2 B Taskbar and Start Menu

Customize the Start menu
Change the picture on the Start menu

Ease of Access

All Control Panel Items ’
e
@
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Specify single- ar double-click to open
Show hidden files and folders

Ease of Access Center
Accommodate low vision
Turn High Contrast on or off

h Fonts
Preview, delete, or show and hide fonts

Change desktop background

Get more gadgets online
Restore desktop gadgets installed with Windows

Use screen reader
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Change sound effects | Change screen saver

Adjust screen resolution | Connect to a projector

Uninstall a gadget

Customize icons on the taskbar

Turn on easy access keys

Use Classic Windows folders

Adjust ClearType text settings

Figure 4-8

You have to have a graphics card that supports
Windows Aero to see the effect. If nothing happens
when you apply an Aero effect, click the Trouble-
shoot Problems with Transparency and Other Aero
Effects link at the bottom of the Personalization
window to have Windows search for the cause.
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Select a theme from the Aero Themes section

e
@(\/;cﬂ! <« Appearance and Personalization » Personalization - ‘{,|

Contrel Panel Home y
Change the visuals and sounds on your computer

Change desktop icons Click a theme to change the desktop background, window celor, sounds, and screen saver all st once.
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Seealso
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Figure 4-9
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Getting Help with
Vision, Hearing,
and Dexterity
Challenges

people don’t always know right off the bat
how to get along when they meet someone
new. Similarly, sometimes Windows has to be
taught how to behave. For example, it doesn't
know right off the bat that somebody using it
has a vision challenge that requires special
help, or that a user prefers a certain mouse
cursor or has difficulty using a keyboard.

Somebody taught you manners, but Windows
depends on you to make settings that custom-
ize its behavior. This is good news for you
because the ability to customize Windows
gives you a lot of flexibility in how you interact
with it.

Here’s what you can do to customize
Windows:

w= Control features that help visually chal-
lenged users to work with a computer,
such as setting a higher contrast, using a
Narrator to read the on-screen text aloud,
or increasing the size of text on-screen.

| “*ap’rer

Getready to...

w= Use Tools for the Visually

Challenged .........c.co.....

= Replace Sounds with

Visual Cues......ovvvvvvvvenn..

= Make Text Larger or

Smaller ...

w= Set Up Speech

Recognition ............ccceee.

w= Modify How Your

Keyboard Works ..............

w= Use the On-screen

Keyboard Feature .............

w= Set Up Keyboard Repeat

RAtES .o,

w=p Customize Mouse

Behavior .....ooeeeeeeeeeeeeeen,

w=» Change the Cursor...........
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w= Work with the Speech Recognition feature that
allows you to input data into a document using
speech rather than a keyboard or mouse.

w= Modify the mouse functionality for left-handed use,
change the cursor to sport a certain look, or make
viewing the cursor as it moves around your screen
easlier.

w= Work with keyboard settings that make input easier
for those who are challenged by physical conditions,
such as carpal tunnel syndrome or arthritis.

Use Tools for the Visually Challenged

1. You can set up Windows to use higher screen contrast to
make things easier to see, read descriptions to you rather
than make you read text, and more. Choose Starte>
Control Panel.

2. In the Control Panel window, click the Optimize Visual
Display link under the Ease of Access tools.

3. In the resulting Make the Computer Easier to See dialog
box (as shown in Figure 5-1), select the check boxes for
features you want to use:

e High Contrast: Turn on higher contrast when
left Alt+left shift+Print Screen Is Pressed. High
contrast is a color scheme that makes your screen
easier to read. You can also choose to have a warn-
ing message display when you turn this setting on,
or have a sound play when it’s turned off or on.

¢ Hear Text and Descriptions Read Aloud: You can
turn on a Narrator feature that will read on-screen
text or an Audio Description feature to describe
what’s happening in video programs.
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o]

@leé' » Control Panel » Ease of Access » Ease of Access Center » Make the computer easier to see 4 | +y | | Search Control Panel £ |

Mk B Vew Tock  Hap

=

Make the computer easier to see
When you select these settings, they will automatically start each time you log on.

High Contrast
Choose a High Contrast theme
7] Turn on or off High Contrast when left ALT + left SHIFT + PRINT SCREEN is pressed
When using keyboard shortcuts to turn Ease of Access settings on:
| Display a warning message when turning a setting on

7] Make a sound when tuming a setting on or off

Hear text and descriptions read aloud
| Turn on Narrator =

Marrator reads aloud any text on the screen, You will need speakers.
[ Turn on Audio Description
Hear descriptions of what's happening in videos (when available).
Make things on the screen larger
Change the size of text and icons
[ Turn on Magnifier

Magnifier zooms in anywhere on the screen, and makes everything in that area larger. You can move
Magnifier around, lock it in one place, or resize it.

Make things on the screen easier to see

Fine tune display effects
[7] Make the focus rectangle thicker
Set the thickness of the blinking cursor: [ w|  Preview: [ | |

I A S s S b AR AR

| oK ‘ | Cancel

Figure 5-1

e Make Things on the Screen Larger: If you click
Turn on Magnifier, you have two cursors on-
screen. One cursor appears in the Magnifier win-
dow where everything is shown enlarged, and one
appears in whatever is showing on your computer
(for example, your desktop or an open applica-
tion). You can maneuver either cursor to work in
your document. (They're both active, so it does
take some getting used to.)

e Make Things On the Screen Easier to See: Here's
where you make settings that adjust on-screen con-
trast to make things easier to see, enlarge the size
of the blinking mouse cursor (see Figure 5-2), and
get rid of distracting animations and backgrounds.
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Seealso
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Figure 5-2

4. When you finish making settings, click OK to apply them

and then click the Close button to close the dialog box.

Replace Sounds with Uisual Cues

76

1. Sometimes Windows alerts you to events with sounds. If
you have hearing challenges, you might prefer to get
visual cues. Choose Start>Control Panel=>Ease of Access
and then click the Replace Sounds with Visual Cues link.
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2. In the resulting Use Text or Visual Alternatives for Sounds
dialog box (see Figure 5-3), make any of the following
settings:

e Turn on Visual Notifications for Sounds (Sound
Sentry) so that Windows will give a visual alert
when a sound plays.

e Choose a setting for visual warnings. These warn-
ings essentially flash a portion of your screen to
alert you to an event.

e To control text captions for any spoken words, select
Turn on Text Captions for Spoken Dialog. Note: This
isn't always available with every application you use.

mm [ o | & [

@uwl-@- v Control Panel » Ease of Access b Ease of Access Center b Use text or visual alternatives for sounds ~ [ 42| [ Search Cantrot Panel £ |

Fe Gt Vew Tock  Haip

Use text or visual alternatives for sounds
When you select these settings, they will automatically start each time you log on.

Use visual cues instead of sounds
[7] Turn on visual notifications for sounds (Sound Sentry)

Choose visual warning
Nane
@ Flash active caption bar
Flash active window

Flash desktop
[ Turn on text captions for spoken dialog (when available)
Seealso

Audic Devices and Sound Themes

Learn about additional assistive technologies online

oK ‘ | Cancel

Figure 5-3
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3. To save the new settings, click OK, and then click the
Close button to close the dialog box.

Visual cues are useful if you are hard of hearing and

@ don’t always pick up system sounds alerting you to
error messages or a device disconnect. After the set-
ting is turned on, it is active until you go back to the
Use Text or Visual Alternatives for Sounds dialog box
and turn it off.

ing you may want to simply increase the volume for
your speakers. You can do this by using the volume
adjustment in a program such as Windows Media
Player (see Chapter 14) or by modifying your system
volume by choosing Hardware and Sound in the
Control Panel and then clicking the Adjust System
Volume link.

@ This may seem obvious, but if you are hard of hear-

Make Text Larger or Smaller
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1. Choose Start=>Control Panel>Appearance and
Personalization. Click Make Text and Other Items Larger
or Smaller in the resulting window.

2. In the resulting Display window (see Figure 5-4), click
the radio button for the size of text you prefer. Smaller is
the default, but you can expand text size to 125 percent
with the Medium setting and 150 percent with the Larger
setting.

3. Click Apply and then click the Close button to close the
dialog box. You'll see the results (see Figure 5-5, which
shows the Larger setting applied) the next time you log in
to Windows.
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Make your text size selection

T o 2 =)

y v‘.fl » Control Panel » fppearance and Personalization » Display - | 43 | ‘ Search Control Panel el

File Edit View Tools Help
E Control Panel Home " " . @
. OrTone Homs Make it easier to read what's on your screen

Adjust resolution You can change the size of text and other items on your screen by choosing one of these options. To

x temporarily enlarge just part of the screen, use the Magnifier tool.

Adjust brights

Calibrate color

=. : () Smaller - 100% (default) Preview

Change di -

Connect to a projector

SR PT) @ Medium - 125%

® Larger - 150%

Figure 5-4
A

2 "
Owner Adobe Reader _

g |2+ Windows Live Messenger [ [ ] o |
Help -

E-mail address:

ubstudin@sn.mm -
Computer Sign in as: Online -

Network

o~ More

B o < Windows Live ID
%

Recycle Bin

=7, -
@ . - EN

Figure 5-5

a

oo . T:59AM
A I R
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Set Up Speech Recognition

1. If you have dexterity challenges from a condition such as
arthritis, you might prefer to speak commands, using a
technology called speech recognition, rather than type
them. Attach a desktop microphone or headset to your
computer and choose Startz>Control Panelc>Ease of
Access=vStart Speech Recognition.

2. The Welcome to Speech Recognition message appears;
click Next to continue. (Note: If you've used Speech
Recognition before, this message will not appear.)

3. In the resulting Microphone Setup Wizard dialog box
(shown in Figure 5-6), select the type of microphone
that you're using and then click Next. The next screen
tells you how to place and use the microphone for
optimum results. Click Next.

) |fr_é; Microphone Setup Wizard
What type of microphone is Microphone (Realtek High Definition Audio)?
('\. o Headset Microphone
9 Best suited for speech recognition, you wear this on your head.
Desktop Microphone
These microphones sit on the desk,
Other
| Such as array microphones and microphones built into other devices.
| MNext || Cancel
.
Figure 5-6
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4. In the following dialog box (see Figure 5-7), read the
sample sentence aloud. When you're done, click Next. A
dialog box appears telling you that your microphone is
now set up. Click Next.

During the Speech Recognition setup procedure, you
are given the option of printing out commonly used
commands. It's a good idea to do this, as speech
commands aren’t always second nature!

@ @ Microphone Setup Wizard
Adjust the volume of Microphone (Realtek High Definition Audio)

Read the following sentences aloud in a natural speaking voice:

"Peter dictates to his computer. He prefers it to typing, and particularly
prefers it to pen and paper.”

Mote: After reading this, you can proceed to the next page.

| Cancel |

Figure 5-7

5. In the resulting dialog box, choose whether to enable or
disable document review. Document review allows
Windows to review your documents and e-mail to help it
recognize your speech patterns. Click Next.

6. In the resulting dialog box, choose either manual activa-
tion mode, where you can use a mouse, pen, or keyboard
to turn the feature on, or voice activation, which is useful
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if you have difficulty manipulating devices because of
arthritis or a hand injury. Click Next.

In the resulting screen, if you wish to view and/or print a
list of speech recognition commands, click the View
Reference Sheet button and read about or print reference
information, and then click the Close button to close
that window. Click Next to proceed.

In the resulting dialog box, either click Run Speech
Recognition at Startup to disable this feature or leave the
default setting. Click Next. The final dialog box informs
you that you can now control the computer by voice, and
offers you a Start Tutorial button to help you practice voice
commands. Click that button, or click Skip Tutorial to skip
the tutorial and leave the Speech Recognition set up.

The Speech Recognition control panel appears (see
Figure 5-8). Say, “Start listening” to activate the feature if
you used voice activation in Step 6, or click the Start
Speech Recognition link if you chose manual activation
in Step 6. You can now begin using spoken commands to
work with your computer.

The Speech Recognition control panel

Configure your Speech Recognition experience @

WU‘ Start Speech Recognition
{ T youw@._‘_.-
~ I )

Q) Set up microph 2 =

®  Learn to use your computer with speech. Learn basic commands and dictation.

a Train your computer to better understand you

= View and print a list of common commands to keep with you so you always know what to say.

If you would like to leamn more about speech relsted taols and support from Microsoft, please visit the Microsoft Speech Online Community.

Set up your comp!

Take Speech Tutorial

Read text to your computer to improve your computer's ability to understand your voice. Doing this
isn't necessary, but can help improve dictation accuracy.

7 Openthe Speech Reference Card

Figure 5-8
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To stop Speech Recognition, click the Close button on

@ the Control Panel. To start the Speech Recognition fea-
ture again, choose Start=>Control Panel=>Ease of
Access and then click the Start Speech Recognition
link. To learn more about Speech Recognition com-
mands, click the Take Speech Tutorial link in the
Speech Recognition Options window accessed from
the Ease of Access window of the Control Panel.

Modify How Your Keyboard Works

1. If your hands are a bit stiff with age or carpal tunnel
problems, you might look into changing how your key-
board works. Choose Start=>Control Panel=>Ease of
Access and then click the Change How Your Keyboard
Works link.

2. In the resulting Make the Keyboard Easier to Use dialog
box (see Figure 5-9), make any of these settings:

¢ Turn on Mouse Keys to control your mouse by
keyboard commands. If you turn on this setting,
click the Set Up Mouse Keys link to specify settings
for this feature.

e Select the Turn on Sticky Keys feature to enable
keystroke combinations to be pressed one at a
time, rather than in combination.

e Turn on Toggle Keys. You can set up Windows to
play a sound when you press Caps Lock, Num Lock,
or Scroll Lock (which I do all the time by mistake!).

e If you sometimes press a key very lightly or press it
so hard it activates twice, you can use the Turn on
Filter Keys setting to adjust repeat rates to adjust
for that. Use the Set Up Filter Keys link to fine-
tune settings if you make this choice.
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¢ To have Windows highlight keyboard shortcuts
and access keys with an underline wherever these
shortcuts appear, click that setting.

e If you want to avoid having windows shift auto-
matically when you move them to the edge of
your screen, use the Make It Easier to Manage
Windows setting.

o e [

@\J-vl'i:}‘ v Control Panel » Easeof Access » Easeof Access Center » Make the keyboard easier to use = | 42| [ search Controt Panet p

File Edit View Tools Help
Make the keyboard easier to use
When you select these settings, they will automatically start each time you log on.

Control the mouse with the keyboard
[T Turn on Mouse Keys

Use the numeric keypad to move the mouse around the screen.

Set up Mouse Keys

Make it easier to type
[ Turn en Sticky Keys
Press keyboard shortcuts (such as CTRL+ALT+DEL) one key at a time.

Set up Sticky Keys

]

[ Turn on Toggle Keys
Hear a tone when you press CAPS LOCK, NUM LOCK, or SCROLL LOCK,
[ Turn on Toggle Keys by holding down the NUM LOCK key for 5 seconds
[] Turn on Filter Keys

Ignore or slow down brief or repeated keystrokes and adjust keyboard repeat rates,

Set up Filter Keys

Make it easier to use keyboard shortcuts
[T]Underline keyboard shortcuts and access keys

Make it easier to manage windows

[7] Prevent windows from being automatically arranged when moved to the edge of the screen

Seealso

Add a Dvorak keyboard and change other keyboard input settings

oK | [ Cancel

Figure 5-9

3. To save the new settings, click OK, and then click the
Close button to close the Ease of Access Center.
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You can click the Learn about Additional Assistive

@ Technologies Online link to go the Microsoft Web
site and discover add-on and third party programs
that might help you if you have a visual, hearing, or
input-related disability.

keyboard isn't responsive and you have a keyboard-
challenging condition, you might also try different
keyboards to see if one works better for you than
another.

@ Keyboards all have their own unique feel. If your

Use the On-screen Keyboard Feature

1. Clicking keys with your mouse may be easier for some
than using a regular keyboard. To use the on-screen
keyboard, choose Start=>Control Panel=>Ease of Access
category.

2. In the resulting window, click the Ease of Access Center
link to open the Ease of Access Center dialog box (see
Figure 5-10), click Start On-Screen Keyboard. The on-
screen keyboard appears (see Figure 5-11).

3. Open a document in any application where you can
enter text, and then click the keys on the on-screen key-
board to make entries.

the first key (in this case, Ctrl), and then click the
second key (Z). You don’t have to hold down the
first key as you do with a regular keyboard.

@ To use keystroke combinations (such as Ctrl+Z), click

4. To change settings, such as how you select keys (Typing
Mode) or the font used to label keys (Font), click the
Options key on the on-screen keyboard and then choose
one of the four options shown in the Options dialog box
and click OK.
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Click this link

—— ]

- u-@ » Control Panel » Ease of Access » Ease of Access Center

= [ 4| [ Search Control Panel
File Edit View Tools Help
B Control Panel Home ;
I A EORE0mE Make your computer easier tq use

@ Change administrative settings Quick access to common{tools

You can use the tools in this sectiof to help you get started,

Windows can read and scan this lisf automatically. Press the SPACEBAR to select the highlighted tool,

[7] Always read this section aloud [7] Always scan this section
Eﬂ Start Magnifier !! Start Narrator
=4 Start On-Screen Keyboard P oset up High Contrast

w Mot sure where to start? Get recommendations to make your computer easier to use
Explore all settings
When you select these settings, they will automatically start each time you log on.

‘!\ Use the computer without a display
" Optimize for blindness

Make the computer easier to see

Optimize visual display

Set up alternative input devices

Make the mouse easier to use

Adjust settings for the mouse or other pointing devices

A
& Use the computer without a mouse or keyboard
S 4

Make the keyboard easier to use
Adijust settings for the keyboard

Use text or visual alternatives for sounds

Set up altematives for sounds

gl Make it easier to focus on tasks
£ Adjust settings for reading and typing

5]

@ -

m

Figure 5-10

5. Click the Close button on the on-screen keyboard to stop
using it.

You can set up the Hover typing mode to activate a
key after you hover your mouse over it for a pre-
defined period of time (x number of seconds). If you
have arthritis or some other condition that makes
clicking your mouse difficult, this option can help
you enter text. Click the Hover over Keys item in the
Options dialog box and use the slider to set how
long you have to hover before activating the key.
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Figure 5-11

Set Up Keyboard Repeat Rates

1. Adjusting your keyboard settings might make it easier for
you to type, and it can be helpful to people with dexterity
challenges. To see your options, choose Start=>Control
Panel=>All Control Panel Items. In the resulting window,
click the Keyboard link.

2. In the Keyboard Properties dialog box that appears, click
the Speed tab (see Figure 5-12) and drag the sliders to
adjust the two Character Repeat settings, which do the
following:

e Repeat Delay: Affects the amount of time it takes
before a typed character is typed again when you
hold down a key.

e Repeat Rate: Adjusts how quickly a character
repeats when you hold down a key after the first
repeat character appears.

If you want to see how the Character Repeat settings
work in action, click in the text box below the two
settings and hold down a key to see a demonstration.

3. Drag the slider in the Cursor Blink Rate section. This affects
cursors, such as the insertion line that appears in text.
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~- Keyboard Properties Cnl o
Speed | Hardware |
Character repeat

th Repeat delay:
Long : M iShort

Bepeat rate:

Slow |_J Fast

Click here and hold down a key to test repeat rate:

Cursor blink rate

None |‘J Fast

| OK | | Cancel

Figure 5-12

4. Click OK to save and apply changes and close the dialog
box. Click the Close button to close the Control Panel
window.

because of arthritis or carpal tunnel syndrome), you
might find that you can adjust these settings to make
it easier for you to get your work done. For example,
if you can’t pick up your finger quickly from a key, a
slower repeat rate might save you from typing more
instances of a character than you'd intended.

E ; If you have trouble with motion (for example,

Customize Mouse Behavior

1. To save you from having to click your mouse too often,
instead of moving your mouse with your hand, you can
use your keyboard to move the cursor; or, you can cause
a window to activate by hovering your mouse over it
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rather than clicking. Choose Start=>Control Panel=>Ease
of Access and then click the Change How Your Mouse
Works link. The Make the Mouse Easier to Use dialog box
opens (see Figure 5-13).

2. To use the numeric keypad to move your mouse cursor
on your screen, choose the Turn on Mouse Keys setting.
If you turn this feature on, click Set Up Mouse Keys to
fine-tune its behavior.

3. Select the Activate a Window by Hovering Over It with The
Mouse check box to enable this (pretty self-explanatory!)
feature.

4. Click OK to save the new settings and then click the
Close button to close the Ease of Access Center.

the Make the Mouse Easier to Use dialog box; then,
on the Buttons tab, use the Switch Primary and
Secondary Buttons feature to make the right mouse
button handle all the usual left button functions,
such as clicking and dragging, and the left button
handle the typical right-hand functions, such as
displaying shortcut menus. This helps left-handed
people use the mouse more easily.

@ If you're left-handed, click the Mouse Settings link in

pointer, in the Mouse Properties dialog box, click the
Pointer Options tab to set the pointer speed (how
quickly you can drag the mouse pointer around your
screen), activate the Snap To feature that automati-
cally moves the mouse cursor to the default choice in
a dialog box, or modify the little trails that appear
when you drag the pointer.

E ; If you want to modify the behavior of the mouse
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e -
Qv-wl'\_é" » Control Panel » Easeof Access » Ease of Access Center » Make the mouse easier to use

e ol ]

File Edit View Tools Help

Make the mouse easier to use
When you select these settings, they will automatically start each time you log on,

Mouse pointers

Change the color and size of mouse pointers.

@ Regular Regular Black Regular w
e BT ]

Large White %I Large Black \ I 5 }_arge ﬁ
nverting

Extra Large I Extra Large I (7 Extra Large
White Black Inverting

Control the mouse with the keyboard

[ Tumn on Mouse Keys

Use the numeric keypad to move the mouse around the screen.
Set up Mouse Keys
Make it easier to manage windows
[] Activate a window by hovering aver it with the mouse
[7] Prevent windows from being automatically arranged when moved to the edge of the screen
Seealso

Mouse settings

Learn about additional assistive technologies online

OK | | Cancel

b |‘.‘7 | | Search Control Panel pel

Figure 5-13

If you have difficulty seeing the cursor on-screen,
experiment with the Windows 7 color schemes to see
if another setting makes your cursor stand out better
against the background. See Chapter 4 for informa-
tion on setting up the color scheme for your
computer.

Change the Cursor
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1. Having trouble finding the mouse cursor on your screen?

You might want to enlarge it or change its shape. Choose
Start=>Control Panel=>Ease of Access>Change How Your
Mouse Works. In the resulting Make the Mouse Easier to

Use dialog box, click the Mouse Settings link.
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2. In the resulting Mouse Properties dialog box, on the
Pointers tab, as shown in Figure 5-14, click to select a
pointer such as Normal Select and then click the Browse
button. (Note that this dialog box may have slightly dif-
ferent tabs depending on your mouse’s model features.)
In the Browse dialog box that appears, click on an alter-
nate cursor and then click Open.

_* Mouse Properties o
| beware | Actwiies | @) DeviceSetings |  Wireless
Buttons |  Buttons Poirtters | PointerOptions |  Scroling

Scheme

(Windows Aero vstem scheme) -] N

| Sawe As... | Delete

Customize:

Help Select I}@
‘Working In Background l:\s‘ /

Busy D ]

Precision Select —|— -
[¥] Enable pointer shadow |se Default | | B |
[7] Allow themes to change mouse poirters

| 0K | | Cancel A

Figure 5-14

3. Click Apply to use the new pointer setting and then click
the Close button to close the Mouse Properties dialog box.

dard cursor (for example, changing the Normal Select
cursor to the Busy hourglass cursor). This could prove
slightly confusing for you and completely baffling to
anybody else who works on your computer. If you

@ Be careful not to change the cursor to another stan-
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®

make a choice and decide it was a mistake, click the
Use Default button on Pointers tab in the Mouse
Properties dialog box to return a selected cursor to
its default choice.

You can also choose the color and size of mouse
pointers in the Make the Mouse Easier to Use dialog
box. A large white or extra large black cursor might
be more visible to you, depending on the color
scheme you have applied to Windows Vista.



Setting Up
Printers and
Scanners

A computer is a great storehouse for data,
images, and other digital information, but
sometimes you need ways to turn printed doc-
uments into electronic files you can work with
on your computer or to print hard copies (a
fancy term for paper printouts) of electronic
documents and images. Here are a few key
ways to do just that:

w= Printers allow you to create hard copies
of your files on paper, transparencies, or
whatever stock your printer can accommo-
date. To use a printer, you have to have
software installed — a printer driver — and
use certain settings to tell your computer
how to find the printer and what to print.

w= You use a scanner to create electronic
files — pictures, essentially — from hard
copies of newspaper clippings, your birth
certificate or driver’s license, pictures, or
whatever will fit into/onto your scanner.
You can then work with the files, send
them to others as an e-mail attachment,
or print them. Scanners also require that
you install a driver that comes with your
machine.

| “*ap’rer

Getready to...

we Install a Printer...................
w= Set a Default Printer ...........

w= Set Printer Preferences ........

w= View Currently Installed
Printers .......ooovieiiiiinneenn,

w= Remove a Printer...............
w= |nstall a Scanner...............

w=> Modify Scanner Settings ....
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Install a Printer
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1. Read the instructions that came with the printer. Some

printers require that you install software before connect-
ing them, but others can be connected right away.

2. Turn on your computer and then follow the option that

fits your needs:

e [f your printer is a Plug and Play device, connect it
and power it on; Windows installs what it needs
automatically.

e Insert the disk (or disc) that came with the device
and follow the on-screen instructions.

o Choose Starte>Devices and Printers.

e If you have a wireless printer, choose Start=>
Devices and Printers and click the Add a Printer
link in the window that appears. Choose the Add a
Network, Wireless, or Bluetooth Printer option
and follow the instructions provided.

3. If you choose the third option in Step 2, in the Devices

and Printers window that appears click the Add a Printer
link near the top.

4. In the resulting wizard window (the Add Printer dialog

box, shown in Figure 6-1), click the Add a Local Printer
option and click Next.

5. In the Choose a Printer Port dialog box, shown in Figure

6-2, click the down arrow on the Use an Existing Port
field and select a port, or just use the recommended port
setting that Windows selects for you. Click Next.
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Select this option and click Next

‘u = Add Printer

What type of prirger do you want to install?

=+ Add a local printer
Use this option only if you don't have a USB printer. (Windows automatically
installs USB printers when you plug them in.)

# Add a network, wireless or Bluetooth printer
Make sure that your computer is connected to the network, or that your Bluetooth
or wireless printer is tumned on.

Cancel

Figure 6-1

Select a printer port

K5 = AddPrinter

Choose a printer port

A printer portis a type of connection that allows your computer th exchange information with a
printer.

@ Use an existing port: [LpT1: rinter Part) -

() Create 3 new port:

Net | [ Cancel

Figure 6-2

6. In the next wizard window (Install the Printer Driver dia-
log box; see Figure 6-3), choose a manufacturer and then
choose a printer. You then have two options:

e If you have the manufacturer’s disc, insert it in the
appropriate CD drive now and click the Have Disk
button. Click Next.
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Choose a manufacturer

Then choose a printer

K3 = Add printer
Install the printef driver
;  Choose yofr printer from the list. Click Windows Update to see more models.
-
To install t§e driver from an installation CD, click Have Disk.
Manufacturer * || Printers
Brother 5 Brother DCP-116C
Canon 5} Brother DCP-117C
Epson 5 Brother DCP-128C
Fuji Xerox | DCP-129C o
EF  This driver is digitally signed. Windows Update | [ Have Disk... |
Tell me why driver signing is impertant
Mext | [ Cancel

Figure 6-3

e [f you don’t have the manufacturer’s disc, click the
Windows Update button to see a list of printer
drivers that you can download from the Microsoft

Web site. Click Next.

7. In the resulting Type a Printer Name dialog box (see
Figure 6-4), enter a printer name. Click Next.

Enter a name for your printer

==
K3 = Add Printer
Type a printer name
Printer name:
This printer will be installed with the Brother DCP-129C driver.
Net || Cancel

Figure 6-4
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8. In the resulting dialog box, click Finish to complete the
Add Printer Wizard.

fourth option in Step 2, you get additional dialog
boxes in the wizard, including one right after you
name the printer, which allows you to share the
printer on your network. Select the Do Not Share
This Printer option to stop others from using the
printer, or select the Share Name option and enter a
printer name to share the printer on your network.
This means that others can see and select this printer
to print to.

@ If your computer is on a network and you choose the

Set a Default Printer

1. You can set up a default printer that will be used every
time you print so you don’t have to select a printer each
time. Choose Start=>Devices and Printers.

2. In the resulting Devices and Printers window (shown in
Figure 6-5), the current default printer is indicated by a
check mark.

3. Right-click any printer that isn't set as the default and
choose Set as Default Printer from the shortcut menu, as
shown in Figure 6-6.

4. Click the Close button in the Devices and Printers win-
dow to save the new settings.

your particular printer model (for example, whether
the printer prints in draft or high-quality mode, or
whether it uses color or only black and white), right-
click a printer in the Devices and Printers window
(refer to Figure 6-6) and choose Printing Preferences.

@ To modify printing properties that are available for
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This same dialog box is available from most com-
mon Windows-based software programs, such as
Microsoft Word or Excel, by clicking the Properties
button in the Print dialog box.

@u'-ﬂ| » Contrel Panel » Hardware and Sound » Devices and Printers » w ldy ] Seoreh Devaces and Pantery 2
File Fot View Teok  Help
Add » device  printer = B
@ l! > 7 N
[Nﬁ“" Ganene Mante: I:n:lc H<[ .“":‘:‘I‘uél:“lul CANER-PC
Keyboard keys Mouse® 100
ot/ /
- < *a" -/ =
Dgﬂdlhlﬁc | vc.,k,.q F100 l.‘lclclol'! ans Snaghs
._‘.,' 10
‘ﬁ't,f
10 fems
The default printer is checked
Figure 6-5
=
L
el |0 TE[=]5] R
Choose Set As Default Printer
Figure 6-6
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default, you'll find that the Set as Default Printer
command will not be available on the shortcut menu
mentioned in Step 3.

E s If you right-click the printer that is already set as the

Set Printer Preferences

1. Your printer might have capabilities such as being able to
print in color or black and white, or print in draft quality
(which uses less ink) or high quality (which produces a
darker, crisper image). To modify these settings for all
documents you print, choose Start=>Devices and Printers
(in the Hardware and Sound group).

2. In the resulting Devices and Printers window, any print-
ers you have installed are listed. Right-click a printer and
then choose Printing Preferences.

3. In the Printing Preferences dialog box that appears
(shown in Figure 6-7), click any of the tabs to display
various settings, such as Color (see Figure 6-8). Note
that different printers might display different choices and
different tabs in this dialog box, but common settings
include

e Color/Grayscale: If you have a color printer, you
have the option of printing in color. The grayscale
option uses only black ink. When printing a draft
of a color document, you can save colored ink by
printing in grayscale, for example.

¢ Quality: If you want, you can print in fast or draft
quality (these settings may have different names
depending on your manufacturer) to save ink, or
you can print in a higher or best quality for your
finished documents. Some printers offer a dpi set-
ting for quality — the higher the dpi setting, the
better the quality.
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e Paper Source: If you have a printer with more
than one paper tray, you can select which tray to
use for printing. For example, you might have 8/
x 11 paper (letter sized) in one tray and 82 x 14
(legal sized) in another.

e Paper Size: Choose the size of paper or envelope
you're printing to. In many cases, this option
displays a preview that shows you which way to
insert the paper. A preview can be especially handy
if you're printing to envelopes and need help figur-
ing out how to insert them in your printer.

Click a tab to see different settings

= HP Deskjet F4100 serie4 Printing Preferences =

| Advanced | Pinting Shortouts | Featues | Color | Services|]

& printing shortcut is a collection of saved print settings that
you can select with a single click

Pinting shortcuts:

General Everydap Piinting

m Phata Printing-Borderless
Paper sizes 86 = 11 inches

— . [Letter -
G | Photo Printingsit whits bordsrs 3 P—

G [Fisin paper -
= Tworsided (Duples] Frinting L
| [Hemal -

Print on bath sidgs:

m Piesentation Piinting | [on -

Orisntation:

lFDltlall T |

Fast/Economical Printing

SaveAs Delsts Rlesel
]
oK Cancel Apply
Figure 6-7

4. Click the OK button to close the dialog box and save set-
tings and then click the Close button to close other open
Control Panel windows.



Also, the settings in the Printing Preferences dialog

@ box may differ slightly depending on your printer
model; color printers offer different options from
black and white printers, for example.

Whatever settings you make using the procedure in

@ this task are your default settings for all printing you
do. However, when you're printing a document from
within a program such as Works word processor, the
Print dialog box you display gives you the opportu-
nity to change the printer settings for that document
only. See Chapter 11 for information about printing
a document.

= HP Deskjet F4100 series Printing Preferences ==
[ Advanced | Prting Shortcuts | Festures | Color | Services|

Colar Options

[ Show preview before printing

2

Ok | ‘ Cancel Apply

Click OK to save settings
Figure 6-8

View Currently Installed Printers

1. Over time you might install multiple printers, in which
case you may want to remind yourself of the capabilities
of each or view the documents you have sent to be

Chapter 6: Setting Up Printers and Scanners
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printed. To view the printers you have installed and view
any documents currently in line for printing, choose
Start=>View Devices and Printers.

In the resulting Devices and Printers window (see Figure
6-9), a list of installed printers and fax machines appears.
If a printer has documents in its print queue, the number
of documents is listed at the bottom of the window. If
you want more detail about the documents or want to
cancel a print job, select the printer and click the See
What's Printing button at the top of the window. In the
window that appears, click a document and choose
Document=>Cancel to stop the printing, if you want.
Click the Close button to return to the Devices and
Printers window.

o

M il 3 e @

HP Dackjet FA100 serins Mol HP Deckget 4100 sesies

The number of documents in queue to print

Figure 6-9

3.

You can right-click any printer and then choose
Properties (see Figure 6-10) to see details about it, such
as which port it’s plugged into or whether it can print
color copies.
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¥ HP Deskjet F4100 series Properties =

TGenerdl | Hardware
ﬁi HP Deskjet F4100 zeries

Device Information

Manufacturer Unawailable

Model HP Deskjet F4100 series
Model number.  Unavailable

Categories; Printer

Description; Unavailable

To view for this dewice, right-click the icon for the device in
5.

Figure 6-10

4. Click the Close button (the red X in the upper right) to
close the Devices and Printers window.

Remove a Printer

1. Over time, you might upgrade to a new printer and
chuck the old one. When you do, you might want to also
remove the older printer driver from your computer so
your Printers window isn't cluttered with printers you
don’t need anymore. To remove a printer, choose Start=>
Devices and Printers (in the Hardware and Sound group).

2. In the resulting Devices and Printers window (see Figure
6-11), right-click a printer and choose Remove Device.
(Note you can also select the printer and click the
Remove Device button at the top of the window.)

3. In the Printers dialog box that appears, click Yes; the
Devices and Printers window closes, and your printer is
removed from the printer list.
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HP Desijet F4100 series  Mudek HP D

Click Remove Device

Figure 6-11

If you remove a printer, it's removed from the list of

@ installed printers, and if it was the default printer,
Windows makes another printer you have installed
the default printer. You can no longer print to it
unless you install it again. See the task, “Install a
Printer,” if you decide you want to print to that
printer again.

Install a Scanner

104

1. Before you can scan documents into your computer with
a scanner, you need to install the scanner driver so your
scanner and computer can communicate. Start by con-
necting the scanner to your computer’s USB port (see
your scanner manual for information about how it con-
nects to your computer).



2.
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Turn the scanner on. Some scanners use Plug and Play, a
technology that Windows uses to recognize equipment
and automatically install and set it up. If your scanner is
Plug and Play enabled, Windows 7 shows a Found New
Hardware message in the Taskbar notification area (in
the lower-right corner). Most Plug and Play devices will
then automatically install, the message will change to
verify the installation is complete, and that’s all you have
to do. If that doesn’t happen, either you're not using a
Plug and Play device or Windows doesn’t have the driver
for that device, so you should click the Found New
Hardware message to proceed.

. In the resulting Found New Hardware Wizard (this starts

only if you don’t permit Windows 7 to automatically
connect to Windows Update), click Yes, This Time Only
and then click Next.

If you have a CD for the scanner, insert it in your CD
drive and click Next. Windows 7 searches for your scan-
ner driver software and installs it.

. Choose Startz>Control Panel. In the Search box type

scanners. Windows returns a set of links. Click on the
View Scanners and Cameras link. In the resulting
Scanners and Cameras window, click the Add Device
button.

. In the resulting Scanner and Camera Installation Wizard

window, click Next. In the next screen of the wizard (see
Figure 6-12), click a Manufacturer in the list on the left
and then click a model in the list on the right.
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Select a manufacturer Then select a model

Scanner and Carhera Installation Wizard =4

‘Which scanner pr camera do you want to install?

(el

Select th} manufacturer and model of your device. If you have ah installation disk, click Have
Disk.

[ Ma

Lex
Herox

|
nufacturer | Model |
mark ‘ Sl Lewrnark X422

Gl

This driver is digitally signed. | Hovedik. |

Tell me wibyy driver signing is important

Figure 6-12

7.

Follow the wizard directions based on the model of scan-
ner you choose in Step 6 and whether you have a manu-
facturer’s disc (a CD- or DVD-ROM). If you don’t have a
disc, Windows will help you download software from the
Internet. When you reach the end of the wizard, click
Finish to complete the installation.

Modify Scanner Settings
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1. After you install a scanner, you might want to take a look

3.

at or change its default settings. To do so, choose Start=>
Control Panel. Type scanners in the Control Panel search
field and press Enter.

2. In the resulting Control Panel window, click View

Scanners and Cameras.

In the resulting Scanners and Cameras dialog box, a list
of installed scanners appears (see Figure 6-13). Click any
scanner in the Scanners and Cameras area, and then click
the Scan Profiles button.



~= Scanners and Cameras ==

If wou do not see your device in the list, rake sure itis connected to the cormputer and tumed
on, then choose Refresh,

Scanners and Camera! 5

=

_|_HP Deskjet
Fa100

Refresh H B Add Device... | [ Scan Profiles | | Broperties |

DoIneed to use this to install my scanner or camera

Close ‘

Click a scanner  Then click Scan Profiles
Figure 6-13

4. In the resulting Profiles dialog box, select a scanner and
click Edit. In the Edit Default Profile dialog box (see
Figure 6-14), review the settings, which may include
(depending on your scanner model) color management
for fine tuning the way colors are scanned and resolution

settings that control how detailed a scan is performed (the

higher the resolution, the crisper and cleaner your elec-
tronic document, but the more time it may take to scan).

5. Click Save Profile to return to the Properties dialog box
and then click the Close button twice to close the Scan
Profiles and Scanners and Cameras windows.

When you're ready to run a scan, place the item to be
scanned in your scanner. Depending on your model,
the item may be placed on a flat “bed” with a hinged

cover or fed through a tray. Check your scanner’s
manual for the specific procedure to initiate a scan
(for example, pressing a Scan or Start button). After

Chapter 6: Setting Up Printers and Scanners

107



Part I: First Steps with Your Computer

you begin the scan, your computer automatically
detects it and displays a dialog box showing you the
scan progress and allowing you to view and save the
scanned item.

Edit Default Profile: Photo ==

HF Deskjet F4100

Profile name: Photol

Setthis profile as default

Source: Flathed -

Calar format: Color -
Eile type: 1P (JPEG image) b

Resolution (D 200
Brightness: ] 0
Contrast: (] 0

Preview or scan images as separate files

Preview 1 | Sawve Profile ‘ | Cancel

Figure 6-14
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Getting Help

Wth so many Windows features, you're

bound to run into something that doesn't

work right or isn't easy to figure out (or that
this book doesn't cover). That's when you need
to call on the resources that Microsoft provides
to help you out.

Through the Help and Support Center, you can
get help in various ways, including the
following:

2

2

Access information that's stored in the
Help system database. Logically enough,
a database contains data; in this case, it
contains answers to questions that users
have about Windows 7 organized by top-
ics such as Printers or Using Your Mouse.
Drill down from one topic to another or
by using a powerful search mechanism to
search by keywords such as e-mail.
There’s even a troubleshooting feature
that helps you pin down your problem.

Get help from your fellow Windows
users. Tap into information exchanged
by users in Windows Communities (sort
of like the community bulletin board in
your local community center) or by using
a little feature called Remote Assistance,
which allows you to let another user take
over your computer from a distance (via
the Internet) and figure out your prob-
lem for you.

| “*ap’rer

Getready to...

w= Explore the Help Table of
Contents ........cocveevivennenn. 110

w= Search for Help ................ 112

w Post a Question in
Windows Communities...... 114

wa» Access Windows Online

Help ..o, 117
w= Connect to Remote
Assistance .......cooeeeveeeen.... 118

w= Change Windows Help and
Support Display Options.... 121

w= Contact Microsoft Customer
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w= Open your wallet and pay for it. Microsoft offers
some help for free (for example, help for installing
its software that you paid good money for), but
some help comes at a price. When you can't find
help anywhere else, you may want to consider fork-
ing over a few hard-earned bucks for this option.

Explore the Help Table of Contents

110

1.

4.

Your first stop in searching for help is likely to be the
built-in help database. One of the simplest ways to find
what you need here is to use the Table of Contents,
which is similar to a book’s Table of Contents. Choose
Start=>Help and Support to open Windows Help and
Support, shown in Figure 7-1. Note: If your copy of
Windows came built into your computer, some computer
manufacturers (such as Hewlett-Packard) customize this
center to add information that’s specific to your com-
puter system.

Click the Browse Help Topics link to display a list of top-
ics. Click any of the topics to see a list of subtopics.
Eventually, you get down to the deepest level of detailed
subtopics, as shown in Figure 7-2.

Click a subtopic to read its contents. Some subtopics con-
tain blue links that lead to related topics or perform an
action such as opening a dialog box. Green links display
a definition or explanation of a term when clicked.

When you finish reading a help topic, click the Close
button to close the Windows Help and Support window.

@ You can click the Print icon in the set of tools at the

top right of the Windows Help and Support window
to print any displayed topic. You can also click the
Minimize button in the title bar to minimize the
window and keep it available while you work on
your computer.
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Windows will automatically get the most up-to-date
help information if you are connected to the Internet
when you open Help and Support. If you are not
connected, you can still browse the database of help
information installed with Windows 7. See Chapter
16 for help with connecting to the Internet.

Click this link

[ |Windows Help and Support

s b i

[~ TN
? ??'JI w g% Ask Options ~

[|search Help

= How to get started with your computer

= Learn about Windows Basics

b ®  Browse Help topics

R

-61 Find an answer quickly
Enter a few words in the search box above.

i -! Check out the new Windows website, which will soon have more information, downloads, and ideas for getting the most out of your Windows 7 PC.

Figure 7-1

[® Windows Help and Support

@\./

[ TR
’“?,! g E[ g% Ask Options ~

Search Help

Can I protect files or folders with a password?

[This content is preliminary and subject to change.]

information, check the Help for the program you're using.

Was this helpful?

‘ Yes ” No ” Somewhat

Read the privacy statement online

Mo, you can't use a password to protect files and folders in Windows. However, some programs that run on Windows allow you to protect individual files with a password. For more

There are other ways to protect your files and folders in Windows. You can encrypt your files using Encrypting File System (EFS], manually specify who can access the folders or files by
setting permissions, or hide them. Choose your method based on how secure the folders or files need to be. Encrypting is the most secure, while hiding the folders is the least secure.

For more informatian about EFS, see What is Encrypting File System (EFS)? For more information about permissions, see What are permissions?

Figure 7-2

111



Part I: First Steps with Your Computer

Search for Help

1. If you don't find what you need by using the Table of
Contents (for instance, say you wanted help using your
mouse but didn’t realize that’s listed under the topic
Getting Started), you may want to use the help search
feature to find what you need by entering keywords such
as mouse or input. Start by opening the Windows Help
and Support window.

2. Enter a search term in the Search Help box and then click
the Search Help button. Search results, such as those
shown in Figure 7-3, appear. Windows will search online
help by default, if you are connected to the Internet. If you
wish to only use offline help, click the Online Help link in
the bottom-right corner and choose Get Offline Help.

3. Explore topics by clicking various links in the search
results. These links offer a few different types of help:

e Procedures, such as Make the mouse easier to use.

¢ Troubleshooting help items are phrased as state-
ments, such as I can’t hear any text read aloud
with Narrator. Clicking one of these takes you to a
troubleshooter wizard.

e Some items provide general information rather
than procedures, such as Tips for Searching the
Internet. (See Figure 7-4.)

4. 1f you have no luck, enter a different search term in the
Search Help text box and start again.
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If you don't find what you need with Search, consider
clicking the Browse Help button in the top right of the
Windows Help and Support window (it sports a little
blue icon in the shape of a book) to display a list of
major topics. Those topics may also give you some
ideas for good search terms to continue your search.

Enter a search term here

[€@3 Windows Help and Support

[~ T IE= R

@ {g) ”‘!‘/ aﬂ w gié Ask Options ~
Mouse »
24 results for Mouse —
1. Make the mouse easier to use
2. Usethe computer without the mouse or keyboard (alternative input ..
3 Make items on the screen appear bigger (Magnifier)
4. Make the keyboard easier to use
L H Keyboard shortcuts
6.  Type without using the keyboard {On-5creen Keyboard)
7. Make your computer easier to use
8. How canlselect text and move around 2 webpage with my keyboard? 2
8 Create keyboard shortcuts to open programs
10. Zoomin on a webpage
11.  Add-on (definition)
12.  Operating system (definition)
13.  Use Speech Recognition to click anywhere on the screen
14,  Use Speech Recognition to browse the Intemet
15,  Make the computer easier to see (optimize visual display)
16.  Spyware: frequently asked questions
17.  Using Accelerators to find addresses, define words, and do other tasks ...
18.  Driver (definition)
19.  Keyboard shortcut {definition)
20, Tips for searching the Internet o
Qg More support options
& Online Help =

View the search results here

Figure 7-3
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[@ Windows Help and Suppert T | o 12 ]
@ &) jj‘z' = El ﬁ% Ask Options ~
Mouse P

Tips for searching the Internet |

[This content is preliminary and subject to change.] In this article

Us SeapEh b
The Internet contains a vast collection of information, but finding what you are looking for can be a challenge. Here are a few tips to help you S Usehisearch bok

search the web more effectively. ¢ Usethe Address bar

# Use more than one
Use the search box semith prbviter
In the Internet Explarer search box, type a keyword or phrase and then press Enter (or press Alt+Enter to display the search results in a new # Search more efficiently
tahb). # Find words or phrases on

a page
K2 Live Search o -
Internet Explorer search box

Tip

® Press Ctrl+E to go to the search box without using the mouse.
Use the Address bar

In the Internet Explorer Address bar, type Find, Go, or ? followed by a keyword, website name, or phrase, and then press Enter. If you want the search results to display in a new tab, press
Alt+Enter after typing the phrase.

Use more than one search provider

¥ you do not find what you're looking for with a particular search provider, you can search using a different one. The Intemet Explorer search box lets you add additional search providers
and switch between them to improve your search results. You can quickly change which search provider to use on a search by clicking the provider's icon below the search box.

To learn how to use different search providers, install new search providers, or change the search provider that Internet Explorer uses by default, see Change or choose a search provider in
Internet Explorer,

Search more efficiently
Here are a few ideas for improving the results of searches. When searching using the address bar, first type find, go, or 2.:
& Use specific words rather than generic categories. For example, instead of searching for dogs, search for a specific breed of dog.

& Use quotation marks to search for specific phrases. Surrounding terms with quotation marks limits the search results to only those webpages that contain the exact phrase you've
specified. Without the quotation marks, the results will include any page that contains the words vou've used, regardless of what order those words are in.
53, More support options

& Online Help +

Figure 7-4

Post a Question in Windows Communities

1. If you want to see how other Windows users have solved
a problem, you can visit Windows Communities and
read posted messages, or even post one yourself and see
if others can help you out. Open the Windows Help and
Support window. Click the Ask button in the top-right
corner. In the Ask a Person for Help section of the page,
click the Microsoft Answers link.

2. In the Microsoft Answers page that opens in your
browser, click the topic on the left that relates to your
problem or question (see Figure 7-5).
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Browse top answers,

):;‘ Hame

'l._, Appearance and Personalization

#y  Gaming

s Hardware and Drivers

B 1mprove Perfarmance

< % Install, Upgrade, and Activate
— ’e Internet Explorer

Iy Programs

f Security and Privacy

N sound and Media

“:-- Wireless and Metworking

_"1 windows Update

,,.‘:,,: Fetting Ready for Windows 7

Manage Your Profile

Getting Ready for Windows 7

&

Top Answers in the Forum B

Getting Ready for Windows 7 Forum
Uninstalling Windows 7 RC

what happened to Windows Mail? [ can't
find it in Windows 7277

will Photo Gallery and Movie Maker be
included in windows 77

wWindows 7 looks coal, should I install the
Release Candidate?

Wthat's the best way to back up my PC?

will the Win? beta automatically update to
the Release Candidate?

How long can I use the Windows 7 beta?

what does "clean installation” of the RC
mean?

Does testing Windows 7 get you a free
copy of the real thing?

Qf See all Answered Questions

€ Go to the Forum

2009 Microsoft Corporation. All rights reserved. Terms of Use | Trademarks | Privacy Statement

:1 Top Microsoft Resources
b 7 IT Pro ar technical expert? Check out the
Windows 7 Springboard Series
Cion't lose your datal Get tips for backing up
your PC

See what's new in Windows 7

More...

Get Help Now
(‘d Contact support by E-mail, Online, or Phone
Find Compatible Devices & Applications
Wisit the Windows Wista Compatibility Center

Help us Improve

m

Give feedback

Figure 7-5

3. Click the Go to the Forum button which displays discus-
sion summaries and indicates the number of discussion
messages (see Figure 7-6).

4. Click on the discussion title to display the threads (series
of related postings) contained in it.

5. Click on a thread title to open it and scroll through the
original posting and replies to it.

¢ Post a new message. To post a message, you have
to sign into Microsoft TechNet using a Windows
Live ID (which you can get for free by going to
www . windowslive.com). Next, select the discus-
sion group to participate in, and then click the Ask
a Question button. If you have never participated in
a discussion, you will be asked to create a profile.
Enter a display name and click the Accept button.
In the Start a New Question or Discussion form,
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enter the Title and message Body in their respective
text boxes. Add any descriptive tags or categories,
and then click Submit to post your question.

¢ Reply to a message in a discussion. With the list
of postings and replies displayed, click the Reply
button, fill in the message, and then click Post.

You can also use the Search feature to search for key-
words or phrases in discussions. Enter a word or phrase
in the Search Forums text box, select where to search in
the Search Forum drop-down list, and then click Go.
Relevant messages are displayed; click one to read it.

It's a good idea to roam around a discussion for

a bit before you post a question to see if it's been
addressed before. If you post a question that’s been
answered several times before, you not only waste
your time and the time of others, but you may find
yourself the recipient of a bit of razzing by regulars to

the discussion forum.

R Web
windows Wista > Forums Home = Windows Wista Forums > Gaming
@ ask a question Search Forums: [5oprch nin L el LS
Gaming g
Install, traubleshoot, set parental controls
Filtering and Sorting Use these options to narrow down the question and discussion list.
Iﬁj all Threads = g Mo Replies 5% Helpful 44 Sort By «
1 [2][3]4]5][s][7]|8] 9] 10] ... 48] 50| >»]| tshowing 1 ta 20 of 982) Replies Mlews
E’\ + Mechwarrior 4 Yengeance 4 79
Wilwlvr Wednesday, August 05, 2009 2:57 A0
Last Reply Diana - PSS MSFT Thursday, dugust 06, 2008 10027 £M
42 =~ Undo Password Parental Gontrols Option 7 5968
lzila beaudain Friday, April OF, 2009 6127 £M
Last Reply KannanSampathkumar Mondsy, dugust 03, 2009 10:15 AM
£ ~ video games graphics glitching a 3153
Dan7?7097 Mondsy, June 08, 2009 3.57 AM
Last Reply Gab 1 Saturday, dugust 01, 2009 3:01 FM
'E) ~ 700 Tycoon 2 and Windows Vista Compatability issues 2 132

se nuss Juesday, Juiv 21, 2009 5:47 AM

United States (English) ~ | Microsoft.com | Sign in

Need Help with Forums?
(FAQ)

My Forum Links

Sign In To Forums
Forums Home
Browse Forums Users

Popular Threads

Fable: The Last chapters nat
installing...

WEB CAMERA DID NOT
REIMNSTALL AFTER FACTORY
REBOOT

Flight Sirmulator ¥ Errar 1305

Al enitry to wch

es graphics glitching

Recent Visitors

Maveen K - Microsoft
L Support

F_ Syed V - Microsoft
Support
Q TOMLOC

m

Figure 7-6
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Access Windows Online Help

1. Open the Windows Help and Support window and then

click the Windows Website link.

2. In the window that appears (see Figure

7-7), use the

links in the following sections to get help:

e Getting Started includes topics such as installing
Windows or hardware (see Figure 7-8), and per-

sonalizing your PC.

e Using Windows 7 takes you to topics that help
you work with Windows features and settings.

Use these sections to get help

=

United States Change | All Microsoft Sites

£7 Windows

oing'

Home  Discover Windows  Products  Shop  Downldads

Windows 7 Help & How-to home  Getting Started  Using Windows 7

Windows 7 Help & How-to

Help & How-to

I Getting started

Find out how to get up and running with
windows 7,
i

Installing Windows

Using Windows 7

See what Windows 7 has in store to help
make everyday tasks a little bit easier,

What's new with the Windows 7 desktop?

Installing new hardware Minimize windows using Aero Shake

Security checklist Arrange windows side by side using Snap

What's new for computers with
touchscreens?

Personalize your PC

Mare...
m

More to explore

;| How to get Windows 7

Find out how you can be amang the
first to get Windows 7 by upgrading
or pre-ordering.

,[i; Ak the community

Post guestions to the Windows 7
forum on the Microsoft Answers
website,

§ Tour the world of Windows 7

Take a lock at all the ways that
Windows 7 makes new things possible,

Figure 7-7

® More to Explore offers information on upgrading
to Windows 7, a link to community forums, and a

tour of Windows 7.
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United States Change | All Microsoft Sites

£7 Windows Search this websit oing [2)]

Home  Discover Windows  Products  Shop  Downloads  Help & How-to

Windows 7 Help 8 How-to home  Getting Started  Using Windows 7

Windows 7 Help & How-to

Getting started Using Windows 7 More to explore
Fine out how to get up and running with See what Windows 7 has in store to help
Windows 7, make everyday tasks a little bit easier, \:l How to get Windows 7

Find out how you can be amang the
first to get Windows 7 by upgrading
or pre-ordering.

,[i% Ak the community

Post questions to the Windows 7
forum on the Microsoft Answers

Installing Windows Wihat's new with the Windows 7 desktop? wehsite,

Installing new hardware Minimize windows using Aero Shake

Security checklist Arrange windows side by side using Snap ; Tour the world of Windows 7
Personalize your PC What's new for computers with Ta.ke a look at all the ways that

PRSES touchscreens? Windows 7 makes new things possible,

< [ m

m

Getting Started offers help installing Windows and new hardware

Figure 7-8

3. Click the Close button to close the online help window
in your browser, and then click the Close button to close
Windows Help and Support.

To set up Help and Support to always include
Windows Online Help and Support when you search
for help, click the Options button and choose Settings.
Be sure the checkbox labeled Improve My Search
Results by Using Online Help (recommended) is
selected, and click OK to accept the change.

Connect to Remote Assistance

1. Remote Assistance can be a wonderful feature for new
computer users because it allows you to permit somebody
else to view or take control of your computer from their
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own computer no matter where they are. You can contact
that person by phone or e-mail, for example, and ask for
help. Then, you can send an invitation using Windows 7
Help. When that person accepts the invitation, you can
give him or her permission to access your system. Be aware
that by doing so you give the person access to all your
files, so be sure this is somebody you trust. When that per-
son is connected, he or she can either advise you about
your problem or actually make changes to your computer
to fix the problem for you. To use Remote Assistance, you
and the other person first have to have Windows and an
Internet connection.

Next, enable Remote Assistance by choosing Start=>Control
Panel=>System and Security=>Allow Remote Access. On the
Remote tab of the System Properties dialog box that is dis-
played, select the Allow Remote Assistance Connections to
This Computer check box, and then click OK.

. Open the Windows Help and Support window.

4. Click the Ask button, and then click the Windows Remote

Assistance link. On the window that appears, shown in
Figure 7-9, click the Invite Someone You Trust to Help
You link. If you have Windows Firewall active, you may
have to disable that feature to allow remote access to your
computer.

. On the page that appears, you can choose to use your

e-mail to invite somebody to help you. You have two
options:

e Click the Save This Invitation as a File option and
follow the instructions to save it as a file; then you
can attach the file to a message using your Web-
based e-mail program.

Chapter 7: Getting Help
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Click to invite a helper

u »1 Windows Remote Assistance

Do you want to ask for orfoffer help?

Windows Remote Assistance conflects two computers so that one person can help troubleshaot or fix
problems on the other person's cqmputer.

- salb [nvite someone you trust to help you
Your helper can view your screen and share control of your computer.

g Help someone who has invited you
Respond to a request for assistance from another persen.

Bead our privacy statement online

Cancel

Figure 7-9

e (Click the Use E-mail to Send an Invitation option
to use a pre-configured e-mail program to send an
e-mail (see Figure 7-10). Enter an address and
additional message content, if you like, and send
the e-mail.

Meitage Ingert Cptiom Format Test
.
] s ' W
B iU = Signature || Foliow !
Up- | B
Thét message has nat been sent
Toy. |
dend E(‘...
[ eeount = | subject | tou hawe received a Remote Assitance evastion
agoenee | 2o tion o incident 05 K
I
Hi,
1 need help with my computer. would you please use Windows Remote Assistance to connect to my computer 5o you
can help me? 4fter you connect, you can view my screen and we can chat online.
Te accept this invitation, double-click the file attached to this message.
Thanks .
lote: Do not accept this Invitetlon unless you know and trust the persen who sent it.

Figure 7-10



Chapter 7: Getting Help

6. In the Windows Remote Assistance window, as shown in
Figure 7-11, note the provided password. When an incom-
ing connection is made, use the tools there to adjust set-
tings, chat, send a file, or pause, cancel, or stop sharing.

£~ Windows Remote Assistance i (=[O ES
- Chat r Settings & Troubleshoot QI Help

Tell your helper the connection password
PANLMRYWBGX6

i'_i:Z' Waiting for incoming connection...

Figure 7-11

7. When you're finished, click the Close button to close the
Windows Remote Assistance window.

good idea. After all, you don’t want somebody trying
to log in to your computer unexpectedly two weeks
from now when you've already solved the problem
some other way. You can make these timing settings
in the Remote Assistance settings in the System
Properties dialog box.

@ Setting a time limit to not more than a few hours is a

know the password — it isn’t included in your e-mail
unless you add it. Although using a password used to
be optional in Windows XP, it's mandatory in
Windows 7.

E sv Remember that it's up to you to let the recipient

Change Windows Help and Support Display Options

1. If you're having trouble reading help topics, get some
help with modifying text size. Open the Windows Help
and Support window.

2. Choose OptionstoText Size and then choose one of the
text size options: Largest, Larger, Medium (the default),
Smaller, or Smallest (see Figure 7-12).
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Largest | Text Size I
Larger

@  Medium

Smaller }
Smallest

e o [ =)

T:’I ] E| E‘:‘i Ask |Options «

Print...

Browse Help

Find (on this page]...
Settings...

Select a text size option
Figure 7-12

3. Your new settings take effect immediately; click the Close
button or navigate to another area of the Windows Help
and Support window.

©)
©)

If you don't like the colors in your Help and Support
screen, you can change them by choosing a different
color scheme in the Control Panel’s Appearance and
Personalization settings.

Don't forget that you can reduce the size of the Help
and Support window by clicking the Restore Down
button in the upper-right corner of the window. This
is especially useful with the Help window so you can
display it side by side with an application or Control
Panel window where you're trying to troubleshoot
the described help topic.

Contact Microsoft Customer Support
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1. Go to the Windows Help and Support window and click
the Ask button in the upper-right corner. On the page
that appears, shown in Figure 7-13, click the Contact
Technical Support link to open the Customer Support
Web site in your default browser.
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2. In the Microsoft Help and Support window that appears,
click a product to see what support options and informa-
tion are offered (see Figure 7-14).

Click this link

@ Windows Help and Support I (o (o =S
@ () ”?! .g;, w 3% Ask Options

Mouse P

More support options
[This content is preliminary and subject to change.]

I you can't find an answer to your question in Help, try these additional support options.

Ask a person for help
» Get afriend to help you over the Internet
If you have computer-savvy friends, you can use # Windows Remote Assistance to enable them to help you fix your problem remotely over the Intemnet.
» Askavolunteer expert online

There are thousands of volunteers online who can help you answer a question. Ask a question or search for an answer online in Windows communities,

L. Contact technical support

Go online to contact your computer manufacturer or Microsoft Customer Support for technical assistance. Microsoft support is also available by e-mail, chat, or phone.

Search other resources

# Get more on the Windows website
The new Windows website will have more how-to articles, videos, free downloads, and inspiring ideas for getting the most out of your Windows 7 PC,
# Find info for IT professionals

I you're an IT professional, go to the Microsoft TechNet website to find in-depth technical information.

Figure 7-13

3. Click on various links for help topics. If you need help
solving problems, click a Solution Center link along the
left side of the product window.

4. Click Support Option links along the bottom left to con-
tact Microsoft or to search for online help topics.

5. Use the Top Issues or Latest News links to find out what
problems others are experiencing and how they've solved
them or news from Microsoft about how to fix problems
or download updates.

6. Click the Close button to close the Internet Explorer
browser.
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Typically, you can call support for two free help
sessions or unlimited installation support by submit-
ting a request via e-mail support or by calling 1-800-

936-3500. There is the option of Premier Third Tier
Support, but this is for what Microsoft refers to as
non-mission-critical issues. This program is geared
towards corporations, and it gives customers access
to Microsoft experts to solve their problems. If
Windows 7 came preinstalled on your computer,
you may be able to contact your manufacturer for
support questions.

To find out about specific support options in your
country, click the Understand Your Support Options
link in the Help and Support home page. Click Support
Options on the page that appears, then select your
country and press Enter. Use the product finder feature
to drill down to the specific help available to you.

/= Upgrade your Internet Experisnos

Microsoft Help and Support

Top Solution Centers
2007 Office Suites

Internet Explorer
Microsoft Update
Office 2003
Outlook 2007

‘ Email
Microsoft Fix it
Product Activation
Windows Vista
Windows <P

More Solution Centers

Support Options
Self Support Gptions

Downloads & Updates
Microsoft Services

Contact Microsoft

Top Issues

Identify, locate, or replace a product key
Get help with error messages
Micrasoft Fix it Solution Center

A folder that is created under the root of the
system drive is missing entries in its security
descriptor, which may cause some
application failures on the English version of
windows 7 Release Candidate 32-hit Liltimate

Description of test update 1 for Windows 7
and Windows Server 2006 RZ Beta and
Release Candidate builds

Error message when you use applications
that are based on legacy Transport Driver
Interface (TDI) filter drivers on a cormputer
thatis running Windows 7 Beta or Windows
Server 2008 R2: "STOP 0x00000001

Aan update is available for Windows Media

Center and Windows Media Player in
windows 7 Beta

Solution Centers

Latest news

United States Change

IR s

Get Help Now

July 28: Critical security patch faor = Contact = Support
Internet Explarer i | Profes=ionsl by Email,

' nline, or Phane,
windows 7 RTM: Learn more

Wit to Expedt Windows Server EaasTools

2008 RZ RTHM Print this page

Download Wista Service Pack 2 E-rnail this page
Obtain the Microsoft Security
Updates far July

Office 2007 Service Pack 2 is
available

Microsoft Money Plus will not be
available for purchase after June
30, 2009

Figure 7-14
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Working with
Software
Programs

ou may think of Windows 7 as a set of use-

ful accessories, such as games, a calculator,
and a paint program for playing around with
images, but Windows 7 is first and foremost an
operating system. Windows 7’s main purpose is
to enable you to run and manage other software
programs, from programs that manage your
finances to a great animated game of bingo. By
using the best methods for accessing and run-
ning programs with Windows 7, you save time;
setting up Windows 7 in the way that works
best for you can make your life easier.

In this chapter, you explore several simple and
very handy techniques for launching and mov-
ing information between applications. You go
through step-by-step procedures ranging from
setting program defaults to removing programs
when you no longer need them.

| “*op’rer

Getready to...

w= Launch a Program............. 128
w= Move Information Between
Programs .........ccccceeenuneen. 130
w= Start a Program
Automatically ................... 132
w= Set Program Defaults ......... 134
w= Remove a Program............ 136
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Launch a Program

1. Launch a program by using any of the following four
methods:

e Choose Start>All Programs. Locate the program
name on the All Programs list that appears and click
it. Clicking an item with a folder icon displays a list
of programs within it; just click the program on that
sublist to open it (as shown in Figure 8-1).

. Administrative Tools
. ASUS Utility

. Axara

. Camtasia Studic 6

) Crawler Toolbar

J CyberLink DVD Suite
. Extras and Upgrades

Owner

Documents

. Games

; HP

. iTunes

. LightScribe Direct Disc Labeling
. Maintenance

Pictures
Music

Games
J Microsoft Mouse
J Microsoft Office Favorites
"o Activation Assistant for Microsoft O
lf: Microsoft Office Access 2007 Computer
[ Microsoft Office Excel 2007
[ Microsoft Office Outlook 2007 Control Panel
[& Microsoft Office PowerPaint 2007
[Z) Microsoft Office Publisher 2007 Devices and Printers
i) Microsoft Office Word 2007

. Microsoft Office Tools EipandSuppatt

1 Back

| |Search programs and files £ |

Click an item to launch it
or click a folder to see its sublist

Figure 8-1

e Double-click a program shortcut icon on the desk-
top (see Figure 8-2).

¢ Click an item on the taskbar. The taskbar should dis-
play by default; if it doesn't, press the Windows logo
key (on your keyboard) to display it, and then click
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an icon on the taskbar (as shown in Figure 8-2), just
to the right of the Start button. See Chapter 3 for
more about working with the taskbar.

e If you used the program recently and saved a
document, choose it from the list of recently used
programs displayed when you first open the Start
menu. Then click a document created in that pro-
gram from the list that displays. (See Chapter 9 for
information about displaying recently used files
on the Start menu.)

Double<click a program’s shortcut icon to launch it...

Chapter 8: Working with Software Programs

ﬁ;@ = 3 ¥ 9

Or click an icon on the Taskbar

Figure 8-2

Wednesday

4

March 2009
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2. When the application opens, if it's a game, play it; if it's a

spreadsheet, enter numbers into it; if it’s your e-mail pro-
gram, start deleting junk mail . . . you get the idea.

Not every program that’s installed on your computer
appears as a desktop shortcut or taskbar icon. To add
a program to the taskbar or to add a desktop short-

cut, see Chapter 3.

Move Information between Programs
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1. Open documents in two programs (see the next section

for more about opening applications). Right-click the
taskbar on the Windows desktop and choose Show
Windows Side by Side (see Figure 8-3).
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If you don't need one of the active programs displayed,

click the Minimize button so just the programs you're

working with appear.

Select the information that you want to move (for exam-

ple text, numbers, or a graphical object in a document),
and drag it to the other application document (see

Figure 8-4).

Release your mouse, and the information is copied to the

document in the destination window.

@
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You can also use simple cut-and-paste or copy-and-
paste operations to take information from one appli-

cation and move it or place a copy of it into a
document in another application. To do this, first
click and drag over the information in a document,
and then press Ctrl+X to cut or Ctrl+C to copy the
item. Click in the destination document where you
want to place the item and press Ctrl+V. In addition,
some applications have Export or Send To com-
mands to send the contents of a document to
another application. For example, Microsoft Word
has a Send Tor>Microsoft Office PowerPoint com-
mand to quickly send a Word document to be the
basis of a PowerPoint presentation outline.

program. For example, you can't click and drag an
open picture in Paint into the Windows Calendar. It
will most dependably work when dragging text or
objects from one Office 2007 or other standard
word-processing, presentation, database, or spread-
sheet programs to another.

@ Remember, this won't work between every type of

Start a Program Automatically

1. If you use a program often, you may want to set it to
start every time you start your computer. Click Start=>
All Programs.

2. Right-click the Startup folder and click Open (see
Figure 8-5).

3. Right-click Start and choose Open Windows Explorer. In
the window that appears, locate and open the folder
where the program you want to start when you start
Windows is located. Click to select it.
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Carntasia Studio 6

Crawler Toolbar

CyberLink DVD Suite

Extras and Upgrades
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iTunes
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Microsoft Mouse
Microsoft Of Expand
Mozilla Firefy
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MNorton Inter| Open All Users Eitiis
QuickTime Explore

Real Explore All Users Computer
Second Life
SlideWhere
Snaglt9 Rename
Spyware Ter
Startup
Windows Live

Music

Games
Open

Delete Control Panel

. Devices and Printers
Properties

Help and Support

1 Back

| Search programs and files

Figure 8-5

4. Drag the item to the Startup window you opened in Step 2.
The program appears in the Startup folder (see Figure 8-6).

5. When you finish moving programs into the Startup
folder, click the Close button in the upper-right corner of
both windows. The programs you moved will now open
every time you start Windows 7.

If you place too many programs in Startup, it may
take a minute or two before you can get to work
because you have to wait for programs to load. Don't
overfill your Startup folder: Use it just for the pro-
grams you need most often.

You can remove an application from the Startup
folder by right-clicking it and choosing Delete.
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Set Program Defaults
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Moving the item to the Startup window

1. To make working with files easier, you may want to con-
trol which programs are used to open files of different
types. Choose Start>Control Panel= Programs.

2. In the resulting Programs window, shown in Figure 8-7,
click the Set Your Default Programs link in the Default
Programs section to see specifics about the programs that
are set as defaults.

3. In the resulting Set Default Programs window, click a
program in the list on the left (see Figure 8-8) and then
click the Set This Program as Default option. You can
also click Choose Defaults for this Program and select



specific file types (such as the JPEG graphics file format

or DOCX Word 2010 file format) to open in this pro-
gram; click Save after you've made these selections

el o |
@V\.J'l + Control Panel » Programs » v [ 2] [ Search Control Panel
File Edit View Tools Help

ntrol Panel Home

System and Security
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Change default settings for media or devices
Make a file type shways open in a specific program | Set your default programs

Desktop Gadgets
Add gadgets to the desktop Get more gadgets online || Uninstall 2 gadget
Restore desktop gadgets installed with Windows

Figure 8-7

Click this link
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Figure 8-8

Then click this option
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4. Click OK to save your settings.

to play media such as movies or audio files by select-
ing Change Default Settings for Media or Devices in
the Programs window you opened in Step 1 earlier.

@ You can also choose which devices to use by default

Remove a Program

1. If you don't need a program, removing it may help your
computer’s performance, which can get bogged down
when your hard drive is too cluttered. Choose Start=>
Control Panel=>Uninstall a Program (under the Programs
and Features category).

2. In the resulting Uninstall or Change a Program window,
shown in Figure 8-9, click a program and then click the
Uninstall (or sometimes this is labeled Uninstall/
Change) button that appears. Although some programs
will display their own uninstall screen, in most cases, a
confirmation dialog box appears (see Figure 8-10).

3. If you're sure that you want to remove the program, click
Yes in the confirmation dialog box. A dialog box shows
the progress of the procedure; it disappears when the
program has been removed.

4. Click the Close button to close the Uninstall or Change a
Program window.

tions, such as Microsoft Office, you get both an
Uninstall and a Change option in Step 2 above.
That's because you might want to remove only one
program, not the whole shooting match. For exam-
ple, you might decide that you have no earthly use
for Access but can't let a day go by without using
Excel and Word — so why not free up some hard
drive space and send Access packing? If you want to

@ With some programs that include multiple applica-
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modify a program in this way, click the Change but-
ton rather than the Uninstall button in Step 2 of this
task. The dialog box that appears allows you to select
the programs that you want to install or uninstall or
even open the original installation screen from your
software program.

leiel (o |5 =]
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Figure 8-10

Warning: 1f you click the Change or Uninstall but-
ton, some programs will simply be removed with no
further input from you. Be really sure that you don’t
need a program before you remove it, or that you
have the original software on disc (or disk) so you
can reinstall it should you need it again.
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®

If you used some earlier versions of Windows, you
note that the Add a Program command is gone.
Because all software created today allows you to put
a CD/DVD into your drive or download it from the
Internet and then follow on-screen directions to
install the program, Microsoft must have decided
that its own Add a Program feature was obsolete!



Working with
Files and Folders

oin me for a moment in the office of yester-

year. Notice all the metal filing cabinets and
manila file folders holding paper rather than
the sleek computer workstations and wireless
Internet connections we use today.

Fast forward: You still organize the work you
do every day in files and folders, but today, the
metal and cardboard have been dropped in
favor of electronic bits and bytes. Files are the
individual documents that you save from
within applications, such as Word and Excel,
and you use folders and subfolders to organize
several files into groups or categories, such as
by project or by customer.

In this chapter, you find out how to organize
and work with files and folders, including

w= Finding your way around files and fold-
ers: This includes tasks such as locating
and opening files and folders.

w= Manipulating files and folders: These
tasks cover moving, renaming, deleting,
and printing a file.

w= Squeezing a file’s contents: This involves
creating a compressed folder to reduce a
large file to a more manageable creature.
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w= Rename a File or Folder..... 149

w= Create a Shortcut to a File
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w= Delete a File or Folder....... 152

w=» Create a Compressed File
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w= Add a File to Your
Favorites List.......c.ccvvvneiinn. 155

w= Back Up Files to a Read/
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w= Backing up files and folders: To avoid losing valu-
able data, you should know how to make backup
copies of your files and folders on a recordable CD/
DVD or flash drive (a small stick-shaped storage
device that fits right into a USB port on your
computer).

Understand How Windows Organizes Data

When you work in a software program, such as a word processor, you
save your document as a file. Files can be saved to your computer hard
drive, to removable storage media such as USB flash drives (which are
about the size of a package of gum and you insert them into a USB
port on your computer), or to recordable DVDs (small flat discs you
insert into a disc drive on your computer).

You can organize files by placing them in folders. The Windows oper-
ating system helps you to organize files and folders in the following
ways:

w= Take advantage of predefined folders: Windows
sets up some folders for you. For example, the first
time you start Windows 7, you find folders for
Documents, Pictures, Videos, and Music already set
up on your computer. You can see them listed in
Windows Explorer, shown in Figure 9-1. (See
Chapter 3 for an explanation of Explorer.)

The Documents folder is a good place to store letters,
presentations for your community group, household
budgets, and so on. The Pictures folder is where you
store picture files, which you may transfer from a
digital camera or scanner, receive in an e-mail mes-
sage from a friend or family member, or download
from the Internet. Similarly, the Videos folder is a
good place to put files from your camcorder, and the
Music folder is where you place tunes you download
or transfer from a music player.
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Predefined folders help organize files
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o]

‘ -4 b Libraries - |+,| ‘ Search Libraries

Organize =

{ Favarites
Public

Bl Desktop

4 Downloads

= Recent Placi

) Libraries

\\% Homegroup

1M Computer

€l Network

MNew libr]

#y Recently Changed

es

| Documents
@ Music

k= Pictures
E Videos

Iy

Libraries

Open a library to see your files and arrange them by folder, date, and other properties
N
| Documents ~lJ Music
i Library - Library

il ooy ﬂ iihrary
< ibrary ., Library

Figure 9-1

[T 2

[T 2

Create your own folders: You can create any num-
ber of folders and give them a name that identifies
the types of files you'll store there. For example, you
might create a folder called Digital Scrapbook if you
use your computer to create scrapbooks, or a folder
called Taxes where you save e-mailed receipts for pur-
chases and electronic tax filing information.

Place folders within folders to further organize
files: A folder you place within another folder is
called a subfolder. For example, in your Documents
folder, you might have a subfolder called Holiday
Card List that contains your yearly holiday newsletter
and address lists. In my Pictures folder, I organize
the picture files by creating subfolders that begin
with the year and then a description of the event or
subject, such as 2005 Home Garden Project, 2007
Christmas, 2009 San Francisco Trip, 2010 Family
Reunion, 2009 Pet Photos, and so on. In Figure 9-2,
you can see subfolders and files stored within the
Pictures folder.
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Folder Subfolders Files in Pictures folder
(E=NECH EX=)
@\;jw‘h ¥ Libraries |» Pictures » b | *}l ‘ Search Pictures L |
Organize « Share with = Slide show Burn New folder =~ 9
¢ Favorites Pictures library Rivare i, SFalsis
4y Recently Changed Includes: 2 locations S o

Public I I
Bl Desktop

& Downloads g
= Recent Places |

= Libraries
-,“ Documents Grandkids Pets Sample Pictures Vacation photos

@ Music

| Pictures

= My Pictures
Public Pictures

E Videos

'v?: Homegroup
1% Camputer

€l Network

Figure 9-2

w= Move files and folders from one place to another:
Being able to move files and folders helps you if you
decide it’s time to reorganize information on your
computer. For example, when you start using your
computer, you might save all your documents to
your Documents folder. That's okay for a while, but
in time, you might have dozens of documents saved
in that one folder. To make your files easier to
locate, you can create subfolders by topic and move
files into them.

Access Recently Used Items

1. If you worked on a file recently, Windows offers a short-
cut to finding and opening it to work on again. Open the
Start menu and right-click any blank area. From the
resulting shortcut menu, choose Properties.

2. In the Taskbar and Start Menu Properties dialog box that
appears, click the Start Menu tab (if that tab isn’t already
displayed).
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3. Make sure that the Store and Display Recently Opened
[tems in the Start Menu and the Taskbar checkbox is
selected (see Figure 9-3), and then click OK.

Privacy
[¥] Store and display recently opened programs in the Start menu

/| Store and display recently opened items in the Start menu and the
taskbar

L Taskbar and Start Menu Properties i b (3
i_‘l’a_sk_b_aL! StartMenu | Toolbars |
To customize how links, icons, and menus look and Customize...
behave in the Start menu, dick Customize.
Power button action: | Shut Down % |

How do I change the way the Start menu looks?

l OK ] l Cancel Apply

Figure 9-3

Make sure this option is selected

4. Open the Start menu and hover your mouse over any
recently opened program listed on the left side that has
an arrow and a submenu of recently opened items
appears to the right. Choose a file from the submenu (see

Figure 9-4) to open it.

7 ] P—
@ Spyware Terminator ecen

=] Document

Sticky Motes ¥ |=] 000_0150

-
a Snaglt 9
7:‘ WordPad 3

:# Computer Management

—
~f Calculator

Click a file to open it

Figure 9-4
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Recently opened programs should be displayed in
the Start menu by default, but if they aren’t, follow

the directions in Step 1 to open the Taskbar and Start
Menu Properties dialog box and make sure that the
Store and Display Recently Opened Programs in the
Start Menu checkbox is selected.

Locate Files and Folders in Your Computer

1. Can’t remember what you named a folder or where on
your computer or storage media you saved it? You can
open the Computer window to locate it. Choose Start=>
Computer.

2. In the resulting Computer window (see Figure 9-5),
double-click an item, such as a USB drive, a CD-ROM
drive, or your computer hard drive, to open it.

el [ [[E S
Kol lims) |_'|i » Computer » v|&’| | Search Computer 2|
File Edit View Tools Help
Organize = System properties Uninstall or change a program ke - - [ 0-
¥ Downloads 4 Hard Disk Drives (2)
2| Recent Places Vistabd (C3)
Playlists :"._! - DOUb|e-C|IC|(
- 89.5 GB free of 149 GB an ”_em
— Libraries DATA (D) .
e
[ Documents = to Open It
= " |2 =W 138GBfree of 138 6B
@' Music 3
=| Pictures
¥ Videos
‘M Computer
&, Vistabd (C:)
NATA M4 =
. L OWMER-PC Workgroup: WORKGROUP Memory: 4.00 GB
o — Processor: Intel(R) Core(TM)2 Duo ...
2items
o
Figure 9-5

3. If the file or folder that you want is stored within another
folder (see Figure 9-6 for an example of the resulting
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window), double-click the folder or a series of folders
until you locate it.

4. When you find the file you want, double-click it to open
it in the application in which it was created.

9-6. Use the commands in this area to perform com-
mon file and folder tasks, such as organizing, shar-
ing, or opening files.

@ Note the buttons on the top of the window in Figure

folders, you might see text listings, as shown in

Figure 9-6, icons, or even thumbnail representations
of file contents. Use the View menu in the Computer
window to configure how to display files and folders.

@ Depending on how you choose to display files and

lies (o[BS

@uvh’u <« Vista6d (C) » v [ 42| | Search vistasa (Cy o |
File Edit View Tools Help
Organize » Mew Folder Include in library « Share with = B= »« i 't:)'
— -~
= RecentPlaces  *  [O] Name Date modified Ttem Type Size 2
Playlists
£ Intel 9
G PerfLogs 12 =
Libraries . 3
et Program Files 1
|-=] Documents .
& . Program File... 1
o Music
B w Users
| Pictures 2 .
3 Windows
E Videos 7 o
devlist KE
__ Finish KE
% Computer I v
£ \ictatid (C2) L Ko KE
iy Vista :
- | | NBOVC_MBO.. 8/8/20084:.05.. 10File 1KE
cu DATA (D)
- 4 n 1]
= 21 items
21 items
.
Figure 9-6

Search for a File

1. If you can't locate a file in the Computer window or in
your Documents folder, you can perform a simple search
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for it. Open the Start menu and type a search term in the
search box at the bottom.

2. A list of search results appears, divided by the location of
the results (see Figure 9-7).

3. Click the See More Results link.

4. In the window that appears (see Figure 9-8), click an

item to view it.

5. When you locate the file you want, you can double-click

it to open it.

Control Panel (7)

=5 Devices and Printers

= View devices and printers

:_: Share printers

Ll Change advanced color management settings for displays, sca...

5 Add a printer

#5 Change default printer
Documents (34)

hﬂ contacts(2)

13_1 contacts(2)

] 406922 Intra_tebpvs_MNM

] 406922 Ch12_tebpvs NM

1] 406922 Chi15_tebpvs_nm

[ 406922 Ch13_tebpvs_nm
Microsoft Office Outlock (1)

i FW: K-12 booklet Edits

Files (1)

ﬁ‘.f.'n Print Management

' See more results

| printers

Figure 9-7
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% | | ShutDown | b |

Search Folders was a new feature in Windows Vista
that has carried over to Windows 7. To save the results
of a search, you can click the Save Search button. In
the Save As dialog box that appears, provide a file-
name and type, set the location to save it to, and then
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click Save. The search results are saved as a search
folder on your computer in your user name folder.

Choose the Folder and Search Options command
from the Organize menu in the Search Results in
Indexed Locations window shown in Figure 9-8 to
modify Search settings. Using the Search tab in the
Folder Options dialog box that appears, indicate
what locations to search, whether to find partial
matches for search terms, and more.

Click an item to view it

o (=[5
S1@) [ » SearchResults » v [ 42| [ printers x
Organize » Save search Bdm E~ [ @
T Favorites j 534830_ch07_tebp_NM fied: 3/9/2009 11:58 AM
B Desktop L w T organized by topics such as Printers or Using Your Mouse, Drill down
@ Downlosds =t Mangy Stevenson
ChlJsers\Nang/\My Documents
= Recent Places
Date modified: 5/3/2009 11:32 AM
#4 Libraries es 51 MB
5 ne com...  Authors: zq1
3 Documents uthors: Denise Seguin
@ Music
k= Pictures Search again in:
B videos = Libraries (M computer | custom.. @ Internet
1M Computer
&, windows? ()
. MANCY FLASH [}
€ Network
.
Figure 9-8

Move a File or Folder

1. Sometimes you save a file or folder in one place but in
reorganizing your work decide you want to move the
item to another location. To do so, right-click the Start
menu button and choose Open Windows Explorer.

2. In the resulting Windows Explorer window, double-click
a folder or series of folders to locate the file that you
want to move (see Figure 9-9).
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el (= (2=

@Uv| <« Sample Pictures » v|w,l | Search Sample Pictures 2
File Edit View Tools Help
Organize » Mew Folder Share with « Slide show 3= (= [ 9'
4 Recently Change # . .
Public Pictures li... Arrange by:  Folder ¥ Includes: 2 library locations
B Desktop "
L Downloads m Butterfly JPG File
= Recent Places =
Playlists ‘.a Field £
Libraries m Flower
[ Documents
o' Music %) girl image
| Pictures
E Videos m Leaves
9 items
9items
.
Figure 9-9

3. Take one of the following actions:

e Click and drag the file to another folder in the
Navigation pane on the left side of the window. If
you right-click and drag, you are offered the
options of moving or copying or creating a short-
cut to the item when you place it via a shortcut
menu that appears.

e Right-click the file and choose Send To. Then
choose from the options shown in the submenu
that appears (as shown in Figure 9-10); these
options may vary slightly depending on the type
of file you choose and your installed software.

4. Click the Close button in the upper-right corner of the
Windows Explorer window to close it.

If you change your mind about moving an item
using the right-click-and-drag method, you can click

Cancel on the shortcut menu that appears.
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Edit

Print
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Rotate Clockwise
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Copy
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|
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Figure 9-10

If you want to create a copy of a file or folder in
another location on your computer, right-click the
item and choose Copy. Use Windows Explorer to
navigate to the location where you want to place a
copy, right-click, and choose Paste or press Ctrl+V.

Rename a File or Folder

1. You may want to change the name of a file or folder to
update it or make it more easily identifiable from other
files or folders. Locate the file that you want to rename
by using Windows Explorer. (Right-click Start and choose
Open Windows Explorer, and then browse to find the file

you want to rename.)

2. Right-click the file and choose Rename (see Figure 9-11).
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Play

Add to Windows Media Player list

Open With 3
Share with 3
Restore previous versions

Send To 3 =G =]

@uv|‘:’ v Libraries » Music » Copy To Folder... A |
Move To Folder... |

File Edit View Tools Help

Organize v ’] Play « Share w/ Cut 'ﬂ '@'
- | Copy
7 Favorites Music | Create Shorteut Iry locations
4 Recently Change = |
Public B Name et Contributir
£ ————— Rename
Bl Desktop 3 iTun
I Downloads Play| Open file location
= Recent Places Sam: Properties
Playlists V| =) mandrin
-4 Libraries
=| Documents
o Music
= Pictures sl 1! ¥
mandrill Dafe modified: 11/7/2008 1:31 PM
IE:' AU Format Sound Size: 361 KB
Renames the selected item.

Select Rename

Figure 9-11

3. The filename is now available for editing. Type a new
name, and then click anywhere outside the filename to
save the new name.

You can’t rename a file to have the same name as
another file located in the same folder. To give a file
the same name as another, cut it from its current
location, paste it into another folder, and then follow
the procedure in this task. Or, open the file and save
it to a new location with the same name, which cre-
ates a copy. Be careful, though: Two files with the
same name can cause confusion when you search for
files. If at all possible, use unique filenames.
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Create a Shortcut to a File or Folder

1. You can place a shortcut to a file or folder you used
recently on the desktop to make it quick and easy to
open it. Locate the file or folder by using Windows
Explorer. (Right-click Start and choose Open Windows
Explorer, and then browse to find the file you want to
make a shortcut to.)

2. In the resulting Windows Explorer window, right-click
the file or folder that you want and select Send Tow>
Desktop (Create Shortcut), as shown in Figure 9-12.

e (o[ ]

| % |li=| » Libraries » Pictures » - |+4‘ | Search Pictures 0|
o~
= . Preview
File Edit View Tools Help
Set as Desktop Background — .
Organize = I Preview - Share with Edit Ol &
4 Recently Change = . i Print
Public Pictures |i... Preview [y locations
Bl Desktop : a
b Downloads Sample Rotate Clockwise 2372009
B Recent Dlaces. |3 w Rotate Counterclockwise
Playlists Terri cat Open With
- Libraries VideaW| | hore wnh /4
- [ @ Snaglt
<| Documents R |
estore previous versions
o Music il m 000_019¢ L |
= Pictures Send To =] Bluetooth File Transfer Wizard
B videos h 000_0191 Copy To Folder... |, Compressed (zipped) Folder
= Move To Folder... B Desktop (create shartcut)
0000190 Date taken: 9/8/2008 2:12 | 45 FaxRecipient
IPG File Tags: Add atag Ut o | R
Copy ’
Create Shortcut
Delete
Rename

Open file location

Properties

Select Desktop (Create Shortcut)
Figure 9-12

3. A shortcut appears on the desktop.

Once you have placed a shortcut on the desktop, to
open the file in its originating application or to open
a folder in Windows Explorer, simply double-click
the desktop shortcut icon.
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Instead of creating a shortcut and dragging it to the
desktop, you can right-click a file or folder and
choose Sent To=>Desktop (Create Shortcut) to accom-
plish the same thing.

Delete a File or Folder

1. If you don't need a file or folder anymore, you can clear
up clutter on your computer by deleting it. Locate the file
or folder by using Windows Explorer. (Right-click Start
and choose Open Windows Explorer, and then browse to
locate the file you want to delete.)

2. In the resulting Windows Explorer window, right-click
the file or folder that you want to delete and then choose
Delete (see Figure 9-13).

it oS

@uv| <« Alaska Course Grades ... »
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Organize v B8 Open with Adobe Reader&
. Favorites
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P Adobe Acrobat Document
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Figure 9-13
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3. In the resulting dialog box (see Figure 9-14), click Yes to

delete the file.
Delete File ol paiaes (3
: —  Areyou sure you want to movwe this file to the Recycle Bin?
]
- 200803 EDL 550,801 Internet Safety (INC GRADE C...
N Type: Adobe Acrobat Document
Size: 9.5 KB
Date modified: 11/22/2008 8:31 AM
Adobe
| Yes | | Mo
.
Figure 9-14

really gone. It's removed to the Recycle Bin. Windows
periodically purges older files from this folder, but
you may still be able to retrieve recently deleted files
and folders from it. To try to restore a deleted file or
folder, double-click the Recycle Bin icon on the desk-
top. Right-click the file or folder and choose Restore.
Windows restores the file to wherever it was when
you deleted it.

@ When you delete a file or folder in Windows, it’s not

the menu that appears in Step 2 earlier, you can press

@ Instead of right-clicking and choosing Delete from
the Delete key on your keyboard.

Create a Compressed File or Folder

1. To shrink the size of a file or all the files in a folder, you
can compress them. This is often helpful when you're
sending an item as an attachment to an e-mail message.
Locate the files or folders that you want to compress by
using Windows Explorer. (Right-click Start and choose
Open Windows Explorer, and then browse to locate the
file[s] or folder][s].)
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2. In the resulting Windows Explorer window, you can do
the following (as shown in Figure 9-15):

e Select a series of files or folders: Click a file or
folder, press and hold Shift to select a series of
items listed consecutively in the folder, and click
the final item.

e Select nonconsecutive items: Press and hold the
Ctrl key and click the items.

limies (o |5 ES

@\;Jvl <« Sample Pictures » v|w,l | Search Sample Pictures o |
File Edit View Tools Help
Organize v ‘jj Preview Share with Slide show » 3:5 - _U '(':)'
4 Recently Change #
Public Pictures li... Arrange by Folder »  Includes
B Desktop =

| Butterfly
L Downloads 1] m

| Recent Places E -
] Field

Playlists

. . _ Flower
Libraries il

m

|'5] Documents -

o) Music | €] girlimage
| Pictures

B videos 7| m =

m 3 items selected Date taken: 2/11/2008 5:05 PM - 3/24/2008 5:05 PM

3 items selected

Figure 9-15

3. Right click the selected items. In the resulting shortcut
menu (see Figure 9-16), choose Send To=>Compressed
(Zipped) Folder. A new compressed folder appears below
the last selected file in the Windows Explorer list. The
folder icon is named after the last file you selected in the
series but can be renamed. Type a new name or click out-
side the item to accept the default name.

You may want to subsequently rename a compressed
folder with a name other than the one that Windows
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automatically assigns to it. See the task “Rename a
File or Folder,” earlier in this chapter, to find out just
how to do that.

— Select Compressed
(Zipped) Folder

Figure 9-16
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Add a File to Vour Favorites List

1. The Favorites list in the Start menu offers another quick
way to access frequently used items. Locate the files or

folders that you want to make a Favorite by using

Windows Explorer. (Right-click Start and choose Open
Windows Explorer.)

2. In the resulting Windows Explorer window, click a file or
folder and drag it to any of the Favorites folders in the
Navigation pane on the left (see Figure 9-17).

3. To see a list of your Favorites, choose Start>Favorites.

4. In the resulting submenu (see Figure 9-18), click an item

to open it.
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@ If the Favorites item doesn’t display on your Start

menu, right-click the Start menu and choose
Properties. On the Start Menu tab in the Taskbar and
Start Menu Properties dialog box, click the Customize
button. Make sure that Favorites Menu is selected,
and then click OK twice to save the setting.

Back Up Files to a Read/Writable CD or DUD

1.

4.

You've put a lot of work into your files, so don't forget
to back them up. If your computer is damaged or loses
data, you'll have a copy safely tucked away. Place a
blank writable CD-R/RW (read/writable) or DVD-R/RW
in your CD-RW or DVD-RW drive and then choose
Start>Documents.

. In the resulting Documents window (see Figure 9-19),

select all the files that you want to copy to disc.

. Right-click the files that you want and then choose Copy

To Folder.

In the Copy Items dialog box that appears, click on the
CD-R/RW or DVD-RW drive and click Copy.

5. Click the Close button to close the Document window.

If you want to back up the entire contents of a folder,
such as the Document folder, you can just click the
Documents folder itself in Step 2.

by using the Back Up Your Computer link in the

@ You can also back up to a network or another drive

Control Panel. Using Windows Backup, you can
make settings to regularly back up to a local disk or
CD-R/RW/DVD drive, or to a network. Backing up to
a CD/DVD is a little different from burning a disc in
that after you back up your files, only changes are
saved each subsequent time a backup is run.
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Figure 9-19
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Using the Desktop
Gadget Gallery
and Gadgets

w indows 7 has a feature called the Desktop
Gadget Gallery. The Gallery contains little
applications, called gadgets, that you can dis-
play as icons on the desktop. Using gadgets,
you can quickly access various handy features
to check the time, organize your schedule with
a calendar, feed online data direct to your
desktop, and more. Here are some of the
things you can do with the Windows gadgets
that we cover in this chapter:

w=  Work with images: Slide Show is a con-
tinuous slide show of the photos in your
Pictures folder.

w= Organize your time: The Calendar gadget
displayed on your desktop helps you keep
track of the days, weeks, and months. The
Clock gadget displays the time using an
old style wall clock and allows you to
make changes to your time zone.

w= Play with a puzzle: A neat little Picture
Puzzle allows you to play a game that'’s
so tiny, even your boss won't notice
you're not actually working.

| “*op’rer

Getready to...

w= Open the Gadget Gallery
and Add Gadgets to the

Desktop .....covvevveieieinne. 160
w= Check the Time................. 162
w= Display a Continuous

Slide Show.........cccoveie, 163
w= Use the Windows

Calendar .......ccccooeinnnn. 165
w= Play with a Puzzle............. 166
w= Convert Currency.............. 167
w= Use the Feed Headlines

Gadget....cooveiiieiiins 168
= Monitor Your CPU............. 170
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w= Work with online data: The Feed Headlines gadget
allows you to grab data from online RSS feeds (a for-
mat used for syndication of news and other content),
such as the latest news or other useful information.
Stocks and Currency Conversion gadgets provide up-
to-the-minute data on stocks and currency values.

w= Keep an eye on your system performance: The CPU
Meter provides up-to-date information about your
computer processor speed and available memory.

Open the Gadget Gallery and
Add Gadgets to the Desktop

1. Right-click the desktop and choose Gadgets to open the
Gadget Gallery window, shown in Figure 10-1.

2. Click on any gadget and drag it to the desktop (see
Figure 10-2).

Bl bl (= | 5 =
Pagel ofl [ searen gadgets g

P

Calendar Clock CPU Meter Currency

Feed Headlines Media Center Picture Puzzle Power2Go

28

Slide Show Stocks Weather

v Show details &# Get more gadgets online

Figure 10-1
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3
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Dragging a gadget to the desktop
Figure 10-2

3. Click the Close button to close the Gadget Gallery.

time. Click the Get More Gadgets Online link in the
Gadget Gallery to scope out the latest gadgets and
then download them.

@ Gadgets are hot, and people are creating more all the

mouse over it and then click the Close button
(marked with an X) that appears next to it. The gad-
get closes. Just follow the steps above to display it on
the desktop again at any time.

@ If you want to send a gadget away, just place your
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Check the Time

1. To display a clock on your desktop, right-click the desk-
top and choose Gadgets.

2. In the Gadget Gallery that appears, click on the clock and
drag it to the desktop.

3. To make changes to the clock style or to change the time
zone, place your mouse over the clock and click the set-
tings button (it sports a little wrench symbol).

4. In the resulting Clock dialog box (see Figure 10-3), click
the Next or Previous button to move through the various
available clock styles.

aore | l +— The Previous and Next buttons

Time zone: 5 ‘
Current computer time - ‘

| Show the second hand

o o]
Figure 10-3

5. If you wish, you can enter a name for the clock in the
Clock Name field. To change the time zone, click the
arrow in the Time Zone field and choose your local time.

6. Click OK to save the clock settings.
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You can display a second hand on your clock by
clicking the Show the Second Hand checkbox in the
Clock Settings dialog box.

local time and the time back home, you can display
more than one clock by simply dragging the clock gad-
get to the desktop from the Gadget Gallery again. Make
changes to the time zone settings and even use two
different styles of clock to tell them apart at a glance.

@ If you are on the road and want to keep track of the

Display a Continuous Slide Show

1. You can display a continuous slide show of the pictures
in your Pictures folder to keep you entertained as you
work or play on your computer. Add the Slide Show gad-
get to the desktop (see the earlier task “Open the Gadget
Gallery and Add Gadgets to the Desktop”).

2. Move your mouse over the Slide Show gadget and use
the tools along the bottom of the slide show (see Figure
10-4) to do the following:

¢ Click the View button to display the current slide
in Windows Photo Viewer.

e Click Pause to stop the slide show at the current
slide.

e Click Previous to go to the previous slide.
e Click Next to go to the next slide.

3. The Slide Show gadget uses the Sample Pictures folder
contents by default. Click the Settings button. In the
resulting Slide Show dialog box (see Figure 10-5), change
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the picture folders to include in the slide show, modify
the number of seconds to display each slide, or add a
transition effect to use between slides.

| J { |
Pause Next

Previous View button
Figure 10-4

Slide Show

| Include subfolders

Show each picture:

15 seconds -

Transition between pictures:

Mone -

[T] Shuffle pictures

| oK | I Cancel

Figure 10-5
4. Click OK to close the dialog box.

When you click the View button to display the cur-
rent slide in Windows Photo Viewer, you can use
tools to modify the image, print it, e-mail it, or even
create a movie. See Chapter 13 for more about using
Windows Photo Viewer.
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Use the Windows Calendar

1. The Calendar gadget isn't an organizer, it just helps you
remember dates with a Calendar display you can place
on your desktop. Add the Calendar gadget (see Figure
10-6) to the desktop. (See the earlier task “Open the
Gadget Gallery and Add Gadgets to the Desktop.”)

March 2009

igure 10-6

2. Move your mouse over the calendar and click the Size
tool to move between the larger size, which displays both
the monthly and daily sections (as shown in Figure
10-7), and the smaller size, which displays only the daily
display by default.

4 Mar 05 » .
sim|Tw/T Fls The SIZG tOOl
12 34B 6 7

8 91011 12 13 14

15 .16 17 18°19'20 21
2223 24 25°26 77 28

March 2009

Figure 10-7

3. With the larger calendar displayed, click the Next or
Previous arrow to move to another month; double-click a
date to display it in the lower part of the calendar; and
click the red tab in the lower-left corner to return to
today’s date.
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to have it display the monthly calendar rather than
the daily calendar, just double-click the small display
and it toggles between month and day.

E s If you prefer to use the smaller size calendar but want

you can jump to the daily display for a specific date

@ With the monthly display shown in the smaller size,
by double-clicking that date in the monthly view.

Play with a Puzzle

1. Add the Picture Puzzle gadget to the desktop. (See the
earlier task “Open the Gadget Gallery and Add Gadgets
to the Desktop.”)

2. Click either of the tools along the top of the puzzle (see
Figure 10-8) to do the following:

e Pause timer stops the automatic count of seconds
of play.

e Show Picture displays the completed picture;
release it and you go back to where you were in
the game.

¢ Solve ends the game and displays the completed
picture.

Pause Show
timer  Picture
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3. To play the game, click any piece adjacent to a blank
square. It moves into the blank space. Keep clicking and
moving pieces until you get the picture pieces arranged to
form a picture.

4. Click the Settings button to the right of the puzzle to
display its settings dialog box (see Figure 10-9).

Picture Puzzle

‘

&) 1 0of11

Figure 10-9

5. Click the Previous or Next button to scroll through avail-
able pictures for the puzzle.

6. When you find the picture you want, click OK to close
the dialog box.

Convert Currency

1. Need to change dollars to euros? If you have an Internet
connection, you can get up-to-the-minute currency val-
ues. Start by adding the Currency Conversion gadget to
the desktop. (See the earlier task “Open the Gadget
Gallery and Add Gadgets to the Desktop.”)

2. Connect to the Internet to access the latest currency rates
(as shown in Figure 10-10), and do any of the following.

e Enter the number of dollars; the number of equiv-
alent euros is displayed.
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| DATA PROVIDERS

Figure 10-10

e Click one of the currency names and a list of avail-
able currencies appears (see Figure 10-11). Click
another currency to change which currencies to
convert from and to.

| SWISS FRANC -
TAWVAN DOLLAR
TANZANIAN SHILLING
THAI BAHT
TUNISIAN DINAR |

5 e e e e e
VIE ONG

ZIMBABWEAN DOLLAR
DATA PROVIDERS

Figure 10-11

To view the online source for the latest currency

@ conversion rates, with the larger size Currency gadget
displayed, click the Data Providers link. The Money-
Central MSN page opens. Click the Banking tab and
then click the Currency Exchange Rates link to view
current rates.

If you want to, you can display several Currency
Conversion gadgets to compare multiple currencies

at the same time.

Use the Feed Headlines Gadget

1. If you like to read the latest headlines (this requires an
Internet connection), add a news feed to your desktop.
First, add the Feed Headlines gadget to the desktop. (See
the earlier task “Open the Gadget Gallery and Add
Gadgets to the Desktop.”)
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2. Click the Feed Viewer window to connect to the default
RSS feed (see Figure 10-12).

3. At the Web site that appears, you can view blog entries,
submit an entry, or subscribe to additional feeds.

Bitter cold, outages after late winter st...

Madoff wants 10 kee...

MSNBC News

Recession changing ...

Read online...

5 Mare than 80,000 homes and | Bitter cold, outage...
businesses remained without

power Tuesday, most in the Teens accused of a...
Southeast, after a late winter
storm durmped snow across
that region and the East A 17-20 w

—

4. Click the Settings button. In the resulting Feed Headlines
dialog box (see Figure 10-13), select the default feed.

Figure 10-12

Feed Headlines

Display this feed: -
Allfeeds - ——— Select the default feed

Mumber of recent headlines to show:
100 headlines -

What are feeds?

| OK | | Cancel

Figure 10-13
5. Click OK to close the dialog box.

Set of Feeds arrows that appear at the bottom of the
View Feeder gadget when you move your mouse over
it to scroll through available feeds.

@ Use the Show Next Set of Feeds and Show Previous

169



Part II: Having Fun and Getting Things Done with Software

Monitor Vour CPU

1. Is your computer acting sluggish? Check its performance
using the CPU Meter. Add the CPU Meter gadget (see
Figure 10-14) to the desktop. (See the earlier task “Open
the Gadget Gallery and Add Gadgets to the Desktop.”)

170

Figure 10-14

2. Use the readouts to monitor the following:

®

e CPU (on the left) monitors how hard your CPU is
working to process various programs and processes
running on your computer.

e Memory (on the right) monitors the percent of
your computer memory that is being used.

That's about all there is to CPU Meter! You can click
the Size button to toggle between a larger and
smaller version, but you can’t make any settings for
it. It's just a little reminder that helps you keep track
of your computer’s performance. If memory is almost
at 100 percent, consider freeing some space. If the
CPU is at a higher percentage, odds are you've got
lots of programs running which could be slowing
down your computer’s performance; consider shut-
ting some down!

If you want more details about your computer mem-
ory, use the Start menu to display the Control Panel
and choose System and Security. The System links
allow you to view the processor speed and the
amount of RAM available.



Creating
Documents with

Works Word

Processor

The two kinds of software programs that
people use most often are word processors
(for working with words) and spreadsheets (for
working with numbers). In this chapter, you
get to see the basic tools of the word processor
built into Microsoft Works.

Works or a trial version of the product comes
preinstalled on some computers. If not, the
program is relatively inexpensive (anywhere
from $30 to $40 depending on where you
shop), so it's a good entry-level program you
may want to have on your computer.

With a word processor, you can create anything
from simple letters to posters or brochures.
You can use both text and graphics to add style
to your documents. You can even use a word
processor to print envelopes or labels so you
can send those holiday newsletters or bro-
chures for the local food co-op on their way.

In this chapter, you explore the following:

| “*ap’rer

1l

Getready to...

w= Open a New Document
and Enter and Edit Text ..... 172

= Save a Document.............. 173

w= Open an Existing

Document..........ccoveenneee. 174
w= Cut, Copy, and Paste

TEXE v 175
web Format Text .......ccceeevnneen. 176
w= Insert a Table .................. 179
w= Add Graphics................... 181
= Resize Objects.................. 182
w= Check Spelling ................. 184
w= Change Page Setup .......... 185
w= Print a Document .............. 187
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w= Enter text and format it by applying different fonts,
colors, and effects.

w= nsert tables for organizing information.
w= [nsert graphics and arrange them on the page.

w= Prepare your document for printing by using spelling-
and grammar-checking tools, modifying the page
setup, and finally, printing it!

Open a New Document and Enter and Edit Text

1. Your first step in creating any document is to open your
word processor and enter and edit some text. Choose
Start=>All Programs=>Microsoft Works and then select the
Microsoft Works Word Processor. The program opens,
and a blank document is displayed (see Figure 11-1).

2. Begin typing your text. Works (like all word-processing
programs) wraps the text, which means it automatically
moves to the next line within a paragraph as you type.
Press Enter twice on your keyboard only when you want
to start a new paragraph.

3. To edit text you have entered, perform any of the follow-
ing actions:

¢ Click anywhere within the text and press
Backspace on the keyboard to delete text to the left
of the mouse cursor.

¢ Click anywhere within the text and press the Delete
key to delete text to the right of the mouse cursor.

¢ Click and drag your cursor over text to select it and
press Delete or Backspace to delete the selected text.
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e Click anywhere within the text and type additional
text.

Begin typing in a blank document

/. Untitled Doc§ment - Microsoft Works Word Processor = EEEE
File Edit Viely Insert Format Tools Table Help [LveSarch ——— |[A]
DREE|ER VA | em @Y @ o - 7|
Tirnes Mews Roman - 10 e | v| B I U ‘%E =E

Y - [ o 3 4 5 & 7| TaskPane

“ Recent Documents

=2 Browse Documents...
#7 Browse Templates

[} New Document

Tip of the Day

Word Processor Shortcuts
When you use the Word
Pracessor, mause and keyboard
shorteuts can help you work more
quickly.

Learn More...

T

Page 10f1

Figure 11-1

Save a Document
1. To save a document for the first time, choose Filec>Save.
2. In the resulting Save dialog box (see Figure 11-2), click
the arrow on the right of the Save In field and click a dif-

ferent folder.

3. Type a name for the document in the File Name text box.
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Type a name for your document

% Save As ==l
Save in; ’r Docunjents - (-; /a0
-~
Mame Date podified Type Size Tags
column ItsDeductible200&
electronics laptops
electronics zip file My Web Sites
Elect5TG3e MNancy
invaices nano web site
Fi m b
File name: | I EFIEEIRTERER] [ sae |
Save az type: |Works Document [* wpsz) v| | Cancel |
| Template... |

Figure 11-2
4. Click Save.

If you want to save the document in another format
(for example, you can save a Works document as
plain text so any word processor can open it), click
the arrow in the Save As Type field in the Save As dia-
log box and choose a different format before you
click the Save button.

Open an Existing Document

1. After you create a file and save it, you can open it to add
to or edit the contents, or you can print it. To open a file
after you save it, with the Works word processor open,
choose Filer>Open.

2. In the Open dialog box that appears (see Figure 11-3),
locate the file on your computer or storage disc by click-
ing the arrow in the Look In field and clicking the disc or
folder where your file is located.
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% Open [
Lok ir: Electronics - (; T e -
Marme Date modified Type Size Tags
|# Figure_corrections
File name: Figure_comections | Open |
Files of type: | Warks Documents [Fwps] v| | Cancel |
Click Open
.
Figure 11-3

3. When you locate the file, click it and then click the Open
button. The file opens, ready for you to edit or print it.

Cut, Copy, and Paste Text

1. You can cut and paste or copy and paste selected text to
move it to or duplicate it in another location in your
document. With a document open in Works word pro-
cessor, click and drag over text to select it; the text is
highlighted (see Figure 11-4).

2. Perform either of the following two steps, depending on
whether you want to cut the text (remove it) or copy it
(leave the existing text and make a copy of it):

e Click the Cut button on the toolbar to cut the text.

¢ Click the Copy button on the toolbar to make a
copy of the text.

3. Windows places the cut or copied text on its Clipboard, a
temporary holding place for cut or copied text or objects.
To paste the cut or copied text to another location within
the document, click where you want the text to appear
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and click the Paste button on the toolbar. The text
appears in the new location.

After you place text or an object on the Windows

Clipboard, you can paste it anywhere. For example,

you can open another document and paste it there or

paste it in an e-mail message. However, it won't stay

on the Clipboard forever. If you cut or copy other text

or objects, your earlier item will soon be removed
from the Clipboard, which holds only a few items

at a time.

Click Cut
Click Copy

[Ei Figure comections.wps - Microsofi \ for s Word Processor

File Edit “iew Insert Format | Togls Table Help

DEEE| @R Y40 o= @@ @Y @ o - 9|0
TmeshewRoman  ~ 12 ~ M~ | B Z U|[El===|i= EE( BT
[ IR O 3o 5 T

Figure #

Error

Replace with

45

Resistor symbol labeled as
lamp

Lamyp symbol, see figure
2.27

4.2

Resister symbol in upper
right of figure

Latg symbol

45

Resistor symbol in upper
right of figure

Lamp symbol

49

Lamyp symbol

4.10

Eesistor spmbol labeled as
lamp

Lamp symbol

4.11

Resistor spmbol labeled as

Lamp symbol

Figure 11-4

Format Text

Select text

1. To format text means to change its size, apply effects such
as bold or italic to it, or change the font (that is, a family
of typeface with a certain look and feel to it). You start by
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selecting the text you want to format. Click and drag your
mouse over the text you want to format to select it.

(Figure 11-5 shows how the selected text is highlighted
in black.)

Click and drag to select text

+ Internet_Safety for the Classroom - Overview[1].wps - Microsoft Works Word Processor (= [
File Edit View Insert Fofmat Tools Table Help :
D& &SRV H %80 | am @R E W @ e -7 @

Arial - 10 m~-|B U IRES R =l
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of locations — home, school, friends, Internet cafés and wirelessly as they roam.

Wyhile much of the news focuses on the threats from online sexual predators, the threats from
bullying, identity theft, scams, and simply unwise behaviars are even more prevalent. Teaching
youth how to understand the ripple effects of online actions and be informed and safe in their
onling interactions should become a critical element in their overall education. This information
needs to be taught consistently — by government public awareness messages, in homes, within
online products themselves, and in schools where society has the greatest apportunity to ensure
that all children will be able to learn the life skills and information they need to be successful
contributing members of society.

The Series
Schools have little funding for mandated initiatives such as this. Teachers themselves may know

little about the technologies and social issues involved, and districts lack the expertise to develop
comprehensive materials covering the topic.

‘While there is some existing Internet safety material targeting schools?, but there is a notable lack
of relevant teaching materials that:

Schools want pre-designed materials® that are easy and inexpensive to implement, and that come
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Figure 11-5

2. Choose Format>Font. In the resulting Font dialog box

(see Figure 11-6), make any of the following formatting
choices:

e Select a font from the list of available fonts. Use the
scroll bar in this list to see more choices and click
the one you want to select it. The font is previewed
in the large box near the bottom of the dialog box.
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Select a font style such as Bold or Italic from the
Font Style list. Font styles are useful for emphasis.

Choose a different text size by selecting a point
size setting from the Size list. The greater the point
size, the larger the text.

If you want to underline the selected text, choose a
style from the Underline drop-down list.

Click the arrow on the Color drop-down list and
select a different color for the text.

Click any of the Effects check boxes to apply effects
to the text.

Click the arrow to see options

Font (2]
Fonk: Font skyle: Size
Eatangchel Reqular 10
BakerSignet BT - | T Wi
Bankizothic Md BT Ikalic 11
Batan Biold 12
T ~ | | o 1o ‘14 -
Underline: Color:
l(none) vJ M &utomatic
Effects
[ strikethrough [T]shadow [T]Engrave
[ ] superscript [T outline []5mall caps
[T subscript []Emboss [Tl caps
Sample

This is a True Type Font, This Font will be used on both printer and screen,

BataneChe

l Ok ] | Cancel

Figure 11-6
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3. Click OK to apply the formatting options you have
selected.

individual formatting settings to selected text. For
example, you can click the Bold button or choose a
different font from the Font drop-down list. If you
don’t see the Formatting toolbar, choose Viewr>
Toolbars>Formatting.

@ You can also use the Formatting toolbar to apply

tles in a single document, as the formatting might
become distracting or make the document difficult to
read. A good guideline is to use only two fonts on a
single page and use effects such as bold or shadowed
text for emphasis only.

@ Try not to use too many formatting bells and whis-

Insert a Table

1. A table is a handy way to organize information with
headings, rows, and columns. You can easily insert tables
in word processors and then fill in the data you want to
organize. With a document opened, choose Tabler>
Insert Table.

2. In the Insert Table dialog box that appears (see Figure
11-7), click a predesigned format for the table in the Select
a Format list box. A sample of the format is displayed.

3. Use the arrows on the other four fields to set the number
of rows and columns in the table and to specify row
height and column width. If you don’t change the height
and width settings, rows and columns will adjust auto-
matically to the text you enter in each table cell.

4. Click OK to insert the table. In the blank table that appears
(see Figure 11-8), the cursor is ready and waiting for you
in the top-left cell, and if that's where you want your first
entry, you can simply begin typing your table contents.
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Select a table style
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Figure 11-7

5. Press Tab to move to the next cell in the table. If you

reach the last cell in the last row and press Tab, a new

row is inserted. Alternatively, you can click in any cell

where you want to add text.

You can

format text you enter in a table just as you

do any other text in your document. Just click and

drag to select the cells you want to format and then
follow the steps in the preceding task, “Format Text.”

To insert additional columns after you've created
your table, click in the column next to which you
want to insert a column and choose Tablem>Insert
Column. Then choose either the Before or After
Current Column option, depending on whether you
want the new column to appear to the left or right of
the current column.
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Type text in the table cells
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little about the technologies and social issues involved, and districts lack the expertise to develop
comprehensive materials covering the topic.

While there is some existing Internet safety material targeting schools?, but there is a notable lack
of relevant teaching materials that:
Don't hype fear; but speak frankly to online safety risks and what to do about them

Figure 11-8

Add Graphics

1. If you have files that contain a drawing or photo, you can
insert them in your document to spruce it up or help you
make a point. With a document open, choose Insertr>
Pictures=>From File.

2. In the resulting Insert Picture dialog box (see Figure
11-9), click the file in your Pictures folder to select it. If
the picture file is in a subfolder within the Pictures
folder, double-click the folder to display those files. If
you want to use a picture file located elsewhere, click the
arrow in the Look In field and choose another location.

3. Click the Insert button. The picture is inserted in your
document.

181



Part II: Having Fun and Getting Things Done with Software

Click the picture
|

_# Insert Picture (B
Lookin: [ Pictures - & T e E-
-
Mame Date taken Tags Size -
) | =
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Files of type: ‘AIIsupportedimagefileformats v] I Cancel | |¥| Enable preview

Figure 11-9

You can also insert built-in drawings and photos

@ called Clip Art by choosing InsertroPicturer>Clip Art.
In the dialog box that appears, select a category and
subcategory to display picture previews. Then click a
picture and click the Insert button to place it in your
document.

Resize Objects

1. After you insert a picture or piece of art, you may want to
resize it. Click the object (such as a photo or Clip Art) to
select it. Small boxes called handles appear around its
edges. See Figure 11-10.

2. Do any of the following to resize the object:

e Click the center handles on the left or right side of
the object and drag outward to make the object
wider, or drag inward to make the object narrower.
This distorts the original proportions.

e Click the center handles on the top or bottom of
the object and drag up or down to make the object
higher or shorter. This action also distorts the
proportions.
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able to apply their knowledge against future risks

Click a handle and drag

Figure 11-10

e Click a handle in any corner and drag outward to
enlarge the object and keep it in proportion, or
drag inward to shrink the object, again keeping it
in proportion to its original size.

You can use another method to resize objects. Select
the object and choose Format=>Object to display the
Format Object dialog box. Click the Size tab and
enter new Height and Width settings. Click OK to
accept the new settings. Depending on the dimen-

sions you enter, the resulting object might be out of
proportion.
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Check Spelling

184

1. 1If you never won spelling bees in school, you'll be glad

to hear that Works has a tool that helps you check and
correct your spelling. Although the tool won't catch every
error (if you typed sore instead of soar, the tool won't
catch it), it can catch many spelling mistakes. With the
document you want to check open, choose Tools=
Spelling and Grammar. If you didnt make any discern-
able errors, a message appears that the spelling check is
complete, but if you did, a dialog box appears.

. In the resulting Spelling and Grammar dialog box (see

Figure 11-11), take any of the following actions:

e Click Ignore Once to ignore the current instance of
the word not found in the dictionary.

e Click Ignore All to ignore all instances of this word.

e Click Add to add the word to the dictionary so it is

no longer questioned in a Spelling and Grammar
check.

e (Click a suggested spelling and then click Change
to change just this instance of the word.

e Click a suggested spelling and click Change All to
change all instances of the word.

3. The Spell Checker moves to the next suspect word, if any,

and you can use any of the options in the preceding list
to fix mistakes. This continues until the Spell Checker
tells you the Spell Check is complete.

4. Click Close to close the dialog box.
@ If you would also like to have Works check your gram-

mar, you can select the Check Grammar checkbox in
the Spelling and Grammar dialog box. When you next
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run the Spelling and Grammar check, Works displays
sentences with possible grammatical problems and
suggestions for how to fix them.

Click to select an alternate spelling

Spelling and Gramnjar: English (United States) ==
Mot in dictionaty:
blogs [ Ignote Once l
Ignore All |
Add |
_Suggestions: )
bogs = Change |
blocs —_————
bloks | Change Al
blobs
blows i

Spelling options
[#] Ignare words in UPPER.CASE options... |
[¥] 1grore words with numbers

[ 1griore Internet and file addresses
'_ Check grammar

Close |

Figure 11-11

It's a good idea to use the Add feature to put unusual

@ words or acronyms you use often in the dictionary. For
example, you might add unrecognized names of peo-
ple or companies, scientific terms, or acronyms such as
IBM or MTV. By adding such words to the dictionary,
you save yourself the time it takes to tell Works over
and over again that those words are correct.

Change Page Setup

1. Word processors use default page setup, that is, settings
such as margins and orientation of your contents on the
document page. If you want to change those settings, you
can do that when you first create the document, or you
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may wait until you're ready to print the document.
With the document whose setup you want to change
displayed, choose File>Page Setup.

2. In the Page Setup dialog box that appears (see Figure
11-12), click the Margins tab. Use the up and down
arrows (called spinner arrows) to increase or decrease mar-
gin settings, or type a new measurement in any of the
Margins boxes.

Click arrows to change margin settings

Page Setup (==
| Margins Source, Sizs &Oriep;atjpnf Ofher Op;ions. Preview

Margins

Top:

m B
Bottom: T
-
1.25"
0.5"
0.47"

Left: lﬁ E
Right: 5 =

From Edge

Header: l =
Footer: %

=

| Reset | 8] || Cancel

Figure 11-12

3. Click the Source, Size & Orientation tab (see Figure
11-13). Select a radio button for either Portrait orienta-
tion (with the longer edges of the paper on the sides) or
Landscape (with the shorter edges of the paper on the
sides).

4. Also on the Source, Size & Orientation tab, you can use
the Paper settings to specify the size of paper you will
print to, and, if you have multiple paper trays, to select
the source for the paper.

5. Click OK to save the new settings.
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Choose an orientation

Page Setup

| Mergins | - Soree, Jae & Orizntation | ather options | | Prevew

Crientation
@ Portrait
") Landscape

Paper

Source: | Automatically Select x> |

Size: |Latter B |

Width: 5.5" 5
Height: 1" 2

‘ Reset | (8! ‘ | Cancel

Figure 11-13

=

page number or the name of the document that you
want to appear on every page on either the top or
bottom), you should check some settings in this
dialog box. On the Margins tab, you can specify
how far from the edge of the paper the header or
footer should appear. On the Other Options tab,
you can control what page number you start with
and whether the header or footer should appear on
the first page of the document. (To insert headers or
footers in your document, use the Header and
Footer command on the View menu.)

@ If you're inserting a header or footer (for example, a

Print a Document

All Windows software uses a similar procedure to print files, and Works
is no different. You simply choose Filew>Print (or in Office 2007 and
later programs, click the Office button and choose Print) and use the
settings shown in Figure 11-14 to determine these variables:

¢ How many copies of the document you want to
print: Be sure there’s enough paper in your printer
to handle them all!

187



Part II: Having Fun and Getting Things Done with Software
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Whether to collate the copies: Collating assembles
sets of documents in the correct page order rather
than printing, say, five page 1s, then five page 2s,
and so on. This can save you effort assembling
your documents yourself.

What pages to print: The Print dialog box you see
in Windows software allows you to print the cur-
rent page, text you select before giving the Print
command, the entire document, or a specified
page or range of pages.

Which printer to print to and preferences for that
printer: You can determine preferences such as the
print quality and whether to print in color or
grayscale.

Always remember before you print to proofread your
document and run a Spell Check to make sure it’s
letter perfect.

Print 2]

Printer

Iame: Liﬁ ILI Propetties

Stakus: Prlntlng:l2 documents. waiting Fird Printer...

Type: HP Deskjet F4100 seties

Where: L5B001 [ Prink ko file

Comment: [™ Manual duplex

Page range Copies

i jes: =1
T all Mumber of copies: 1 =
" Current page (" Selection

" Pages: |

¥ B v Collate
Enter page numbers andjor page ranges IF 1

separated by commas. For example, 1,3,5-12

Print what: |D0cument showing markup ﬂ Zoam

Prinit: |P.II pages in range ﬂ RAgEs pethest Lpage jv
Scale to paper size:  |Na Scaling ﬂ
CQptions. .. [o]'4 I Close |
Figure 11-14



Working with
Numbers and
Finances

spreadsheet program allows you to auto-

mate both simple and complex calcula-
tions. You enter numbers and then perform
actions on them such as calculating an average
or generating a sum for a range of numbers.
You can format the data in a spreadsheet and
also generate charts based on the numbers you
enter.

Microsoft Works includes a spreadsheet pro-
gram that provides some pretty sophisticated
tools for working with numbers and charts.
You can also use this and other spreadsheet
programs to create tables of data, such as your
home inventory or investments.

In addition to working with a spreadsheet pro-
gram, there are several ways you can get infor-
mation about your investments and perform
financial transactions online. Together, a
spreadsheet program and the financial tools
you can use on the Internet can make manag-
ing your financial life much easier.
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Explore the Structure of a Spreadsheet

190

Spreadsheet software, such as Microsoft Works Spreadsheet and
Microsoft Excel, uses a grid-like structure for entering data. The indi-
vidual cells of the grid are formed by the intersection of a row with a
column, so a cell is identified by a column letter followed by a row
number. For example, B3 identifies the cell located at the intersection
of the second column over and third row down.

Here are some additional facts you should know about spreadsheets:

You can enter text or numbers in spreadsheets.

When you click in a cell, the Formula bar becomes
active. You can enter contents and edit those con-
tents in the Formula bar (see Figure 12-1).

Use the two scroll bars, the one to the right and
the one at the bottom, to move vertically or hori-
zontally through a large spreadsheet.

You can perform calculations on numbers that
you've entered in a spreadsheet, such as adding
numbers or calculating an average of several
numbers.

You can format the contents of cells or use an
AutoFormat feature to apply predesigned styles to
selected cells. Note that in some predesigned for-
mats, the grid lines are neither displayed nor
printed.

After you've entered some data into your spread-
sheet, you can easily generate a chart representing
that data graphically.



Enter data in the Formula bar
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Figure 12-1

Open Works Spreadsheet and Enter Text

1. To start a new spreadsheet and begin filling it with infor-
mation, first choose Start=>All Programs=>Microsoft
Workst>Microsoft Works Spreadsheet.

2. In the blank spreadsheet that appears, click in a cell to
make it active (see Figure 12-2).

3. Begin typing; notice that what you type appears in both
the cell and the Formula bar.

[l Unsaved Spreadsheet - Microspft Works Spreadsheet =a{EonF==|
File Edit View Insert Format] Tools Help | e |
Avisl -0 - D@ SRl BB ru/===(zsB0 =3O

D4 00— |
A | B | s | O = | o | £} | H g4 B
1
2 Vacation Budget
2 Travel Hotel Food Gifts
4 2830 780 I 500 _l
i
53
7
&}
Z
1 |
1
12
13
14 |
15
16 |
|
18 |
19
20
e
22
Zoom|00% =+ 4 }

Press ALT ko choose commands, or F2 to edit,

Scroll bar
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Click a cell to make it active

il Unsaved Spreadsheet - Micros¢ft Works Spreadsheet [=ll= =]
File Edit View Insert Format| Tools Help |_= e Search |
Auial o v|DeE SRl sn(elru/=s== s B =T @

c3 | |
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1
2
3 L.
4
o
B
7
g
)
o |
11|

12
13
14

Figure 12-2

4. Press Tab to complete the entry and move to the next
cell. Note that you can also click the Enter button (see
Figure 12-3), which looks like a check mark, to complete
your entry and keep the current cell active.

The Enter button

[l Unsaved Spreadsheft - Microsoft Works Spreadsheet (===
File Edit View Insqrt Format Tools Help |_= e Search |
iial b DR SRl sfme((Blzru/l=s==zs@n =@
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=
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12
13
14

Figure 12-3
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@ You can open a new, blank spreadsheet at any time

by choosing Filem>New. To open an existing, saved
file, choose Filec>Open to locate and open it.

anything. See Chapter 11 for information about

@ Remember to save your work often to avoid losing

saving.

Format Numbers

1.

5.

You can format text in the cells of a spreadsheet by
applying effects or changing the text font or color, just as
you do for text in a word processor (see Chapter 11).
However, formatting numbers in a spreadsheet is a bit
different. In this procedure, you format the number to fit
a category such as currency or to include a certain num-
ber of decimal points. To begin formatting numbers, first
click the cell containing the numbers you want to format.
To select multiple cells, click a cell and drag up, down,
right, or left to select a range of cells.

. Choose Formate>Number.

In the Format Cells dialog box that appears with the
Number tab displayed (see Figure 12-4), click an option
in the Select Format Type list, such as Currency or Percent.

Click the up or down arrow in the Set Decimal Places
field to specify how many decimal places the number
should have; for example, 22.10 (two decimals), 22.1
(one decimal), or 22 (no decimals). Your settings appear
in the Preview box.

Click OK to apply your formatting selections and close
the dialog box.

matting numbers in lists or budgets, but they aren’t

@ Currency and General are common options for for-

the only ones. You can even format numbers to
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display as dates, times, or fractions. If you want any
zero to appear as False (in other words no value) and
any number (that is any value at all) to appear as
True, choose the True/False number type.

Click a number format

Figure 12-4

Apply AutoFormats to Cells

1. You can also format sets of cells by using the
AutoFormats, which are predesigned sets of formatting
choices such as cell shading or borders. Click and drag to
select a range of cells.

2. Choose FormatoAutoFormat.
3. In the AutoFormat dialog box that appears (see Figure

12-5), select a format from the list provided. You see a
preview of the design.
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Click a format

AutoFormat
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Figure 12-5

4. 1f you like, you can modify the settings for including col-
umn and row headings and totals by selecting or dese-
lecting any of the four check boxes on the right of the
dialog box.

5. Click OK to apply the selected formatting to the cell
range.

Perform Simple Calculations

1. A spreadsheet program is way more than just a place to list
numbers and text. After you've entered some numbers in
your spreadsheet, you can use powerful spreadsheet tools
to perform simple or complex calculations, from averaging
a set of numbers to complex statistical analysis. Click in a
cell where you would like calculation results to appear.
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2. Choose Tools>Easy Calc or press the Easy Calc button
on the toolbar.

3. In the Easy Calc dialog box that appears (see Figure
12-6), click a function in the Common Functions list box
and then click Next.

Click a function

Easy Calc

Click the Function wod want to use in your Formula.

Carmman functions

fAdd Multiplies bwo or mare numbers using &
subitrack farmula,
Mulkiply i
Divide
Average
Cther Functions
CQkher | Displays a complete list of Functions

Cancel < Back Mexk =

Figure 12-6

4. In the following dialog box (see Figure 12-7), enter a
range of cells, such as A1:C4, in the Range field. Or click
the button on the right of the Range field; the dialog box
is then hidden, allowing you to click and drag on your
spreadsheet to select the cells you want to calculate. After
you make the selection, the dialog box appears again.

5. Click Next. In the Final Result dialog box, you can enter a
different cell location, such as G5, in the Result At text
box, and the result will be saved in the cell you indicate.
Click Finish to complete the calculation. The result of the
calculation now appears in the designated cell.
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Figure 12-7

To quickly add numbers, you can simply click in the

@ cell where you want to place the results and then
click the AutoSum button on the toolbar (which
looks kind of like a capital M turned sideways).
Spreadsheet suggests cells you might want to include
in the calculation, but you can click and drag to
select more or different cells. Click or press Enter to
complete the sum.

Complete a Series with Fill

1. Life consists of patterns, and spreadsheets make entering
items with patterns quick and easy. For example, if you
are entering a series of odd numbers (1, 3, 5, and so on),
you can use tools to complete the series automatically.
Enter some data in sequential cells that constitutes the
beginning of a series, such as 1, 2, 3, or January,
February, March (see Figure 12-8).
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Begin a data series Handle
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Figure 12-8

2. Click and drag over the data; a small handle appears at
the end of the series (in the bottom-right corner for items
in a column or at the far right for items in a row).

3. Click and drag the handle to add items to your series (see
Figure 12-9). For a series in a column, drag down, but
for a series in a row, drag to the right. For example, if you
entered January, February, and March, you might drag
over nine blank cells to add the rest of the months of the
year. Works Spreadsheet completes the series.

Spreadsheet can detect patterns as well. For example,
if you enter 11, 22, and 33 and fill out the series, you
get 44, 55, 66, and so on. However, if selected data
has no discernable pattern, when you drag to fill, the
data will simply be repeated again and again.

@ Items in a series don’t have to be sequential. Works
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Drag the handle to fill out the series
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Figure 12-9

Insert a Chart

1. If you want to see your data represented visually, the
Works spreadsheet can create attractive charts from your
data. To start, you have to first enter the data you want
your chart to be based on.

2. Click and drag over the data to select it and then click the
New Chart button on the toolbar.

3. In the resulting New Chart dialog box (see Figure 12-10),
click a Chart Type image to select it.

4. Enter a title for the chart in the Chart Title text box. Click
the Show Border or Show Gridlines checkbox to apply
those effects.

5. Click OK to display the chart (see Figure 12-11). To go
back to the spreadsheet, you can choose Viewr>Spreadsheet.
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200
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After you insert a chart, you can use tools on the
Format menu or on the Chart toolbar, such as the
Chart Type button or the Borders button, to make
changes to chart type, borders used around the chart,
or font style or size.

Get Advice about Finances Online

You can use the Internet to access a wealth of financial information
online. You can read current news stories, get advice about how to
invest, and connect with others to share information. Keep in mind
that the quality of information online can vary drastically, and you
can’t always believe everything you read. Try to find sites of reputable
financial companies you might know from your offline financial deal-
ings, such as Merrill Lynch or Forbes Magazine. Also, never give out
financial account numbers to anybody via e-mail, even if they claim to
be with a reputable company.

Here are some of the resources available to you for planning and mon-
itoring your finances (see Chapter 16 for details about how to go to
any Web site):

e Visit sites such as www.money.cnn.com/
magazines/moneymag/moneyl101 for simple
financial lessons about topics such as setting a
budget and planning your retirement from
CNNMoney.

e Visit www. financialplan.about.com for
financial planning advice by age.

e Search for online publications such as The Wall
Street Journal (www.wallstreetjournal.com),
Forbes (www. forbes.com), as shown in Figure
12-12, or Kiplinger's (www.kiplinger.com) for
articles about the latest financial and investing
trends.
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Figure 12-12

e Check out online discussion forums such as www .
money .MSN. com to connect with others who are
interested in learning more about finances. However,
be very careful not to reveal too much personal infor-
mation to anybody you meet online, especially about
your specific finances and accounts.

In the United States, you're entitled to order a free
credit report from major credit report organizations
every year, and you can order those reports online.
Visit www . annualcreditreport.com to get started.

Windows 7 lets you display gadgets (little programs,
such as a calculator, that do handy things) on your
desktop. Add the Stocks gadget to check stock quotes at
a glance. See Chapter 10 for details on adding gadgets.
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Bank Online

Many people today are banking online because it's convenient. You
can typically make account transfers, check your balance, and even
download your account activity to a program such as Quicken to
manage your financial records or work with your taxes.

Consider this information when banking online:

e Most online banks, such as Barclays in the United
Kingdom (see Figure 12-13), have very strong
security measures in place; however, you should
be sure that you're using a secure Internet connec-
tion to go online. If you use a wireless home net-
work that isn't protected, for example, it’s possible
for someone to tap into your online transactions,
so you should have whoever sets up your network
enable security and a firewall. (See Chapter 21 for
an introduction to basic security.) Also, if you use
a public wireless network such as those in airports
or hotels, unless you can ask somebody in author-
ity if it is secure, don’t log on to any financial
accounts.

e You may need to set things up with your bank so
that you can access your account online and make
transfers among your different accounts. Talk to
your bank about what they require.

e Be careful to choose strong passwords (random
combinations of letters, numbers, and punctuation
are best) for accessing your bank accounts. If you
write the passwords down, put them someplace
safe. See Chapter 18 for advice about strong
passwords.
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e Be aware of your financial rights, such as how
credit cards and bank accounts are protected by
law. The FDIC Web site offers lots of information
about your banking and financial life at www.
fdic.gov. It's specific to the United States, but
some of the advice about online financial dangers
is pertinent no matter where you live.
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Invest Online

Every major broker has an online presence. Investing online is conve-
nient, and online brokers enable you to place buy or sell orders very
quickly and inexpensively. In addition, you can manage investment
accounts online.
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Here are some tips for online investing:

e Understand the fees. Online brokerage fees are
typically lower than working with a full-service
broker. However, online broker fees can vary
widely. Shop around for a broker you trust and
who has reasonable fees.

e Buyer beware. Though online banking is protected
by most federal governments, including the United
States, online investment accounts don't always
share similar protections, depending on what
country you live in. Consider asking your invest-
ment counselor for advice about how protections
work in your country.

e Handle various types of investments. Beyond
buying and selling stocks, you can invest in bonds,
deposit to your IRA or other retirement accounts,
and more. Companies such as Fidelity (www .
fidelity.com) give you lots of investment
choices.

e Retain offline access to your account. Remember
that one downside to online investing is that if
your computer connection is down or your bro-
ker’s server is down, you can’t get to your online
brokerage to invest. Keep a phone number handy
so you can reach your broker by an alternative
method in the case of technical glitches.

e Check what others have to say. Visit sites such as
The Motley Fool (see Figure 12-14) for articles and
advice on investing.

Chapter 12: Working with Numbers and Finances
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Getting the Most
from Movies and
Digital Photos

A picture is worth a thousand words, and
that's probably why everybody is in on the
digital image craze. Most people today have
access to a digital camera (even if only on their
cell phones) and have started manipulating

and swapping photos like crazy, both online
and off.

In this chapter you discover how to
w= Play movies with Windows Media Player.
w= Ipload photos from your digital camera.

w= View your photos and add tags and rat-
ings to help you organize and search
through photos.

w= E-mail a photo to others.

w= Burn photos to a DVD to pass around to
your friends.

| “*op’rer

13

Getready to...
w=» Work with Media

Software ........ccoceovreiiinn 208
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== View a Digital Image in the
Windows Photo Viewer ..... 214
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w= Create and Play a Slide
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Work with Media Software

208

Your computer is a doorway into a media-rich world full of music,
digital photos, and movies. Your computer provides you with all
kinds of possibilities for working with media. Windows 7 has two
useful media programs built right into it: Windows Media Player
and Windows Photo Viewer. In combination, they give you the
ability to play music and set up libraries of music tracks; view,
organize, and edit photos; and edit and play your own home
movies.

Here's what you can do with each of these programs:

= Windows Media Player (see Figure 13-1) is just

what its name suggests: a program you can use to
play music, watch movies, or view photos. It also
offers handy tools to create playlists (customized lists
of music you can build and play) and set up libraries
of media to keep things organized. You can even
burn media to a DVD so you can play it on your
DVD player or another computer.

w= Windows Photo Viewer (see Figure 13-2) enables
you to work with digital photos; it opens automati-
cally when you double-click a photo file. You can
also burn media to a disc or order prints from within
Photo Viewer.

w= [Ising photo properties in the Pictures library (see
Figure 13-3) you can organize your photos by add-
ing tags that help you search for just the photo you
need. You can also run slide shows using the Picture
library.
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Figure 13-2
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Figure 13-3

Play Movies with Windows Media Player

1. To open Windows Media Player and begin working with
music and movie files, click the icon with an orange
circle containing a right-facing arrow on the taskbar, or
choose Start=>All Programs>Windows Media Player. If
this is your first time using the player, you may be
prompted to make some basic settings.

2. Click the Maximize button in the resulting Media Player
window. (Maximize is in the upper-right corner of the
window, next to the X-shaped Close button, and has a
square icon.)

3. Click Videos in the navigation pane to the left.

4. In the window listing video files that appears, click the
Library folder that contains the movie you want to play
(as shown in Figure 13-4).
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Click the folder that contains the movie you want to play

[ Windows Media Player =R

@\) » Library » Videos b All Videos Play Bumn Syne

Organize ¥  Stream v Create playlist ~ S v | Searc P - @
Ep Library

& Playlists

a JJ Music
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() Album
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s [+ Vi 05

=] Pictures

& Recorded TV

=) OFFICE12 [E)

L P\

f® Other Libraries

f‘! Media Guide ~

%o { l@.‘ iy 4 ——@ =

Figure 13-4

5. Double-click a file to begin the playback (see Figure 13-5).
Use tools at the bottom of the screen to do the following
(if they disappear during playback, just hover your mouse
over that area to display them again):

¢ Adjust the volume of any soundtrack by clicking
and dragging the slider left (to make it softer) or
right (to make it louder). Click the megaphone-
shaped volume icon to mute the sound (and click
it again to turn the sound back on).

e Pause the playback by clicking the round Pause
button in the center of the toolbar.
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e Stop the playback by clicking the square-shaped
Stop button toward the left.

e Skip to the next or previous movie by clicking the
arrow buttons to the left or right of the Pause
button.

Playing 'Wildlife in HD': 6134 K bits/second

Figure 13-5

6. Click the Close button to close Media Player.

To stop the movie before it finishes, click the Stop
button. Note that the Rewind and Fast Forward
tools aren’t available for single movie clips — they
jump you from one track to another when playing
sound files.
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Upload Photos from Your Digital Camera

Uploading photos from a camera to your computer is a very simple
process, but it helps to understand what'’s involved. (This is similar to
the process you can use to upload movies from a camcorder — in
both cases, check your manual for details.) Here are some highlights:

2

2

2

Making the connection: To upload photos from

a digital camera to a computer requires that you
connect the camera to a USB port on your computer
using a USB cable that typically comes with the cam-
era. Power on the camera or change its setting to a
playback mode as instructed by your user’'s manual.

Installing software: Digital cameras also typically
come with software that makes uploading photos to
your computer easy. Install the software and then
follow the easy-to-use interface to upload photos. If
you're missing such software, you can simply con-
nect your camera to your computer and use
Windows Explorer to locate the camera device on
your computer and copy and paste photo files into a
folder on your hard drive. (Chapter 3 tells you how
to use Windows Explorer.)

Printing straight from the camera: Some cameras
save photos onto a memory card, and many printers
include a slot where you can insert the memory card
from the camera and print directly from it without
having to first upload pictures. Some cameras also
connect directly to printers. However, if you want to
keep a copy of the photo and clear up space in your
camera’s memory, you should upload even if you
can print without uploading.
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View a Digital Image in the Windows Photo Viewer

1. To peruse your photos and open them in Windows
Photo Viewer, click Start=>Pictures.

2. In the resulting window, if there are folders in this library,
double-click on one to display files within it. Double-click
on any photo in any Pictures Library folder. In the
Windows Photo Viewer window, shown in Figure 13-6,
you can use the tools at the bottom (see Figure 13-7) to
do any of the following:

10000202 - Windows Photo Viewer el bl (=[BRS

B Fle - Print v EE—ma\l @& Bun ~ [H Open ~ @
»

P~ @ (e ‘Q. My 5 ¢ | X

Figure 13-6

e The Previous and Next icons move to a previous
or following image in the same folder.

e The Display Size icon, in the shape of a magnify-

ing glass, displays a slider you can click and drag
to change the size of the image thumbnails.
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Display Play Rotate
size Slide Show Clockwise

— = - | :
FORST- TR | u'!:_f)'u P S ¢ | X

|
Previous Next J Delete

Rotate Counterclockwise
Figure 13-7

e The Delete button deletes the selected image.

¢ The Rotate Clockwise and Rotate Counterclock-
wise icons spin the image 90 degrees at a time.

® The center Play Slide Show button, with a slide
image on it, displays the images in your Picture
folder in a continuous slide show.

If you want to quickly open a photo in another appli-
cation, click the Open button at the top of the

Windows Photo Viewer window and choose a pro-
gram such as Paint or Microsoft Office Picture
Manager.

Add a Tag to a Photo

1. Tags help to categorize photos so you can search for
them easily. To create a new tag, choose Starte>Pictures.
Locate the photo you want, right-click it, and choose
Properties.

2. In the Properties dialog box that appears, click the
Details tab (see Figure 13-8).
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Click the Details tab
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Remove Properties and Personal Information
[ ok ][ cance

Figure 13-8

3. Click the Tags item and a field appears. Enter a tag(s) in
the field (see Figure 13-9) and click OK to save the tag.

4. Now if you display your Pictures library in Windows
Explorer in a Details view, the tag will be listed next to
the photo. Tags are also used when you view photos in
Windows Media Center.

To delete a tag, just display the photo Properties dia-
log box again, click to the right of the tag, and press
Backspace.

To see a list of all photos in the Photo Gallery orga-
nized by tags, click the arrow on the Arrange By item
and choose Tag.
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Enter a tag here
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Figure 13-9

E-Mail a Photo

1. Choose Start>Pictures. In Pictures Library, shown in
Figure 13-10 in Details view, click to the left of the
thumbnail to select the photo; a checkmark appears in a
checkbox to indicate it is selected. To choose multiple
photos, click additional thumbnails.

2. Choose FilervSend Tor>Mail Recipient. In the Attach Files
dialog box that appears (see Figure 13-11), change the
photo size by clicking the Picture Size drop-down arrow
and choosing another size from the list if you wish.

3. Click Attach. An e-mail form from your default e-mail
appears with your photo attached.

217



Part II: Having Fun and Getting Things Done with Software

Selected photos
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Figure 13-11

4. Fill out the e-mail form with an addressee, subject, and
message (if you wish), and then click Send.

Choose smaller size photos to attach to an e-mail
because graphic files can be rather big. You might
encounter problems sending larger files, or others
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might have trouble receiving them. Using a smaller
size is especially important if you are sending multi-
ple images. Note that although you can send a video
file as an e-mail attachment, you can’t resize it; video
files make photo files look tiny by comparison, so it’s
probably better to send one at a time, if at all.

the Photo Viewer open, click and drag a photo to
your e-mail. This method attaches the original file
size to the message.

Burn a Photo to a DVD

1. You can burn a copy of your photos to a DVD to share
them or to have a backup. Insert a writable DVD into
your disc drive.

@ You can also open an e-mail form first. Then, with

2. With the Pictures Library open in Windows Explorer, dis-
play a photo by locating it with the navigation pane and
double-clicking the thumbnail to display it in Windows
Photo Viewer.

3. Click the Burn button and then choose Data Disc.

4. A balloon message appears on the taskbar indicating that
you have files waiting to be burned to DVD. Click the
balloon and a list of files waiting to be burned appears,
as shown in Figure 13-12.

5. Click the Burn to Disc button. In the Burn to Disc dialog
box that appears, enter a name in the Disc Title (the
default name is today’s date), and if you wish, change the
recording speed; click Next.

6. A progress window appears (see Figure 13-13.

7. When the files have been burned to the disc, a confirming
dialog box appears, and your disc drawer opens. Click
Finish to complete the process and close the dialog box.
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If you want to check the photos you've added before
you burn the DVD, click the Preview button in the
Ready to Burn DVD window.

Create and Play a Slide Show

1. You can use the photos in your Pictures Library to run
your own slide show. Choose Start=>Pictures. Double-
click the Picture Library to display all pictures within it.

2. Click an image to select it. Holding down the Ctrl key,
repeat this to select all the photos you want to appear in
the slide show (see Figure 13-14).

Photos selected for slide show
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Figure 13-14
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3. Click the Slide Show button. The first image appears in a
separate full-screen display. The slides move forward
automatically, cycling among the photos repeatedly (see
Figure 13-15).

4. Press Escape to stop the slide show.

check out Windows Media Center. Here you can
create and save any number of custom slide shows,
reorganize slides, and edit slide shows to add or
delete photos. You might also consider a commercial
slide show program such as PowerPoint if you want
to create more complex slide shows.

@ If you want a more sophisticated slide show feature,

Figure 13-15
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Playing Music in
Windows 7

Music is the universal language, and your
computer opens up many opportunities

for appreciating it. Your computer makes it
possible for you to listen to your favorite
music, download music from the Internet,
play audio CDs and DVDs, and organize your
music by creating playlists. You can also save
(or burn in computer lingo) music tracks to a
CD/DVD or portable music device such as the
hugely popular iPod.

With a sound card installed and speakers
attached, you can use Windows media pro-
grams to do the following:

w=  Getting your computer ready for listening
by setting up your speakers and adjusting
the volume

w= Playing music using Windows Media
Player

w= Managing your music by creating play-
lists of tracks you download

w= Burning tracks to CD/DVD or syncing
with portable music devices

w= Making settings to copy music from CD/
DVDs to your computer (called ripping)

| “*opter

14

Getready to...
w= Set Up Speakers.............. 224

w= Adjust System Volume ....... 225

w= Create a Playlist ............... 227
w= Burn Music to a
CD/DVD.....oovveieieiins 229
= Sync with a Music
Device .....ccovvvviiniiiiiane, 230
wm Play MUSIC ......ooveieieaen, 231

w= Make Settings for Ripping
Music ......ooovvviniiiii 233
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Set Up Speakers

1. Attach speakers to your computer by plugging them into
the appropriate connection (often labeled with a little
megaphone or speaker symbol) on your CPU, laptop, or
monitor.

2. Choose Start>Control Panelt®Hardware and Sound; then
click the Manage Audio Devices link (under the Sound

category).

3. In the resulting Sound dialog box (see Figure 14-1), click
the Speakers item and then click the Properties button.

4 Sound R = T

Playback | Recording | Sounds | Communicaﬁonsg

Select a playback device below to modify its settings:

MVIDIA HDMI Cutput
NI I Audic

-‘é- Ry

a Spe
@ o

Realtek Digital Output
g Ready

[ OK J| Cancel J

Click on Speakers... Then click Properties
Figure 14-1

4. In the resulting Speakers Property dialog box, click the
Levels tab, shown in Figure 14-2, and then use the
Speakers slider to adjust the speaker volume. Note: If
there is a small red x on the speaker button, click it to
activate the speakers.
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] Speakers Properties el (=5
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Microphone
[} 91 |£| | Balance |
| OK | | Cancel

Figure 14-2

5. Click the Balance button. In the resulting Balance dialog
box, use the L(eft) and R(ight) sliders to adjust the bal-
ance of sounds between the two speakers.

6. Click OK three times to close all the open dialog boxes
and save the new settings.

calls, check out the Communications tab of the
Sound dialog box. Here you can make a setting to
have Windows automatically make adjustments to
sounds to minimize background noise.

@ If you use your computer to make or receive phone

Adjust System Volume

1. You can set the master system volume for your computer
to be louder or softer. Choose Starte>Control Panel=
Hardware and Sound.
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226

2. Click the Adjust System Volume link under Sound to dis-
play the Volume Mixer dialog box (shown in Figure 14-3).

Device Applications

© L

Speakers ¥ Systern Sounds

® ©

Figure 14-3

3. Make any of the following settings:

e Move the Device slider to adjust the system's
speaker volume up and down.

e For sounds played by Windows (called system
sounds), adjust the volume by moving the
Applications slider.

¢ To mute either the main or application volume,
click the speaker icon beneath either slider so that
a red circle appears.

4. Click the Close button twice.

ume of your default sound device. Click the Volume
button (which looks like a little gray speaker) in the
notifications area of the taskbar. To adjust the volume,

@ Here’s a handy shortcut for quickly adjusting the vol-
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use the slider on the Volume pop-up that appears, or
select the Mute Speakers button to turn off sounds
temporarily.

a mute button to control sounds from your com-
puter. Some even include buttons to play, pause, and
stop audio playback. Having these buttons and other
controls at your fingertips can be worth a little extra
in the price of your keyboard.

@ Today many keyboards include volume controls and

Create a Playlist

1. A playlist is a saved set of music tracks you can create
yourself — like building a personal music album. Choose
Start=>All Programs>Windows Media Player.

2. Click the Library button and then click the Create Playlist
button. A playlist appears in the navigation pane on the
left. Type a name for the playlist and then click anywhere
outside the playlist to save the name.

3. Double-click a category (for example, Music) to display
libraries, and then double-click a library in the left pane;
the library contents appear (see Figure 14-4). Click an
item and then drag it to the new playlist in the naviga-
tion pane. Repeat this step to locate additional titles to
add to the playlist.

4. To play a playlist, click it in the Library pane and then
click the Play button.

5. You can organize playlists by clicking the Organize but-
ton (see Figure 14-5) and then choosing Sort By. In the
submenu that appears, sort by features such as title, art-
ist, or release date.
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You can also right-click a playlist in the Library pane
and choose Play to play it or choose Delete to delete
the list, though the original tracks that make up the
list still exist.

Burn Music to a CD/DVD

1. Saving music files to a storage medium such as a CD or
DVD is referred to as burning. You might burn music to a
disc so you can take it to a party or another computer
location. Insert a blank CD or DVD suitable for storing
audio files in your computer CD/DVD-RW drive.

2. Open the Windows Media Player, click the Burn tab, and
then click one or more songs, albums, or playlists and
drag them to the Burn pane (see Figure 14-6).

|| Windows Media Player Bl bl (= (=)
@@ ¥ Library » Music » All Music Play i Sync
Organize +  » = S 2@ @ ) Clear List P~ A

Album
Amy Tiemann -- Mojo Mom

The Mojo Mom Podc... Mojo Mom and Internet...  41:06 -
fimi Tierann — Mo :;.,éfi/ restart the player
Podcast

2009

Connect a burner and

Burn List

Traditional Alternate Theme 3:20
Streisand Alternate Theme 3:20 Country Jingle 3:20
Traditional Christmas 319
| Loretta Lynn Country lingle 3:20
- 1999 Mood Music 319
\I nm
MoodMusic 0150 Y O | B [oled w@w PRl 4| @ =

Songs placed in the Burn pane

Figure 14-6
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3. Click Start Burn. Windows Media Player begins to burn
the items to the disc. The Status column for the first song
title reads Writing to Disc and changes to
Complete when the track is copied.

4. When the burn is complete, your disc is ejected
(although you can change this option by clicking the
Burn Options button and choosing Eject Disc After
Burning to deselect it).

®
®

If you swap music online through various music-
sharing services and then copy them to CD/DVD and
pass them around to your friends, always do a virus
check on the files before handing them off. Also, be
sure you have the legal right to download and swap
that music with others.

Note that optical discs come in different types,
including CD-R (readable), CD-RW(read/writable),
DVD+, DVD- and DVD+/-. You must be sure your
optical drive is compatible with the disc type you are
using or you cannot burn the disc successfully. Check
the packaging for the format before you buy!

Sync with a Music Device
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1. If you have a portable music player, you can sync it to
your computer to transfer music files to it. Connect a
device to your computer and open Windows Media
Player.

2. Click the Sync tab; a Device Setup dialog box appears
(see Figure 14-7).

3. Name the device, and click Finish. The device is now
synced with Windows Media Player and will be automat-
ically updated whenever you connect it to your
computer.



|©] Windows Media Player - Device Setup [y
2 Device Setup
Lexar (7.4 GE) Configure Sync

Name your device:

iPod)|

When you dick Finish, your device will be updated to mirror your Windows Media Player
library. In the future, the device will be updated whenever you connect it to your computer.

What are my options with sync?

| Fnish | | Cancel

Figure 14-7

To add items to be synced to a device, with the Sync
@ tab displayed, simply drag items to the right pane. If

you are connected, or the next time you connect, the

items are copied onto the device automatically.

If you want to be sure that the sync is progressing,
click the Sync Options button (it’s on the far right of

the top of the Sync tab and looks like a little box

with a checkmark in it) and choose View Sync Status.

Play Music
1. Choose Start=>All Programs=>Windows Media Player.

2. Click the Library button and then double-click Music or
Playlists to display a library like the one shown in Figure
14-8. Double-click an album or playlist to open it; the
titles of the songs are displayed in the right pane.

Chapter 14: Playing Music in Windows 7
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Figure 14-8

3. Use the buttons on the bottom of the Player window (as
shown in Figure 14-9) to do the following:

Stop Mute

Play/Pause
|

Shuffle List

B
| Mood Music 0104 [ &¢ C_i) II mg@:w 4 T 2=l
Repeat List Next
Previous Volume

Figure 14-9

e Click a track, and then click the Play button to
play it. When a song is playing, this button
changes to the Pause button.

e Click the Stop button to stop playback.

232



Chapter 14: Playing Music in Windows 7

¢ Click the Next or Previous button to move to the
next or previous track in an album or playlist.

e Use the Mute and Volume controls to pump the
sound up or down without having to modify the
Windows volume settings.

use the List Options button on the Play pane and
choose Shuffle List to have Windows Media Player
move around the tracks on your album randomly.
Click this button again to turn the shuffle feature off.

@ Tired of the order in which your tracks play? You can

and Previous buttons you can double-click a track in
the track list in the Media Player window. This can be
much quicker if you want to jump several tracks
ahead or behind of the currently playing track.

@ To jump to another track, rather than using the Next

Make Settings for Ripping Music

1. If you place a CD/DVD in your disc drive, Windows
Media Player will ask if you want to rip the music from
the disc to your computer. Doing so stores all the tracks
on your computer. To control how ripping works, with
Windows Media Player open, click the Organize button
and choose Options.

2. Click on the Rip Music tab to display it.

3. In the resulting window (see Figure 14-10) you can make
the following settings:

¢ Click the Change button to change the location
where ripped music is stored; the default location
is your Music folder.
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Figure 14-10

e (Click the File Name button to choose the informa-
tion to include in the filenames for music that is
ripped to your computer (see Figure 14-11).

e Choose the audio format to use by clicking the
Format drop-down list.

e Many audio files are copyright protected. If you
have permission to copy and distribute the music,
you may not want to choose the Copy Protect
Music checkbox; however, if you are downloading
music you paid for and therefore should not give
away copies of, you should ethically choose to
Copy Protect music so that Windows prompts you
to download media rights or purchase another copy
of the music when you copy it to another location.
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File Name Options
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Figure 14-11

e [f you don’t want to be prompted to rip music
from CD/DVDs you insert in your drive, but
instead want all music ripped automatically, click
the Rip CD Automatically checkbox.

e If you want the CD/DVD to eject automatically
after ripping is complete, select the Eject CD after
Ripping checkbox.

4. When you finish making settings, click the OK button to
save them and close the Options dialog box.

the ripped music. The smallest size file will save

@ Use the Audio Quality slider to adjust the quality of

space on your computer by compressing the file, but
this causes a loss of audio quality. The Best Quality
will provide optimum sound, but these files can be
rather large. The choice is yours based on your tastes
and your computer’s capacity!
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Playing Games
in Windows 7

A 1l work and no play is just wrong no mat-
ter how you look at it. So, Microsoft has
built plenty of games into Windows to keep
you amused.

Many computer games are essentially virtual
versions of games that you already know, such
as Solitaire and Chess. But Windows has added
some interesting treats to the mix — several
that depend to a great extent on some neat on-
screen animation.

Altogether, you can access eleven games
through Windows, and this chapter gives you a
sampling of the best of them. Here’s what you
can expect:

w= Traditional card games, such as Solitaire
and Hearts

w= Games of dexterity, such as Minesweeper,
where the goal is to be the fastest, smart-
est clicker in the West

w= An online version of chess called Chess
Titans that helps you hone your chess
strategy against another player or your
computer

w= A world of online gaming

| “*opter

1

Getready to...

w= Play Solitaire .................... 238
w= Play FreeCell ................... 241
w= Play Spider Solitaire.......... 243
w= Play Minesweeper............. 245
w= Play Hearts...........c.ccoe..... 247
w= Play Chess Titans.............. 249
w= Play Online Games........... 250
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No matter what your comfort level with computers, these games are
pretty darn easy to play and they're fun, so why not give them a try?

Play Solitaire

1. Choose Start=>Games. If this is the first time you're play-
ing games, Windows displays a Set Up Game dialog box.
If it does, make choices (like whether to automatically
check for game updates) and click OK. In the resulting
Games window (see Figure 15-1), double-click Solitaire.

i (o ((E =]

';_‘)"\/" |,”‘1 Fames - |¢¢| | Search Games £ |
File Edit View Tools Help
Organize » Options Tools » Parental Controls B = O -Z@.-
_f‘ \ Internet Checkers " TR
Microsoft Corporation \ i 1/
S ! '
-4
£ N
Y | Internet Spades
£ Mahjong Tltans
‘él ! oft Corporation -
,{\r This computer's Performance
|\“"|“'135"“'EEF'Er Information has not been created.

Rate this computer

P Purble Place Learn more
‘9 .-\ Microsoft Corporation
: Solitaire 3
’!I' Microsoft Corporation
o Croso
2 Spider Solitaire
[ " Microsoft Corporation :
'@- 12 items
E
12items

Double-click Solitaire

Figure 15-1

2. In the resulting Solitaire window, if you need help with
game rules, read the How to Play message that appears.
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When you're ready to play, click a card (see Figure 15-2)
and then click a card in another deck that you want to
move it on top of. The first card you click moves.

Click a card

Time: 10 Score: 3

Figure 15-2

3. When playing the game, you have the following options:

¢ [f no moves are available, click the stack of cards
in the upper-left corner to deal another round of
cards.

¢ If you move the last card from one of the six laid-
out stacks, leaving only face-down cards, click the
face-down cards to flip one up. You can also move
a King onto any empty stack.

e When you reach the end of the stack of cards in
the upper-left corner, click them again to redeal
the cards that you didn't use the first time.
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¢ You can play a card in one of two places: either
building a stack from King to Ace on the bottom
row, alternating suits; or starting from Ace in any
of the top four slots, placing cards from Ace to
King in a single suit.

e When you complete a set of cards (Ace to King),
click the top card and then click one of the four
blank deck spots at the top-right of the window. If
you complete all four sets, you win.

4. To deal a new game, choose Gamer>New Game (or press
F2). Unlike life, it’s easy to start over with Solitaire!
When prompted, choose Quit and Start a New Game.

5. To close Solitaire, click the Close button.

©)

To change settings for the game, choose Gamer>
Options. The two main settings you'll probably deal
with here are Draw (which gives you an option of
turning over one card or a stack of three cards on
each deal) and Scoring (which offers the option of
not using scoring at all, or using Standard or Vegas-
style scoring). Standard scoring starts you off with
nothing in the bank and pays you $5 or $10 for
every card you place depending on whether you
place it on the lower stacks or the area where you
place Aces. Vegas-style is a bit more complex, starting
you off with a $52 debit ($1 per card in the deck),
and crediting you $5 per card you place in the Aces
area, with the object being to come out in the black
(money-wise, that is) at the end. You can also choose
to time your game.

Don't like a move you just made? Undo it by choos-
ing Game=>Undo. This only works for the last move,
however. You can also get unstuck if you're on a los-
ing streak by choosing Game=>Hint.



Play FreeCell

1. FreeCell is a variation on solitaire. Choose Start>Games;
in the Games Windows, double-click FreeCell.

2. In the resulting FreeCell window, shown in Figure 15-3,
a game is ready to play. If you want a fresh game, you
can always choose Gamer>New Game; a new game is
dealt and ready to play.

®

The goal is to move all the cards, grouped by the four
suits, to the home cells (the four cells in the upper-
right corner) stacked in order from Ace at the bottom
to King at the top. The trick here is that you get four
free cells (the four cells in the upper-left corner)
where you can manually move a card out of the way
to free up a move. You can also use those four slots to
allow you to move up to four cards in a stack at once.
(For example, you can move a Jack, 10, 9, and 8 all
together onto a Queen.) You can move only as many
cards as there are free cells available plus one. Free
spaces in the rows of card stacks also act as free cells.
You win when you have four stacks of cards for each
of the four suits placed on the home cells.

3. Click a card; to move it, click a free cell or another card at
the bottom of a column. Figure 15-4 shows a game
where two free cells are already occupied.

®

If you move a card to a free cell, you can move it
back to the bottom of a column, but only on a card
one higher in an alternate color. You could move a 3
of hearts to a 4 of spades, for example. You stack the
cards in the columns in alternating colors, but the
cards in the home cells end up in order and all in
one suit.

Chapter 15: Playing Games in Windows 7
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freecell.org, a Web site devoted to FreeCell.
Here you can engage in live games with other play-
ers, read more about the rules and strategies, and
even buy FreeCell merchandise. Don't say I didn't
warn you about the possibility of addiction.

@ If you get hooked on this game, try going to www .

Play Spider Solitaire

1. Choose StarttvGames; in the Games windows, double-
click Spider Solitaire. If you've never played the game
before, the Select Difficulty window appears. Click your
comfort level: Beginner, Intermediate, or Advanced.

2. In the resulting game window, click a card and then click
another card or drag it to the bottom of another stack or
to an empty stack so that you match the same suit in
each stack, moving in descending order from King to Ace
(see Figure 15-5).

Stack same-suited cards in descending order

@ | Spider Solitaire el o )(C =5
Game Help

Score: 431 Moves: 9

Figure 15-5
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3. Move a card to automatically turn over a new card in the

stack.

4. After you complete a set of cards in a suit, those cards are
moved off the game area. The goal is to remove all the
cards in the fewest moves. You can

Deal a new set of cards. Choose Gamer>New
Game or click the stack of cards in the bottom-
right corner to deal a new set of cards. (Note: You
are prompted to quit, restart, or keep playing;
choose Keep Playing.)

Save your game. Choose Gamer>Exit and then click
Save in the Exit Game dialog box to save your game.

Change the options. Choose Game=>Options (see
Figure 15-6) and select a new difficulty level.
Other options mainly affect how or whether you
save games and open them to continue, and
whether the variously annoying or angelic sounds
play when you click a card, deal a card, or fold a
stack (assuming your computer system is set up
with a sound card and speakers).

Options
Difficulty
@ Beginner
One suit
Two suits

") Advanced
Four suits

[] Play sounds
7] show tips

Intermediate

|| Display animations

'_ | Always continue saved game
[ '.Always save game on exit

Cancel

| oK

Figure 15-6
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5. When you finish playing, click the Close button and either
click Save or Don’t Save in the Exit Game dialog box.

Stuck for a move? Try choosing Gamer>Hint. Various

@ combinations of cards are highlighted in sequence to
suggest a likely next step in the game. If you're not
stuck but just bored with the appearance of the game,
choose Gamer>Change Appearance and select other
desk and background styles.

Play Minesweeper

1. Choose Start®>Games; in the Games window, double-click
Minesweeper. If you've never played the game, a Select
Difficulty dialog box appears. Click on your selection.

2. The Minesweeper game board opens (see Figure 15-7).
Click a square on the board, and a timer starts counting
the seconds of your game.

¥ Minesweeper il o ][5 ][E5
Game Help

— Click any square to start

(© wm
Figure 15-7

)

e If you click a square and numbers appear in
various squares, the number tells you how
many mines are within the up to eight squares

Chapter 15: Playing Games in Windows 7
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surrounding that square; if it remains blank,
there are no mines within the eight squares
surrounding it.

e If you click a square and a bomb appears, all the
hidden bombs are exposed (see Figure 15-8), and
the game is over.

e Right-click a square once to place a flag on it mark-
ing it as a mine. Right-click a square twice to place a
question mark on it if you think it might contain a
bomb to warn yourself to stay away for now.
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Game Help
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Figure 15-8

3. To begin a new game, choose Game>New Game. In the
New Game dialog box, click Quit and Start a New Game.
If you want to play a game with the same settings as the
previous one, click Restart This Game.

4. You can set several game options through the Game
menu:

e To change the expertise required, choose
Game=>Options and then choose Beginner,
Intermediate, or Advanced.
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e To change the color of the playing board, choose
Gamer>Change Appearance.

e If you want to see how many games you've won,
your longest winning or losing streak, and more,
choose Gamer>Statistics.

5. To end the game, click the Close button, and when
prompted to save the game, click Save or Don’t Save.

If you want a bigger game board (more squares,
more bombs, more fun), choose Game=>Options and

then click Custom and specify the number of squares
across and down and the number of bombs hidden
within them.

Play Hearts
1. Choose StartevGames and double-click Hearts.

2. In the resulting Hearts window, shown in Figure 15-9,
your hand is displayed while others are hidden. Begin
play by clicking three cards to pass to your opponent,
and then click the Pass Left button.

3. Each player moving clockwise around the window plays
a card of the same suit by clicking it. The one who plays
the highest card of the suit in play wins the trick. (A trick
is the cards you collect when you play the highest card of
the suit.)

4. Choose Gamer>Options to change the settings shown in
Figure 15-10. You can rename the other three players,
play sounds, show tips, or specify how to save a game.

5. To end the game, choose GamerExit or click the Close
button. When prompted, either Save or Don’t Save the
game.
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Click to pass three selected cards
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Figure 15-9
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Figure 15-10

Check out the menus in the Games window for orga-
nizing and customizing the various games that
Windows 7 makes available and to set Parental
Controls.
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Play Chess Titans

1.

Chess is an ancient game of strategy. If you're a chess
buff, you'll enjoy playing a computer opponent in the
Windows version, Chess Titans. To begin playing chess,
choose Start>Games; in the Games window, double-click
Chess Titans. The first time you play the game, the Select
Difficulty window appears. Click a skill level to start a
game.

In the resulting Chess Titans window, a new game is
ready to play. By default, a new game will be played
against the computer, but you can choose to play another
person when you start a new game. If you want to start a
new game at any time, you can always choose Gamew>
New Game Against Computer or New Game Against
Human; a new game is ready to play.

. Click a piece; all possible moves are highlighted. To

move the piece, click the space where you want to move
it. Once you make a play, your opponent (either the
computer or another human) moves a piece. Figure

15-11 shows a game in progress with possible moves
highlighted.

@ You can change the game options so that possible

moves are not highlighted. Choose Game=>Options.
In the resulting Options window, deselect the Show
Valid Moves checkbox and then click OK. The
Options dialog box also lets you control a variety of
other settings, including whether you're playing as
black or white, whether to show tips or play sounds,
and the quality of graphics. If you're new to the
game, which is rather complex, try visiting www .
chess. com for beginner instructions and strategies.
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Possible moves are highlighted

Figure 15-11

modify it to look like a different material, such as
wood. Choose Gamer>Change Appearance. In the
Change Appearance window, click a style of chess
piece and a style of chess board. Click OK to save
your settings.

@ Don't like the look of your chess board? You can

Play Online Games

250

There are thousands of gaming sites online that let you interact with
other players from around the world. Search in your browser using
keywords such as “card games” or “Chess” to find them. Some are
simple games like Poker or Chess. Others are part of sophisticated vir-
tual worlds where you take on a personality, called an avatar, and can
even acquire virtual money and goods.
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Here are some tips for getting involved in online gaming and some
advice for staying safe:

w=  Safety first! You're playing games with strangers, so
avoid giving out personal information or choosing a
revealing user name. If somebody gets inappropri-
ately emotional or abusive while playing the game,
leave the game immediately and report the player to
the site owner.

m= |n some cases, you can play a computer; in others,
you play against other people the game site matches
you up with. You can usually request a level of play,
so if you're a beginner, you can feel comfortable that
you'll be matched with other beginners.

w= To play some games, you may need additional soft-
ware, such as Adobe Shockwave Player or software to
enable your computer to play animations. If you see
such a message on a game site, be sure you're down-
loading software from a reputable source that has a
good privacy policy for users and credentials like a
Better Business Bureau seal so you don’t download a
virus or spyware.

w= Many games are free, though some require that you
enter information about yourself to become a mem-
ber. Read the fine print carefully when signing up.

w= Many game sites offer tutorials or practice games to
help you learn and improve. Figure 15-12 shows the
Tutorial page for Legends of Norrath, a multiplayer,
online, role-playing game.
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Figure 15-12

w= Some games allow several players to participate at
once, so you might have to be on your toes! In addi-
tion to manipulating pieces or characters, you might
also be able to communicate with other players
using instant messaging or even voice messages.
Chapter 20 explains how instant messaging works.

w= Online gaming can be addictive, so be as moderate
in your playing online as you are offline. Remember
that these games are just for fun.
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“Since we got it, he hasn’t moved from that spot for
eleven straight days. Oddly enough they call this
‘getting up and running’ on the Internet.”







Understanding
Internet Basics

or many people, going online might be the

major reason to buy a computer. You can
use the Internet to check stock quotes, play
interactive games with others, and file your
taxes, for example. For seniors especially, the
Internet can provide wonderful ways to keep in
touch with family and friends located around
the country or on the other side of the world
via e-mail or instant messaging. You can share
photos of your grandchildren or connect with
others who share your hobbies or interests.

But before you begin all those wonderful activ-
ities, it helps to understand some basics about
the Internet and how it works.

This chapter helps you to understand what the
Internet and World Wide Web are, as well as
some basics about connecting to the Internet
and navigating around.
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The Internet, cyberspace, the Web . . . people and the media bounce
around many online-related terms these days, and folks sometimes use
them incorrectly. Your first step in getting familiar with the Internet is
to understand what some of these terms mean.

Here's a list of common Internet-related terms:

w= The Internet is a large network of computers that con-
tain information and technology tools that can be
accessed by anybody with an Internet connection.
(See the next section for information about Internet
connections.)

w= Residing on that network of computers is a huge set
of documents, which form the World Wide Web, usu-
ally referred to as just the Web.

w= The Web includes Web sites, which are made up of
collections of Web pages just as a book is made up of
individual pages. Web sites can be informational,
host communication tools such as chats or discussion
boards that allow people to “talk” via text messages,
or enable you to buy or bid for a wide variety of
items in an entire online marketplace referred to as
the world of e-commerce.

w= To get around online, you use a software program
called a browser. There are many browsers available,
and they're free. Internet Explorer is Microsoft’s
browser; others include Mozilla Firefox, Google
Chrome, and Opera. Browsers offer tools to help you
navigate from Web site to Web site and from one
Web page to another.

w= When you open a Web site, you might see colored
text or graphics that represent hyperlinks, also referred
to as links. You can click links to move from place to



place within a Web page, on a Web site, or around
the Internet. Figure 16-1 shows some hyperlinks
indicated by highlighted text or graphics.

A link can be a graphic (such as a company logo) or
text. A text link is identifiable by colored text, and it's
usually underlined. After you click a link, it usually
changes color to show that you've followed the link.

Click a graphical hyperlink
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Before you can connect to the Internet for the first time, you have to
have certain hardware in place and choose your Internet service provider
(also referred to as an ISP or simply a provider). An ISP is a company
that owns dedicated computers (called servers) that you use to access
the Internet. ISPs charge a monthly fee for this service.

In the past, you could sign up with an ISP such as Microsoft's MSN to
get dial-up access (that is, access via your regular phone line) to the
Internet. Today many people pay to access the Internet through their
telephone or cable television provider, whose connections are much
faster than a dial-up connection. Companies such as AOL now focus
on content they provide such as news, human interest stories, horo-
scopes, and games.

You can choose a type of connection to go online. Depending on the
type of connection you want, you will go to a different company for
the service. For example, a DSL connection might come through your
phone company, whereas a cable connection is available through
your cable-TV company. Not every type of connection is necessarily
available in every area, so check with phone, cable, and small Internet
providers in your town to find out your options and costs (some offer
discounts to AARP members, for example).

Here are the most common types of connections:

w= Dial-up connections: With a dial-up connection,
you use a phone line to connect to the Internet,
entering a phone number that’s provided by your
ISP. This is the slowest connection method, but it's
relatively inexpensive. Your dial-up Internet provider
will give you local access numbers, which you use to
go online. Using these local access numbers, you
won't incur long distance charges for your connec-
tion. However, with this type of connection, you
can’t use a phone line for phone calls while you're
connected to the Internet, so it's no longer a very
popular way to connect.
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Digital Subscriber Line: DSL also uses a phone line,
but your phone is available to you to make calls
even when you're connected to the Internet. DSL is a
form of broadband communication, which may use
phone lines and fiber-optic cables for transmission.
You have to subscribe to a broadband service (check
with your phone company) and pay a monthly fee
for access.

Cable: You may also go through your local cable
company to get your Internet service via the cable
that brings your TV programming rather than your
phone line. This is another type of broadband ser-
vice and is also faster than a dial-up connection.
Check with your cable company for monthly fees.

Satellite: Especially in rural areas, satellite Internet
providers may be your only option. This requires
that you install a satellite dish. BlueDish and
Comcast are two providers of satellite connections to
check into.

Wireless hotspots: If you take a wireless-enabled
laptop computer with you on a trip, you can piggy-
back on a connection somebody else has made. You
will find wireless hotspots in many public places,
such as airports, cafes, and hotels. If you're in range
of such a hotspot, your computer usually finds the
connection automatically, making Internet service
available to you for free or for a fee.

Internet connections have different speeds that depend partially on
your computer’s capabilities and partially on the connection you get
from your provider. Before you choose a provider, it's important to
understand how faster connection speeds can benefit you:

2

Faster speeds allow you to send data faster. In addi-
tion, Web pages and images display faster.

Chapter 16: Understanding Internet Basics
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Dial-up connection speeds run at the low end about
56 kilobits per second, or Kbps. Most broadband
connections today are around 500 to 600 Kbps. If
you have a slower connection, a file might take min-
utes to upload (for example a file you're attaching to
an e-mail). This same operation might take only sec-
onds at a higher speed.

Depending on your type of connection, you'll need different
hardware:

[ 2

nmp
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A broadband connection uses an Ethernet cable and a
modem, which your provider should make available,
as well as a connection to your phone or cable line.

Many desktop and laptop computers come with a
built-in modem for dial-up connections (though these
are being left out more and more as people move to
wireless connections) and are enabled for wireless. If
you choose a broadband connection, your phone or
cable company will provide you with an external
modem and wireless router (usually for a price).

If you have a laptop that doesn’t have a built-in wire-
less modem, you can add this hardware by buying a
wireless CardBus adapter PC card at any office sup-
ply or computer store. This card enables a laptop to
pick up wireless signals.

Many providers offer free or low-cost setup when you
open a new account. If you're not technical by nature,
consider taking advantage of this when you sign up.

Set Up an Internet Connection

1. The first step is to set up a connection in Windows so you
can access the Internet. Choose Start>Control Panel=>
Network and Internet.
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2. In the resulting window, click Network and Sharing
Center.

3. In the resulting Network and Sharing Center window (see
Figure 16-2), click the Set Up a New Connection or
Network link.

Click this link

[EEES
@uv!:f » Control Panel b MNetwork and Internet b Metwork and Sharing Center - ‘4, ‘ | Search Control Ponel el
@
Control Panel Home . f— . . . j
View your basic network information and pet up connections
" e E & Ry E See full map
Manage wireless networks * [ 'b w
Change adapter cettings
iR ' NANCY-PC finksys Internet
Change advanced sharing (This computer}
settings " . - "
i View your active networks Ceonnect or disconnect
. linksys Access type: Internet i
1 ] Wk rie i Connections: etwork Connection
£ Work network
Change your netwarking settings
i Setup a new connection of network  m—)
= gt up 2 wireless, broadband, dial-up, ad hoc, or VPN connection; or set up a reuter or access point.
‘5, Connect to a netwoerk
Connect or reconnect to a wireless, wired, dial-up, or VPN netwerk connection,
@, Choose homegroup and sharing options
Access files and printers located on other network computers, or change sharing settings,
.::l Troubleshoot problems
Diagnese and repair network problems, or get troubleshooting information.
HomeGroup
Internet Options
Windows Firewall

e ][0 @] [m]
Figure 16-2

4. In the Choose a Connection Option window, click Next
to accept the default option of creating a new Internet
connection. If you are already connected to the Internet,
a window appears; click Set Up a New Connection

Anyway.
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5. In the resulting dialog box, click your connection. (These
steps follow the selection of Broadband.)

6. In the resulting dialog box, shown in Figure 16-3, enter
your user name, password, and connection name (if you
want to assign one) and then click Connect. Windows
automatically detects the connection, and the Network
and Sharing Center appears with your connection listed.

[=llE
@ %y Connectto the Internet

Type the information from your Internet service provider (ISP}
User name: Julie
paEEW’Drd: .............l

| Show characters

Remember this password
Connection name: Broadband Connection
s [] Allow other people to use this connection

This option allows anyone with access to this computer to use this connection,
Ldon't have an ISP
| Connect | | Cancel

Figure 16-3

In many cases, if you have a disc from your ISP, you
don’t need to follow the preceding steps. Just pop
that DVD into your DVD-ROM drive, and in no time,

a window appears that gives you the steps to follow
to get set up.

Navigate the Web

1. You need to learn how to get around the Web using a
browser such as the popular Internet Explorer from

Microsoft. Open IE by clicking the Internet Explorer icon
in the Windows taskbar.
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2. Enter a Web site address in the Address bar, as shown in
Figure 16-4 (www.ilookbothways.com is my compa-
ny’s Web site), and then press Enter.

Enter a Web address
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Figure 16-4

3. On the resulting Web site, click a link (short for hyperlink;
a link takes you to another online page or document),
display another page on the site using navigation tools
on the page such as the Education tab on the page in
Figure 16-4), or enter another address in the Address bar
to proceed to another page.
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A link can be an icon or text. A text link is identifiable
by colored text, usually blue. After you click a link, it
usually changes to another color (such as purple) to
show that it's been followed.

4. Click the Back button to move back to the first page that

you visited. Click the Forward button to go forward to
the second page that you visited.

5. Click the down-pointing arrow at the far right of the

Address bar to display a list of sites that you visited
recently, as shown in Figure 16-5. Click a site in this list
to go there.
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The Refresh and Stop buttons on the right end of the
Address bar are useful for navigating sites. Clicking
the Refresh button redisplays the current page. This is
especially useful if a page updates information fre-
quently, such as on a stock market site. You can also
use the Refresh button if a page doesn’t load correctly;
it might load correctly when refreshed. Clicking the
Stop button stops a page that’s loading. So, if you
made a mistake entering the address, or if the page is
taking longer than you'd like to load, click the Stop
button to halt the process.

You can use the Pop-Up Blocker to stop annoying
pop-up ads as you browse. Click the Tools menu but-

ton and choose Pop-up Blocker, Turn On Pop-up
Blocker to activate this feature. You can also use the
Pop-up Blocker Settings command on this same
menu to specify sites you want to allow pop-ups to
appear in.

Use Tabs in Browsers

1. Tabs allow you to have several Web pages open at once
and easily switch among them. With Internet Explorer
open, click New Tab (the smallest tab on the far right of
the tabs).

2. In the new tab that appears, which displays some infor-
mation about tabs (see Figure 16-6), enter a URL in the
Address bar and press Enter. The URL opens in that tab.
You can then click other tabs to switch among sites.

3. Click the Quick Tabs button (it consists of four little
squares on the far left of the tabs) to display a thumbnail
of all open tabs (see Figure 16-7), or click the Tab List
button (the arrow to the right of the Quick Tabs button)
to display a text list of tabs.
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The new tab
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Figure 16-6

4. Close an active tab by clicking the Close button on the

right side of the tab.

A tab is a sort of window you can use to view any
number of sites. You don’t have to create a new tab

to go to another site. Having the ability to keep a few

tabs open at a time means you can more quickly
switch between two or more sites without navigating
back and forth either with the Previous or Next but-
tons or by entering URLs. You can also create more
than one Home Page tab that can appear every time
you open IE. See the task “Set Up a Home Page” for

more about this.
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The Quick Tabs button
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Figure 16-7

You can also press Ctrl+T to open a new tab in
Internet Explorer. Also, if you want to keep one tab
open and close all others, right-click the tab you
want to keep open and choose Close Other Tabs.

Set Up a Home Page

1. Your home page(s) appear automatically every time you
log on to the Internet, so choose one or a few sites that
you go to often for this setting. Open IE and choose
Tools=>Internet Options.
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2. In the resulting Internet Options dialog box, on the
General tab, enter a Web site address to use as your
home page, as shown in Figure 16-8, and then click OK.
Note that you can enter several home pages that will
appear on different tabs every time you open IE, as

shown in Figure 16-8.

Alternatively, click one of the following preset buttons

shown in Figure 16-8:

e Use Current: Sets whatever page is currently dis-
played in the browser window as your home page.

e Use Default: This setting sends you to the MSN

Web page.

e Use Blank: If you're a minimalist, this setting is
for you. No Web page displays; you just see a

blank area.
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3. Click the Home Page icon (see Figure 16-9) on the IE
toolbar (it looks like a little house) to go to your home

page.

If you want to have more than one home page, you
can create multiple home page tabs that will display
when you click the Home button. Click the arrow on
the Home button and choose Add or Change Home
Page. In the Add or Change Home Page dialog box
that appears, click the Add This Webpage to Your
Home Page Tabs radio button, and then click Yes.
Display other sites and repeat this procedure for all
the home page tabs you want.

The Home Page icon
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Figure 16-9
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To remove a home page you have set up, click the
arrow on the Home Page button and choose Remove
and then choose a particular home page, or choose
Remove All from the submenu that appears.



Browsing the
Web with
Internet Explorer

browser is a program that you can use to

move from one Web page to another, but
you can also use it to perform searches for
information and images. Most browsers, such
as Internet Explorer (IE) and Mozilla Firefox
are available for free. Macintosh computers
come with a browser called Safari built in.

Chapter 16 introduces browser basics, such as
how to go directly to a site when you know the
Web address, how to use the Back and Forward
buttons to move among sites you've visited,
and how to set up the home page that opens
automatically when you launch your browser.

In this chapter you discover more ways of
using Internet Explorer. By using IE you can

w= Navigate all around the Web. Use the IE
navigation features to go back to places
you've been (via the Favorites and
History features), and use Google to
search for new places to visit.

w= Customize Internet Explorer. You can
modify what tools are available to you in
Internet Explorer toolbars to make your
work online easier.
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Work with RSS Feeds. On the Internet you can use
RSS Feeds to get content from sites sent to you to
keep you up to date on news or opinions from vari-
ous sources.

Print content from Web pages. When you find what
you want online, such as a graphic image or article,
just use the Print feature of IE to generate a hard

copy.

Play Podcasts. You can listen to podcasts, which are
audio programs you find on many Web sites cover-
ing a variety of topics.

Search the Web

1. You can use words and phrases to search for information
on the Web using a search engine. In this example, you'll
use Google, a popular search engine. Enter www .
google.com in your browser’s Address bar.

272

2. Enter a search term in the text box and then click the
Google Search button.

3. In the search results that appear (see Figure 17-1), you
can click a link to go to that Web page. If you don't see
the link that you need, click and drag the scrollbar to
view more results.

®

You can use the Internet Explorer search feature to
search (it’s in the upper-right corner of IE, with a lit-
tle magnifying glass button on the right edge).
Change the search engine used to perform the search
by clicking the arrow to the right of the Search field
and choosing another provider listed there, or click
the Find More Providers link to see a more compre-
hensive list.
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Click a link in the results list
Figure 17-1

4. Click the Advanced Search link on the Google home page
to change Search parameters.

5. In the resulting Advanced Search page, shown in Figure
17-2, modify the following parameters:

e Find Web Pages That Have: These options let you
narrow the way words or phrases are searched; for
example, you can find matches for the exact word-
ing you enter only.

e But Don’t Show Pages That Have: Enter words
that you want to exclude from your results. For
example, you could search flu and specify you
don’t want results that involve swine flu.
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e Need More Tools: Here you can control how
many results are shown on a page, what language
to search for, and which specific file types or
domains to search.
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e Date, Usage Rights, Numeric Range, and More:
Click here for even more advanced search

parameters.

Type the word(s) you want to find

RN =

o T
CH ) o [ bt goupleumysenced seanniie
Ble Edit Mew Fgvordes Tool  Help
p Favarites M Google Advanced Search

@ Gooale Advancad Search - Windaws Intamet Explorer

"!EA.b:".'. R -

Web Images Yideos Maps Mews Shopping Groall maore «

Sinin *

GOL nge Advanced Search

flu, epidemic, 1910 ~zwine

Find web pages that have...
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Results per page
Languagis
Filis type

Search within @ site or domain

Goonde ook Search
Google Code Search Newl
Gonde Scholar
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, edirnse, 1915 —

Dut don't show pages that hava...

swini
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any limiuags

any Toermal

& Db, ey nghls, numens range, and men

Topicspreific search engines fmm Google:

Bntranced Search Tips | Aboul Google
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BED Unix Universities
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Figure 17-2

Knowing how search engines work can save you
time. For example, if you search by entering golden
retriever, you typically get sites that contain both
words or either word. If you put a plus sign between
these two keywords (golden+retriever), you get only
sites that contain both words.
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Find Content on a Web Page

1. With IE open and the Web page that you want to search
displayed, click the arrow on the Search box, and choose

Find on

2. In the resulting Find toolbar that appears on the active
tab, as shown in Figure 17-3, enter the word that you

This Page.

want to search for. As you type, all instances of the word

on the page are highlighted. Click the Options button
and use the following options to narrow your results:

e Match Whole Word Only: Select this option if you
want to find only the whole word (for example, if
you enter elect and want to find only elect and not
electron or electronics).

e Match Case: Select this option if you want to

match the case (for example, if you enter Catholic
and want to find only the always-capitalized reli-

gion and not the adjective catholic).

Enter the word to find
€ N hnology ir} Medicine - N dicine - Wind Internet Explorer o | [
@'\_/- - |g http://inderstandingnano.com/medicine. html = | *f| A | |:-:' writing tools P
File Edit Wiew Favgrites Tools Help
1.7 Favorites | 93 @& puggested Sites ¥ 2 | Get More Add-ons ¥ & Getting Started @ | Customize Links
~ »
edicine - Nanomedicine [ | gm v Pagev Safetyw Tools~ i@~

(& Nanotechnology in

% Find: | nanotubg —

Nanotech
Applications:

Medicine

Air Quality

Applications of nanotechnology in medicine currently being developed involve employing nano-
particles to deliver drugs, heat, light or other substances to specific cells in the human body.
Engineering particles to be used in this way allows detection and/or treatment of diseases or
injuries within the targeted cells, theraby minimizing the damage to healthy cells in the body.

2 !@ Options ~ | 1 match

ads by Google

Vicks® Brand
Vicks® therapy
solutions relieve

Figure 17-3

3. Click the Next button and you move from one high-
lighted instance of the word to the next (see Figure

17-4). If you want to move to a previous instance, click
the Previous button.
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a1l duction to N hnology - Windows Internet Explorer e o | 25

@v e |Q http://understandingnano.com/introduction.html 52 | "y| X | ‘&’-’ writing tools
File Edit View Favorites Tools Help

7.7 Favorites i= @ Suggested Sites v & Get More Add-ons » @] Getting Started 2 | Customize Links

x Find: | [T | Previous Next || 7| Options = | 3 matches
Py TS

@ Introduction to Nanotechnolagy fi = B v = # v Pagew Safetyv Took~ @~

o~

»

7 P! e
These RNA strands are attracted to cancer cells. When the nanoparticle encounters a cancer cell
it adheres to it and releases the drug into the cancer cell. This directed method of drug delivery
has great potential for treating cancer patients while producing less side harmful affects than
those produced by conventional chemotherapy.

Fabrics. The properties of familiar materials are being changed by manufacturers who are
adding nano-sized components to conventional materials to improve performance. For example,
some clothing manufacturers are making water and stain repellent clothing using nano-sized
whiskers in the fabric that cause water to bead up on the surface.

Reactivity of Materials. The properties of many conventional materials change when formed as
nano-sized particles (nanoparticles). This is generally because nanoparticles have a greater
surface area per weight than larger particles; they are therefore more reactive to some other
molecules. For example studies have show that nanoparticles of iron can be effective in the
cleanup of chemicals in groundwater because they react more efficiently to those chemicals
than larger iron particles.

Strength of Materials. Nano-sized particles of carbon, (for example | ﬂs and bucky balls)
are extremely strong. Nanotubes and bucky balls are composed of only cafbon and their strength
comes from special characteristics of the bonds between carbon atoms. pne proposed

application that illustrates the strength of nanosized particles of carbon if the manufacture of t-
shirt weight bullet proof vests made out of carbon nanoctubes.

Micro/Nano ElectroMechanical Systems. The ability to !ﬁrgemrors, sensor elements,
as well as electronic circuitry in silicon surfaces allows the manufgcture of miniature sensors
such as those used to activate the airbags in your car. This technique is called MEMS (Micro-
ElectroMechanical Systems). The MEMS technique results in close [integration of the mechanical
mechanism with the necessary electronic circuit on a single silico chip, similar to the method
used to produce computer chips. Using MEMS to produce a device|reduces both the cost and size
of the product, compared to similar devices made with conventiopal methods. MEMS is a
stepping stone to NEMS or Nano-ElectroMechanical Systems. NEM$ products are being made by a
few companies, and will take over as the standard once manufactprers make the investment in
i the eaninment neaded tn nroduce nann-sized features. o o
Done o &) Interet | Protected Mode: On

Hq10% ~

The highlighted instances of the word
Figure 17-4

4. When you're done searching, click the Close button on

the left side of the Find toolbar.

Many Web sites have a Search This Site feature that
allows you to search not only the displayed Web
page but all Web pages on a Web site, or to search by
department or category of item in an online store.
Look for a Search text box and make sure that it
searches the site — and not the entire Internet.
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Add a Web Site to Favorites

1. If there's a site you intend to revisit, you may want to
save it to IE’s Favorite folder so you can easily go there
again. Open IE, enter the URL of a Web site that you
want to add to your Favorites list, and then click Go (the
button with two blue arrows on it to the right of the
Address bar.

2. Click the Favorites button to display the Favorites pane,
and then click the Add to Favorites button.

3. In the resulting Add a Favorite dialog box, shown in
Figure 17-5, modify the name of the Favorite listing to
something easily recognizable. If you wish, choose
another folder or create a folder to store the Favorite in.

Change the favorite name here

Add a Favorfte

Add this webpgge as a favorite. To access your favorites, visit the

e Favarites Centgr.

MName: MSH.com —

Create in: |57 Favorites v| | Mew Folder |

Add | [ Concel |

Figure 17-5
4. Click Add to add the site.

5. Click the Favorites button and then click the name of the
site from the list that's displayed (see Figure 17-6) to go
to that site.
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Click the Favorites button

Favarites Bar
. Microsoft Websites | Muir. We have recommendations for you. (Not Nancy Muir?)
SN Websites
Windows Live
& | Network Solutions Webmail
& | About Grafton Village Cheese, Grafton, V...

Gift Cards [v]

Cart

& Windows 7 Beta Support, Deployment, R.
. 3mazon.com Online Shopping for Electr...
. Links for United States

? Has Arrived  awerer

Moilla Firefox Sleeker design. More storage. Longer battery -
£ About Grafton Village Cheese, Graften, V... life. Choose from over 250,000 books all W Read more
£ | Get Bookmark Add-ons available in under 60 seconds. And now 3
| Blackboard Login Alaska Kindle can read to you. Our revolutionary
2008-05 (May) wireless reading device just got better. » Find similar items
. 2008-11 (Mov) Learn more
2. Amazon c

E A .com: Online St ing for Electronics, Apparel, Computers, Books, DVDs & more - Windows Internet Explorer e o [P =2
@\J - ‘ A, hitp://www.amazon.com - ‘ ‘7‘ % | [#2 writing toole L~
File Edit View Favorites Tools Help
E-—; Favorites | ¢ [ Suggested Sites » 2| Get More Add-ons ¥ @] Getting Started 2| Customize Links
i T = = »
i Add to Favorites.. ¥ [#] otechnology Made Cl... ©) Look Both Ways: Clearspa... | fi v B v [ d v Pagev Safety~ Tools~ igh~
Favorites E e [ | Previous Nest | [F] Options |
l ASUS E-Service |;|_ Your Earnings Summary ¢ What's New M Discussion Boards ©  Settings v iml'lﬂSSUCiBIES ot

Your Account | Help

H Your Lists 3 |

Amazon 6 posts since yesterday
& | Equifax Freeze Confirmation Daily B LOG Posts for Nancy

Nobel laureate Morrison returns
more explicitly to the net of pain...

.

Figure 17-6

Regularly cleaning out your Favorites list is a good
idea — after all, do you really need the sites that you
used to plan last year’s vacation? With the Favorites
Center displayed, right-click any item and then
choose Delete or Rename to modify the favorite
listing.

You can keep the Favorites Center as a side pane in
Internet Explorer by displaying it and then clicking
the Pin to Favorites Center button (it has a left-facing
green arrow on it and is located in the top-right cor-
ner of the pane).

Organize Favorites

1. You can organize favorites into folders to make them eas-
ier to find. With Internet Explorer open, click the
Favorites button to open the Favorites pane. Click the
arrow on the right of the Add to Favorites button and
then choose Organize Favorites.
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2. In the resulting Organize Favorites dialog box (see Figure
17-7), click the New Folder, Move, Rename, or Delete

button to organize your favorites.

Select a favorite...

& Organize Favorites

ASUS E-Service
Favorites Bar
Microsoft Websites
MSN Websites
Windows Live
& | Network Solutions Webmail

| | & About Grafton Village Cheese, Grafton, Viermont. Aged cheddar cheese.

& | Equifax Freeze Confimation

& | Windows 7 Beta Support, Deployment, Resources

8. amazon.com Online Shopping for Electronics, Apparel, Computers, Book ...
Links for United States
Mozilla Firsfox

& | About Grafton Village Cheese, Grafton, Viermont. Aged cheddar cheese

ASUS E-Service
Favorites Folder

Modified:
1/23/2009 4:00 PM

—‘_

»

m

|| New Folder | | Move... | | Rename | | Delete...

| Close

Then click an action

Figure 17-7

3. When you finish organizing your Favorites, click Close.

These steps provide a handy way to manage several
sites or folders, but you can also organize favorite
sites one by one by using the Favorites pane. (You
display the Favorites pane by clicking the Favorites
button.) Right-click any favorite site listed in the
pane and choose a command: Create New Folder,
Rename, or Delete, for example.
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If you create new folders in the above steps, then you
will have to manually transfer files into those folders.
To do this just display the Favorites Center and click
and drag files listed there on top of folders.

View Your Browsing History

1. If you went to a site recently and want to return there
again but can’t remember the name, you might check
your browsing history to find it. Click the Favorites but-
ton and then click the History tab to display the History
pane (see Figure 17-8).

The History tab

— o ]

‘& Wicrosoft Corporqition - Windows Internet Explorer
'|‘9|XH:' writing tools P

uv - |E‘J http:|/www.microsoft.com/en/us/default.aspx
File Edit View Faporites Tools Help
77 Favorites || 75 | Suggested Sites v 2 | Get More Add-ons v | Getting Started 2 | Customize Links

5 v B - = @ v Pagev Safetyv Took~ @~

< Add to Favorites... |+ [&] lology M... | € Look Both Ways: Cl... |[]) Microsoft Corpo... %

[Favorites | Feeds] Fistory | , | Peinis Nt | ) Optioms = |
W\awByDate -J
] Last Week

Tn_‘Tuesday .‘
T Wednesday
_uJ'Saturday

), amazon (www.amazon.com)

United States Change

£l Computer
1 ilookbothways (www.ilookbothways.... | |
€] inbox (www.inbox.com) .
1€ look2ways (look2ways.com) =
STV | (e 1ost of your memories ) e o
) msn (www.msn.com) Manage, edit, share, and print Visit Microsoft Update
) pubstudio (pubstudic.com) 4 =5 B
5 '
&
&
3)
)

) search.live (search.live.com)
£, understandingnano (understandingn... | |
&) understandingnano (www.understan..,
), webhelp.quest (webhelp.quest.net)

=) wm50.inbox (wm30.inbox.com)

Figure 17-8

2. Click the down-arrow on the History button (see Figure
17-9) and select a sort method:

e View By Date: Sort favorites by date visited.

e View By Site: Sort alphabetically by site name.
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e View By Most Visited: Sort with the sites visited

most on top and those visited least at the bottom
of the list.

e View By Order Visited Today: Sort by the order in
which you visited sites today.

Click the arrow

‘& Wicrosoft Corporation - Windows In|

lernet Explorer

]

\\-..J u |[: http://www.microsoft.com)
File Edit View Favorites Tools Hel

5.7 Favorites | 53 @ | Suggested Sites ¥

s# Add to Favorites...

| Favorites | Feeds | History

fen/us/default.aspx

Get More Add-ons v @] Getting Started 2| Customize Links

£l
[] lology M... D Look Both Ways: Cl... |[J Microsoft Corpo... X

5

- | +s | X | |:' writing tools

=] xq; v Page~ Safety~ Tools~ ff:i'v =

o~

Hest | [F] Optians ~ |

[View By Order Visited Today

View By Date
View By Site

Search History

View By Most Visited ‘ |
View By Order Visited Todas ‘

Tl Today

Juy Now | Downloads & Trials - Partner & Customer Sclutions | Security & Updates | Training & Events

United States Changs

Support | About Microsoft

m

§in Silverlight

Figure 17-9

|

3. In the History pane, you can click a site to go to it. The
History pane closes.

®
®

Customize the Internet Explorer Toolbar

You can also choose the arrow on the right of the
Address bar to display sites you've visited.

Choose Search History on the History menu to dis-

play a search box you can use to search for sites
you've visited.

1. You can customize the toolbars that offer common com-
mands in IE so the commands you use most often are

included. Open

IE.

2. Click Toolse>Toolbars=>Customize. The Customize

Toolbar dialog box (shown in Figure 17-10) appears.
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Customize Toolbar —— (o]
Ayailable toolbar buttons: Curment toclbar buttons: | Close |
| Separator - Safety -
A Tent Size ::,’E Tools \E
aﬂ-i-- Encoding — Add = ﬂ- Help
o+ Edit £ HF Clipbook
K ocut ~Remove | |[F] HP Smart Select )
5z Copy i‘bReseamh = e Up
0 Fooe Ce T
517t S - — | (ove
4 [ | 3 < m 3

Figure 17-10

3. Click a tool on the left and then click the Add button to
add it to the toolbar.

4. Click a tool on the right and then click the Remove but-
ton to remove it from the toolbar.

5. When you're finished, click Close to save your new tool-
bar settings. The new tools appear (see Figure 17-11);
click the double-arrow button on the right of the toolbar
to display any tools that IE can’t fit on-screen.

Find new tools here

‘£ Microsoft Corporation - vs Inte Explorer —— o ]S
uu - |E: http://www.microsoft.com/en/us/default.aspx bd | *‘7| X | ‘f‘ writing tools =l g
File Edit View Favorites Tools Help
Ty Favorites |32~ @ Amazon.com: ... | (@ Nanotechnolog... | € Lok Both Way... [ Microsoft C... % Bi - B v & - Pahev safety~ Toos~ @~ ||
% Find: ‘ e I rsaiate R | 7] options -‘ £5 HP Clipbook

| HP Smart Select

@ Upgrade your Internet experience (il ?: Reeuen
@ Full Screen F11
8] <tv> DeveloperTools Fi2

Print Preview...

Windows Office = All Products | Buy Now | Downloads &Trials | Partner & Customer Solutions | Security & Updates | Training & Events | Support | About Microsoft

Figure 17-11

m

You can use the Move Up and Move Down buttons
in the Customize Toolbar dialog box to rearrange the
order in which tools appear on the toolbar. To reset
the toolbar to defaults, click the Reset button in that
same dialog box.
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If you want to add some space between tools on the
toolbar so it's easier to see, click the Separator item
in the Available Toolbar Buttons list and add it
before or after a tool button.

View RSS Feeds

1. You can view information sent to you via RSS feeds using
IE. Click the Favorites button; then click the Feeds tab to
display a list of recently displayed RSS Feeds (see Figure
17-12).

. Favorites 25+ | A Amazon.com: Onling

o= Add to Favorites.., - |

[ Faverites | Feedls | History|
Feeds for United States
Links

) Microsoft at Home
Microsoft at Work
[ MSNBC News

Figure 17-12

2. Double-click a folder to open it, and then click a feed to
display it (see Figure 17-13).

Click a feed to view it

‘€ MWicrosoft At Home - Windows Internet Explorer ] =]
@\J ~| ] hitp://go micrasoft.com/fulink/?Linkid=68928 <45 % | [82 free games o -
File Edit View Favorites Tools Help
- = = " T
i.¢ Favorites | 05|~ | 8 Amazon.com: OnlineS... | @ Nanotechnology Made... € Microsoft At Home P~ B - [0 & v Pagew Safety~ Tools~ @@~
75 Add to Favorites Bar = %] | | | Options +
[Foverites| Feeds [pitony| g
. Feeds for United States
i i 31/31
I Displaying
Micrasoft Feeds 3
2 . — 7
g Microsoft at Home (et S -
[l Microsoft at Work Al =1
MSNBC News *iNew 2
rn, or should you try to do it yourself? The following quiz can help give you an idea s
and current tax laws, Sort by:
¥ Date
OX Title

Figure 17-13
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3. You can also click the View Feeds on This Page button on
the toolbar to view any active feeds listed on the cur-
rently displayed page.

when there are no RSS feeds on the current page, and

@ The View Feeds on This Page button is grayed out
it turns Red when feeds are present.

built in, you can explore other feed readers. Just type
RSS feeds into Internet Explorer’s Search box to find
more information and listings of readers and RSS
feed sites.

@ Though Internet Explorer has an RSS feed reader

Print a Web Page
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1. If a Web page includes a link or button to print or dis-
play a print version of a page, click that and follow the
instructions.

2. If the page doesn't include a link for printing, click the
Print button on the IE toolbar.

3. In the resulting Print dialog box, decide how much of the
document you want to print and then select one of the
options in the Page Range area, as shown in Figure 17-14.

numbers in the Pages text box of the Print dialog box
doesn’t mean much when printing a Web page — the
whole document might print because Web pages
aren’t divided into pages as word-processing docu-
ments are.

@ Note that choosing Current Page or entering page

4. Click the up-arrow in the Number of Copies text box to
print multiple copies. If you want multiple copies col-
lated, select the Collate check box.
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Choose a page range option

= Print [ — |
| General :Opﬁongl.
Select Printer
i B Add Printer i m Microsoft XPS Docurr
o0 Brother DCH-116C 3 Snaglt 9
Fax
[¥] %) HP Deskjet F4100 series
4 m ¥
Status: Cffling Print to file | Preferences |
Location:
Comment: | Find Prirter... |
| Page Range |
@ Al Mumber of copies: 1
"1 Pages: 1
231 213
Enter either a single page number or a single 1= 1=
page range. For example, 5-12
FPrint | | Cancel | A

Figure 17-14

5. When you adjust all settings you need, click Print.

Play Podcasts

Many sites offer podcasts, which are audio recordings of interviews,
opinions, or informative oral articles. To check this out, go to The New
York Times site by entering this address in your browser’s address bar:
www.nytimes.com/ref/multimedia/podcasts.html.

Click on the little arrow on the right of any podcast, as shown in
Figure 17-15. The podcast begins playing (in some cases podcasts
open a new windows with an animated display that plays during the
podcast, though that doesn’t happen at The New York Times site). Use
the controls to do any of the following:

m=  Click the Stop button (it has two little vertical bars
on it) to stop playback.

m= Click and drag the wedge-shaped volume control to
increase or decrease the volume.
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w= Click the diamond-shaped object on the bar that
shows the podcast’s progress to move forward or
backward in the program. Note that the time point
where you are in the podcast is displayed to the right
of this bar.

[& Podcasts  New York Times - Mozilla Firefox _——— o (=]
File Edit View History Bookmarks Tools Help

o 4y & | hitp/www.nytimes com/reffmultimedia/podcasts. html vy - [G-G Pl
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:\Lesltc.tttmehtoTimeaPeopLe n TimesPeople Lets You Share and Discover the Best of NY. TASAM | T Mo, thanks
HOME PAGE | TODAY'S PAPER | VIDEQ | MOST FOPULAR TIMES 'ror:\:s'_ GetHome Delivery Login | Register Now
", 5 h ALY T
ahl' ,’.\t‘wl_]urk Times earc imes.com |

Tuesday, April 21, 2009 POdcaStS = |

WORLD U.S. N.Y./REGION BUSINESS TECHNOLOGY SCIENCE HEALTH SPORTS OPINION @ ARTS STYLE TRAVEL JOBS REALESTATE AUTOS
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ﬁ—“ 5 THE YACHTS OF SEABOURN. VENTER TO WIN
L -

NYTimes.com Podcasts

e [ ] feed our addiction
PODCAST LATEST EPISODE to Mideast oil
3 Backstory NYT: Back Story With f

Jane Bornemeier talks to Times reporters about the Sheryl Gay Stolberg E i ht IO bal

top stories of the day. (mp3) g g_

Schedule: Mondsy through Fridsy y

- 106 Warmlng com
SUBSCRIBE
i e
Book Review NYT: Book Review for I EER T ! fal -

m Sam Tanenhaus, editor of The New York Times Book  4/17/2009 (mp3)
Review, discusses this week's issue. Visit an archive of
previous Book Review Podcasts. " 15:00 ot
Schedule: Friday
SUBSCRIBE

Daone

Click the arrow to play the podcast
Figure 17-15
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Staying Safe
While Online

Getting active online carries with it certain
risks, like most things in life. But just as
you know how to drive or walk around town
safely when you know the rules of the road,
you can stay relatively safe online.

In this chapter you discover some of the risks
and safety nets that you can take advantage of
to avoid risk, including:

w= Understand what risks exist. Some risks
are human in the form of online preda-
tors wanting to steal your money or
abuse you emotionally; other risks come
from technology such as computer
viruses. For the former, you can use the
common sense you use when interacting
offline to stay much safer. For the latter,
there are tools and browser settings to
protect you.

m= Be aware of what information you
share. Abuses such as ID theft occur most
often when you or somebody you know
shares information about you that's
nobody’s business. Find out how to spot
who is exposing information (including
you) and what information to keep pri-
vate and you'll become much safer
online.

| “*op’rer

Getready to...
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Risks on the Internet.......... 288

= Use Suggested Sites .......... 291
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w=» Change Privacy Settings .... 297

w= Enable the Content

AQVISOT ..o 299
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Exposure.......ccccoeviennenn. 301
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Private .......cccovviiiiiies, 304
w= Spot Phishing Scams and

Other E-mail Fraud............ 306

w= Create Strong Passwords ... 308
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m= Avoid scams and undesirable content. You can use
the Content Advisor to limit the online locations
that your computer can visit so you don’t encounter
sites you consider undesirable. You can also find out
how to spot various e-mail scams and fraud so you
don’t become a victim.

w= Create safe passwords. Passwords don’t have to be
hard to remember, just hard to guess. I provide some
guidance in this chapter about creating passwords
that are hard to crack.

Understand Technology Risks on the Internet

When you buy a car, it has certain safety features built in. After you
drive it off the lot, you might find that the manufacturer slipped up
and either recalls your car or requests that you go to the dealer’s ser-
vice department to have a faulty part replaced. In addition, you need
to drive defensively to keep your car from being damaged in daily use.

Your computer is similar to your car in terms of the need for safety. It
comes with an operating system (such as Microsoft Windows) built in,
and that operating system has security features. Sometimes that oper-
ating system has flaws, and you need to get an update to keep it
secure. And as you use your computer, you're exposing it to dangerous
conditions and situations that you have to guard against.

Threats to your computer security can come from a file you copy from
a disc you insert into your computer, but most of the time, the danger
is from a program that you download from the Internet. These down-
loads can happen when you click a link, open an attachment in an
e-mail, or download one piece of software without realizing that mal-
ware (malicious software) is attached to it.

You need to be aware of these three main types of dangerous
programs:
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To protect your information and your computer from these various

A virus is a little program that some nasty person
thought up to spread around the Internet and infect
computers. A virus can do a variety of things, but
typically, it attacks your data by deleting files, scram-
bling data, or making changes to your system set-
tings that cause your computer to grind to a halt.

Spyware consists of programs responsible for tracking
what you do with your computer. Some spyware
simply helps companies you do business with track
your activities so that they can figure out how to sell
you things; other spyware is used for more insidious
purposes, such as stealing your passwords.

Adware is the computer equivalent of telemarketing
phone calls at dinner time. After adware is down-
loaded onto your computer, you'll get annoying
pop-up windows trying to sell you things all day
long. Beyond the annoyance, adware can quickly
clog up your computer. Its performance slows down,
and it’s hard to get anything done at all.

types of malware, you can do several things:

2

You can buy and install an antivirus, anti-spyware,
or anti-adware program. It’s critical that you install
an antivirus program, such as those from McAfee,
Symantec (see Figure 18-1), or Trend Micro, or the
freely downloadable AVG Free. People are coming
up with new viruses every day, so it's important that
you use software that is up to date with the latest
virus definitions and that protects your computer
from them. Many antivirus programs are purchased
by yearly subscription, which gives you access to
updated virus definitions that the company con-
stantly gathers throughout the year. Also, be sure to

Chapter 18: Staying Safe While Online
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run a scan of your computer on a regular basis. For
convenience, you can use settings in the software to
set up automatic updates and scans. Consult your
program'’s Help tool for instructions on how to use
these features.

o |[E=][E2
@ Leave Feedback @) Norton Account @) Help & Suppart

Norton Internet Security"
Subscription: 171 days remaining.

Secure

Run a Scan

Schedule 3 scan

Manage Quarantined ltems
Run Secutity Inspector Reatly
Log in or out of [dentity Safe
Manage Identity Safe Profile

Figure 18-1

w= Install a program that combines tools for detecting
adware and spyware. Windows 7 has a built-in pro-
gram, Windows Defender, which includes an anti-
spyware feature. (I cover Windows Defender tools
later in this chapter.) If you don’t have Windows 7,
you can purchase programs such as Spyware Doctor
from PC Tools or download free tools such as
SpyBot or Spyware Terminator.

w= Use Windows tools to keep Windows up to date
with security features and fixes to security prob-
lems. You can also turn on a firewall, which is a
feature that stops other people or programs from
accessing your computer without your permission. I
cover Windows Defender and firewalls in Chapter 21.
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w= Use privacy and security features of your browser,
such as the Suggested Sites and InPrivate Browsing
features new to IE 8.

Use Suggested Sites

1. To have Internet Explorer suggest sites you might like
that are related to the currently displayed site, click the
Tools button and choose Suggested Sites (a checkmark
appears next to it as shown in Figure 18-2). When a
prompt appears asking if you want to discover Web sites
you might like based on sites you have visited, click Yes.

B -~ = == ~ Page~ Safety~| Tools~

L5 Reopen Last Browsing Session

1 Pop-up Blocker 4
2] Manage Add-ons

Work Offline

Al

Compatibility View

Compatibility View Settings

7| Full Screen F11
Toolbars 1

Explorer Bars E
<e> Developer Tools F12
v Suggested Sites

Y. Internet Options

Choose Suggested Sites
Figure 18-2

2. Click the Suggested Sites button on the Favorites toolbar
(if the toolbar isn’t displayed, right-click the toolbar area
and click on Favorites Bar). A list of suggested sites
appears in a pop-up window (see Figure 18-3).
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A list of suggested sites

# | Suggested Sites v]g Get More Add-ons v 2| Gettin

op 5 websites that are similar to

¥ eBay

® Target

‘B Best Buy

m Barnes & Moble

O overstock.com: Online Shopping J

Other Suggestions

< +4 | https://ieonline.micr... % Microsoft Corpora...

Figure 18-3

3. Click on a site to display its URL.

up with suggestions, so when you first activate it, it
may take a little while before it comes up with useful
suggestions.

Download Files Safely

1. Open a Web site that contains downloadable files.
Typically Web sites offer a Download button or link that
initiates a file download.

@ Suggested Sites uses your browsing history to come

2. Click the appropriate link to proceed. Windows might
display a dialog box asking your permission to proceed
with the download; click Yes.

3. In the resulting File Download dialog box, shown in
Figure 18-4, choose either option:

¢ Click Run to download to a temporary folder.
You can run an installation program for software,
for example. However, beware: If you run a pro-
gram directly from the Internet, you could be
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introducing dangerous viruses to your system. You
might want to set up an antivirus program to scan
files before downloading them.

e Click Save to save the file to your hard drive. In
the Save As dialog box, select the folder on your
computer or removable storage media (a USB
Flash drive, for example) where you want to save
the file. If you're downloading software, you need
to locate the downloaded file and click it to run
the installation.

File Download - Security Warning — — (]
Do you want to run or save this file?

MName: windows-kb830830-v2.5.exe
Type: Application, 9.77MB

From: download.microsoft.com

;'|

E E
Bun || Save i Cancel I

| | While files from the Intemet can be useful, this file type can
) t‘ potertially ham your computer. F you do not trust the source, do not
b run or save this software. VWhat's the risk?

Figure 18-4

to download (for example, if it's from an unknown

source and, being an executable file type, could con-
tain a virus), click Cancel in the File Download dia-

log box.

@ If you're worried that a particular file might be unsafe

(some can take 20 minutes or more), you may have
to babysit it. If your computer goes into standby
mode, it could pause the download. If your com-
puter automatically downloads Windows updates, it
may cause your computer to restart automatically as
well, cancelling or halting your download. Check in
periodically to keep things moving along.

@ If a particular file will take a long time to download
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Turn on InPrivate Browsing and Filtering

1. InPrivate Browsing is a new feature that stops IE from
saving information about your browsing session, such as
cookies and your browsing history. InPrivate Filtering
allows you to block or allow sites that are automatically
collecting information about your browsing habits. To
turn on InPrivate features, open IE.

2. Click Safety and choose InPrivate Browsing to turn that
feature on. The tab shown in Figure 18-5 appears.

The InPrivate tab

‘£ InPrivate - Windows Internet Explorer - [InPfivate]

——— ] (S

@I@®RN[ iwrivate Elboutineiivaid = [#2 [ x | [ £ Live Searcn o ~
File Edit View Favorites Tools Help
7. Favorites & InPrivate “-‘h iyl E] v ] mm - Page~v Safety> Tools~w -@' ey

When InPrivate is turned on, you will see this indicator

O - e o

InPrivate Browsing helps prevent Internet Explorer from storing data about your
browsing session. This includes cookies, temporary Internet files, history, and other
data. Toolbars and extensions are disabled by default. See Help for more
information,

InPrivate Blocking helps you control whether third parties can automatically collect
information about your web browsing based on the sites you visit. InPrivate Blocking
does this by identifying third-party content that is used by multiple websites you visit.
Some website content might not be displayed unless you choose to allow these third-
party websites,

To turn off InPrivate, close this browser window.

Learn more about InPrivate | R

"4 InPrivate Blocking: OF @) Internet | Protected Mode: On

®100% v

Figure 18-5
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3. Click Safety and choose InPrivate Filtering Settings; if you
haven't turned this feature on, a window appears asking
you to turn it on; click the Block for Me link and again
choose InPrivate Filtering Settings. The dialog box shown
in Figure 18-6 appears. Choose one of the following

settings:

e Automatically Block blocks any site that uses con-

tent from other sites you've visited.

e Choose Content to Block or Allow allows you to
open the InPrivate Filtering Settings dialog box
and use the Allow and Block buttons to select

which sites to allow and which to block.

Choose a setting

InPrivate Filtering settings =]
1 InPrivate Fittering
il
T When you vigit multiple websites that contain content from the same provider, such az a
map, advertisement, or web mEasurement toolz, some information about wour visits might
be shared with the content prgvider. |f you chooze to block content, portions of the
websites pou visit might not by available.
Chooze content to black o |
or allow
r
Content provider Status Uszed by Content = !
googlesyndication.com  Blocked 11 sites expanzion_emb| = |
quantzerye.com Blocked 14 sites quant.jz |
doubleclick. net Blocked 15 sites test_domain. jz
doubleclick. net Blocked 15 sites ads
google-analytics. com Blocked 16 sitez gajs bt
S : = i £ : |
More information from this content provider Allow Block
10 ~| Show content from providers used by this number of websites Refresh
you've visited. [3-30] =
Advanced settings
Learn more about InPrivate Filbering | oK. | | T

Figure 18-6

Chapter 18: Staying Safe While Online

295



Part lll: Exploring the Internet

4. Click OK to save your settings. When you browse a bit
and then reopen the InPrivate Filtering Settings dialog
box (Safety=>InPrivate Block), you see blocked and
allowed sites listed.

would like to periodically clear your browsing history
manually, with IE open, you can press
Ctrl+Shift+Delete to do so.

@ If you don’t want to use InPrivate Browsing but

Use SmartScreen Filter
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1. SmartScreen Filter lets you check Web sites that have been
reported to Microsoft as generating phishing scams or
downloading malware to your computer. To turn
SmartScreen Filter on, click on the Safety button and then
choose SmartScreen Filter>Turn On SmartScreen Filter.
In the confirmation dialog box that appears, click OK.

2. To use SmartScreen Filter, go to a Web site you want to
check. Click the Safety button and choose SmartScreen
Filterm>Check This Website.

3. The SmartScreen Filter window appears (see Figure
18-7), indicating whether it found any threats. Click the
OK button to close the message.

SmartScreen Filter -— ——

| SmartScreen Filter checked this website and did not report any threats

Ewen though this site has not been reported to Microsoft for containing threats, check the
address to make sure itis a site you trust. If you believe this is an unsafe site, dick the
Safety button, dick SmartScreen Filter, and then dick Report Unsafe Website,

.j@ How does SmartScreen Filter help protect me?

Figure 18-7
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Once turned on, SmartScreen Filter automatically
checks Web sites and will generate a message if you
visit one that has reported problems. However, that
information only gets updated periodically, so if you
have concerns about a particular site, use the proce-
dure given here to check the latest information about
the Web site.

Change Privacy Settings

1. You can modify how IE deals with privacy settings to
keep information about your browsing habits or identity
safer. With IE open, choose Tools=>Internet Options and
click the Privacy tab, as shown in Figure 18-8.

The Privacy tab

Internet Options (|

| General ! Security | Privacy |Conhent 5 Connections ; Programs E Advanced |

Settings

L To set a standard privacy level instead of using custom

:@; settings, dick the Default button,
Custom

- Advanced or imported settings

f Sites i | Import | | Adyanced | | Default |

Pop-up Blocker

| || Prevent most pop-up windows from | Settings |
@—' appearing.
[¥] Turn on Pop-up Blocker
InPrivate

[[IDo not collect data for use by InPrivate Blocking
[¥] Disable toolbars and extensions when InPrivate starts

r'n
[

| OK || Cancel H Apply |

Figure 18-8

297



Part lll: Exploring the Internet
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2. Click the slider and drag it up or down to make different
levels of security settings.

3. Read the choices and select a setting that suits you.

4. Click the Sites button to specify sites to always or never
allow the use of cookies. In the resulting Per Site Privacy
Actions dialog box (shown in Figure 18-9), enter a site in
the Address of Website box and click either Block or
Allow.

Enter a Web site here

Per Site Privacy Actions - — (]

Manage Sites

€ | “ou can specify which websites are always or never allowed to use

i) cookies, regardless of their privacy policy.

Type the exact address of the website you want to manage, and then click Allow
or Block.

To remove a site from the list pf managed sites, select the name of the website
and click the Remove button

Address of website:
|

Bock |

| Allow |
Managed websites:
Domair Setting Bemove
freegamesgalore.com Always Block T
smithsonian.org Always Allow ———
oKk |

Figure 18-9

5. Click OK twice to save your new settings.

The default setting, Medium, is probably a good bet
@ for most people. To restore the default setting, click

the Default button in the Internet Options dialog

box’s Privacy tab or use the slider to move back to

Medium.



You can also use pop-up blocker settings on the
Privacy tab to specify which pop-up windows to
allow or block. Just click the Settings button, enter a
Web site name, and then click Add to allow pop-ups.

Enable the Content Advisor

1.

Use Content Advisor to alert you when you visit sites
with certain types of content you or your family might
find objectionable. With IE open, choose Toolst>Internet
Options.

In the resulting Internet Options dialog box, click the
Content tab to display it.

Click the Enable button; if a confirmation dialog box
appeatrs, click Yes to proceed. (Note: If there is no Enable
button, but there are Disable and Settings buttons instead,
Content Advisor is already enabled. Click the Settings but-
ton to see the options and make changes if you wish.)

On the Ratings tab of the Content Advisor dialog box
(see Figure 18-10), click one of the categories (such as
Depiction of Drug Use) and then move the slider to use
one of three site-screening settings: None, Limited, or
Unrestricted.

Repeat Step 4 for each of the categories.

Click the Approved Sites tab (see Figure 18-11) and enter
the name of a specific site that you want to control access
to. Then click Always or Never.

e Always allows users to view the site, even if it's
included in the Content Advisor screening level
you've set.

e Never means that nobody can visit the site even if
it's acceptable to Content Advisor.

Chapter 18: Staying Safe While Online
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Content Advisor - —

Ratings | Approved Sites I General I Ad\ranc:ed|

Select a category to view the rating levels:
& ICRA3
ZI\ Ry intimidation.
ZI\ Content that sets a bad example for young children
ZI\ Depiction of alcohol use

ZI\ Depiction of drug use
©1 Depiction of gambling T

Adjust the slider to specify what users are allowed to see:

]

MNone
Description

No content that creates feelings of fear, intimidation, etc. in any
context

To view the Intemet page for this rating service,
click Mare Info. —

[ ok || cancel |

Figure 18-10

Enter a Web site here

EContent Advisar e

 Ratings Approved Sites |Genem| IMvanced

@ ‘You can create a list of websites that are always viewable or never

viewablk regardless of how they are rated.

Allow this webpite:

List of approved and disapproved websites:

& alfreeringtone som
& microsoft.com
& onlinegambling US4 com

& wonderfulgames .com

[ ok ][ cancel |[ 2opy

Figure 18-11
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7. When you finish making your settings, click OK; if
prompted to create a supervisor password, do so. Click
OK again to save your settings.

to see, you can do that, too. On the General tab of
the Content Advisor dialog box, make sure that the
Supervisor Can Type a Password to Allow Viewers to
View Restricted Content check box is selected, and
then click Create Password. In the dialog box that
appears, enter the password, confirm it, and then
enter a hint and click OK. Now if you're logged on as
the system administrator, you can get to any
restricted site by using this password.

@ If you want to view sites that you don’t want others

created and apply them to Internet Explorer, click the
Rating Systems button on the General tab. Here you
can choose a system already shown there. Or, click
Add; then, in the resulting Open Ratings System File
dialog box, choose another system to apply.

@ To find rating systems that various organizations have

Understand Information Exposure

Many people think that if they aren’t active online, their information
isn’t exposed. But you aren’t the only one sharing your information:

w= Employers: Many employers share information about
employees. Consider carefully how much information
you're comfortable with sharing through an employee
bio posted on your company Web site. How much
should be visible to other employees on your
intranet? When you attend a conference, is the
attendee list shown in online conference documents?
And even if you're retired, there may still be informa-
tion about you on your old employer’s Web site.
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Review the site to determine if it reveals more than
you'd like it to — and ask your employer to take
down or alter the information if needed.

w= (Government agencies: Some agencies post personal
information, such as documents concerning your
home purchase and property tax (see Figure 18-12),
on publicly available Web sites. Government agen-
cies may also post birth, marriage, and death certifi-
cates, and these documents may contain your Social
Security number, loan number, copies of your signa-
ture, and so on. You should check government
records carefully to see if private information is
posted and demand that it be removed.

& Treasurer - Excise Tax Affidavit Search - Windows Internet Fxplorer = =T
@\_/ 4 |£; hitp://wwwv.co jefferson.wa.us/treasurer/PropertyTaxSearch.asp B "9| X | ‘f' Live Search oo F
g Favorites | 9 & | Suggested Sites ¥ & | Web Slice Gallery ~
: - >
(ETreasurer - Excise Tax Affidavit Search Xiov B v 2 ® v Pagev Ssfetyv Toolsv @

@Jefferson County WASHINGTON

“ Weather Station 7 - DatabaseTools [ Maps = @, Webcam

_ Home  CountyInfo ~ Departments  Search
Property Tax Search

Search by Parcel Number

If you know your parcel number, enter it below then click search, You will be redirected
to the Taw Information Page for this parcel.

Parcel Mumber: | sEARCH |

Search by House Number and Street Name

Figure 18-12

w= Family members and friends: They may write about
you in their blogs or mention you on special-interest
sites such as those focused on genealogy.

w= Clubs and organizations: Organizations with whom
you volunteer, the church you attend, and profes-
sional associations may reveal facts such as your
address, age, income bracket, and how money much
you've donated.
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Newspapers: If you've been featured in a newspaper
article, you may be surprised to find the story, along
with a picture of you or information about your
work, activities, or family, by doing a simple online
search. If you're interviewed, ask for the chance to
review the information that the newspaper will
include, and be sure that you're comfortable with
exposing that information.

Online directories: Services such as www.white
pages.com, shown in Figure 18-13, or anywho.
com list your phone number and address, unless
you specifically request that these be removed. You
may be charged a small fee associated with remov-
ing your information — a so-called privacy tax —
but you may find the cost worthwhile. Online
directories often include the names of members of
your family, your e-mail address, the value of your
home, your neighbors’ names and the values of
their homes, an online mapping tool to provide a
view of your home, driving directions to your home,
and your age. The record may also include previous
addresses, schools you've attended, and links for
people to run background checks on you.

Because services get new information from many
sources, you'll need to check back periodically to see
if your information has again been put online — if it
has, contact the company or go through their
removal process again.

Try entering your home phone number in any brows-
er’s address line; chances are you'll get an online
directory listing with your address and phone num-
ber (although this doesn’t work for cell phone
numbers).

Chapter 18: Staying Safe While Online
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& The Official WhitePages - Find People for Free - Windows Internet Explorer

[= e |2

N P T—— :
@ 2, @ htt whitepages.com
7. Favorites 9% & | Suggested Sites > & | Web Slice Gallery ~

¢ The Official \WhitePages - Find People for Free

paci}

R
'r| KHL ! Live Search

vE—Jv

b l.l"eh > Page~> Safety~ Tools~ 0'

o >

»

WhitePages.com”

SONDX

SRV Y [V ——

%

heta—

Quick Search | iPhone & Mobile | International Resources |

GULIEN People Search | Business Search | Reverse Lookup | Area & ZIP Codes | Add Your Listing
Send Text Messages

People Search [2]|| Business Search .
WhitePages
Basic Seatch | Adwanced Search “Hame or Category k.
FirstHame Makeover
City or ZIP/Postal State/Prov
“Last Hame
[T sawe as defautt location Faster searches
City or ZIP/Postal  State/Prov Fresh '3'3!" & 'IE“i']T
colors ¢ aesig
*required [ Search More ways to connect
*required | search |

Advertise with Us

Eind old high schoal friends Eind old high schoal friends

Figure 18-13

Keep Vour Information Private
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Sharing personal information with friends and family enriches your
relationships and helps you build new ones. The key is to avoid shar-
ing information with the wrong people and shady companies because,
just as in the real world, exposing your personal information online is
one of your biggest risks.

Criminals come in all flavors, but the more savvy ones collect infor-
mation in a very systematic way. Each piece of information is like
another drop of water that, over time, collects to form a very clear pic-
ture of your life. And after criminals collect and organize the informa-
tion, they never throw it away because they may be able to use it many
times over.

Fortunately, information exposure is a risk you have a great deal of
control over. Before sharing information such as your date of birth,
make sure that you're comfortable with how the recipient will use the
information.
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Address and phone number: Abuse of this informa-
tion results in you receiving increased telemarketing
calls and junk mail. Although less common, this
information may also increase a scammer’s ability to
steal your identity and make your home a more
interesting target for break-ins.

Names of husband/wife, father, and mother
(including mother’s maiden name), siblings, chil-
dren, and grandchildren: This information is very
interesting to criminals, who can use it to gain your
confidence and then scam you, or use it to guess
your passwords or secret question answers, which
often include family members’ names. This informa-
tion may also expose additional family members to
ID theft, fraud, and personal harm.

Information about your car: Limit access to license
plate numbers; VINs (vehicle identification num-
bers); registration information; make, model, and
title number of car; your insurance carrier’s name
and coverage limits; loan information; and driver’s
license number. The key criminal abuse of this infor-
mation includes car theft (or theft of parts of the car)
and insurance fraud. The type of car you drive may
also indicate your financial status, and that adds one
more piece of information to the pool of data crimi-
nals collect about you.

Information about work history: In the hands of
criminals, your work history can be very useful for
“authenticating” the fraudster and convincing people
and organizations to provide them with more of
your financial records or identity.

Information about your credit status: This informa-
tion can be abused in so many ways that any time
you're asked to provide this online, your answer
should be no. Don't fall for the temptation to check

Chapter 18: Staying Safe While Online
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your credit scores for free through sites that aren't
guaranteed reputable. Another frequent abuse of
credit information is found in free mortgage calcula-
tors that ask you to put in all kinds of personal
information in order for them to determine what
credit you qualify for.

Many people leave messages on their e-mail letting
people know when they’ll be away from their offices.
This is really helpful for colleagues, but exercise cau-
tion and limit who you provide the information to.
Leaving a message that says, “Gone 11/2-11/12. I'm
taking the family to Hawaii for ten days,” may make
you a prime target for burglary. And you'll probably
never make the connection between the information
you exposed and the offline crime.

You may need to show your work history, particu-
larly on resumes you post on Internet job or
business-networking sites. Be selective about where
you post this information, create a separate e-mail
account to list on the resume, and tell what kinds of
work you've done rather than give specifics about
which companies and what dates. Interested, legiti-
mate employers can then contact you privately, and
you won't have given away your life history to the
world. After you've landed the job, take down your
resume. Think of it as risk management — when you
need a job, the risk of information exposure is less
than the need to get the job.

Spot Phishing Scams and Other E-mail Fraud

As in the offline world, the Internet has a criminal element. These
cybercriminals use Internet tools to commit the same crimes they've
always committed, from robbing you to misusing your good name
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and financial information. Know how to spot the types of scams that
occur online and you'll go a long way towards steering clear of
Internet crime.

Before you click a link that comes in a forwarded e-mail message or
forward a message to others, ask yourself:

w= s the information legitimate? Sites such as www .
truthorfiction.com, www.snopes.com (see
Figure 18-14), or http://urbanlegends.
about . com can help you discover if an e-mail is
a scam.

/2 snopes.com: Urban Legends Reference Pages - Windows Intemet Explorer =

File Edit View Favorites Tools Help

Links g | Customize Links

S o 25 |4 Windows Live Hotmail &) snopes.com: Urban Leq... o Bl v @ v |:kPage ¥ (iTools » "t
. Quick Search [Fa] | (€]~ Tvos your se=rch fiere. = Lo Search web ~ | Look for File 'l Services (17) = | |4 Web Security Guard » o = & | customize = | Crawier’ ~
& Pop-up blocked. Also, to help protect your security, Internet Explorer blocked other contentfrom this site. Click here for options x

%
WERERIGHIRIHERE [SHOPROW
nopes WIULERYOU weees oo DAL
pes.con
Rumnor Has It
What's New Randomizer Hot 25 FAQ Odd News Glaossary Newslefter Message Board
CATEGORIES:
» Autos
= Business
o T e Man Falling: Photograph shows man falling from a skyscraper while occupants

grasp at him through a window.
- College

» Computers

Figure 18-14

w= Does a message ask you to click links in e-mail or
instant messages? If you're unsure whether a mes-
sage is genuinely from a company or bank that
you use, call them, using the number from a past
statement or the phone book. Remember: Don't call
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a phone number listed in the e-mail; it could be
fake. To visit a company’s or bank’s Web site, type
the address in yourself if you know it or use your
own bookmark rather than clicking a link. If the
Web site is new to you, search for the company using
your browser and use that link to visit its site. Don't
click the link in an e-mail, or you may land on a site
that looks right — but is just a good fake.

w= Does the e-mail have a photo or video to down-
load? If so, exercise caution. If you know the person
who sent the photo or video, it’s probably fine to
download, but if the photo or video has been for-
warded several times and you don't know the person
who sent it originally, be careful. It may deliver a
virus or other type of malware to your computer.

In addition to these questions, also remember the following:

w= If you decide to forward (or send) e-mail to a
group, always put their e-mail addresses on the
Bcc: (or Blind Carbon Copy) line. This keeps every-
one’s e-mail safe from fraud and scams.

w= Think before you click. Doing so will save you and
others from scams, fraud, hoaxes, and malware.

Create Strong Passwords
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A strong password can be one of your best friends in protecting your
information in online accounts and sites. Never give your password to
others, and change passwords on particularly sensitive accounts, such
as bank and investment accounts, regularly.

Table 18-1 outlines five principles for creating strong passwords.
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Table 18-1 Principles for Strong Passwords

Principle How to Do It

Length Use at least ten characters.

Strength Mix it up with upper- and lowercase letters, characters, and
numbers.

Obscure Use nothing that's associated with you, your family, your
company, and so on.

Protect Don't place paper reminders near your computer.

Change The more sensitive the information, the more frequently you

should change your password.

Look at Table 18-2 for examples of password patterns that are safe but
also easy to remember.

Table 18-2 Examples of Strong Passwords

Logic Password

Use a familiar phrase typed with a varia- L8r_L8rNot2day = Later, later, not
tion of capitalization and numbers today

instead of words (text message

shorthand).

2BorNot2B_ThatIsThe? = To be or
not to be, that is the question.

Incorporate shortcut codes or acronyms. CSThnknAU2day = Can't Stop
Thinking About You today

2Hot2Hndle = Too hot to handle

Create a password from an easy to 1mlooklngatyahoo = I'm looking at
remember phrase that describes what Yahoo (We replaced the Is with 1s.)
you're doing, with key letters replaced by

numbers or symbols.

MyWork@HomeNeverEnds

(continued)
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Table 18-2 (continued)

Logic

Password

Spell a word backwards with at least one
letter representing a character or number.

$1idoffaD = Daffodils (The $ replaces
the s.)

ylfrettuB = Butterfly (The 1 replaces
the 1)

QWERTY7654321 = This is the 6 letters
from left to right in the top row of your
keyboard, plus the numbers from right to
left across the top going backwards.

Use patterns from your keyboard. (See
Figure 18-15.) Make your keyboard a
palette and make any shape you want.

1QAZSDRFBHUS is really just making
a W on your keyboard. (Refer to
Figure 18-15.)

Figure 18-15
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Keeping In Touch
with E-Mail

A n e-mail program is a tool you can use to
send text messages to others. These mes-
sages are delivered to their e-mail inbox, usually
within seconds. You can attach files to e-mail
messages and even put graphic images within
the message body. You can get an e-mail
account through you Internet provider or
through sites such as Yahoo! and Microsoft
Live Hotmail. These accounts are typically free.

When you have an e-mail account, you can
send and receive e-mail through the account
provider’s e-mail program online, or you can
set up a program on your computer, such

as Microsoft Outlook, which comes with
Microsoft Office, or Windows Live Mail, which
is built into Internet Explorer to access that
account. These programs typically offer more
robust e-mail and contact management fea-
tures than the programs that providers such as
Yahoo! offer.

To make your e-mailing life easy, this chapter
takes a look at these tasks:

w= Choose an e-mail provider. Find out
how to locate e-mail providers and what
types of features they offer.

| “*op’rer

19

Getready to...

w= Set Up an Internet-Based

E-mail Account......ccooveveiiinnnn 312
m= Manage Accounts in

Windows Live..........ccoeoernnn. 314
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Live Mail ...oooviiiiic 316
w=» Open Windows Live Mail

and Receive Messages ............. 319
w= Create and Send E-Mail............ 321
w=» Send an Aftachment ................. 325
wep Read a Message..................... 327
w= Reply to a Message.................. 328
w Forward E-Mail ..........ccccevnee. 330
w= Create and Add a Signature ..... 331
w= Format E-Mail Messages ........... 333
wep Apply a Theme ........cccovevvnennen, 335

w=» Add People to the Contact List... 337

wm» Customize the Reading Pane

w= Create Message Folders ........... 340
w= Organize Messages in Folders... 342



Part lll: Exploring the Internet

w= Manage your e-mail account. Make settings to send
out messages with different e-mail addresses if you
want to forward more than one e-mail account to
Windows Live Mail so you can check all your mes-
sages in one place. This is useful if you use both
work and home e-mail accounts, for example.

w= Receive, send, and forward messages. Deal with the
ins and outs of receiving and sending e-mail. Use the
formatting tools that Windows Live Mail provides to
make your messages more attractive and readable.

w= Add information into the Address Book. You can
quickly and easily manage your contacts as well as
organize the messages you save in e-mail folders.

w= Set up the layout of all Windows Live features. Use
the Folder bar and Layout features to create the most
efficient workspace.

Set Up an Internet-Based E-Mail Account
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Your Internet service provider (ISP), whether that’s your cable or

phone company or a small local provider, probably offers you a free
e-mail account along with your service. You can also get free accounts
from many online sources, such as Yahoo!, AOL, Gmail, and Windows

Live Mail.
Here are some tips for getting your own e-mail account:

w= Using e-mail accounts provided by an ISP: Check
with your ISP to see whether an e-mail account
comes with your connection service. If it does, your
ISP should provide instructions on how to choose an
e-mail alias (that is the name on your account, such
as SusieXYZ@aol.com) and password and sign in.
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2

2

2

Searching for an e-mail provider: If your ISP
doesn’t offer e-mail, or you prefer to use another ser-
vice because of features it offers, use your browser’s
search engine to look for what's available. Don’t use
the search term “free e-mail” because results for any
search with the word free included are much more
likely to return sites that will download bad pro-
grams like viruses and spyware onto your computer.
Alternatively, you can go directly to services such as
Yahoo, AOL, or Gmail by entering their addresses in
your browser’s address box (for example, www .
gmail.com).

Finding out about features: E-mail accounts come
with certain features that you should be aware of.
For example, they each provide a certain amount of
storage for your saved messages. (Look for one that
provides 4 gigabytes or more.) The account should
also include an easy-to-use Address Book feature to
save your contacts’ information. Some services pro-
vide better formatting tools for text, calendar, and
to-do list features. Whatever service you use, make
sure it has good junk-mail features to protect you
from unwanted e-mails. You should be able to con-
trol junk-mail filters to place messages from certain
senders or with certain content in a junk-mail folder
where you can review or delete them.

Signing up for an e-mail account: When you find
an e-mail account you want to use, sign up (usually
there will be a Sign Up or Get An Account button or
link to click) by providing your name and other con-
tact information and selecting a username and pass-
word. The username is your e-mail address, in the
form of UserName@service. com, where the
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service is, for example, Yahoo, Windows Live Mail,
or AOL. Some usernames might be taken, so have a
few options in mind.

w= Make sure your username is a safe one: Don't use
your full name, your location, age, or other identifi-
ers if possible. Such personal identifiers might help
scam artists or predators to find out more about you
than you want them to know.

Manage Accounts in Windows Live
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1.

In addition to providing your Windows Live e-mail
address so others can send you mail directly, you can use
settings in various e-mail programs to forward your mail
to your Windows Live address so you can receive all your
e-mail messages in one place. You can then make settings
in Windows Live to use other e-mail addresses when
responding to messages so your recipients assume the
messages are coming from the originating account.
Follow these steps to set up your accounts in Windows
Live Mail. Open your browser and type www .mail.
live.com in the address field and press Enter.

. Windows opens your default browser and displays the

Windows Live Mail sign-in window shown in Figure 19-1.
If you need to start a new account at this point, click the
Sign Up button and go through the sign-up procedure. If
you already have an account, click the Sign In to Windows
Live button and enter your password in the field that
appears, and then click the Sign In button to sign in.

Click on the Mail link to go to the Mail portion of
Windows Live.

Choose Options=>More Options. In the resulting Options
window, shown in Figure 19-2, click the Send and
Receive Mail from Other E-Mail Accounts link.
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5. In the resulting window (see Figure 19-3), click the Add
Another Account to Send Mail From link.

6. In the following screen, enter an e-mail address and click
the Send Verification E-mail button. An e-mail is sent to
that account. Open the account and view the e-mail.
Click the link in the e-mail to verify that it's okay for
Windows Live to send e-mail with that address on it.

7. Once verified, you are set up to send out messages with
that account name. In a new e-mail form, simply click
the arrow on the right of the From field and select the
account you want the message to go from.

& Sign In - Windows Internet Explorer =x
& Sign In - Wind, 1 Expl o [ &S

laginlive.cam/login.sfwa=wsignind Ja&rpsny=11&ct=1250525510&ner=5.5.4177 0awp=MBlawr V|V7| % | [© sing o

@-\L}-v |a":‘.=.':
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P AT o
&7 Windows Live
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Haotmail Sign in

-“_-gl zsgﬁmj‘ Microsoft technology helps fight spam and improve 33 windows Live 10 |
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1 Get more done thanks to greater ease and speed,
- Enjoy 5 B of storage that grows when vou need it. More coal Password;
stuff on the way. Forgot your password?
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sign up |

Use enhanced s=curity
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Figure 19-1
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Click this link

@ Windows Live Hotmpil - Windows Intermet Explorer =TEE
@Q = |-f' nttp://mdil.live.com/7rru=inbox ¥ | ‘7| X | ‘P Live Search 2z
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| Windows Live Hotmail = B v e g Sately e Tacky @
i Y £
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Windows Live Send and receive mail from other e-mail accounts
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Figure 19-2

Get to Know Windows Live Mail

Windows Live (see Figure 19-4) is typical of many e-mail programs
in that it includes both menus and tools to take actions such as
deleting an e-mail, creating a new e-mail, and so on. There’s also a
list of folders on the left. Some typical folders are your Inbox, where
most incoming mail appears; your Outbox or Drafts folder, where
saved drafts of e-mails are saved ready to be sent; and your Sent
folder, where copies of sent e-mails are stored.
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Figure 19-3

Finally, the central area of the screen may display folder contents or, if
you are creating or viewing a message, a preview pane that shows the
contents of a selected message in the Inbox or other folder (in Figure
19-4, the contents of a message being composed are displayed).

To organize messages in the Inbox, click the Sort By
drop-down list and select an option, such as From
(to sort the messages alphabetically by sender),
Received (to sort by the date they were received), and
SO on.
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Folders Preview pane Toolbar
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Figure 19-4

When you access Windows Live Mail and many of
the other online e-mail services, you are using a pro-
gram that is hosted online, rather than software on
your computer. That makes it easy to access your
mail from any computer because your messages and
folders are kept online. If you use an e-mail program
such as Outlook, the software and your messages are
stored on your computer.
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Open Windows Live Mail and Receive Messages

1. Use your browser to go to Windows Live (www.mail.
live.com).

2. Windows opens your default browser and displays the
Windows Live sign-in window shown in Figure 19-5.

E Home - Windows Live - Windows Internet Explorer o e =]
@Q - |."’ http://home five.com/?showunauth=18mcid= WL Wave3lntro &2 | 4',| X | \-7? free games o~
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Free downloads | More about mobile

Done & & Internet | Protected Mode: On ®100% -

Figure 19-5

3. Click on the Sign In to Windows Live button and enter
your password in the field that appears, and then click
the Sign In button to sign in. Windows Live automati-
cally sends and receives all messages.
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4. Click the Mail link at the top of the page, if necessary, to
view your Inbox, shown in Figure 19-6. New messages
sport a small closed envelope icon; those with attach-
ments have a paper clip icon as well.

Messages in the Inbox
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Figure 19-6

If your mail doesn’t come through, it's probably
because your e-mail provider’s servers are experienc-
ing technical problems. Just wait a little while. If you
still can’t get mail, make sure your connection to the
Internet is active. Your browser may show you your
Inbox, but if you've lost your connection, new mes-

sages can't be received.

Note that if an e-mail has a little exclamation point
next to it in your Inbox, somebody has flagged it as
urgent. It's usually best to check out those e-mails

first!
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Create and Send E-Mail

1. Creating e-mail is as simple as filling out a few fields in a
form. Open Windows Live Mail in your browser (www .
mail.live.com).

2. Sign in, and then click the Mail button on the Windows
Live Mail screen, if needed, to go to your Inbox.

3. Click the New button to create a new, blank e-mail form
(see Figure 19-7).

A new, blank e-mail
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Figure 19-7

4. Type the e-mail address of the recipient(s) in the To field
text box. If you want to send a copy of the message, click
the Show Cc & Bcc link and enter an address(es) in the
Cc or Bcc field text box.
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5. Click in the Subject field text box and type a concise yet
descriptive subject.

6. Click in the message window and type your message (see
Figure 19-8).

Enter your message here
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Figure 19-8

Don't press Enter at the end of a line when typing a
message. Windows Live has an automatic text wrap
feature that does this for you. Do be concise. If you
have lots to say, consider sending a letter by snail
mail or overnight delivery. Most people tire of read-
ing text on-screen after a short while.

Keep e-mail etiquette in mind as you type. For exam-
ple, don't type in ALL CAPITAL LETTERS. This is
called shouting, which is considered rude. Do be
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polite even if you're really, really angry. Your message
could be forwarded to just about anybody, just about

anywhere, and you don’t want to get a reputation as
a hothead.

7. When you finish typing your message, you should check
your spelling (unless you're the regional state spelling
champ). Click the Spell Check button and Windows Live
automatically checks spelling and places a red, wavy line
under questionable words (see Figure 19-9). Correct any
errors. If you add more text to your message and want to

check the new text for spelling, click the Spell Check but-
ton again.
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Figure 19-9

8. Click the Send button. A messages appears like the one in
Figure 19-10 telling you the message is on its way!
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Confirmation of a sent message
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Figure 19-10

If the message is really urgent, you might also click
the High Importance button (it looks like a red
exclamation point) to add a bright red exclamation
mark to the message header to alert the recipient.
Click the Low Importance button (it looks like a
blue, downward-pointing arrow) to return the
priority to Low.

Remember that when creating an e-mail, you can
address it to a stored address by using the Address
Book feature. Click the To button, and your Address
Book appears. You can then select a contact(s) from
there. Windows Live Mail also allows you to just
begin to type a stored contact in an address field (To
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or Cc), and it provides a list of likely options while
you type. Just click on the correct name when it
appears in the list to enter it.

Send an Attachment

1. It's very convenient to be able to attach a document or
image file to an e-mail that the recipient can open and
view on his end. To do this, go to www.mail.live.com,
sign in, and click on Malil if necessary. Click New to create
a new e-mail message, address it, and enter a subject.

2. Click the Attach button.

3. The Choose File to Upload dialog box appears (see
Figure 19-11). Locate the file that you want and then
click Open.
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'\:j“\:j' |~ v Libraries » Documents » - |v,| | Search Documents 2|
Organize = Mew Folder B ~ [l '9'

- Favorites Document... Arrange by Folder = Includes: 2 library locations

1 Recently Change
Public My Received Files 1/23/2009 =
f
BE Desktop A
- Downloads I My Scans 1/23/2009

= Recent Places
Playlists My Stationery /23,2009
f

Sample Music

\E, My Web Sites
Libraries
[ Documents PCs TS Revision 1/23/2009
o Music !
| Pictures Personal 1/23/2009
= videnc = L i
File name: | v [AllFiles () -

| Open | | Cancel |

Figure 19-11
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4. The name of the attached file appears in the Attach field
text box (see Figure 19-12) indicating that it’s uploading.
When the first attachment finishes uploading, you can
click the Attach button again and repeat Step 3 as many
times as you like to add additional attachments.

An attached file

‘€ Windows Live Hotmail - Windows Internet Explorer e | o =se

@\_} - | 4 http://maillive.com/Trlu=inbox 54 | ‘7| A | ‘f' Live Search BT
File Edit View Favorites Tools |Help

77 Favorites | 4 Windows Live Hotmisil Fi - B ~ 1 & v Pagev Safety~ Tooks~ @~ 7
£7 Windows Live™ Home Profile People Mail Photos Morew MSNw Search the web E| Helen~
sgnout

Hotmail send | Safe draft attach ;| Spell check Richtextv | # } | Cancel Optionsv @@ v
copperglow@msn.com Frojn: copperglow®@msn.com » Show Cc & Bee 7 Snete

Inbox || ;

To _| MuirWords@acl.com Choose the type of info you'd

Junk Fhcb fhe TRt BLHER te © = like to add to your message.

Eirans Subjgct: | Association conference Maps

Sent .

0 Total size: 0.0 KB of 10.0 MB _— "
Deleted (14) . = estaurants
" scand002.jpg (Uploading... | Cancel)
Manage folders Movie times
A e = v IESSITITEERS S AW G

Related places % 3 @ | verdana x S - Images

Today 2

I need a lift to the conference on Tuesday. Is there a chance you can pick me up? Videos
Contact list
Ealondar Also, are the flyers printed yet? If you need help with that, let me know. Business listings
George
Rediscover
Hotmail >

Figure 19-12

5. Click the Send button to send the message and
attachment.

You can attach as many files as you like to a single
e-mail by repeating steps in this task. Your limitation
is size. Various e-mail programs have different limita-
tions on the size of attachments, and some prevent
you from attaching certain types of files for security
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reasons. If you attach several documents and your
e-mail fails to get sent, just send a few e-mails and
spread the attachments out among them.

Read a Message

1. When you receive an e-mail, your next step is to read it.

Click an e-mail message in your Inbox or double-click it
to open it in a larger window. Unread messages sport an
icon of an unopened envelope to the left of the message

subject.

2. Use the scrollbars in the message window to scroll down

through the message and read it (see Figure 19-13).
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copperglow@msn.com  Reply Reply all Forward = &4

Inbox

& Live H il - Wind Internet Explorer [ |[=F ]
@\_/ " | & http://mail live.com/Trru=inbox - | Vy| x | |:' Live Search P
File Edit Yiew Favorites Tools Help
57 Favorites I Windows Live Hotmail M v B v [ ™ v Pagev Safetyv Toolsv i@~ &
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£7 Windows Live™ Home Profile Pecple Mail Photos Morev MSNy Segrch the web E}‘ Helen~
sign out
Hotmall Mew Delete Junk Markasv Movetor Options v @~

=T The next version of the proposal
Drafts From: Nancy Muir (nmuir@inbox.com)
Sent: Sun 4,/05/09 1:45 PM
Sent i
copperglow@msn.com
Deleted (12) 01 attachment Byt
Manage folders FY 2010 R..doc (70.5 KE
Related places
a T've attached the funding proposal. Can you download it and look it over?
Today
Contact list 1focussed on the budget information on this round. I think we're in pretty good shape, but I'll check in with
Andreas tomorrow on his piece of this,
Calendar
Please give me a call tomorrow and et me know if you have questions,
L}
o iaad Antoinette DON T Pay
For
Free Online Photosharing - Share your photos online with your friends and family! Whlte TEeth
Visit http://www.inbox.com/photosharing to find out more!
The Secret

Figure 19-13
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3. If the message has an attachment, it shows a paper clip
symbol when the message is closed in your Inbox; attach-
ments are listed in the open message. To open an attach-
ment, click it.

4. In the File Download dialog box (see Figure 19-14), click
the Open button to open the file with the suggested pro-
gram. The attachment opens in whatever program is asso-
ciated with it (such as the Windows Fax and Picture
Viewer for a graphics file) or the program it was created
in (such as Microsoft Office Word).

your hard drive, click the Save button in Step 4,
choose the location to save the file to, and then click
Save.

@ If you'd rather save an attachment to a storage disc or

File Download (==

Do you want to open or save this file?

@ j Name: FY 2010 Request -- Murray[i].doc
Type: Microsoft Office Word 97 - 2003 Document, 94.0...

From: 65.55.40.119

Open | [ Save | F Coned |

I £ 1 While files from the Intgmet can be useful, some files can potentially
a ham your computer. f fou do not trust the source, do not open or
ks save this file. What's tHe risk?

Click Open
Figure 19-14

Reply to a Message

1. If you receive an e-mail and want to send a message
back, use the Reply feature. Open the message you want
to reply to, and then select one of the following reply
options, as shown in Figure 19-15:
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e Reply: Send the reply to only the author.

e Reply All: Send a reply to the author as well as to
everyone who received the original message.

2. In the resulting e-mail form (see Figure 19-16), enter
any additional recipient(s) in the To and/or Cc or Bcc
text boxes and type your message in the message
window area.

3. Click the Send button to send the reply.

Select a reply option

& http//mail live.com|

Frru=inbox

- ‘iﬂ_x‘ |£:r Live Search

Fle Edit View Favorites Tools

Help

i Favorites |d} Windows Live Hol
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i r B -~ e v Page~

Safety v Tools» Ov B

£7 Windows Live™
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copperglow@msn.com
Junk
Drafts
Sent
Deleted (12)
Manage folders
Related places
Today
Contact list

Calendar

¥

* Safere-mall
Rediscover
Hotmail > |

Privacy >

‘Home Profile People Mail Photos Morev Search the web

New | [elete Junk | Markas v Moveto | B8
Reply Reply all' Forward | & 4 X

The next version of the proposal

From: Nancy Muir (nmuir@inbox.com)
Sent: Sun 4/05/09 1:45 PM
To:  copperglow@msn.com
B 1 attachment
FY 2010 R...doc (70.5 KB)

T've attached the funding proposal. Can you download it and lock it over?

Ifocussed on the budget information on this round. I think we're in pretty good shape, but I'll check in with
Andreas tomorrow on his piece of this.

Please give me a call tomorrow and let me know if you have questions.

Antoinette

Free Online Photosharing - Share your photos online with your friends and family!
Visit http://www.inbox.com/photosharing to find out more!

Figure 19-15
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Enter recipients here

£ Windows Live Hotmail - Windows Internet Explorer
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File Edit View Favorites Tools Help
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Please give me a call tomorrow and let me know if you have questions.
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Free Online Photosharing - Share your photos online with your friends and family!
Visit bttp//www.inbox.com/photosharing te find out more!

Inbox To: | nmuir@inbox.com * |~ Choose the type of info you'd
Junk Click e : like to add to your message.
Drafts 1 - .
Subject: | RE: The next version of the proposal Maps
Sent
> | v v EEE=E =T IEE=E A= AW
Deleted (12) % 52 @ verdana 10 B! UEEEEEEEREA Restaurants
Manage folders Sounds good | Movie times
Related places Imaqes
o Date: Sun, 5 Apr 2009 12:45:53 -0800 -
ey From: nmuir@inbox.com Videos
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I've attached the funding proposal. Can you download it and look it over?
3 1 focussed on the budget information on this round. I think we're in pretty good shape, but I'll
rediscover | | ! ; check in with Andreas tomorrow on his piece of this.
Hommail > | N

Figure 19-16

Forward E-Mail

1. To share an e-mail you receive with others, use the
Forward feature. Open the e-mail message that you want
to forward.

2. Click the Forward button on the toolbar.

3. In the message that appears with FW: added to the begin-
ning of the subject line, enter a new recipient(s) in the To
and/or Cc and Bcc fields, and then enter any message
that you want to include in the message window area, as
shown in the example in Figure 19-17.
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Enter your message here

‘& Windows Live Hotrfail - Windows Internet Explorer o s
@\_/ - | #! http://nfail.live.com/Tru=inbox = | *?| A | |f’ Live Search P
File Edit Miew Favortes Tools Help
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Manage folders
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% 53 @ Verdana |10+ BI U= =
Related places Images
Today L _Check out Antoinette's update on this.
E Videos
Contact list
Babnikar Date: Sun, 5 Apr 2009 12:45:53 -0800 Business listings
From: nmuir@inbox.com
Subject: The next version of the proposal
To: copperglow@msn.com
Rediscover
Hotmail >

I've attached the funding proposal. Can you download it and look it over?
1 focussed on the budget information on this round. I think we're in pretty good shape, but I'l
check in with Andreas tomorrow on his piece of this.

Figure 19-17

4. Click Send to forward the message.

Create and Add a Signature

1. A signature is a quick way to add some closing informa-
tion such as your name and organization to the end of
every message. Choose Optionse>More Options to open
the Options page. Click the Personal E-mail Signature
link (under Customize Your Mail) (see Figure 19-18).

2. In the Personal E-mail Signature form that opens (see
Figure 19-19), type your signature. Use the tools on the
toolbar to change the text formatting, such as changing
the font or font size or applying effects such as bold or
italic to it.
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‘& Windows Live Hotmail - Windows Internet Explorer =0 |
@\J - | Y http://mail.live.com/Trru=inbox bl | '9| X | ‘f' Live Search 2Lz
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Hotmail Options
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Offers
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Today
Contact list
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Select language
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Figure 19-18
3. Click Save to save the signature.

If you have a Web site and want to include a link to it
in your signature, click the Insert Hyperlink button in
the toolbar shown in Figure 19-19. Enter the address

in the text box that appears and then click OK.

Remember that if you attach your signature to every
outgoing e-mail including e-mail replies, whoever
you communicate with will get the information
provided there. Consider issues of identity theft
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before you provide your address, phone number, and
other personal information to all and sundry.

Enter your signature here

‘& Windows Live | il - Windows Internet Explorer _———— ][]
@\J . | B hitd//mail live.com/rmi=inbox -Iv,| x | |ff TieSeanch P~
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sgn out
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Show options fo
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Mail I E
-
S Helen Voss
Offers Paradigm Electronics|

Free newsletter)s

Related places

Today
Contact list

Calendar

Reciscover
Hotmail >

| Save ‘ ‘ Cancel |

Figure 19-19

Format E-Mail Messages

1. Windows Live provides tools to format the text in your
message to change fonts, add color, and more, just as you
would in a word-processing document. Create a new
e-mail message or open a message and click Reply or
Forward.

2. Enter text, and then select the text that you want to for-
mat (see Figure 19-20).
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Figure 19-20

3. Use any of the following options to make changes to the
font. (See the toolbar containing these tools in Figure
19-21.)

e Font Name drop-down list: Choose an option
from the drop-down list to apply it to the text.

¢ Font Size drop-down list: Change the font size
here.

¢ Bold, Italic, and Underline buttons: Apply styles
to selected text.

e Justify Left, Justify Center, and Justify Right but-
tons: Adjust the alignment.

e Insert Ordered List and Insert Unordered List
buttons: Apply numbering order to lists or precede
each item with a round bullet.
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e Unindent and Indent buttons: Indent that para-
graph to the right or move (decrease) it to the left.

¢ Insert Hyperlink button: Use this to insert a
hyperlink to another Web site or document.

¢ Insert Horizontal Rule button: Insert a line divid-
ing the signature from the message body.

e Foreground Color button: Display a color palette
and click a color to apply it to selected text.

¢ Background Color button: Add color to the back-
ground of the message.

¢ Insert Emoticon button: Click this to view a selec-
tion of graphical smiles and other images to
include in your signature for a bit of fun.

Unindent and Indent options

Ordered and Unordered Lists | Insert Hyperlink
Justify options Horizontal Rule
Bold, Italic, and Underline Foreground Color
Font Size Background Color
Font I|\Iome |||15erf Emoticon

Figure 19-21

Apply a Theme

1. You can modify the appearance of Windows Live Mail by
applying a theme which contains preset designs and col-
ors to the window. Choose Optionsw>More Themes.

2. In the Themes page that appears (see Figure 19-22), click
on a theme from the list.

335



Part lll: Exploring the Internet

£ Windows Live Hotmail - Windows Internet Explorer

—— R T EXR

@\J - |.r‘ hittp://mail.live.com/7rru=inbax v|+¢| x ||-7_’ Live Search L2 -
File Edit View Favorites Tools Help
= 7 7 T s »
i Favorites |23~ | 4 Windows Live Hot.. | @& Nanotechnology Made... | € Look Both Ways: Clears... fi ~ B ~ = d® - Poger Safety~ Teols~ @~
Py Al o : 2 p—— T ,'
&7 Windows Live Home Profile People Mail Photos Morey MSMN* ’ Search the web E‘ Nancy ¥ ||@
sign out

Y =] »
Themes "N e -1 3
‘Windows Live » Options » Themes w "K 2 v‘-‘. 8 i
s P ) e
» .
1

Standard themes

Themes appear on all Windows Live pages except Events and Spaces.

| Y@
Lo X
Dynamic themes

Dynamic themes change on your Home and Profile pages, depending on things like time of day or weather.

=

&l

2 |
'R
15 ”

© 2009 Microsoft | Privacy ‘ Legal

Help Central ‘ Account | Feedback

Done & € Internet | Protected Mode: On

100% ~

Figure 19-22

3. Click Save to apply the stationery to Windows Live Mail,
and click the Mail link to return to your Inbox sporting
the new look (see Figure 19-23).

If you are the visual type, you should know that you
can also insert a picture in an e-mail message. With
the e-mail form open, click the Images item in the
Quick Add pane to the right. Enter a search term in
the Search field text box to find an image online, and
then click on any image result to insert it in your
e-mail. You can also use Quick Add to add a map,
movie time, video, business listing, or restaurant
information.
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Figure 19-23

Add People to the Contact List

1. To make addressing e-mails faster, you can save people’s
e-mail addresses and more in a Contact List. In the
Windows Live Mail main window, click the Contact List
link in the left pane to open the People page, as shown
in Figure 19-24.

2. To create a new contact, click the New button.
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Figure 19-24

3. In the resulting Contact dialog box, as shown in Figure
19-25, enter contact information:

e Name and E-mail: Enter the person’s first name
and last name. (This is the only information you
must enter to create a contact.)

¢ Personal Information: Enter the person’s e-mail
address, home and mobile phone numbers, and
home addresses.

¢ Business Information: Enter information about
the company that the person works for as well as
his work e-mail, phone, fax, and address.

e Other Information: Enter any other e-mail,
phone, Web site, or birthday information for the
person.
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Figure 19-25

4. Click Save to save your new contact information, and
then click Mail to return to your Inbox.

You can search contacts by clicking on People in any
Windows Live window and entering search text in
the Search Your Contact List field. You can also click
on the letters listed across the top of the Contacts
window to look for people whose last names begin
with that letter.

Customize the Reading Pane Layout

1. You can modify the layout of elements in the Windows Live
main page to suit you. In the Mail portion of Windows Live,
choose Optionst>More Options to open the Options win-
dow. Click on the Mail link in the left pane.
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2. Click on Reading Pane Settings (under Customize Your
Mail). Select various options in the Reading Pane
Settings, as shown in Figure 19-26, to modify where the
reading pane appears and when to show messages in the
reading pane.

£ Windows Live Hotmail - Windows Internet Explorer o | ]
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© show the first message automatically

Related places
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Contact list Save Cancel

Calendar
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Hotmail >

Figure 19-26

3. Click Save to save your reading pane settings.

Create Message Folders

1. Message folders are a way to organize your incoming
messages so you can find them easily. You can create
folders with a few simple steps. Choose the Manage
Folders link near the bottom of the list of folders within
the Inbox in the left pane to open the Manage Folders
window shown in Figure 19-27.
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The Manage Folders link
Figure 19-27

2. Click New.

3. In the New Folder dialog box (see Figure 19-28), enter a
folder name and click Save.

4. Click Mail to return to your Inbox.

If you want to remove or rename a folder, you can
use the tools in the Manage Folders window shown
in Figure 19-27 to do so.
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Enter a name for the new folder

‘€ Windows Live Hotmail - Windows Internet Explore|
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Liniversity of
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Bachelor of Science in
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Figure 19-28

Organize Messages in Folders

1. To move a message in your Inbox into a folder, select the
checkbox in front of the message and choose Move
To>[Folder Name], as shown in Figure 19-29.

2. To move a message between folders, with a folder (such
as the Inbox) displayed, click a message and then drag it
into another folder in the Folders list.

3. To delete a message in a folder, click the folder name to
open it and click the checkbox in front of the message.
Click Delete.

If you want to mark a message as junk mail so that
Windows Live Mail puts any message from that
sender in the Junk folder going forward, click the
checkbox in front of the message and then click Junk.
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Connecting with
People Online

The Internet offers many options for connect-
ing with people and sharing information.

You'll find discussion boards and chat sites on
a wide variety of sites, from news sites to recipe
sites, sites focused around grief and health
issues, and sites that host political- or con-
sumer-oriented discussions.

There are some great senior chat rooms for
making friends, and many sites allow you to
create new chat rooms on topics at any time.

Instant messaging (IM), on the other hand,
isn't a Web site but a service. Using software
such as Windows Live Messenger, IM allows
you to chat in real time with your contacts.
You can access instant messaging programs via
your computer or your cell phone.

As with any site where users share information
such as social networks and blogs, you can stay
safer if you know how to sidestep some abuses,
including data mining (gathering your per-
sonal information for commercial or criminal
intent), social engineering ploys that try to
gain your trust and access to your money, ID
theft scams, and so forth. If you're careful to
protect your privacy, you can enjoy socializing
without worry.
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In this chapter, I look at some ways of sharing information and tell
you how to do so safely.

Use Discussion Boards

346

1.

A discussion board is a place where you can post written messages, pic-
tures, and videos on a topic. Others can reply to you, and you can
reply to their postings.

Discussion boards are asynchronous, which means that you post a mes-
sage (just as you might on a bulletin board at the grocery store) and
wait for a response. Somebody might read it that hour — or ten days
or several weeks after you make the posting. In other words, the
response isn’t instantaneous, and the message isn't usually directed to
a specific individual.

You can find a discussion board about darn-near every topic under the
sun, and these are tremendously helpful when you're looking for
answers. They're also a great way to share your expertise — whether
you chime in on how to remove an ink stain, provide history trivia
about button styles on military uniforms, or announce the latest
breakthroughs in your given field. Postings are likely to stay up on the
site for years for people to reference.

To try one, enter this URL in your browser’s address field:
www.microsoft.com/communities/newsgroups/
en-us/default.aspx. (Note that some discussion
boards require that you become a member with a user
name and sign in before you can post, though this site
doesn't.)

On the left side of the screen, click English (or another
language of your choice) and then click a topic area, such
as Home and Entertainment.
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3. In the topic list that appears, click another topic, such as
Games, to see more options. Continue to click until you
get to a specific discussion board, such as the one shown
in Figure 20-1.

4 Discusslons In Age of Empires - Opera
File Edit View Bookmarks Widgets Tools Help

[ Discussions in Age .. €3

United States Change | All MigosoftSites | Signin &

Microsoft Discussion Groups Home Communities Home Communities Worldwide

Discussions in Age of Empires | 84 | Help |2 Sign®
English
+ Search For: In: Age of Empires =
| _Home and [ L~ £ 8 s
Entertainment | |- select new pos}_-g_l 1§ Expand All | show: [All threads B e [t os = |
Games Youtube Geyser 1st Video Traffic Marketing Solution www.youtubegeyser.com =
EPC 1 post 11/28/2008
=) = Send Free SMS Worlwide to any mobile phone iphone gsm http://free4sms.info
# Age of Empires 1 post 11/28/2008
 General Gaming AOE Mythology )
Discussion 1post . 11/28/2008
# Simulators Age of Empires III: The Asian Dynasties Expansion Pack from Amazon @
U et . 1 post 11/26/2008
@ Windows XP Gamin Installer reports OMB RAM 9
# Zoo Tycoon 1 post 11/25/2008
Lz iD KE!t‘!’ 11f22,"200€)8
pos
EThe Zone Age Of mythology Product Key won't let me play online. ]
Xbox 1 post 11/21/2008
Lohen graavauksesta

Figure 20-1

4. When you click a posting that has replies, you'll see that
they are organized in the middle of the page in easy-to-
follow threads, which arrange postings and replies in an
outline-like structure. You can review the various partici-
pants’ comments as they add their ideas to the entire
conversation.

5. To reply to a posting yourself, first click the posting, and
then click the Reply button, fill in your comments (see
Figure 20-2), and click Post.
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Enter your comments here
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Figure 20-2

Participate in Chat

348

A chat room is an online space where groups of people can talk back
and forth via text, audio, Web camera, or a combination of media.
(See Figure 20-3, which shows a Web site that links to hundreds of
chat rooms.) In chat, you're having a conversation with one or more
people in real time, and your entire conversation appears in the chat
window. Here are some characteristics of chat you should know:

w= When the chat is over, unless you save a copy, the
conversation is typically gone.
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m= [nteractions are in real time (synchronous), which
means you can interact with others in the moment.

m= Several people can interact at once, although this can
take getting used to as you try to follow what others
are saying and jump in with your own messages.

w= When you find a chat you want to participate in,
sign up to get a screen name, and then you simply
enter the chat room, enter your message, and submit
it. It shows up in the stream of comments and others
may — or may not — reply to it.

1J Chat Groups Paltalk - Opera
File Edit View Bookmarks Widgets Tools Help

Hi, Guest! 1
Notam n

BetA
#“Members | Chat Rooms | Diowrioat - Express My Account

NOT A PALTALK MEMBER? JOIN NOW CREATE OR MANAGE YOUR OWN GROUP.

Arts and Entertainment E

@ Profles @ ChatGroups @ News & Support

Ads by Google
Choose Subcategory Adult Chat Rooms
(Eree)
Chat With Sexy Local
Adults In Your ZIP Code -
Chat MNow!

TrueCyberChat com

RESULTS: Local Chat {(100% Free)
There are 250 chat groups in Arts & Entertainment. 1 of these chat groups have open rooms Chat Instantly With
People Near You. Enter

SORT BY: ‘Lwe Rooms E YuurZiE& Chat Now!

www.247ChatBomb.com

1 -1 of 1 rooms open for Arts & Entertainment.

Psst, this means you can go in them and talk to people. like, right now. | 2 }S_I'HSM‘JM
vien

Single women looking for
men 40+ Signup free to

aapg| LS Anime Haven btohimeck
g*!@ﬂ 11 member(s) | Ranng: | English

Wanted

Arts & Entertainment = Othe

Anime. music. games. chatroom

[® & B3 100 [

Figure 20-3
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When you're talking to someone in a chat room with
multiple people, you can, if you'd like, invite him to
enter a private chat room, which keeps the rest of the
folks who wandered into the chat room out of your
conversation. Also, others can invite you into private
chat rooms. Be careful who you interact with in this
way, and be sure you understand the motivations for
making your conversation private. This may be
entirely reasonable, or it may be that you're dealing
with someone with suspect motivations.

Before you get started, check out the Web site’s Terms
of Use and privacy, monitoring, and abuse reporting

procedures to understand the safety protections in
place before joining a conversation. Some sites are
well monitored for signs of abusive content or inter-
actions; others have no monitoring at all. If you
don’t like the terms, find a different site.

Send and Receive Instant Messages (IMs)

350

Instant messaging (often called just IMing) used to be referred to as real-
time e-mail. It used to be synchronous, meaning that two (or more)
parties could communicate in real time, without any delay. It’s still
synchronous, but now you can also leave a message that the recipient
can pick up later.

Instant messaging is a great way to stay in touch with the younger gen-
erations, who rarely use e-mail. IM is ideal for quick little messages
where you just want an answer without forming a formal e-mail, as
well as for touching base and saying hi. Text messaging on cell phones
is largely the same phenomena: This isn't a tool you'd typically use for
a long, meaningful conversation, but it’s great for quick exchanges.

Depending on the IM service you use, you can do the following:
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w= Write notes to friends, grandchildren, or whoever, as
long as they've installed the same IM service that
you're using.

w= Talk as if you were on the phone.
w= Send photos, videos, and other files.

w= [se little graphical images, called emoticons (such as
smilies or winks) and avatars, to add fun to your IM
messages.

w= See participants via Web cameras.
w= Get and send e-mail.

w= Search the Web, find others using Global Positioning
System (GPS) technology, listen to music, watch vid-
eos, play games, bid on auctions, find dates, and more.

w= Track the history of conversations and even save
transcripts of them to review later.

Instant messaging programs vary somewhat, and you have several to
choose from, including Windows Live Messenger (available at
http://download.live.com/?sku=messenger), Yahoo!
Messenger (available at http://messenger.yahoo.com), and AOL
Instant Messenger, also know as AIM (available at www.aim. com).
Google mail (gmail) has a built-in IM feature.

To get started with a new messaging program, you need to follow the
general steps in the upcoming list. But as with any software, if you
aren’t sure how to use its features, consult its Help documentation for
specific instructions.

1. Download and install the messaging program according
to the instructions on the provider's Web site.
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2. Set up an account and sign in; this may simply involve
entering your e-mail address and password.

You can send IMs from a computer to a mobile
phone (and vice versa) and from one mobile phone
to another. If you include your mobile phone num-
ber as part of your IM profile, anyone who can see
your profile can view it. This is useful information
for friends and criminals, so it's important to consider
whether you want your number exposed — especially
if you have many people on your contact list who
you don't personally know.

3. Double-click a contact to initiate chat. (You can import
contacts from your e-mail contacts when you sign up, or
you can add them yourself.)

4. Click the phone button or icon to initiate a phone call.

®

IM programs let your contacts see when you're
online, unless you change your settings to hide this
information — something that’s good to know when
you're busy and don’t have time to chat. You can
choose availability settings such as Online, Busy, Be
Right Back, Out to Lunch, or even display your sta-
tus as Offline, even when you aren’t. In the
Windows Live Messenger IM program shown in
Figure 20-4, click the arrow next to your name to
access such a list.

IM is one place where people use shortcut text. Some
of this will be familiar to you, such as FYI (for your
information) and ASAP (as soon as possible). Other
short text may be less familiar, such as LOL (laughing
out loud). Visit www . swalk.com for a table of com-
mon shortcut text terms. Knowing these will make
communicating with younger folks more fun.
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Click this arrow

&3 | Find a contact &

. \d) Leam more about the Customer
Experience Improvement Program

EEEFEEEREEEEEERE

1
 E
1

Figure 20-4

Consider what you're saying and sharing in IM and
how you'd feel if the information was made public.
IM allows you to store your conversation history,
which is super useful if you need to go back and
check something that was said. But it has its down-
side. Anything you include in IM can be forwarded to
others. If you're at work, keep in mind that many
employers monitor IM (and e-mail) conversations.

If you run across illegal content — such as child

pornography — downloading or continuing to view
this for any reason is illegal. Report the incident to
law enforcement immediately.
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Use Web Cams

Web cams are relatively inexpensive, and many laptops now come
with Web cams embedded in their lids. (See Figure 20-5.) A Web
cam can be a great way to communicate with friends and family, but
it can quickly become risky when you use it for conversations with
strangers.

/= Gateway Officlal Slte: Gateway - P Serles - Windows Internet Explorer =

'.‘- http://www.gateway.com/programs/pseries/design.php Vl 4 | PS5 National Fraud Information Center P -

File Edit View Favorites Tools Help

T 4kt | %% Gateway Official Site: Gateway - P Series v B - # - [Page » {Tools >

rich and

FULL-SIZED KEYBOARD AND MEDIA PANEL

nid i

djus

‘‘‘‘‘‘

WEBCAM AND FINGERPRINT READER

Done @ Internet | Protected Mode: On H100% -

Figure 20-5

w= Giving your image away, especially one that may
show your emotional reactions to a stranger’s state-
ments in real time, simply reveals too much infor-
mation that can put you at risk.
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w= If you use a Web cam to meet with someone you
don’t know online, they may expose you to behavior
you'd rather not see.

w= Note that Web cams can also be high-jacked and
turned on remotely. This allows predators to view
and listen to individuals without their knowledge.
When you aren’t using them, consider turning your
Web cam off or disconnecting it if it isn’t a built-in
model.

Teens in particular struggle to use good judgment

when using Web cams. If you have grandchildren or
other children in your care, realize that normal inhi-
bitions seem to fall away when they aren’t physically
present with the person they're speaking to — and
many expose themselves, figuratively and literally. In
addition to having a conversation about appropriate
Web cam use with children and teens, it may be wise
to limit access to Web cams.

Overview of Collaborative and Social Networking Sites

Although you may think kids are the only active group using social
networking, you can see from the table in Figure 20-6 that it isn’t the
case. In fact, persons 35-54 years old make up a large segment of
social networkers.

US Internet Users Who Visit Social Networks, by
iGender and Age, Q2 2008 & Q2 2009 (% of respondents
lin each group)

Q2 2008 Q2 2009

[Gender

Male 21.3% 37.6%
Female 31.1% 48.0%
(rge

=35 52.4% 71.5%
[35-54 21.3% 43.1%
G5+ &A% 18.9%

Eource: TNS and The Conference Board, "Consumer Internet Barometer
Becand Quarter 2009,° Jupe 18, 2009

105201 wtnw.eMarketer cony

Figure 20-6
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There are several types of sites where people collaborate or communi-
cate socially. The following definitions may be useful:

w=  Wiki: A Web site that allows anyone visiting to con-
tribute (add, edit, or remove) content. Wikipedia, for
example, is a virtual encyclopedia built by users pro-
viding information in their areas of expertise.
Because of the ease of collaboration, wikis are often
used when developing group projects or sharing
information collaboratively.

w= Blog: An online journal (blog is short for web log)
that may be entirely private, open to select friends or
family, or available to the general public. You can
usually adjust your blog settings to restrict visitors
from commenting on your blog entries, if you'd like.

w= Social networking site: This type of Web site (see
Figure 20-7) allows people to build and maintain an
online Web page and create networks of people that
they're somehow connected to — their friends, work
associates, and/or other members with similar inter-
ests. Most social networking sites also host blogs and
have social networking functions that allow people
to view information about others and contact each
other.

w= Social journaling sites: Sites such as Twitter allow
people to go online with short notes which are
typically about what they're doing at the moment.
Many companies and celebrities are now tweeting,
as posting comments on Twitter is referred to. You
can “follow” individuals on Twitter so you're always
informed if somebody you are a fan of makes
a post.
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Figure 20-7

Sign Up for a Social Networking Service

Many social networking sites, such as Facebook or MySpace, are gen-
eral in nature and attract a wide variety of users. Facebook, which was
begun by some students at Harvard, has become today’s most popular
general site, and many seniors use its features to blog, exchange virtual
“gifts,” and post photos. Other social networking sites revolve around
particular interests or age groups.

When signing up for a service, understand what is required informa-
tion and what is optional. You should clearly understand why a Web
service needs any of your personally identifiable information and how
they may use that information — before providing it. Consider care-
fully the questions that sites ask users to complete in creating a profile.

Accepting a social networking service’s default set-
tings may expose more information than you intend.

357



Part lll: Exploring the Internet

358

Walk through the signup process for Eons, a senior social networking
site, to see the kinds of information they ask for. Follow these instruc-

tions to do so:

1. Type this URL into your browser’s address line: www .
eons . com.

2. Click the Sign Up button.

3. In the signup form that appears (see Figure 20-8), enter
your name, e-mail address, a password, your birthdate,
gender, and zip code.

Note that the site requires your birthdate to verify that

you are a senior, but you can choose to hide this infor-
mation from others later if you don’t want it displayed.
(We recommend hiding your birthdate.)

ime, guest! Log in or Signup Help

Sign up for Eons. I's free and easy to join.
Al fieldds on this page are required.

Full name

Ernail address

Create a password

Birthday

Gender

L5 ZIP code

Jane Alexanderson First and last name

IJAmomSE7 @juno. com|

At least 5 characters

October v 27 v 1950 El 9 Why does Eons need this?
© Female
O Male
| live outside the U3

By clicking "Sign up" you are indicating that you have read
and agree to the ' Terms of Use and ' Privacy Palicy

Already signed up as an Eons member? Log in

Eons is the online
community for
BOOMers and beyond.

On Eong, you can...
Stay in touch with friends and family onling
Share photos and videos
Discuss your passions and interests
Caontrol your privacy
Find friends you haven't seen in eons
Challenge yourself and others to brain games

And, most of all, have fun!

Gel ready to BOOM Your Life!

Figure 20-8
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4. Click the Sign Up button. On the screen that appears (see
Figure 20-9), note that your actual name is the screen
name that members will see. We recommend you change
this by highlighting the text and typing your alias over it.

Consider nicknames and the messages they send. Names
like lookin'forlove or lonelyinHouston may
send a message that you're lonely and emotionally
vulnerable.

Change your screen name

See if your new screen name is available

Screen name  |JaneAlexandersan Your screen name is how Eons . =
members know you. Keep this Eons is l_he online
e or create a new one community for
: — BOOMers and beyond.
On Eans, you can...
Werification (type what Stay in touch with friends and family online

you see) Share photos and videos

Discuss your passions and interests

Type the two wards: Cantral your privacy
CHA
2 @APFLH" : Find friends you haven't seen in eons

Challenge yourself and others to brain garmes
And, most of all, have fun!

Gel ready to BOOM Your Lifel

2006-2008 Eans, Inc. All rights reseved Home  About Us Careers Privacy Policy  Terms of Use  Advertise Help Contact Help Team

Figure 20-9

5. Click Check Availability to see if the alias you entered is
not already in use as a screen name. If the screen name
you request is already taken, choose another screen name
and try again.

6. Type the word or phrase shown in the Verification field
and click Sign Up.
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7. At this point, you're instructed to check your e-mail
account for a message. When you receive the message,
click the link in it to confirm your e-mail address.

8. Note that after you confirm your e-mail address, a confir-
mation appears, offering a link to enhance your profile.
Click that link.

9. Scroll to the bottom of the page. In the last paragraph on
the page, click the Privacy Settings link.

10. On the Privacy Settings page (see Figure 20-10), note
which settings default to Everyone, allowing anyone on
the site to view your information, see your recent activity,
comment on your blog, contact you, and so on.

Search Eons

People

Elocked Members

Who can view my full profile? Everyone

Whio can view my real name? Mo one
Who can view my email? Ma one -
Who can contact me by private messaging me? Everyone -

Who can see when | am online? Everyone «

Wha can imite me as a friend?  Everyone -
Who can see my LifaPath? Everyone -
“Who can comment on my blog? Everyone -
Wha can comment on my profile?  Ewveryone -
Comments posted to my profile will be posted Automatically -
Who can see my recent activity?  Everyone -

Who can be notified when it's my birthday? Mly friends and groups | belong to

Figure 20-10
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1 1. Change any privacy settings you wish and click Save.

®

®

Remember that social networking sites sometimes
ask for information during signup that they use to
provide you with a customized experience that suits
your needs. But sometimes the information isn’t
needed for the service they're providing you at all —
they simply want it for marketing purposes, to show
to other members, or to sell.

It’s often very difficult to remove information from
sites if you later regret the amount of information
you've shared. It’s best to be conservative in the
information you share during the signup process;
you can always add more later.

How Online Dating Works

Many seniors are making connections with others via online dating
services, and if you've been wondering if this route could be for you,
here’s how you can jump into the world of online dating:

2

2

2

2

Choose a reputable dating site. (See the section,
“Select a Dating Service,” later in this chapter.)

Sign up and provide information about your likes,
dislikes, preferences, and so on. This often takes the
form of a self-guided interview process.

Create and modify your profile to both avoid expos-
ing too much personal information and ensure that
you're sending the right message about yourself to
prospective dates.

Use search features on the site (see Figure 20-11) to
find people who interest you and send them mes-
sages or invitations to view your profile.

Chapter 20: Connecting with People Online
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w= You'll get messages from other members of the site,
to which you can respond (or not). Use the site’s
chat and e-mail features to interact with potential
dates. You may also be able to read comments about
the person from others who've dated him or her, if
the site has that feature.

w= When you're comfortable with the person and feel
there might be a spark, decide if you want to meet
the person offline.

LLaamiss < jEa VIEW MORE | LOCAL SINGLES

=B P

Itransiste]

o Senior Passions

Ads by Google Senior Acliviies Senior Chat Room Senior Year Senior Men Senior Citizens

Search R i -count EVERYTHING IS 100% FREE

Who's Online Who's Popular Search 1 ] Search by Keyword

General Dating Search

lama: |Male sesking a Female E
Age range: mto 55 E

Country: [USA E

Location: [Entire Country E

(e

Identify the type of people you'd like to meet
Figure 20-11

meet online, but they typically have the best safe-
guards in place. If you want to interact with people
you meet on other sites, you should provide your
own safeguards. Create a separate e-mail account (so

@ Formal dating sites aren’t the only places that people
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you can remain anonymous and abandon the e-mail
address if needed). Many dating sites screen partici-
pants and provide strong reporting measures that are
missing on other types of sites, so be particularly
careful. Take your time getting to know someone first
before connecting.

Select a Dating Service

Select your online dating service carefully.

1=

2

[T 2

1=

2

Look for an established, popular site with plenty of
members and a philosophy that matches your own.

Review the site’s policy regarding your privacy and
its procedures for screening members. Make sure
you're comfortable with them.

Use a service that provides an e-mail system that you
use for contacting other members only (sometimes
called private messaging). By using the site’s e-mail
rather than your own e-mail address, you can main-
tain your privacy.

Some sites, such as http://saferdates.com,
shown in Figure 20-12, offer stronger levels of
authenticating members. Safer Dates, for example,
uses fingerprint identification and screening to make
you more confident that you know who you're inter-
acting with.

Visit a site such as www.consumerrankings.com/
Dating.com for comparisons of sites. Whether you
choose a senior-specific dating site such as DatingFor
Seniors.com or a general population site such as
PerfectMatch.com, reading reviews about them
ahead of time will help you make the best choice.

Chapter 20: Connecting with People Online

363



Part lll: Exploring the Internet

364

L)

| dove |}
\
S“é“&gﬂ’gﬁ’i _ﬂ%, =
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who has a photo
Search

GET STARTED NOW

Featured Profiles

LEVEL 1 VERIFIED

Age: 22 I <
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Looking for: Man

Figure 20-12

If you try a site and experience an unpleasant inci-
dent involving another member, report it and make
sure the service follows through to enforce its poli-
cies. If it doesn’t, find another service.
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Taking Care of
Your Computer

The Sth Wave By Rich Tennant
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“A centralized security management system
sounds {ine, but then what would we do
with all the dogs?”






Protecting
Windows

our computer contains software and files

that can be damaged in several different
ways. One major source of damage is from
malicious attacks that are delivered via the
Internet. Some people create damaging pro-
grams called viruses specifically designed to get
into your computer’s hard drive and destroy or
scramble data. Companies might download
adware on your computer, which causes pop-
up ads to appear, slowing down your comput-
er’'s performance. Spyware is another form of
malicious software that you might download
by clicking a link or opening a file attachment;
spyware sits on your computer and tracks your
activities, whether for use by a legitimate com-
pany in selling you products or by a criminal
element to steal your identity.

Microsoft provides security features within
Windows 7 that help to keep your computer
and information safe, whether you're at home
or travelling with a laptop computer.

In this chapter, I introduce you to the major
concepts of computer security and cover
Windows 7 security features that allow you to
do the following:

w= [Inderstand computer security and why
you need it.

| “*op’rer

Getready to...

w= Understand Computer

Security ..oooveerieeiieee,

w= Understand Windows

Update Options...............
w= Run Windows Update .....

w= Set Up Trusted and

Restricted Web Sites .......

w= Enable the Windows

Firewall....oooeeeeeeeeeeee,

= Set Up a Password for

Your Computer ...............

w=> Check Your Computer’s

Security Status ................
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w= Run periodic updates to Windows, which installs
security solutions and patches (essentially, patches
fix problems) to the software.

w= Enable a firewall, which is a security feature that
keeps your computer safe from outsiders and helps
you to avoid several kinds of attacks on your data.

w= Set up a password to protect your computer from
others.

w= Protect yourself against spyware.

Understand Computer Security

368

When you buy a car, it has certain safety features built in. After you
drive it off the lot, you might find that the manufacturer slipped up
and either recalls your car or requests that you go to the dealer’s ser-
vice department to get a faulty part replaced. In addition, you need to
drive defensively to keep your car from being damaged in daily use.

Your computer is similar to your car in terms of the need for safety. It
comes with an operating system (such as Microsoft Windows) built in,
and that operating system has security features. Sometimes that oper-
ating system has flaws, and you need to get an update to keep it
secure. And as you use your computer, you're exposing it to dangerous
conditions and situations that you have to guard against.

Threats to your computer security can come from a file you copy from
a disc you insert into your computer, but most of the time the danger
is from a program that you downloaded from the Internet. These
downloads can happen when you click a link, open an attachment in
an e-mail, or download a piece of software without realizing that the
malware is attached to it.
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There are three main types of dangerous programs (called malware) to
be aware of:

2

[T 2

1=

A virus is a little program that some nasty person
thought up to spread around the Internet and infect
computers. A virus can do a variety of things, but
typically it attacks your data, deleting files, scram-
bling data, or making changes to your system set-
tings that cause your computer to grind to a halt.

Spyware consists of programs whose main purpose
in life is to track what you do with your computer.
Some spyware simply helps companies you do busi-
ness with track your activities so they can figure out
how to sell you things; other spyware is used for
more insidious purposes, such as stealing your
passwords.

Adware is the computer equivalent of telemarketing
phone calls at dinner time. Once adware gets down-
loaded onto your computer, you'll get annoying
pop-up windows trying to sell you things all day
long. Beyond the annoyance, adware can quickly
clog up your computer, so its performance slows
down, and it’s hard to get anything done at all.

To protect your information and your computer from these various
types of malware, you can do several things:

2

You can buy and install an antivirus, antispyware,
or antiadware program. Programs such as McAfee
Antivirus, Norton Antivirus from Symantec (see
Figure 21-1), or the freely downloadable AVG Free
from Grisoft can help stop the downloading of mali-
cious files, and they can detect files that have some-
how gotten through and delete them for you.
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Remember that after you install such a program, you
have to get regular updates to it to handle new
threats, and you need to run scans on your system to
catch items that might have snuck through. Many
antivirus programs are purchased by yearly subscrip-
tion, which gives you access to updated virus defini-
tions that the company constantly gathers
throughout the year.

w= Some other programs such as Spyware Doctor
from PC Tools combine tools for detecting adware
and spyware. Windows 7 has a built-in program,
Windows Defender, that includes an antispyware
feature. Windows Defender tools are covered later

in this chapter.

£ Antivirus Software - Spyware Remover | Norton AntiVirus - Windows Internet Explorer

[ s st syt cominpron/antiviriss

United States

N rton # Shopping B | Search

IMorton

Welcome Products & Services Viruses & Risks Support Downloads ‘Community Store

Symar lorton P

Norton™ AntiVirus 2009 - Upgrade »

Norton Winning protection against viruses, spyware, and malicious software
AntiVirus 2009

'@ Download antivirus software
co
| 2-Year Download

ADD TO CART

$39.9

Norton will donate
10% OF YOUR
SECURITY PRODUCT
PURCHASE PRICE

to keep kids safe online

More Infor

For Windaws XPivista® | iew Product Tour 51v | Wiew Product Tutorisls 21

How It Works System Requirements Compare Related Products Product Support
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Key Benefits

- Stops viruses, worms, spyware, bots, and more—Keeps your systerm
protected against all types of malicious threats.
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« NEWA Rapid pulse upiates every 5 to 15 minutes—provides up-to-the-minute
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+ Prevents virus-infected emails and instant messaces from soreadina—

& Internet | Protected Mode: On

HAPPY MOTHER'S DAY!
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Figure 21-1
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w= You can use Windows tools to keep Windows up
to date with security features and fixes to security
problems. You can also turn on a firewall, which is a
feature that stops other people or programs from
accessing your computer without your permission.
These two features are covered in this chapter.

Understand Windows Update Options

When a new operating system like Windows 7 is released, it has been
thoroughly tested; however, when the product is in general use, the
manufacturer begins to find a few problems or security gaps that it
couldn’t anticipate. For that reason, companies such as Microsoft
release updates to their software, both to fix those problems and deal
with new threats to computers that appeared after the software release.

Windows Update is a tool you can use to make sure your computer
has the most up-to-date security measures in place. You can set
Windows Update to work in a few different ways by choosing Start=>
All Programs>Windows Update and clicking the Change Settings link
on the left side of the Windows Update window that appears. In the
resulting dialog box (see Figure 21-2), click on the Important Updates
drop-down list and you find these settings:

w= Install Updates Automatically: With this setting,
Windows Update starts at a time of day you specify,
but your computer must be on for it to work. If
you've turned off your computer, the automatic
update will start when you next turn on your com-
puter, and it might shut down your computer in the
middle of your work to complete the installation.

w= Download Updates But Let Me Choose Whether to
Install Them: You can set up Windows Update to
download updates and have Windows notify you
(through a little pop-up message on your taskbar)
when they're available, but you get to decide when

371



Part IV: Taking Care of Your Computer

372

the updates are installed and when your computer
reboots (turns off and then on) to complete the
installation. This is my preferred setting because I
have control and won't be caught unawares by a
computer reboot.

Click this arrow for drop-down list

@uv‘ o« System and Security » Windows Update » Change settings - | +?| | Search Control Pane pel |

E=1 [ECH 5

Choose how Windows can install updates

When your computer is anline, Windows can autematically check for important updates anHl install them
using these settings. When new updates are available, you can also install them before shutfing down the
computer.

How deoes automatic updating help me?

Important updates

Check for updates but let me choose whether to download and install them

ew updates: |Every day at |3:00 AM
Recommended updates
[7] Give me recommended updates the same way [ receive important updates

Who can install updates

[Z] Allow all users to install updates on this computer

Note: Windows Update might update itself automatically first when checking for other updates. Read our
privacy statement online.

[ Bok ][ cancel

Figure 21-2

nmp

n-p

Check for Updates But Let Me Choose Whether to
Download and Install Them: With this setting, you
neither download nor install updates until you say
so, but Windows notifies you that new updates are
available.

Never Check for Updates: You can stop Windows
from checking for updates and check for them your-
self, manually (see the following task). This puts
your computer at a bit more risk, but it's useful for
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you to know how to perform a manual update if you
discover a new update is available that you need to
proceed with a task (such as getting updated drivers
or a language pack).

Run Windows Update

1. Choose Start=>All Programs=>Windows Update.

2. In the Windows Update window, click Check for
Updates. Windows thinks about this for a while, so feel
free to page through a magazine for a minute or two.

3. In the resulting window, as shown in Figure 21-3, click
the Updates Are Available link to see all optional or
important updates link.

Click this link
— |
{ .l\“') - |f_| » Control Panel » System and Security » Windows Update ~ ‘ 4,‘ | Search Control Panel 2|
File Edit View Tools Help
& Control Panel Home . @
E Windows Update
+3 Check for updates
Change settings = . .
i : I No important updates avhilable
View update history |
ore hidden updates 6 optional updates are available J Mo updates are currently selected.
(7) Updates: frequently asked
questions
Most recent check for updates:  Yesterday at 7:27 PM
Updates were installed: Yesterday at 7:28 PM, View update history
You receive updates: For Windows and other products from Microsoft Update

See also

Installed Updates

Figure 21-3
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4.

In the following window, which shows the available
updates (see Figure 21-4), click to select available critical
or optional updates that you want to install. Then click
the OK button.

Select update to install

(o= e
| )=[E « Systemand Security » Windows Update » Select updates to install - |+ Search Control Panel o |
I~ | y: iy P P 3,
File | Edit View Tools Help
Stlect the updates you want to install
[ MName Size Microsoft Silverlight (KE960353)
opt Sitverlight (1) ~ | Microsoft Silverlight is a lightweight
W] Microsoft Sifverlight (KB960353) browser plug-in for Internet Explorer
B S . o N and Firefox that blends animation,
Windows 7 Client (4 * | audio/video, and interactivity to deliver
| Realtek - Network - Realtek RTL8168C(P)/8111C (P) Family PCI-E Gigabit Ether... 119 KB richer Web site experiences.
[Z]  Ricoh Company - Bus Controllers and Ports, Storage - Ricoh Memary Stick H.., 81 KB Published: 2/25/2009
__. Ricoh Company - Bus Controllers and Ports, Storage - Riceh SD/MMC Host C... 55 KB = Update is ready for
| Ricoh Company - Bus Controllers and Ports, Storage - Ricoh xD-Picture Card ... 117 KB downloading
Windows Live (1) A | More information
| Windows Live Essentials 11MB Support information

Mo updates are selected. ‘ OK | Cancel

Fig
5.

ure 21-4

In the Windows Update window that appears, click the
Install Updates button. A window appears showing the
progress of your installation. When the installation is
complete, you might get a message telling you that it’s a
good idea to restart your computer to complete the
installation. Click Restart Now.

You can set up Windows Update to run at the same

time every day. Click the Change Settings link in the
Windows Update window and choose the frequency
(such as every day) and time of day to check for and
install updates.
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Running Windows Update either automatically or
manually on a regular basis ensures that you get the
latest security updates to the operating system, so it’s
a good idea to stay current.

Set Up Trusted and Restricted Web Sites

1. You can set up Internet Explorer to recognize sites you
trust and those you don’t want IE to take you to. Click
the Internet Explorer icon in the Windows taskbar to start
your browser.

2. Choose Tools=>Internet Options.

3. In the Internet Options dialog box (see Figure 21-5),
click the Security tab.

Security tab
|

Internet Optipns e [T

| General | Security !Privacy l Content ! Connections ! Programs ! Advanced |

Select a zone to view or change security settings.

@ & v 0

Local intranet  Trusted sites  Restricted sites

Internet

This zone is for Internet websites, i
except those listed in trusted and
restricted zones.

Security level for this zone

Custom

Custom settings.
-To change the settings, dick Custom level,
-To use the recommended settings, dick Default level,

[¥]Enable Protected Mode (requires restarting Internet Explorer)

| Custom level... || Default level |

I Reset all zones to default level |

l OK ] | Cancel

Figure 21-5
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4. Click the Trusted Sites icon and then click the Sites
button.

5. In the resulting Trusted Sites dialog box, enter a URL in
the Add This Web Site to the Zone text box for a Web site
you want to allow your computer to access. If you want
any locations for a particular company, such as
Microsoft, to be allowed, you can use a wildcard in the
form of an asterisk, as shown in Figure 21-6.

An asterisk serves as a wildcard

Trusted s|tes P ——

& ¥pu can add and remove websites from this zone. All websites in

Y]
y tihis zone will use the zone's security settings.

Add this website to the zone:

https :/fvww.ilookbothways.com

Websites:

https: /= microsoft.com

[¥] require server verification {https:) for all sites in this zone

Close

Figure 21-6

6. Click Add to add the site to the list of Web sites, as
shown in Figure 21-6.

7. Repeat Steps 3-6 to add more sites.

8. When you're done, click Close and then click OK to close
the dialog boxes.

9. Repeat Steps 1-8, clicking the Restricted Sites icon rather
than Trusted Sites in Step 4 to designate sites that you
don’t want your computer to access.
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If the Require Server Verification (https:) for All Sites
In This Zone checkbox is selected in the Trusted Sites
dialog box, any trusted site you add must use the
https prefix, which indicates that the site has a
secure connection.

of the Internet Options dialog box to control which
sites are allowed to download cookies to your com-
puter. Cookies are tiny files that a site uses to track
your online activity and recognize you when you
return to the source site. Trusted sites are ones that
you allow to download cookies to your computer
even though the privacy setting you have made might
not allow many other sites to do so. Restricted sites
can never download cookies to your computer, no
matter what your privacy setting is.

@ You can establish a Privacy setting on the Privacy tab

Enable the Windows Firewall

1. A firewall keeps outsiders from accessing your computer.
Choose Startz>Control Panel=>System and Security=
Windows Firewall.

2. In the Windows Firewall window that appears (see
Figure 21-7), check that the Windows Firewall is marked
as On. If it isn't, click the Turn Windows Firewall On or
Off link in the left pane of the window.

3. In the resulting Customize Settings window (see Figure
21-8), select the Turn on Windows Firewall radio but-
ton for Home or Work (Private) Network Location
Settings and/or Public Network Location Settings and
then click OK.

4. Click the Close button to close Windows Security Center
and the Control Panel.
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Verify the firewall is on

E Control Panel Home r . .
I Soniroiane Home Help protect your computer with Windows Firewall

Allow a program or feature
through Wi
@ Chang

Windows Firewall can help prevent hackers or malicious software from gaining access to your computer
through the Internet or a network.

How does a firewall help protect my computer?

What are network locations?
l l@ Home or work (private) networks Connected (»)

Metworks at home or work where you know and trust the people and devices on the network

Troubleshoot my network

'— Windows Firewall state: On
Incoming connections: Block all connections to programs that are not on the
list of allowed programs
Active home or work (private) networks: ff‘.‘? 2WIRE148
Motification state: Motify me when Windows Firewall blocks a new
program
. @ Public networks Not Connected (¥

See also

Figure 21-7

A firewall is a program that protects your computer
from the outside world. This is generally a good
thing, unless you use a Virtual Private Network
(VPN). Using a firewall with a VPN results in you
being unable to share files and use some other VPN
features.

Antivirus and security software programs may offer
their own firewall protection and may display a mes-
sage asking if you want to switch. Check their fea-
tures against Windows and then decide, but usually
most firewall features are comparable. The important
thing is to have one activated.

=[]
@Qv‘o » Control Panel » Bystem and Security » Windows Firewsll - |¢,| | Search Control Pane! Pl
File Edit View Tools Help
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——— | ]

@\;jvli\' <« System an

File Edit View Tools

Custon
You can

What are
Home or]

a.

Public ng

Security » Windows Firewall » Customize Settings v | 44| || Search Control Paret P |

elp

ize settings for each type of network
odify the firewall settings for each type of network location that you use.
etwork locations?
work (private) network location settings
@ Turn on Windows Firewall
| Block all incoming connections, including those in the list of allowed programs

[7] Notify me when Windows Firewall blocks a new program

Turn off Windows Firewzll (not recommended)

fwork location settings

@u

| LS Turn on Windows Firewall

| Block all incoming connections, including those in the list of allowed programs

[] Notify me when Windows Firewall blocks a new program

Turn off Windows Firewzll (not recommended)

oK | | Cancel

Figure 21-8

Set Up a Password for Your Computer

1. To set up a password so others can’t get at your computer
and files without entering that password, choose Start=>
Control Panel, and then click User Accounts and Family

Safety.

2. In the resulting window, shown in Figure 21-9, click the
Change Your Windows Password link. Then, if you have
more than one user account, click an account to add the
password to. Click the Create a Password for Your
Account link.

3. In the Create a Password for Your Account screen, shown
in Figure 21-10, enter a password, confirm it, and add a

password

hint.
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Click this link

T (]

- wv‘% v Control Panel » User Accounts and Family Safety » - | 5 | | Search Control Panel P

File Edit View Tools Help

E Control Panel Home

% User Accounts
em and Security Change your account picture | B Add or remove user accounts | Change your Windows password

k and Internet
Parental Controls

'5‘ Set up parental controls for any user

Hardware and Sound

Programs
Windows CardSpace

User Accounts and Family
Manage Information Cards that are used to log on to online services

Safety

Appearance and <
Personalization | Credential Manager
Clock, Language, and Region " Manage Windows credentials

Ease of Access

Mail (32-bit)

&
@
7
@

All Control Panel Items

Figure 21-9

4. Click the Create Password button.

5. You return to the Make Changes to Your User Account
window. If you wish to remove your password at some
point, you can click the Remove Your Password link here.

6. Click the Close button to close the User Accounts
window.

If you forget your password, Windows shows the hint
you entered to help you remember it, but remember
that anybody who uses your computer can see the
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hint when it’s displayed. So, if lots of people know
that you drive a Ford and your hint is “My car
model,” your password protection is about as effec-
tive as a thin raincoat in a hurricane.

Enter and confirm the new password

o =3
@\\/ﬂ?"}{ + Control Panel »| User Accounts and Family Safety » User Accounts » Create Your Password - |*’7| | Search Control Pane!l P

File Edit View Tools Help

Create a password for your account

1
|l Owner
Administrator

sasscaced]

Confirm new password

I your password contains capital letters, they must be typed the same way every time you log on.
How to create a strong password
Type a password hint

The password hint will be visible to everyone who uses this computer,
What is a password hint?

| Create password || Cancel

Figure 21-10

After you create a password, you can go to the User
Accounts window and change it at any time by click-
ing Change Your Password. You can also change the
name on your user account by typing Change Your
Account Name.

Check Your Computer’s Security Status

1. Choose Start=>Control Panel=>System and Security.
2. In the resulting System and Security window (see Figure

21-11), click the Review Your Computer’s Status and
Resolve Issues link.
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Click this link

===
@uv\“@ » Control Panel » System and Security » = [#3 ][ search ontrot pare ol

Control Panel Home B Adtion Center

e temy s ity Review your computer's status and resolve issues
1By Change User Account Control settings | Troubleshoot common computer problems
Restore your computer to an earlier time

MNetwork and Internet

Hardware and Sound

£¥ \Windows Firewall
Programs

Check firewall status | Allow a program through Windows Firewall
User Accounts and Family

Safety & System

Appearance and - View amount of RAM and processor speed Check the Windows Experience Index
Deroniition By Allow remote access | See the name of this computer | B Device Monager
Clock, Language, and Region = Windows Update

Ease of Access Turn automatic updating on or off | Check for updates View installed updates

\i Power Options
= Change battery settings | Require a password when the computer wakes
Change what the power buttons do | Change when the computer sleeps
A Backup and Restore
Back up your computer | Restare files fram backup
"i BitLocker Drive Encryption
W\ Protect your computer by encrypting data on your disk | Manage BitLocker
5. Administrative Tools
1
1¥=| Freeup diskspace | Defragment your hard drive
®) Create and format hard disk partitions |~ B View event logs | B Schedule tasks

NVIDIA Control Panel
=D

=

Figure 21-11

3. In the Action Center window that appears (see Figure
21-12), check to see if the Security item states whether
Windows found any antivirus software on your
computer.

4. 1f Windows did not find such software, click the Find a

Program Online button and review the recommended secu-

rity software partners that Microsoft recommends. If you
want to purchase one of these solutions, click the logo of
the company you want to buy from and you are taken to
their site where you can buy and download the software.

It's very important that you do have antivirus and
antispyware software installed on your computer,
and that you run updates to them on a regular basis.
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These types of programs help you avoid download-
ing malware to your computer that could cause
advertising pop-ups, slow your computer’s perfor-
mance, damage computer files, or even track your
keystrokes as you type to steal your identity and
more. If you don’t want to pay for such a program,
consider a free solution such as Spyware Terminator
(www . spywareterminator.com).

Find out if you have antivirus software

ESE (IR 5|
@le" » Control Panel » fystem and Security » Action Center v‘*’” Szarch Control Pane ol
® -
Control Panel Home c )
Review recent messages and resolve problems

Change Action Center settings Action Center has detected one or more issues for you to review.
) Change User Account Contral

settings P )

g Security ¥
View archived messages
View perfformance information Virus protection (Important) ———————————
Find a program online

Windows did not find antivirus software on this computer.

Turn off messages about virus protection

Windows Defender needs to scan your computer

n

Scanning on a regular basis helps improve the security of your Scan now
computer.

Windows Update

Windows Update is set to check with you before downloading Change settings...
and installing updates,

Turn off messages about Windows Update

See also Maintenance X
Backup and Restore

Windows Update If you don't see your problem listed, try one of these:

‘ P‘—| Troubleshooting ." Recovery
S rind i ¥

and fiv nrohlems Rectnre vnur comniter tn

Windows Program
Compatibility Troubleshooter

Figure 21-12
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Maintaining
Windows

A 11 the wonderful hardware that you've
spent your hard-earned money on doesn’t
mean a thing if the software driving it goes
flooey. If any programs cause your system to
crash (meaning it freezes up and you have to
take drastic measures to revive it), you can try a
variety of tasks to fix it. You can also keep your
system in good shape to help you avoid those
crashes. In this chapter, you find out how to
take good care of your programs and operating
system in these ways:

m= When a program crashes, you can simply
shut that program down by using the
Windows Task Manager. This utility
keeps track of all the programs and pro-
cesses that are running on your
computer.

w= [f you've got problems and Windows
isn't responding, sometimes it helps to
restart in Safe Mode, which requires only
basic files and drivers. Restarting in Safe
Mode often allows you to troubleshoot
what'’s going on, and you can restart
Windows in its regular mode after the
problem is solved.
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w= [se the System Restore feature to first create a system
restore point (a point in time when your settings and
programs all seem to be humming along just fine),
and then restore Windows to that point when trou-
ble hits.

w= You can clean up your system to delete unused files,
free up disk space, and schedule maintenance tasks.

w= If you need a little help, you might run a trouble-
shooting program to help you figure out a problem
you're experiencing with a program.

Shut Down a Nonresponsive Application

1. 1f your computer freezes and won't let you proceed with
what you were doing, press Ctrl+Alt+Del.

2. In the Windows screen that appears, click Start Task
Manager.

3. In the resulting Windows Task Manager dialog box (see
Figure 22-1), click the Applications tab and select the
application that you were in when your system stopped
responding.

4. Click the End Task button.

5. In the resulting dialog box, the Windows Task Manager
tells you that the application isn’t responding and asks
whether you want to shut it down now. Click Yes.

If pressing Ctrl+Alt+Del doesn’t bring up the Task
@ Manager, you're in bigger trouble than you thought.
You might need to press and hold your computer’s
power button to shut down. Note that some applica-
tions use an AutoSave feature that keeps an interim
version of the document that you were working in —
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you might be able to save some of your work by open-
ing that last-saved version. Other programs don’t have
such a safety net, and you simply lose whatever
changes you made to your document since the last
time you saved it. The moral? Save, and save often.

You may see a dialog box appear when an applica-
tion shuts down that asks if you want to report the

problem to Microsoft. If you say yes, information is
sent to Microsoft to help them provide advice or fix
the problem down the road.

The Applications tab
|

"2 Windows Task Manager =3 EcH =)
File ptions  View Windows Help
| Applcations | Processes | services | Performance | Networking [Users |
=
Task Skatus
Ill%]534830 Ch2z [Compatibility Mode] - Microsoft ...  Running
\&= Snagit Running
Submitted Chapters Senior 2nd edition Running
l End Task. ] l Switch To ] I Mew Task, ..
Processes: 44 CPU Usage: 0% Physical Memory. 27%

Figure 22-1

Start Windows in Safe Mode

1. To start Windows in a mode that loads only the most
vital files, allowing you to get started and fix problems
(for example, by performing a system restore to a time
before the problems), remove any CDs or DVDs from
your computer.
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2. Choose Start, click the arrow on the right of the Shut
Down button, and then choose Restart to reboot your
system (see Figure 22-2).

L=5 Snagit9

@ Windows Media Center

Getting Started 3

Nancgy

Documents

| Caleulator
o Pictures
Sticky Nates

@3 Snipping Toal
)

>
a / Paint

‘_‘«‘ Remote Desktop Connection
(0]

Music
Games
Computer

Control Panel

3] Magnifier
E & Devices and PrinfRSI I

= Microsoft Office Application Log off
Recovery Default Programy Lock

Restart

»  AllPrograms ~ Help and Suppo

Ir&u!!!ﬂlﬂbl!’@

Closes all open programs, shuts down Windows, and
then starts Windows again.

Sleep
Hibernate

‘ Search progroms and files Pl

Figure 22-2

3. When the computer starts to reboot (the screen goes
black), begin pressing F8.

4. 1f you have more than one operating system, you might
see the Windows Boot Manager menu. Use the up- and
down-arrow keys to select the Windows 7 operating sys-
tem. Or, type the number of that choice, press Enter, and
then continue to press F8.

5. In the resulting Advanced Boot Options window (a plain-
vanilla, text-based screen), press the up- or down-arrow
key to select the Safe Mode option from the list and then
press Enter.

6. Log in to your computer with administrator privileges; a
Safe Mode screen appears (see Figure 22-3). Use the
tools in the Control Panel and the Help and Support



system to figure out your problem, make changes, and
then restart. When you restart again (repeat Step 2), let
your computer start in the standard Windows 7 mode.

@ Windows Help and Support _lol ]
/‘?‘ - HJ 5% sk Options =

[Search Help £

s W

Whatis safe mode?

[This content is preliminany and subject to change.]

Safe mode is a troubleshooting option for Windows that starts your computer in a
limited state, Only the basic files and drivers necessary to run Windows are started.
The words Safe Mode appear in the comers of your monitor to identify which
Windows mode you're using,

If an existing problern doesn't reappear when you start in safe mode, you can
eliminate the default settings and basic device drivers as possible causes, If wou don't
know the cause of the problem, you can use the process of elimination ta help you
find the problem. Try starting all of the programs you commanly use, including the
programs inyour Startup folder, one by one to see if a prograrn ight be the cause
of the problem,

I your computer automatically starts in safe mode without prompting, 3 problem
wvith your cormputer might be preventing Windows from starting normally, Ifyou
think the cause of the problem might be a recently installed program ar device, try
using Recovery in Control Panel, For more information, see What is Recovery?

For more information about warking in safe mode, see the following Help topics:

 Advanced startup options (including safe mode)

& Startyour computer in safe mode

# Diagnostic tools ta use in safe mode J
-

93 Maore support options

Figure 22-3

When you reboot and press F8 as in Step 2, you're in
the old text-based world that users of the DOS oper-
ating system will remember. It’s scary out there! Your
mouse doesn’t work a lick, and no fun sounds or
cool graphics exist to sooth you. In fact, DOS is the
reason the whole For Dummies series started because
everybody felt like a dummy using it, me included.
Just use your arrow keys to get around and press
Enter to make selections. You're back in Windows-
land soon. . ..

Create a System Restore Point

1. You can back up your system files, which creates a
restore point you can later use to return your computer
to earlier settings if you begin to experience problems.

Chapter 22: Maintaining Windows
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Choose Start=>Control Panel=>System and Security and
in the resulting System and Security dialog box, click
the System link.

2. In the System dialog box, click the System Protection link

in the left panel. In the System Properties dialog box that
appears (see Figure 22-4), click the Create button.

System Properties - —

&T)  Use system protection to undo
| restore previous versions of file:

System Restore

*You can undo system changes by reverting l

your computer to a previous restore point. System Restore...

Protection Settings

Available Drives Protection
&, VistaB4 (C:) (System) On
s DATA (D) OFf

Conrfigure restore settings, manage disk space, IJ
and delete restore points. | igure...

Create a restore point right now for the drives that | e |
have system protection tumed on. i

ok || cance |

Click this button

Figure 22-4

3. In the Create a Restore Point dialog box that appears,

enter a name to identify the restore point, such as the
current date or the name of a program you are about to
install, and click Create.

4. Windows displays a progress window. When the restore

point is created, the message shown in Figure 22-5
appears. Click Close to close the message box, click Close
to close the System Protection dialog box, and Close
again to close the Control Panel.
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System Protection - —

|'0'. The restore point was created successfully.

|_Close |

Figure 22-5

Every once in a while, when you install some soft-

@ ware and make some new settings in Windows, and
when things seem to be running just fine, create a
system restore point. It's good computer practice, just
like backing up your files, only you're backing up
your settings. Once a month or once every couple of
months works for most people, but if you frequently
make changes, create a system restore point more
often.

system recovery disc that probably came with your
computer or that you created using discs you pro-
vided. However, system recovery essentially puts your
computer right back to the configuration it had when
it was carried out of the factory. That means you lose
any software you've installed and documents you've
created since you began to use it. A good argument
for creating system restore points on a regular basis,
don't you think?

@ A more drastic option to System Restore is to run the

Restore the Windows System

1. Choose Start=>Control Panel=>Back Up Your Computer
(under System and Security).

2. In the Back Up and Restore window, click the Recover
System Settings On Your Computer link. In the Recovery
window, shown in Figure 22-6, click the Open System
Restore button.
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— )]
i v Control Panel » ontrol Panel ltems » Recover - | + earch Control Panel
Qv Lo G | Panel » All C | Panel R ry + Search C [ P 2|

File Edit View Tools Help

@
5 Control Panel Home . . e N
SIS A Restore this computer to an earlier point in time

Troubleshoot 2 problem For most system problems, try System Restore first. For serious problems, use the advanced recovery methods

Uninstall 2 program to re-image your computer or reinstall Windows.

Restore user files
System Restore

Unde changes to system files and programs, but leave user files such as ] Open System Restore

documents, pictures, and music unchanged. This might remove
recently-installed programs and drivers.

Advanced recovery methods

Click this button
Figure 22-6

3. The System Restore feature shows a progress dialog box
as it starts. In the resulting System Restore window, click
Next.

4. In the System Restore dialog box that appears, click the
system restore point to which you want to restore the
computer and click the Next button.

5. A dialog box confirms that you want to run System
Restore and informs you that your computer will need to
restart to complete the process. Close any open files or
programs, and then click Finish to proceed.

6. The system goes through a shutdown and restart
sequence, and then displays a dialog box that informs
you that the System Restore has occurred.

7. Click OK to close it.

System Restore doesn’t get rid of files that you've
saved, so you don’t lose your Ph.D. dissertation.
System Restore simply reverts to Windows settings as
of the restore point. This can help if you or some
piece of installed software made a setting that is
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causing some conflict in your system that makes your
computer sluggish or prone to crashes. If you're con-
cerned about what changes will happen, click the
Scan for Affected Programs button shown in the win-
dow displayed in Figure 22-7.

Your very best bet is to be sure you create a set of
backup discs for your computer when you buy it. If
you didn’t do that, and you can't get things running
right again, contact your computer manufacturer.
They may be able to send you a set of recovery discs,
though they may charge a small fee. These discs
restore your computer to its state when it left the fac-
tory, and in this case you lose applications you
installed and documents you created, but you get
your computer running again.

@ System Restore doesn’t always solve the problem.

i System Restore — — (]
Restore your computer to the state it was in before the selected event é |
'
=
How do I choose a restore point?
Current time zone: Pacific Daylight Time
Date and Time Description Type
15/2009 7:27:23 AM
3/15/2009 6:59:56 AM March 15 Manual
3/15/2009 6:52:44 AM Windows Backup System
3/15/2009 6:43:47 AM Windows Backup System
"] show more restore points l Scan for affected programs -|—
< Back |[ Next = ] | Cancel |

Click this button
Figure 22-7
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Defragment a Hard Drive

394

1. To clean up files on your hard drive, choose Starte>
Control Panel=System and Security and then click
Defragment Your Hard Drive in the Administrative Tools
window.

2. In the resulting Disk Defragmenter window (see Figure

22-8), to the left of the Defragment Disk button is the
Analyze Disk button. Use this to check whether your disk
requires defragmenting. When the analysis is complete,
click the Defragment Disk button. A notation appears
(see Figure 22-9) showing the progress of defragmenting
your drive.

3. When the defragmenting process is complete, the Disk

Defragmenter window shows that your drive no longer
requires defragmenting. Click Close to close the window
and then close the Control Panel.

4j Disk Defragmenter e o B

% Disk Defragmenter consolidates fragmented files on your computer's hard disk to improve system
performance. How does Disk Defragmenter help?

Schedule:

Scheduled defrag tation is turned on % Configure schedule...

Run at 1:00 AM every Wednesday
Mext scheduled run: 3/11/2009 1:00 AM

Current status:

Disk Last Run Progress
.';_".‘.‘Jistaﬁél (G MNever run
Ca DATA (D) Mever run

To best determine if your disks need defragrmenting right now, you need to first analyze your disks.

%! Analyze disk | | %y Defragment disk |

Cloze

Figure 22-8
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4; Disk Defragmenter e (o = =)

»  Disk Defragmenter consolidates fragmented files on your computer's hard disk to improve system
« performance. How does Disk Defragmenter help?

Schedule:

Scheduled defragmentation is turned on | % Configure schedule...
Run at 1:00 AM every Wednesday

Mesxt scheduled run: 3/11/2009 1:00 AM

Current status:

Disk Last Run Progress
éVistaﬁ4 (C:) Running... Pass 1: 0% defragmented
ca DATA (D) Mever run

To best determine if your disks need defragmenting right now, you need to first analyze your disks.

| ¥ Stop operation |

| LClose |

Progress is indicated here

Figure 22-9

Warning: Disk defragmenting could take a while. If
you have energy-saving features active (such as a
screen saver), they could cause the defragmenter to
stop and start all over again. Try running your defrag
overnight while you're happily dreaming of much
more interesting things. You can also set up the pro-
cedure to run automatically at a preset period of
time, such as once every two weeks by using the
Configure Schedule button in the Disk Defragmenter
window.

Free Disk Space

1. To run a process that cleans unused files and fragments
of data off of your hard drive to free up space, choose
Start>Control Panel=>System and Security and then click
Free Up Disk Space in the Administrative Tools.
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2. In the Disk Cleanup dialog box that appears, choose the
drive you want to clean up from the drop-down list and
click OK. Disk Cleanup calculates how much space you
will be able to free up (see Figure 22-10).

Disk Cleanup — — ]

e Disk Cleanup is calculating how much space you will be
~ abletofree on Vistab4 (C:). This may take a few minutes
to complete.

Calculating...

Scanning: System emor memory dump files

Figure 22-10

3. The resulting dialog box, shown in Figure 22-11, tells
you that Disk Cleanup calculated how much space can
be cleared on your hard drive and displays the suggested
files to delete in a list (those to be deleted have a check
mark). If you want to select additional files in the list to
delete, click to place a check mark next to them.

=, Disk Cleanup for Vista64 (C:) e =3

."I.ji-e:lzz-aeanup !

f—-.‘- ‘You can use Disk Cleanup to free up to 4.04 GB of disk

space on Vistab4 {C:).
Files to delete:

Cffline Webpages
., Game Statistics Files

4 m 3

Total amourt of disk space you gain: 17.3MB
Description

Downloaded Program Files are ActiveX. controls and Java applets
downloaded automatically from the Intemet when you view certain
pages. They are temporarity stored in the Downloaded Program
Files folder on your hard disk.

I/ Clean up system files View Files

How does Disk Cleanup work?

| oK || Cancel |

Figure 22-11
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4. After you select all the files to delete, click OK. The
selected files are deleted. Click the Close button to close
the Control Panel.

log box to see more details about the files that
Windows proposes to delete, including the size of the
files and when they were created or last accessed.

@ Click the View Files button in the Disk Cleanup dia-

you might consider replacing your hard drive with

@ If you can’t free up enough disk space for your needs,
one that has more capacity.

Delete Temporary Internet Files
by Using Internet Explorer

1. When you roam the Internet, various files may be down-
loaded to your computer to temporarily allow you to
access sites or services. To clear these away, first open
Internet Explorer.

2. Choose Tools=>Internet Options.

3. On the General tab of the resulting Internet Options dia-
log box (see Figure 22-12), click the Delete button in the
Browsing History section.

4. In the resulting Delete Browsing History dialog box,
shown in Figure 22-13, click the Temporary Internet Files
checkbox to select it if it's not already selected and click
Delete.

5. A confirmation message asks whether you want to delete
the files. Click Yes. Click Close and then click OK to close
the open dialog boxes.
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Click this button

Internet Options T[]

General ISecurity I Privacy | Content ; Connections ! Programs ! Advanced|

Home page
/‘ To create home page tabs, fype each address on its own line.
g
ol | e

Use current | | Use default H Use blank

Browsing history

i) Delete temparary files, histdry, cookies, saved passwords,
¥ and web form information.

|| Delete browsing history pn exit

Delete... | | Settings ]
Search
") Change search defaults. | Settings
&
Tabs
Change how webpages are displayed in | Settings |
— | tabs. I —
Appearance
Caolors | l Languages ] l Fonts ] l Accessibility ]
l oK ] | Cancel ] Appl
Figure 22-12

Temporary Internet files can be deleted when you
run Disk Cleanup (see that task earlier in this chap-
ter), but the process that I describe here allows you
to delete them without having to make choices about
deleting other files on your system.

Windows 7 offers a feature for rating and improving
your computer’s performance. From the Control
Panel, click System and Security, and then click the
Check the Windows Experience Index Base Score
link. In the resulting dialog box, click the Rate This
Computer button to get a rating of your processor
speed, memory operations, and more.
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Verify this option is selected

Delete Browsing History [l

Keep cookies and temporary Internet files that enable your Favorite
websites ko retain preferences and display Faster,

—7| Temporary Internet files
Copies of webpages, images, and media that are sawved For Faster
viewing.

/| Cookies
Files stared on wour computer by websites to save preferences
such as login information.

&<

|History
List of websites you have visited,

" | Form data
Saved information that vou have byped into Forms,

" | Passwords

Saved passwords that are automatically filled in when you sign in
to a website you've previously visited,

InPrivate Filtering data
Saved data used by InPrivate Filtering to detect where websites may
be automatically sharing details about vour wisit,

About deleting browsing histary: Delete | | Cancel

Figure 22-13

Schedule Maintenance Tasks

1. Choose Start=>Control Panel=>System and Security and
then click Schedule Tasks in the Administrative Tools
window.

2. In the resulting Task Scheduler dialog box, shown in
Figure 22-14, choose Actiont>Create Task.

3. In the resulting Create Task dialog box (see Figure
22-15), enter a task name and description. Choose when
to run the task (either only when you are logged on, or
whether you're logged on or not).
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() Task Scheduler —— o (]
File Action View Help
G|
(%) Task Scheduler (Local) sk St L - 3/5/2009 9: 1 Actions
@ Task Scheduler Library . | Task Scheduler (Local) =
‘ Overview of Task Scheduler - Connect to Another C.
f L".I You can use Task Scheduler to create and manage _‘ ] Create Basic Task...
_.~ common tasks that your computer will carry out | S b Credts Task
automatically at the times you specify. To begin, 13 p
click a command in the Action menu, Import Task...

m

Tasks are stored in folders in the Task Scheduler Display All Running Ta...

lihrans Traview ar nefarm an aneratinn an an

AT Service Account Co...

Task Status o | View F
Status of tasks that have startted in ... | Last 24 hours L &, Refresh
[ Help
Reading data, please wait...
Reading data ... Cancel Refresh
.
Figure 22-14
(-1 Create Task =]

General |Triggers | Actions I Conditions i Settings|

Mame: |
Location: %
Author: Owner-PC\Owner
Description:
Security options

When running the task, use the following user account:

Owner-PC\Owner Change User or Group... |

@ Run only when user is logged on
) Run whether user is logged on or not
Do not store password, The task will only have access to local computer resources.

[] Run with highest privileges

7] Hidden Configure for: | Windows Vista™, Windows Server™ 2008 > |

[ ok ][ cancel ]

Choose when to run the task

Figure 22-15
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4. Click the Triggers tab and then click New. In the New
Trigger dialog box, choose a criteria in the Begin the Task
drop-down list and use the settings to specify how often
to perform the task as well as when and at what time of
day to begin. Click OK.

5. Click the Actions tab and then click New. In the New
Action dialog box, choose the action that will occur from
the Action drop-down list. These include starting a pro-
gram, sending an e-mail, or displaying a message.
Depending on what you choose here, different action
dialog boxes appear. For example, if you want to send an
e-mail, you get an e-mail form to fill in. Click OK.

6. If you want to set conditions in addition to those that
trigger the action that control whether it should occur,
click the Conditions tab and enter them.

7. Click the Settings tab and make settings that control how
the task runs.

8. After you complete all settings, click OK to save the task.

If you like a more wizard-like interface for building a

@ new task, you can choose the Create Basic Task item
from the Action menu. This walks you through the
most basic and minimal settings you can make to
create a new task.

Troubleshoot Software Problems

1. If you can't figure out why you're having problems with a
piece of software, choose Startz>Control Panel=Find and
Fix Problems (under System and Security).

2. In the resulting Troubleshooting window (see Figure
22-16), click Programs.
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Click this link

——— ]
—
@uv\ﬁ » Control Panel » All Control Pane|tems » Troubleshooting = | 42| || search Control Panei P

File Edit View Tools Help

@

B Control Panel Home
M ConialanclHome Troubleshpot computer problems

Click on a tasf to automatically troubleshaot and fix comman computer problems. To view more
troubleshootgrs, click on a category or use the Search box.

Change setfings [} Programs
Get help from someone you " Run programs made for previous versions of Windows
trust Help improve Internet Explorer performance

Hardware and Sound

“-j' Configure a device | Usea printer '_i:l' Troubleshoot audio recording
‘E'Trcub\eshcct audio playback

@ Network and Internet

Connect to thelnternet | Access shared files and folders on other computers

Appearance and Personalization
“S«' Display Aerc desktop effects

System and Security
Fix problems with Windows Update | Run maintenance tasks "‘j‘ Improve power usage
Check for performance issues

Help and Support

Recovery Get the most up-to-date troubleshooters from the Windows Online Troubleshooting service

Figure 22-16

3. In the resulting Troubleshooting Problems-Programs
window, choose what you want to troubleshoot:

e Network allows you to troubleshoot a connection
to the Internet.

e Web Browser helps you figure out problems you
may be having with the Internet Explorer browser.

e Program Compatibility is a good choice if you
have an older program that doesn’t seem to be
functioning well with this version of Windows.
Program compatibility is a common cause of prob-
lems running software.
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e Printing allows you to find out why you're having
difficulty with your printer, including checking for
the correct printer driver software.

e Media Player troubleshooting can be used to pin-
point problems with general settings, media files,
or playing DVDs.

4. Follow the sequence of instructions for the item you
selected to let Windows help you resolve your problem
(see Figure 22-17).

In some cases you'll be asked for administrator per-
mission for the troubleshooter to perform an action,
so it's a good idea to run the troubleshooting wizard
through an administrator level account. See Chapter
2 for more about user accounts and administrators.

) .| Hardware and Devices

Troubleshooting has successfully completed
Is the problem fixed? Try attempting the task you were trying to do before.

* Close the troubleshooter

* Explore additional options

Problems found

Hardware changes might not have been detected Detected !

View detailed information

| Cance!_|

Figure 22-17
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accessibility. See assistive options
accounts. See user accounts
Address Book for e-mail, 324-325
Administrator account, 31-32
adware, 289, 369. See also malware
(malicious software)
Aero themes, 69-71
All Programs list
creating desktop shortcuts, 49-50
displaying from Start menu, 40
launching programs, 40, 51, 128
Startup folder, 132-134
antivirus, anti-spyware, and anti-
adware programs, 289-290,
369-370, 382-383
AOL Instant Messenger (AIM), 351
appearance. See display
applications. See programs
arranging icons on desktop, 45-46
assistive options
Audio Description feature, 74
for dexterity challenges, 80-90
eliminating distracting elements, 75
Filter Keys feature, 83
finding more, 85
for hearing challenges, 76-78
keyboard settings, 83-84, 87-88
Magnifier feature, 75
mouse behavior settings, 88-90

mouse cursor settings, 75, 89-93
Mouse Keys feature, 83, 89
Narrator feature, 74
overview, 73-74
screen contrast adjustment, 74,75
On-screen Keyboard feature, 85-87
Speech Recognition feature, 80-83
Sticky Keys feature, 83
text size adjustment, 78-79
Toggle Keys feature, 83
for visual challenges, 74-76, 78-79,
90-92
visual cues for sounds, 76-78
attachments to e-mail
cautions about downloading, 308
malware, 288-289
photos, 217-219
sending, 325-327
auction sites, 17-18
Audio Description feature, 74
audio files, default devices for, 136
audio port, 26
AutoFormats (spreadsheet), 194-195

ol e

backing up, 140, 157-158

banking online, 203-204

blogs, 356

broadband Internet connection, 22,
23, 259, 260. See also Internet
connection
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browsers, 256. See also Internet
Explorer
browsing. See Internet Explorer;
searching the Web
browsing history
deleting, 397-399
viewing, 280-281
burning CDs or DVDS
backing up files, 157-158
music, 229-230
photos, 219-221
recovery disks, 20
buying a computer
customized computers, 23-24
DVD or CD drive choices, 19-20
guidelines, 16-18
hard drive choices, 21

Internet connection concerns, 22-23

monitor choices, 18-19
price ranges, 16-18
processor choices, 21

RAM choices, 21, 22
reasons for, 8-10, 16-17
return policies, 17
shipping costs, 17

types of computers, 13-15
Windows 7 versions, 15
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cable Internet connection, 22, 23,
259. See also Internet connection

calculations (spreadsheet), 195-197

Calendar gadget, 164-166

CDs. See DVDs and CDs

central processing unit (CPU), 11,
14, 21, 169-170
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challenges, physical. See assistive
options
charts, 199-201
chat rooms, 348-350
Chess Titans game, 249-250
clicking, 28-29
clicking and dragging, 29
Clip Art, 182. See also pictures
clock
Daylight Saving Time, 31
gadget, 162-163
setting date and time, 29-31
closing. See also deleting or removing
documents, 57
gadgets, 161
nonresponsive programs, 386-387
programs, 44, 55-57
shutting down your computer,
35-36
collaborative networking. See social
networking
colors
for desktop background, 62-64
desktop themes, 60-61, 63-66,
69-71
for e-mail messages, 335
for Help and Support Center, 122
for mouse cursor, 90, 92
printer preferences for, 99
restful, 69
for screen elements, 68-69
for text in word processor, 178
for Windows” appearance, 60-61
compatibility problems, 402
compressed files or folders, 153-155
Computer window
finding files and folders in, 144-145
opening files from, 145
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connecting to people online
chat rooms, 348-350
dating services, 361-364
discussion boards, 346-348
instant messages, 307-308,
350-353
social networking, 355-361
Web cams for, 354-355
Contact List for e-mail, 337-339
Content Advisor (IE), 299-301
contrast adjustment for screen, 74, 75
converting currency, 167-168
copying
between programs, 130-132
text in word processor, 175-176
CPU (central processing unit), 11,
14, 21, 169-170
CPU Meter gadget, 169-170
credit reports online, 202, 305-306
CRT (cathode ray tube), 18
Currency Conversion gadget,
167-168
customer support, 122-124. See also
Help and Support Center
customized computers, 23-24
customizing
desktop background, 62-64
Internet Explorer toolbars, 281-283
screen elements, 68-69
screen resolution, 60, 61-62
screen saver, 61, 66-68
Start menu, 42-43
themes, 60-61, 63-66, 69-71
Windows’ appearance (overview),
60-61
Windows Live Mail Reading Pane,
339-340
cut- or copy-and-paste, 132, 175-176

o)) e

date and time
Calendar gadget, 164-166
Clock gadget, 162-163
Daylight Saving Time, 31
scheduling tasks, 399-401
setting on computer, 29-31
dating services online, 361-364
Daylight Saving Time, 31
default printer, setting, 97-99
defragmenting a hard drive, 394-395
deleting or removing. See also closing
browsing history, 397-399
desktop shortcuts not used, 50
e-mail messages, 342
emptying the Recycle Bin, 46-47
Favorites folder items (IE), 278
files and folders, 152-153
freeing up disk space, 395-397
gadgets, 161
home page, 270
photos from Photo Viewer, 215
playlists, 229
printers, 103-104
programs (uninstalling), 12, 136-138
programs from Startup folder, 133
tags from photos, 216
temporary Internet files, 397-399
desktop. See also specific elements
adding gadgets to, 160-161
arranging icons on, 45-46
background picture or color, 62-64
described, 37-38
elements on, 38-40
removing gadgets from, 161
themes, 60-61, 63-66, 69-71
viewing, 40
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desktop computers, 14, 260. See also
buying a computer

Desktop Gadget Gallery, 159. See also

gadgets
desktop shortcuts
arranging, 45-46
changing size of, 46
deleting unused shortcuts, 50
described, 39, 49

to files or folders, creating, 151-152

launching programs from, 39, 50,
52,128, 129
to programs, creating, 49-50
resetting to default setup, 50
dexterity challenges
keyboard settings, 83-84, 87-88
mouse behavior settings, 88-90
mouse for left-handed people, 89
On-screen Keyboard feature, 85-87
Speech Recognition feature, 80-83
dial-up Internet connection, 22, 258,
260. See also Internet connection

digital camera photos, uploading, 213

discussion boards, 346-348
Disk Cleanup, 395-397
Disk Defragmenter, 394-395
display. See also monitors
aids for visual challenges, 74-76,
78-79, 90-92
Audio Description feature, 74
contrast adjustment, 74, 75
desktop background, 62-64
eliminating distracting elements, 75
Help and Support Center options,
121-122
Magnifier feature, 75
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methods of customizing, 60-61
modifying elements, 68-69
mouse cursor settings, 75, 89-93
Narrator feature, 74
orientation of, 61
resolution of, 19, 60, 61-62
screen saver, 61, 66-68
text size adjustment, 78-79
themes, 60-61, 63-66, 69-71
transparency effects, 69-71
documents. See files and folders
downloading safely, 292-293, 308
drivers, 93, 95-96, 105
DSL Internet connection, 22, 23, 259.
See also Internet connection
DVD drives, choosing, 19-20
DVDs and CDs. See also burning CDs
or DVDS
compared, 10
ripping music from, 233-235
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ease of access. See assistive options
e-mail. See also Windows Live Mail
compressing files for, 153-155
etiquette, 322-323
free providers, 313
to groups, 308
links in, 307-308
safe usernames for accounts, 314
scams and frauds, 306-308
sending photos, 217-219
setting up an account, 312-314
vacation notification messages, 306
erasing. See deleting or removing
Excel, 190
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Favorites folder (IE)
adding Web site to, 277-278
deleting or renaming items, 278
organizing, 278-280
Favorites list (Start menu), 155-157
FDIC Web site, 204
Feed Headlines gadget, 168-169
Fidelity Web site, 205
files and folders. See also opening
files
adding to Favorites list, 155-157
backing up, 157-158
choosing programs to open,
134-136
closed when program closes, 57
closing without closing program, 57
compressed, creating, 153-155
creating folders, 141
deleting, 152-153
desktop shortcuts to, 151-152
displaying from Start menu, 40, 48
downloading files safely, 292-293
Favorites folder (IE), 277-280
finding, 47, 144-147
folders predefined by Windows, 140
folders within folders, 141-142
moving, 142, 147-149
recently used, displaying, 142-143
renaming, 149-150
saving files before closing programs,
55, 57
Startup folder, 132-134
Windows Live Mail folders,
340-343
Filter Keys feature, 83

financial information online,
201-202
firewall, 290, 368, 371, 377-379
flat bed scanners. See scanners
flat panels, 18. See also monitors
folders. See files and folders
fonts. See formatting
footers for documents, 187
formatting
AutoFormats (spreadsheet),
194-195
charts, 201
defined, 176
e-mail messages, 333-335
numbers in spreadsheet, 193-194
tables in word processor, 180
text in word processor, 176-179
forwarding e-mail, 330-331
fraudulent e-mail, 306-308
FreeCell game, 241-243
freeing up disk space, 395-397
Frequently Used Programs area
described, 38
displaying, 144
using, 43-44, 52, 129
frozen computer, shutting down, 35
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Gadget Gallery, 159
gadgets
adding to desktop, 160-161
Calendar, 164-166
Clock, 162-163
CPU Meter, 169-170
Currency Conversion, 167-168
described, 40
Feed Headlines, 168-169
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gadgets (continued)
finding more, 161
Picture Puzzle, 166-167
removing from desktop, 161
Slide Show, 163-164
Stocks, 202
games
Chess Titans, 249-250
computers suitable for, 14-15
FreeCell, 241-243
Hearts, 247-248
Minesweeper, 245-247
online, 250-252
Parental Controls for, 248
Picture Puzzle gadget, 166-167
Solitaire, 238-240
Spider Solitaire, 243-245
gigahertz (GHz), 21
Google
instant messaging feature, 351
searching the Web with, 272-274
graphics. See pictures

o/l o

handicaps. See assistive options
hard drives
defragmenting, 394-395
freeing up disk space, 395-397
size needed, 21
Windows 7 space requirements, 22
hardware. See also buying a
computer; specific kinds
CPU, 11, 14, 21
customized computers, 23-24
defined, 7, 11
hard drives, 21, 22
for Internet connection, 22, 260
keyboard, 11, 26
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modems, 22, 260

monitors, 11, 18-19, 26
mouse, 11, 26, 28-29
optical drives, 19-20
overview, 11

peripherals, 11

printers, 93-104

RAM, 21, 22

scanners, 93, 104-108
Windows 7 requirements, 22

headers for documents, 187
headlines, gadget for, 168-169
hearing challenges, aids for, 76-78
Hearts game, 247-248

Help and Support Center

asking a person for help, 114-116,
118-121
contacting Microsoft Customer
Support, 122-124
contacting Windows Communities,
109, 114-116
display options, 121-122
finding support options, 124
methods of getting help, 109-110
online help from, 117-118
printing help topics, 110
Remote Assistance, 109, 118-121
searching for help, 112-114
Table of Contents, 110-111
hibernate mode, 35, 41-42
home page for browsing, 267-270
hyperlinks, 256-257, 263-264,
307-308

o] e

icons on desktop. See desktop
shortcuts
IE. See Internet Explorer
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impairments. See assistive options
information exposure, 287, 301-304,
357, 361. See also privacy
InPrivate Browsing and Filtering (IE),
294-296
installing
changing options for installed
programs, 136-137
digital camera software, 213
printers, 94-97
programs, 138
scanners, 104-106
uninstalling programs, 12, 136-138
instant messages (IMs)
described, 345
links in, 307-308
sending and receiving, 350-353
Internet, defined, 256
Internet connection. See also security
and safety
companies providing, 258
firewall for, 290, 368, 371, 377-379
hardware needed for, 260
risks with, 287-291, 368-369
setting up, 260-262
speeds, 259-260
types of, 22-23, 258-259
Internet Explorer (IE)
Back and Forward buttons, 264
browsing history, 280-281,
397-399
changing default search engine, 272
Content Advisor feature, 299-301
deleting temporary Internet files,
397-399
downloading files safely, 292-293
Favorites Center side pane, 278
Favorites folder, 277-280

finding content on a page, 275-276
History button, 280-281
home page for, 267-270
InPrivate Browsing feature, 294-296
navigating the Web with, 262-265
playing podcasts, 285-286
printing a Web page, 284-285
privacy settings, 297-299
Refresh button, 265
risks with, 287-291, 368-369
searching using Google, 272-274
SmartScreen Filter feature, 296-297
Stop button, 265
Suggested Sites feature, 291-292
toolbar customization, 281-283
troubleshooting problems, 402
using tabs in, 265-267
viewing recently visited sites, 264
viewing RSS feeds, 283-284
Internet resources. See Web resources
investing online, 204-206
ISPs (Internet service providers),
258, 312
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keyboard. See also dexterity
challenges
connecting to computer, 26
controlling mouse with, 83, 88-89
described, 11
Filter Keys feature, 83
repeat rates, 83, 87-88
On-screen Keyboard feature, 85-87
Sticky Keys feature, 83
Toggle Keys feature, 83
volume controls on, 227
keyboard shortcuts, highlighting, 84
Kiplinger's Web site, 201
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laptop computers. See also buying a
computer
hibernate mode, 35, 41-42
Internet connection hardware, 260
overview, 13-14
launching programs
from All Programs list, 40, 51, 128
automatically at startup, 132-134
from desktop shortcuts, 39, 50, 52,
128, 129
from Frequently Used Programs
area, 43, 52, 129
from taskbar, 52, 128-129
LCD (liquid crystal display), 18-19
links, 256-257, 263-264, 307-308
logging on
switching user accounts, 28, 33-34
when starting Windows 7, 26-27

ol o

Magnifier feature, 75
Mail. See Windows Live Mail
maintaining your computer. See also
troubleshooting
creating a restore point, 389-391
defragmenting a hard drive,
394-395
deleting temporary Internet files,
397-399
freeing up disk space, 395-397
overview, 385-386
restoring the system, 391-393
scheduling tasks, 399-401
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malware (malicious software). See
also security and safety
IE SmartScreen Filter for, 296-297
programs combating, 289-290,
369-370, 382-383
protecting against, 289-291
types of, 288-289, 369
margins for documents, 186, 187,
196-197
maximizing windows, 40, 54
media. See also specific media
choosing default devices for, 136
multimedia computers for, 14
software for, 208-210
memory (RAM), 21, 22
Microsoft Excel, 190
Minesweeper game, 245-247
minimizing windows, 40, 53, 54
modems, 22, 260
monitors, 11, 18-19, 26. See also
display
Motley Fool Web site, 205-206
mouse. See also dexterity challenges
connecting to computer, 26
controlling with keyboard, 83,
88-89
cursor settings, 75, 89-93
described, 11
for left-handed people, 89
On-screen Keyboard feature, 85-87
using, 28-29
Mouse Keys feature, 83, 89
movies, 136, 210-212
moving items
arranging icons on desktop, 45-46
e-mail messages, 342-343
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into Favorites folders (IE), 280
files and folders, 142, 147-149
between programs, 130-132
windows, 54
multimedia computers, 14. See also
buying a computer
music. See also sound
burning CDs or DVDS, 229-230
Copy Protect option, 234
master system volume for, 225-227
playing, 231-233
playlist creation, 227-229
ripping from CDs or DVDs,
233-235
speaker setup for, 224-225
syncing music devices, 230-231
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Narrator feature, 74

New York Times Web site, 285

nonresponsive programs, shutting
down, 386-387

notebooks. See laptop computers

Notifications area, 38, 226-227

o () o

online resources. See Web resources
On-screen Keyboard feature, 85-87
opening files
blank Works Spreadsheet, 193
from Computer window, 145
from Windows Explorer, 47
in Works word processor, 174-175
opening programs. See launching
programs

operating system, 12-13, 15-16, 22.
See also Windows 7
optical drives, 19-20
orientation
of display, 61
of Works word processor
documents, 186, 187

o pPoe

page setup in Works, 185-187
paper for printing, 100, 186
parallel port, 26
Parental Controls for games, 248
passwords
for banking online, 203
creating for user accounts, 27
for Internet connection, 262
logging on to Windows 7, 27
strong, creating, 308-310
for user account, 379-381
peripherals, 11. See also printers;
scanners
personalizing. See customizing
phishing scams, 306-308
physical challenges. See assistive
options
Picture Puzzle gadget, 166-167
pictures
adding in word processor, 181-182
burning to DVD, 219-221
Clip Art, 182
computers suitable for, 14
deleting photos, 215
for desktop background, 62-64
e-mail attachments, cautions for, 308
e-mailing, 217-219, 336
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pictures (continued)
Pictures Library for, 208, 210,
217-222
rotating photos, 215
slide shows, 163-164, 215, 221-222
tagging in Windows Photo Viewer,
215-217
themes, 60-61, 63-66
uploading from digital camera, 213
for user account, changing, 34
viewing, 214-215
Windows Photo Viewer for, 208,
209, 214-217
Pictures Library
burning photos to DVD, 219-221
described, 208, 210
e-mailing photos from, 217-219
slide show creation, 221-222
playlists, 227-229
podcasts, playing with IE, 285-286
ports, 11, 26, 94-95
PowerPoint, 222
printers
changing settings when printing, 101
currently installed, viewing,
101-103
default, setting, 97-99
drivers for, 93, 95-96
installing, 94-97
preferences, 97-98, 99-101
removing, 103-104
viewing properties for, 102-103
wireless, 94
printing
changing printer settings for, 101
help topics, 110
page setup options, 185-187
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pictures from digital camera, 213
troubleshooting, 403
Web pages, 284-285
word processor documents,
187-188
privacy. See also security and safety
dating service issues, 361
IE settings for, 297-299
information exposure, 287,
301-304, 357, 361
InPrivate Browsing and Filtering
(IE), 294-296
with instant messaging, 352
keeping your information private,
304-306
private chat rooms, 350
social networking issues, 357, 358,
301
Web cam issues, 354-355
profiles for scanners, 106-107
programs. See also launching
programs; specific programs
antivirus, anti-spyware, and anti-
adware, 289-290, 369-370,
382-383
closing, 44, 55-57
digital camera software, 213
displaying list of programs, 40
for e-mail, 311
for games online, 251
installed, changing options,
136-137
installing, 138
instant messaging, 351
media software, 208-210
moving info between, 130-132
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nonresponsive, shutting down,
386-387
removing (uninstalling), 12,
136-138
setting defaults for, 134-136
software, defined, 7, 11
software basics, 12-13
switching between, 54-55, 57
troubleshooting problems, 401-403
utilities, 12
protection. See privacy; security and
safety
puzzle, gadget for, 166-167

o R o

RAM, 21, 22
reading e-mail, 327-328
rebooting your computer, 35
receiving e-mail, 319-320
recovery disks, burning, 20
Recycle Bin, 38, 46-47
refurbished computers, 17
Remote Assistance, 109, 118-121
removing. See closing; deleting or
removing
repeat rates for keyboard, 83, 87-88
replying to e-mail, 328-330
resizing
Help and Support Center text, 121
Magnifier feature, 75
mouse cursor, 90-92
objects in Works word processor,
182-183
photos for e-mail, 217, 218-219
text in Works word processor, 178
text on-screen, 78-79

windows, 40, 53-54

in Works word processor, 182-183
resolution, screen, 19, 60, 61-62
restoring the system, 391-393
Restricted Web sites, 375-377
return policies for computers, 17
right-clicking, 29
ripping music from CDs or DVDs,

233-235

risks. See security and safety
rotating photos, 215
RSS feeds, 272, 283-284

oS e

Safe Mode, starting in, 387-389
Safer Dates service, 363
safety. See security and safety
satellite Internet connection, 259. See
also Internet connection

saving

AutoSave feature, 387

before closing programs, 55, 57

custom themes, 66

importance of, 387

scanner profiles, 107

search results, 146-147

Works documents, 173-174
scams, e-mail, 306-308
scanners

drivers for, 105

installing, 104-106

settings for, 106-107

using, 107-108
scheduling maintenance tasks,

399-401

screen. See display; monitors
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screen saver, 61, 66-68
scrolling with mouse, 29
Search Folder feature, 146-147
searching in your computer, 112-114,
145-147
searching the Web. See also Web
resources
advanced searches, 273-274
finding content on a page, 275-276
information exposure check, 303
for RSS feed readers, 284
Search text boxes on pages for, 276
simple searches, 272-273
in Windows Communities, 116
security and safety. See also passwords
antivirus, anti-spyware, and anti-
adware programs for, 289-290,
369-370, 382-383
for banking online, 203
in chat rooms, 350
checking computer’s status,
381-383
computer, overview, 368-371
for dating services online, 362-364
for downloading files, 292-293
e-mail account usernames for, 314
e-mail fraud, 306-308
firewall for, 290, 368, 371, 377-379
IE Content Advisor for, 299-301
IE InPrivate Browsing and Filtering
for, 294-296
IE privacy settings for, 297-299
IE SmartScreen Filter for, 296-297
information exposure, 287,
301-304, 357, 361
instant messaging issues, 353
for investing online, 205
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keeping information private,
304-306
malware risks and protection,
288-291, 369-371
Parental Controls for games, 248
phishing scams, 306-308
risks on the Internet, 287-291,
368-369
Trusted and Restricted Web sites for,
375-377
Web cam issues, 354-355
Windows Defender for, 12-13, 290,
370
Windows Update for, 371-375
sending e-mail. See Windows Live
Mail
servers, defined, 258
setting up your computer
changing user account picture, 34
connecting the monitor, keyboard,
and mouse, 26
creating a user account, 28, 31-32
date and time settings, 29-31
logging on to Windows 7, 26-27
shutting down your computer,
35-36
switching user accounts, 33-34
shortcut text, 352
shuffling music tracks, 233
shutting down
computer, 35-36
nonresponsive programs, 386-387
signatures for e-mail, 331-332
sleep mode, 35, 41
Slide Show gadget, 163-164
slide shows
creating, 221-222
playing, 163-164, 215
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SmartScreen Filter (IE), 296-297
social networking
overview, 355-357
signing up for social networking,
357-361
types of, 356
software. See operating system;
programs
Solitaire game, 238-240
sound. See also music
for Caps Lock, Num Lock, and
Scroll Lock keys, 83
for playing games, 14
visual cues for, 76-78
volume setting for, 78, 226
speakers, 78, 224-225
Speech Recognition feature, 80-83
Spell Checker, 184-185, 323
Spider Solitaire game, 243-245
spreadsheets. See Works Spreadsheet
spyware, 289, 369. See also malware
(malicious software)
Spyware Doctor, 370
Standard user account, 31-32
Start menu
actions possible from, 40-41
customizing, 42-43
described, 37
displaying, 40, 41
starting programs. See launching
programs
starting Windows
launching programs upon, 132-134
logging on, 26-27
in Safe Mode, 387-389
Startup folder, 132-134
stationery for e-mail, 335-336
Sticky Keys feature, 83

stock transactions online, 204-206
Stocks gadget, 202
strong passwords, creating, 308-310
Suggested Sites feature (IE), 291-292
support. See Help and Support
Center
switching
between programs, 54-55, 57
user accounts, 28, 33-34
syncing music devices, 230-231
System Restore
creating a restore point, 389-391
restoring the system, 391-393
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tables, creating, 179-181
tabs in browsers, 265-267
tagging photos, 215-217
Task Manager, 386
taskbar
described, 38
displaying additional items, 44
launching programs, 52, 128-129
switching between programs, 55
temporary Internet files, deleting,
397-399
themes
choosing, 64-65
described, 60-61
saving custom themes, 66
Windows Aero, 69-71
Windows Live, 335-336, 337
threads on discussion boards, 347
time. See date and time
time zone, 30, 162
Toggle Keys feature, 83
toolbars (IE), customizing, 281-283
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transparency effects, 69-71

troubleshooting. See also maintaining

your computer
Aero themes, 70
frozen computer, 35
nonresponsive programs, 386-387

mouse cursor settings, 75, 89-93
Narrator feature, 74
text size adjustment, 78-79

visual cues for sounds, 76-78
volume

adjusting in Windows Media Player,

software problems, 401-403 211

starting in Safe Mode, 387-389 keyboard controls for, 227
Trusted Web sites, 375-377 master system volume, 225-227
turning off your computer, 35-36 Notifications area button, 226-227
Twitter, 356 setting for speakers, 78
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uninstalling programs, 12, 136-138 Wall Street Journal Web site, 201

uploading Web, defined, 256
attachments to e-mail, 325-327 Web browsers, 256. See also Internet
defined, 9 Explorer
pictures from digital camera, 213 Web browsing. See Internet Explorer;
USB port, 26 searching the Web

Web cams, 354-355
Web pages, defined, 256
Web resources. See also connecting to

used computers, 17
user accounts
changing picture for, 34

creating, 28

passwords for, 379-381

switching, 28, 33-34
utilities, 12. See also programs

o (/o

VGA port, 26
viruses, 289, 367, 369. See also
malware (malicious software)
visual challenges
Audio Description feature, 74
contrast adjustment for screen, 74,
75
eliminating distracting screen
elements, 75
Magnifier feature, 75
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people online; searching the Web
assistive technologies, 85
auction sites, 17-18
banking online, 203-204
for buying a computer, 17-18
credit reports online, 202, 305-306
dating service comparisons, 363
directories online, 303
FDIC site, 204
financial information, 201-202
FreeCell site, 243
gadgets, 161
games online, 250-252
help online, 117-118
IM text shortcuts, 352
instant messaging programs, 351
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investing online, 204-206
Microsoft Customer Support,
122-124
Remote Assistance feature, 118-121
RSS feed readers, 284
for scam checking, 307
Windows Communities, 109,
114-116
Windows Live Mail site, 319, 321
Web sites, defined, 256
wikis, 356
windows
making easier to manage, 84
maximizing, 40, 54
minimizing, 40, 53, 54
moving, 54
transparency effects, 69-71
Windows Aero themes, 69-71
Windows Communities, 109,
114-116
Windows Defender, 12-13, 290, 370
Windows Explorer. See also files and
folders
compressing files or folders,
153-155
deleting files or folders, 152-153
finding files or folders, 47
moving files or folders, 147-149
opening files from, 48
renaming files or folders, 149-150
Windows Firewall, enabling,
377-379
Windows Help and Support Center.
See Help and Support Center
Windows Live Mail. See also e-mail
adding people to Contact List,
337-339
Address Book feature, 324-325

creating and sending e-mail,
321-325
creating folders for messages,
340-342
customizing the Reading Pane,
339-340
deleting messages, 342
exclamation point next to messages,
320, 324
formatting messages, 333-335
forwarding e-mail, 330-331
inserting pictures in e-mail, 336
managing e-mail accounts, 314-316
organizing messages in folders,
342-343
overview, 316-318
reading e-mail, 327-328
receiving e-mail, 319-320
replying to e-mail, 328-330
sending attachments, 325-327
signatures for e-mail, 331-332
signing in, 319
sorting messages in the Inbox, 317
themes for, 335-336, 337
Windows Live Messenger, 351
Windows Media Center, 222
Windows Media Player
burning music CDs or DVDS,
229-230
described, 208, 209
playing movies, 210-212
playing music, 231-233
playlist creation, 227-229
ripping music from CDs or DVDs,
233-235
shuffling music tracks, 233
syncing music devices, 230-231
troubleshooting, 403

419



Computers For Seniors For Dummies, 2nd Edition

Windows Photo Viewer
adding tags to photos, 215-217
deleting photos, 215
described, 208, 209
playing slide shows, 215
rotating photos, 215
viewing photos in, 214-215
Windows 7
customizing appearance of, 60-71
shutting down, 35-36
starting and logging on, 26-27
starting in Safe Mode, 387-389
switching user accounts, 28, 33-34
system requirements for, 22
versions of, 15
Windows Task Manager, 386
Windows Update
described, 371
running, 373-375
settings for, 371-373
Windows Vista, 15-16
Windows XP, 15-16
wireless Internet connection, 22, 259,
260. See also Internet connection
wireless printers, 94. See also printers
Works Spreadsheet
AutoFormats for cells, 194-195
basics, 190-191
calculations using, 195-197
cost of Works, 171
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entering text, 191-192

filling out a series, 197-199

formatting numbers, 193-194

inserting a chart, 199-201

opening a new blank spreadsheet,
193

opening the program, 191

saving documents, 173-174

Works word processor

adding graphics, 181-182

cost of Works, 171

cutting or copying and pasting text,
175-176

editing text in, 172-173

entering text in, 172

formatting text, 176-179, 180

inserting a table, 179-181

opening an existing document,
174-175

opening the program, 172

page setup options, 185-187

printing a document, 187-188

resizing objects, 182-183

resizing text, 178

saving documents, 173-174

Spell Checker, 184-185

World Wide Web, defined, 256

oyo

Yahoo! Messenger, 351



With this friendly, hassle-free
guide, you can finally benefit from
all the Internet has to offer

If you'd like to be able to exchange e-mails with your
grandchildren, share photos with friends far away, and
enjoy the convenience of shopping and paying bills
online without checks and stamps, this book is just the
ticket. It explains what you need, where to get it, how
to use it,and how to stay safer, with plenty of examples
and illustrations.

* Choose wisely — investigate different types of computers,
price ranges, and how to set up the computer when you get
ithome

* Learn about Windows- 7 — practice all the basics from
turning on the computer to managing files and using the
Help system

* Get things done — use Microsoft® Works software to create
documents, plan budgets with spreadsheets, and get
organized

* Photos, music, and more — work with photos from your
digital camera, listen to music, and play games

* The world online — connect to the Internet, set up an
e-mail account, read and write blogs, and shop more safely

* Enlarge your circle — explore social networking sites
like Facebook and Eons and meet people who share your
interests

* Keep your computer happy — use routine maintenance,
virus protection, and updates

Nancy C. Muir owns a writing and consulting company that
specializes in business and technology topics. She is the author
of over 50 books including all editions of Computers For Seniors

For Dummies. Nancy provides free online safety tips through
the Web site ilookbothways.com and contributes columns on
www.RetireNet.com.
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Open the book and find:

* How to use the keyboard and
mouse

* Tips for making the computer
do what you want

* How to install a printer

* Advice for interacting with a
computer if you have vision,
hearing, or dexterity challenges

* How to create and edit
documents

* Directions for organizing your
photos

* Internet safety tips

* How to chat online

Go to Dummies.come®
for videos, step-by-step photos,
how-to articles, or to shop!
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